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Logical partitioning

You can set up, manage, and troubleshoot AIX®, IBM® i, Linux®, and Virtual I/O Server logical partitions
using the Hardware Management Console (HMC), Integrated Virtualization Manager, or Virtual Partition
Manager. By creating logical partitions, you can reduce the footprint of your datacenter by consolidating
servers, and maximize the use of system resources by sharing resources across logical partitions.

What’s new in Logical partitioning
Read about new or significantly changed information in Logical partitioning since the previous update of
this topic collection.

May 2009

The following updates have been made to the content:
v Logical partitions can share the memory in the shared memory pool by using the PowerVM™ Active

Memory™ Sharing technology (or shared memory). The following table shows information that is new
for shared memory.

Table 1. New information for shared memory

Information for systems that are managed by a
Hardware Management Console (HMC)

Information for systems that are managed by an
Integrated Virtualization Manager

v “Shared memory” on page 25

v “Preparing to configure shared memory on a system
that is managed by an HMC” on page 94

v “Configuring the shared memory pool” on page 134

v “Managing the shared memory pool” on page 139

v “Managing the memory configuration of a logical
partition” on page 182

v “Performance considerations for shared memory
partitions” on page 217

v “Shared memory” on page 25

v “Preparing to configure shared memory on a system
that is managed by the Integrated Virtualization
Manager” on page 93

v Defining the shared memory pool by using the
Integrated Virtualization Manager

v Managing the shared memory pool by using the
Integrated Virtualization Manager

v Dynamically managing memory by using the
Integrated Virtualization Manager

v “Performance considerations for shared memory
partitions” on page 217

v You can use the HMC graphical interface, version 7 release 3.4.2 or later to perform many virtual
network and storage tasks for a Virtual I/O Server logical partition. In previous versions, you were
required to complete these tasks using a Virtual I/O Server command-line interface. The following
tasks are new through the HMC graphical interface.
– “Creating a shared Ethernet adapter for a VIOS logical partition using the HMC” on page 136
– “Creating a virtual disk for a VIOS logical partition using the HMC” on page 137
– “Creating storage pools” on page 138
– “Changing a virtual disk for a VIOS logical partition using the Hardware Management Console” on

page 178
– “Changing a storage pool for a VIOS logical partition using the Hardware Management Console” on

page 180
– “Changing a physical volume for a VIOS logical partition using the Hardware Management

Console” on page 181
– “Changing an optical device for a VIOS logical partition by using the Hardware Management

Console” on page 179

© Copyright IBM Corp. 2007, 2009 1



– “Changing virtual fibre channel for a Virtual I/O Server using the Hardware Management Console”
on page 181

November 2008

The following updates have been made to the content:
v With N_Port ID Virtualization (NPIV) and virtual fibre channel adapters, you can configure the

managed system so that multiple logical partitions can access independent physical storage through
the same physical fibre channel adapter. The following information is new for virtual fibre channel
adapters:
– “Virtual fibre channel” on page 59
– “Configuring a virtual fibre channel adapter” on page 131
– Managing virtual Fibre Channel on the Integrated Virtualization Manager

PDF file for Logical partitioning
You can view and print a PDF of the logical partitioning information.

Logical partitioning PDF
You can set up, manage, and troubleshoot AIX, IBM i, Linux, and Virtual I/O Server logical partitions by
using the Hardware Management Console (HMC), Integrated Virtualization Manager, or Virtual Partition
Manager. By creating logical partitions, you can reduce the footprint of your datacenter by consolidating
servers, and you can maximize the use of system resources by sharing resources across logical partitions.

To view the PDF file of Logical partitioning, approximately 1 MB in size, see

http://publib.boulder.ibm.com/infocenter/systems/scope/hw/topic/iphat/iphat.pdf .

Saving PDF files

Large PDF files can be difficult to open online. For best results, save the PDF to your local drive for
viewing or printing. Follow these steps:
1. Right-click the PDF link in your browser.
2. Click the option that saves the PDF locally.
3. Navigate to the directory in which you want to save the PDF.
4. Click Save.

Downloading Adobe® Reader

You need Adobe Reader installed on your system to view or print these PDF files. You can download a
free copy from the Adobe Reader Web site at http://www.adobe.com/products/acrobat/readstep2.html

.

Integrated Virtualization Manager PDF
The Integrated Virtualization Manager provides a Web-based system management interface and a
command-line interface that you can use to manage some IBM Power Systems® and some IBM
BladeCenter® blade servers that use the IBM Virtual I/O Server.

Integrated Virtualization Manager (approximately 1MB)
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Saving PDF files

Large PDF files can be difficult to open online. For best results, save the PDF to your local drive for
viewing or printing. Follow these steps:
1. Right-click the PDF link in your browser.
2. Click the option that saves the PDF locally.
3. Navigate to the directory in which you want to save the PDF.
4. Click Save.

Downloading Adobe Reader

You need Adobe Reader installed on your system to view or print these PDF files. You can download a
free copy from the Adobe Reader Web site at http://www.adobe.com/products/acrobat/readstep2.html

.

Logical partition overview
Logical partitioning is the ability to make a server run as if it were two or more independent servers.
When you logically partition a server, you divide the resources on the server into subsets called logical
partitions. You can install software on a logical partition, and the logical partition runs as an independent
logical server with the resources that you have allocated to the logical partition.

You can assign processors, memory, and input/output devices to logical partitions. You can run AIX, IBM
i, Linux, and the Virtual I/O Server in logical partitions. The Virtual I/O Server provides virtual I/O
resources to other logical partitions with general-purpose operating systems.

Logical partitions share a few system attributes, such as the system serial number, system model, and
processor feature code. All other system attributes can vary from one logical partition to another.

You must use tools to create logical partitions on your servers. The tool that you use to create logical
partitions on each server depends on the server model and the operating systems and features that you
want to use on the server.

Benefits of logical partitioning
When you create logical partitions on your server, you can consolidate servers, share system resources,
create mixed environments, and run integrated clusters.

The following scenarios illustrate the benefits of partitioning your server:

Consolidating servers
A logically partitioned server can reduce the number of servers that are needed within an
enterprise. You can consolidate several servers into a single logically partitioned system. This
eliminates the need for, and expense of, additional equipment.

Sharing resources
You can quickly and easily move hardware resources from one logical partition to another as
needs change. Technologies such as the Micro-Partitioning™ technology allow for processor
resources to be shared automatically among logical partitions that use a shared processor pool.
Similarly, the PowerVM Active Memory Sharing technology allows for memory resources to be
shared automatically among logical partitions that use the shared memory pool. Other
technologies, such as dynamic logical partitioning, allow for resources to be manually moved to,
from, and between running logical partitions without shutting down or restarting the logical
partitions.

Logical partitioning 3
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Maintaining independent servers
Dedicating a portion of the resources (disk storage unit, processors, memory, and I/O devices) to
a logical partition achieves logical isolation of software. If configured correctly, logical partitions
also have some hardware fault tolerance. Batch and 5250 online transaction processing (OLTP)
workloads, which might not run well together on a single machine, can be isolated and run
efficiently in separate partitions.

Creating a mixed production and test environment
You can create a combined production and test environment on the same server. The production
logical partition can run your main business applications, and the test logical partition is used to
test software. A failure in a test logical partition, while not necessarily planned, will not disrupt
normal business operations.

Merging production and test environments
Partitioning enables separate logical partitions to be allocated for production and test servers,
eliminating the need to purchase additional hardware and software. When testing has been
completed, the resources allocated to the test logical partition can be returned to the production
logical partition or elsewhere as required. As new projects are developed, they can be built and
tested on the same hardware on which they will eventually be deployed.

Running integrated clusters
Using high-availability application software, your partitioned server can run as an integrated
cluster. You can use an integrated cluster to protect your server from most unscheduled failures
within a logical partition.

Although there are many benefits to creating logical partitions, consider the following points before
choosing to use logical partitions:
v Processor and memory failures might result in the failure of the entire server with all of its logical

partitions. (The failure of a single I/O device affects only the logical partition to which the I/O device
belongs.) To reduce the possibility of system failure, you can use the Advanced System Management
Interface (ASMI) to set the server to deconfigure failing processors or memory modules automatically.
After the server deconfigures the failing processor or memory module, the server continues running
without using the deconfigured processor or memory module.

v Administering a consolidated system might be more difficult in some ways than administering
multiple smaller systems, particularly if the resources in the consolidated system are used at a level
close to their capacity. If you anticipate that you will use your server at a level close to its capacity,
consider ordering a server model that is capable of Capacity on Demand (CoD).

Related information

Capacity on Demand

Sharing resources between logical partitions
Although each logical partition acts as an independent server, the logical partitions on a server can share
some kinds of resources with each other. The ability to share resources among many logical partitions
allows you to increase resource utilization on the server and to move the server resources to where they
are needed.

The following list illustrates some of the ways in which logical partitions can share resources. For some
server models, the features mentioned in this list are options for which you must obtain and enter an
activation code:
v The Micro-Partitioning technology (or shared processing) allows logical partitions to share the

processors in shared processor pools. Each logical partition that uses shared processors is assigned a
specific amount of processor power from its shared processor pool. By default, each logical partition is
set so that the logical partition uses no more than its assigned processor power. Optionally, you can set
a logical partition so that the logical partition can use processor power that is not being used by other
logical partitions in its shared processor pool. If you set the logical partition so that it can use unused
processor power, the amount of processor power that the logical partition can use is limited by the
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virtual processor settings of the logical partition and by the amount of unused processor power
available in the shared processor pool that is used by the logical partition.

v Logical partitions can share the memory in the shared memory pool by using the PowerVM Active
Memory Sharing technology (or shared memory). Instead of assigning a dedicated amount of physical
memory to each logical partition that uses shared memory (hereafter referred to as shared memory
partitions), the hypervisor constantly provides the physical memory from the shared memory pool to
the shared memory partitions as needed. The hypervisor provides portions of the shared memory pool
that are not currently being used by shared memory partitions to other shared memory partitions that
need to use the memory. When a shared memory partition needs more memory than the current
amount of unused memory in the shared memory pool, the hypervisor stores a portion of the memory
that belongs to the shared memory partition in auxiliary storage. Access to the auxiliary storage is
provided by a Virtual I/O Server logical partition. When the operating system attempts to access data
that is located in the auxiliary storage, the hypervisor directs a Virtual I/O Server to retrieve the data
from the auxiliary storage and write it to the shared memory pool so that the operating system can
access the data. The PowerVM Active Memory Sharing technology is available with the PowerVM
Enterprise Edition hardware feature, which also includes the license for the Virtual I/O Server
software.

v Dynamic logical partitioning allows you to manually move resources to, from, and between running
logical partitions without shutting down or restarting the logical partitions. This allows you to share
devices that logical partitions use occasionally. For example, if the logical partitions on your server use
an optical drive occasionally, you can assign a single optical drive to multiple logical partitions as a
desired device. The optical drive would belong to only one logical partition at a time, but you can use
dynamic logical partitioning to move the optical drive between logical partitions as needed. Dynamic
logical partitioning is not supported on servers that are managed using the Virtual Partition Manager.

v Virtual I/O allows logical partitions to access and use I/O resources on other logical partitions. For
example, virtual Ethernet allows you to create a virtual LAN that connects the logical partitions on
your server to each other. If one of the logical partitions on the server has a physical Ethernet adapter
that is connected to an external network, you can configure the operating system of that logical
partition to connect the virtual LAN with the physical Ethernet adapter. This allows the logical
partitions on the server to share a physical Ethernet connection to an external network.

v A Host Ethernet Adapter (HEA), or Integrated Virtual Ethernet (IVE), allows multiple logical partitions
on the same POWER6™ processor-based system to share a single physical Ethernet adapter. Unlike
most other types of I/O devices, you can never assign the HEA itself to a logical partition. Instead,
multiple logical partitions can connect directly to the HEA and use the HEA resources. This allows
these logical partitions to access external networks through the HEA without having to go through an
Ethernet bridge on another logical partition.

Related concepts

“Shared processors” on page 18
Shared processors are physical processors whose processing capacity is shared among multiple logical
partitions. The ability to divide physical processors and share them among multiple logical partitions is
known as the Micro-Partitioning technology.
“Shared memory” on page 25
You can configure your system so that multiple logical partitions share a pool of physical memory. A
shared memory environment includes the shared memory pool, logical partitions that use the shared
memory in the shared memory pool, logical memory, I/O entitled memory, at least one Virtual I/O
Server logical partition, and paging space devices.

Managed systems
A managed system is a single physical server plus the resources that are connected to the physical server.
The physical server and the connected resources are managed by the physical server as a single unit.
Connected resources can include expansion units, towers, and drawers, and storage area network (SAN)
resources that are assigned to the server.
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You can install a single operating system on a managed system and use the managed system as a single
server. Alternately, you can use a partitioning tool, such as the Hardware Management Console (HMC) or
the Integrated Virtualization Manager to create multiple logical partitions on the managed system. The
partitioning tool manages the logical partitions on the managed system.

Manufacturing default configuration
The manufacturing default configuration is the initial single partition setup of the managed system as
received from your service provider.

When your system is in the manufacturing default configuration, you can install an operating system on
the managed system and use the managed system as a nonpartitioned server. In this state, you do not
need to manage the system using a Hardware Management Console (HMC).

If you choose to attach an HMC to a managed system that is in the manufacturing default configuration
for reasons other than partitioning (such as to activate Capacity on Demand), all of the physical hardware
resources on the system are automatically assigned to the logical partition. If you add new physical
hardware resources to the managed system, the resources are automatically assigned to the logical
partition. However, in order to use the newly added resources, you need to dynamically add the
resources to the logical partition or restart the logical partition. You do not need to make any partitioning
changes on the server if you do not want to do so.

However, if you use the HMC to create, delete, change, copy, or activate any logical partitions or partition
profiles on the managed system, the system will then be in partition mode. You must then use the HMC
to manage the managed system. If the server has at least one IBM i logical partition, then you must also
change the managed system properties on the HMC so that one of the IBM i logical partitions on the
managed system is the service partition for the managed system. If a managed system is managed using
an HMC, and you want to return the managed system to an nonpartitioned state or if you want to
partition the managed system with the Integrated Virtualization Manager or the Virtual Partition
Manager, then you must follow a special procedure to reset the server.

Managed systems that are partitioned using the Integrated Virtualization Manager are not managed with
an HMC. If a managed system is managed using the Integrated Virtualization Manager, then you do not
need to reset the server to return the managed system to a nonpartitioned state. Also, you do not need to
reset the server if you want to switch from using the Integrated Virtualization Manager to using an HMC.
To switch to using an HMC, back up the data on each logical partition, attach the HMC to the server,
create the logical partitions, and restore the data to the storage assigned to each logical partition.
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Related concepts

“Logical partitioning tools”
You must use tools to create logical partitions on your servers. The tool that you use to create logical
partitions on each server depends upon the server model and the operating systems and features that
you want to use on the server.
Related tasks

“Resetting the managed system to a nonpartitioned configuration” on page 127
You can use the Hardware Management Console (HMC) and the Advanced System Management
Interface (ASMI) to erase all of your logical partitions and reset the managed system to a nonpartitioned
configuration. When you reset the managed system, all of the physical hardware resources are assigned
to a single logical partition. This allows you to use the managed system as if it were a single,
nonpartitioned server.
Related information

Activating Capacity Upgrade on Demand

Logical partitioning tools
You must use tools to create logical partitions on your servers. The tool that you use to create logical
partitions on each server depends upon the server model and the operating systems and features that
you want to use on the server.

Hardware Management Console
The Hardware Management Console (HMC) is a hardware appliance that you can use to configure and
control one or more managed systems. You can use the HMC to create and manage logical partitions and
activate Capacity Upgrade on Demand. Using service applications, the HMC communicates with
managed systems to detect, consolidate, and send information to service and support for analysis.

The HMC also provides terminal emulation for the logical partitions on your managed system. You can
connect to logical partitions from the HMC itself, or you can set up the HMC so that you can connect to
logical partitions remotely through the HMC. HMC terminal emulation provides a dependable connection
that you can use if no other terminal device is connected or operational. HMC terminal emulation is
particularly useful during initial system setup, before you have configured your terminal of choice.

In this figure, you can see the logical partitions and the server firmware on the server. The server firmware
is code that is stored in system flash memory on the server. The server firmware directly controls the
resource allocations on the server and the communications between logical partitions on the server. The
HMC connects with the server firmware and specifies how the server firmware allocates resources to the
managed system.

If you use a single HMC to manage a server, and the HMC malfunctions or becomes disconnected from
the server firmware, then the server continues to run, but you will not be able to change the logical

Logical partitioning 7



partition configuration of the server. If desired, you can attach an additional HMC to act as a backup and
to provide a redundant path between the server and service and support.

Partitioning using the HMC is supported on all IBM Power Systems models, although some models
require you to enter a PowerVM Editions activation code before partitioning the managed system.

Partition profile:

A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.

A partition profile specifies the desired system resources for the logical partition and the minimum and
maximum amounts of system resources that the logical partition can have. The system resources specified
within a partition profile includes processors, memory, and I/O resources. The partition profile can also
specify certain operating settings for the logical partition. For example, you can set a partition profile so
that, when the partition profile is activated, the logical partition is set to start automatically the next time
that you power on the managed system.

Each logical partition on a managed system that is managed by an HMC has at least one partition profile.
If desired, you can create additional partition profiles with different resource specifications for your
logical partition. If you create multiple partition profiles, you can designate any partition profile on the
logical partition to be the default partition profile. The HMC activates the default profile if you do not
select a specific partition profile to be activated. Only one partition profile can be active at one time. To
activate another partition profile for a logical partition, you must shut down the logical partition before
you activate the other partition profile.

A partition profile is identified by the logical partition ID and partition profile name. Logical partition
IDs are whole numbers used to identify each logical partition that you create on a managed system, and
partition profile names identify the partition profiles that you create for each logical partition. Each
partition profile on a logical partition must have a unique partition profile name, but you can use a
partition profile name for different logical partitions on a single managed system. For example, logical
partition 1 cannot have more than one partition profile with a partition profile name of normal, but you
can create a normal partition profile for each logical partition on the managed system.

When you create a partition profile, the HMC shows you all of the resources available on your system.
The HMC does not verify if another partition profile is currently using a portion of these resources.
Therefore, it is possible for you to overcommit resources. When you activate a logical partition using a
partition profile, the system attempts to start the logical partition using the resources that are specified in
the partition profile. If the minimum resources specified in the partition profile are not available on the
managed system, the logical partition cannot be started using the partition profile.

For example, you have four processors on your managed system. Logical partition 1 with partition profile
A has three processors, and logical partition 2 with partition profile B has two processors. If you attempt
to activate both of these partition profiles at the same time, logical partition 2 with partition profile B will
fail to activate because you have overcommitted processor resources.

When you shut down a logical partition and reactivate the logical partition using a partition profile, the
partition profile overlays the resource specifications of the logical partition with the resource
specifications in the partition profile. Any resource changes that you made to the logical partition using
dynamic logical partitioning are lost when you reactivate the logical partition using a partition profile.
This is desirable when you want to undo dynamic logical partitioning changes to the logical partition.
However, this is not desirable if you want to reactivate the logical partition using the resource
specifications that the logical partition had when you shut down the managed system. It is therefore best
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to keep your partition profiles up to date with the latest resource specifications. You can save the current
configuration of the logical partition as a partition profile. This allows you to avoid having to change
partition profiles manually.

If you shut down a logical partition whose partition profiles are not up to date, and the logical partition
is set to start automatically when the managed system starts, you can preserve the resource specifications
on that logical partition by restarting the entire managed system using the partition autostart power-on
mode. When the logical partitions start automatically, the logical partitions have the resource
specifications that the logical partitions had when you shut down the managed system.
Related tasks

“Saving the logical partition configuration to a partition profile” on page 177
You can save the current configuration of a logical partition to a new partition profile using the
Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical
partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate
the logical partition. This procedure allows you to save the changed configuration to a new partition
profile instead of having to enter the changed resource allocations manually.

Processor resource assignment in partition profiles:

When you create a partition profile for a logical partition, you set up the desired, minimum, and
maximum amounts of processor resources that you want for the logical partition.

The desired value is the resource amount that the logical partition gets if you do not overcommit the
resource on the managed system. If the desired amount of resources is available when you activate the
partition profile, then the logical partition starts with the desired amount of resources. However, if the
desired amount of resources is not available when you activate the partition profile, then the resources on
your managed system are overcommitted. In that case, if the amount of resources that are available on
the managed system is equal to or greater than the minimum amount of resources in the partition profile,
then the logical partition starts with the available amount of resources. If the minimum amount of
resources is not met, then the logical partition does not start.

If the managed system allows the configuration of multiple shared processor pools, then you can limit
the number of processors that are used by a specific group of logical partitions by configuring a shared
processor pool for those logical partitions and reassigning those logical partitions to that shared processor
pool. For example, if you use per-processor licensing for IBM i, and you have a limited number of IBM i
licenses for your managed system, you can create a shared processor pool for the IBM i logical partitions
on the managed system and set the maximum number of processing units for that shared processor pool
to be equal to the number of IBM i licenses on the managed system. If you configure a shared processor
pool and assign logical partitions to that shared processor pool, the number of processing units used by
those logical partitions plus the number of processing units that are reserved for the use of uncapped
logical partitions within the shared processor pool cannot exceed the maximum number of processing
units that you set for that shared processor pool.

If you create a partition profile that is set to use shared processors, the HMC calculates a minimum,
maximum, and desired number of virtual processors for the partition profile. The calculation of virtual
processors is based upon the minimum, maximum, and desired number of processing units that you
specify for the partition profile. By default, the virtual processor settings are calculated as follows:
v The default minimum number of virtual processors is the minimum number of processing units

(rounded up to the next whole number). For example, if the minimum number of processing units is
0.8, the default minimum number of virtual processors is 1.

v The default desired number of virtual processors is the desired number of processing units (rounded
up to the next whole number). For example, if the desired number of processing units is 2.8, the
default desired number of virtual processors is 3.
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v The default maximum number of virtual processors is the maximum number of processing units
rounded up to the next whole number and multiplied by two. For example, if the maximum number
of processing units is 3.2, the default maximum number of virtual processors is 8 (4 times 2).

When you activate the logical partition using the partition profile on the HMC, the logical partition is
assigned the desired number of virtual processors. You can then use dynamic logical partitioning to
change the number of virtual processors to any number between the minimum and maximum values, so
long as the number of virtual processors is greater than the number of processing units that are assigned
to the logical partition. Before changing the default settings, performance modeling should be performed.

For example, you create a partition profile on the HMC with the following processor unit settings.
Minimum processing units 1.25
Desired processing units 3.80
Maximum processing units 5.00

The default virtual processor settings for this partition profile on the HMC are as follows.
Minimum virtual processors 2
Desired virtual processors 4
Maximum virtual processors 10

When you activate the logical partition using this partition profile on the HMC, the operating system sees
four processors, because the logical partition is activated with the desired value of four virtual processors.
Each of these virtual processors has 0.95 processing units supporting the work assigned to the processor.
After the logical partition is activated, you can use dynamic logical partitioning to change the number of
virtual processors on the logical partition to any number between 2 and 10, so long as the number of
virtual processors is greater than the number of processing units that are assigned to the logical partition.
If you increase the number of virtual processors, bear in mind that you will have less processing power
supporting the work assigned to each processor.
Related concepts

“Processors” on page 15
A processor is a device that processes programmed instructions. The more processors that you assign to a
logical partition, the greater the number of concurrent operations that the logical partition can run at any
given time.

Memory resource assignment in partition profiles:

When you create a partition profile for a logical partition, you set up the desired, minimum, and
maximum amounts of memory resources that you want for the logical partition.

When you create a partition profile that is set to use dedicated memory, the desired, minimum, and
maximum amounts of memory that you specify refer to physical memory in the system. If the desired
amount of physical memory is available on the managed system when you activate the partition profile,
the logical partition starts with the desired amount of physical memory. However, if the desired amount
of physical memory is not available when you activate the partition profile, the physical memory on your
managed system is overcommitted. In that case, if the amount of physical memory that is available on
the managed system is equal to or greater than the minimum amount of physical memory in the partition
profile, the logical partition starts with the available amount of physical memory. If the minimum amount
of physical memory is not available, then the logical partition does not start.

When you create a partition profile that is set to use shared memory, the desired, minimum, and
maximum amounts of memory that you specify refer to logical memory. When you activate the partition
profile, the logical partition starts with the desired amount of logical memory. You can dynamically add
and remove logical memory to and from a running logical partition within the minimum and maximum
values set in the partition profile.
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Related concepts

“Memory” on page 21
Processors use memory to temporarily hold information. Memory requirements for logical partitions
depend on the logical partition configuration, I/O resources assigned, and applications used.

I/O device assignment in partition profiles:

I/O devices are assigned to partition profiles on a slot-by-slot basis. Most I/O devices can be assigned to
a partition profile on the HMC as required or as desired.
v If an I/O device is assigned to a partition profile as required, then the partition profile cannot be

successfully activated if the I/O device is unavailable or is in use by another logical partition. Also,
after the logical partition starts, you cannot use dynamic logical partitioning to remove the required
I/O device from the running logical partition or move the required I/O device to another logical
partition. This setting is suitable for devices that are required for the continuous operation of the
logical partition (such as disk drives).

v If an I/O device is assigned to a partition profile as desired, then the partition profile can be
successfully activated if the I/O device is unavailable or is in use by another logical partition. The
desired I/O device can also be deconfigured in the operating system or system software and removed
from the running logical partition or moved to another logical partition using dynamic logical
partitioning. This setting is suitable for devices that you want to share among multiple logical
partitions (such as optical drives or tape drives).

The exception to this rule is host channel adapters (HCAs), which are added to partition profiles on the
HMC as required. Each physical HCA contains a set of 64 globally unique IDs (GUIDs) that can be
assigned to partition profiles. You can assign multiple GUIDs to each partition profile, but you can assign
only one GUID from each physical HCA to each partition profile. Also, each GUID can be used by only
one logical partition at a time. You can create multiple partition profiles with the same GUID, but only
one of those partition profiles can be activated at a time.

You can change the required or desired setting within any partition profile for any I/O device at any
time. Changes to the required or desired setting for an I/O device take effect immediately, even if the
logical partition is running. For example, you want to move a tape device from one running logical
partition to another, and the I/O device is required in the active partition profile for the source logical
partition. You can access the active partition profile for the source logical partition, set the tape device to
be desired, and then deconfigure and move the tape device to the other logical partition without having
to restart either logical partition.

If you create an IBM i logical partition using the HMC, you must tag I/O devices to perform certain
functions for that IBM i logical partition.
Related concepts

“Tagged resources for IBM i logical partitions” on page 68
When you create an IBM i logical partition using the Hardware Management Console (HMC), you must
tag I/O processors (IOPs) or I/O adapters (IOAs) to perform specific functions for the IBM i logical
partition.
Related reference

“Virtual adapters” on page 55
With virtual adapters, you can connect logical partitions with each other without using physical
hardware. Operating systems can display, configure, and use virtual adapters just like they can display,
configure, and use physical adapters. Depending on the operating environment used by the logical
partition, you can create virtual Ethernet adapters, virtual fibre channel adapters, virtual Small Computer
Serial Interface (SCSI) adapters, and virtual serial adapters for a logical partition.

Partition profiles that use all of the system resources:

Logical partitioning 11



You can create partition profiles on your HMC that specify all of the resources on the managed system. If
you activate a logical partition using such a partition profile, then the managed system assigns all of its
resources to the logical partition.

If you add additional resources to the managed system, the managed system automatically assigns the
added resources to the logical partition when the profile is activated. The profile must be activated while
the server is in ’partition standby’ state, because automatic restart of the logical partition will not assign
newly added processor and memory resources. You do not need to change the partition profile for the
managed system to assign the additional resources to the logical partition.

You cannot activate a logical partition using a partition profile that specifies all of the system resources if
any other logical partition is running. However, after the logical partition is activated with all of the
system resources, you can remove most processor and memory resources and all I/O resources from the
logical partition using dynamic logical partitioning. This allows you to start other logical partitions using
the resources that you remove from the logical partition. There is an implicit minimum amount of
processor and memory resources that is reserved for the logical partition that uses all of the system
resources, so you cannot remove all processor and memory resources from such a logical partition.
Related concepts

“Managing logical partition resources dynamically” on page 162
You use the Hardware Management Console (HMC) to add, remove, or move processor, memory, and
I/O resources between running logical partitions without restarting the logical partitions or the managed
system.

System profile:

A system profile is an ordered list of partition profiles that is used by the Hardware Management Console
(HMC) to start the logical partitions on a managed system in a specific configuration.

When you activate the system profile, the managed system attempts to activate each partition profile in
the system profile in the order specified. A system profile helps you activate or change the managed
system from one complete set of logical partition configurations to another.

It is possible for you to create a system profile whose partition profiles specify more resources than are
available on the managed system. You can use the HMC to validate the system profile against the
currently available system resources and against the total system resources. Validating your system
profile ensures that your I/O devices and processing resources are not overcommitted, and it increases
the likelihood that the system profile can be activated. The validation process estimates the amount of
memory needed to activate all of the partition profiles in the system profile. It is possible that a system
profile can pass validation and yet not have enough memory to be activated.

System profiles cannot include partition profiles that specify shared memory. In other words, logical
partitions that use shared memory cannot be activated by using a system profile.
Related tasks

“Validating a system profile” on page 161
When you validate a system profile, the Hardware Management Console (HMC) compares the resources
defined in the system profile with the resources available on the managed system. If the system profile
requires more resources than are available on the managed system, a message is displayed on the HMC.

Partitioning with the Integrated Virtualization Manager
The Integrated Virtualization Manager is a browser-based system management interface for the Virtual I/O
Server. The Integrated Virtualization Manager provides you with the ability to create and manage logical
partitions on a single server.

Virtual I/O Server is software that provides virtual storage and shared Ethernet resources to the other
logical partitions on the managed system. Virtual I/O Server is not a general purpose operating system
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that can run applications. Virtual I/O Server is installed on a logical partition in the place of a general
purpose operating system, and is used solely to provide virtual I/O resources to other logical partitions
with general purpose operating systems. You use the Integrated Virtualization Manager to specify how
these resources are assigned to the other logical partitions.

To use the Integrated Virtualization Manager, you must first install Virtual I/O Server on an
unpartitioned server. Virtual I/O Server automatically creates a logical partition for itself, which is called
the management partition for the managed system. The management partition is the Virtual I/O Server
logical partition that controls all of the physical I/O resources on the managed system. After you install
Virtual I/O Server, you can configure a physical Ethernet adapter on the server so that you can connect
to the Integrated Virtualization Manager from a computer with a Web browser.

Note: The Integrated Virtualization Manager is supported only on specific server models.

This figure illustrates an IBM Power Systems server or an IBM BladeCenter blade server with POWER®

Architecture technology. The Virtual I/O Server is in its own logical partition, and the client logical
partitions are managed by the Virtual I/O Server logical partition. The browser on the PC connects to the
Integrated Virtualization Manager interface over a network, and you can use the Integrated Virtualization
Manager to create and manage the logical partitions on the server.

Resource assignment

When you use the Integrated Virtualization Manager to create logical partitions, you can assign memory
and processor resources directly to logical partitions. If a logical partition uses dedicated processors, you
specify the exact number of dedicated processors for the logical partition to use. If a logical partition uses
shared processors, you can specify the number of virtual processors for the logical partition, and the
Integrated Virtualization Manager calculates the number of processing units it assigns to the logical
partition based on the number of virtual processors. If the logical partition uses dedicated memory, you
can specify the amount of physical memory for the logical partition to use. If the logical partition uses
shared memory, you can specify the amount of logical memory for the logical partition to use. In all
cases, the amount of resources that you assign to a logical partition is committed to the logical partition
from the time that you create the logical partition until the time that you change this amount or delete
the logical partition. You cannot overcommit processor and memory resources to logical partitions by
using the Integrated Virtualization Manager.

A logical partition that is created by using the Integrated Virtualization Manager has minimum and
maximum processor values. The minimum and maximum values are used when you use a workload
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management application on the managed system, when you restart the managed system after a processor
failure, or when you dynamically move resources to or from the Virtual I/O Server management
partition. By default, the minimum and maximum values are set to the same value as the actual amount
of committed resources. You can change the minimum and maximum processor values at any time.

A logical partition that is created by using the Integrated Virtualization Manager has minimum and
maximum memory values. For logical partitions that are configured to use dedicated memory, these
values refer to physical memory. The minimum and maximum values are used when you use a workload
management application on the managed system, when you restart the managed system, or when you
dynamically move memory to or from the Virtual I/O Server management partition. For logical partitions
that are configured to use shared memory, these values refer to logical memory. The minimum and
maximum values are used when you use a workload management application on the managed system,
when you restart the managed system, or when you dynamically add or remove memory to or from a
logical partition that uses shared memory. For logical partitions that are configured to use either
dedicated or shared memory, you can change the minimum and maximum memory values only while
the logical partition is not running.

When you use the Integrated Virtualization Manager to create logical partitions on your managed system,
a fraction of the memory and a fraction of the processors on the managed system are assigned to the
Virtual I/O Server management partition. If desired, you can change the memory and processor resources
that are assigned to the management partition to match your Virtual I/O Server workload. Physical disks
can be assigned directly to logical partitions, or they can be assigned to storage pools, and virtual disks
(or logical volumes) can be created from these storage pools and assigned to logical partitions. Physical
Ethernet connections are generally shared by configuring the physical Ethernet adapter as a virtual
Ethernet bridge between the virtual LAN on the server and an external, physical LAN.
Related information

Integrated Virtualization Manager

Virtual Partition Manager
The Virtual Partition Manager is a feature of IBM i that allows you to create and manage one IBM i logical
partition and up to four Linux logical partitions on a single IBM System i® server. You can use the Virtual
Partition Manager to create logical partitions on any IBM System i model that does not require a
Hardware Management Console (HMC).

To use the Virtual Partition Manager, you must first install IBM i on an nonpartitioned server. After you
install IBM i, you can initiate a console session on IBM i and use System Service Tools (SST) to create and
configure Linux logical partitions. IBM i controls the resource allocations of the logical partitions on the
server.
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This figure illustrates the IBM i logical partition and the Linux logical partitions that are managed by the
IBM i logical partition. The user creates and configures the Linux logical partitions on the server by
accessing SST over the twinaxial console.

When you use the Virtual Partition Manager to create logical partitions on a server, SST is the only tool
that you can use to create and manage the logical partitions. You cannot use System i Navigator to create
or manage logical partitions on a server. However, the console session that you use to access SST can be
initiated using either Operations Console (LAN or direct attach) or a twinaxial console.
Related information

Virtual Partition Manager: A Guide to Planning and Implementation RedPaper

Physical and virtual hardware resources
When you create logical partitions on a managed system, you can assign the physical resources on the
managed system directly to logical partitions. You can also share hardware resources among logical
partitions by virtualizing those hardware resources. The methods used to virtualize and share hardware
resources depend on the type of resource that you are sharing.

Processors
A processor is a device that processes programmed instructions. The more processors that you assign to a
logical partition, the greater the number of concurrent operations that the logical partition can run at any
given time.

You can set a logical partition to use either processors that are dedicated to the logical partition or
processors that are shared with other logical partitions. If a logical partition uses dedicated processors,
then you must assign processors (in increments of whole numbers) to the logical partition. A logical
partition that uses dedicated processors cannot use any processing capacity beyond the processors that
are assigned to the logical partition.

By default, all physical processors that are not dedicated to specific logical partitions are grouped
together in a shared processor pool. You can assign a specific amount of the processing capacity in this
shared processor pool to each logical partition that uses shared processors. Some models allow you to use
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the HMC to configure multiple shared processor pools. These models have a default shared processor pool
that contains all the processor resources that do not belong to logical partitions that use dedicated
processors or logical partitions that use other shared processor pools. The other shared processor pools on
these models can be configured with a maximum processing unit value and a reserved processing unit
value. The maximum processing unit value limits the total number of processors that can be used by the
logical partitions in the shared processor pool. The reserved processing unit value is the number of
processing units that are reserved for the use of uncapped logical partitions within the shared processor
pool.

You can set a logical partition that uses shared processors to use as little as 0.10 processing units, which is
approximately one tenth of the processing capacity of a single processor. You can specify the number of
processing units to be used by a shared processor logical partition down to the hundredth of a processing
unit. Also, you can set a shared processor logical partition so that, if the logical partition requires more
processing capacity than its assigned number of processing units, the logical partition can use processor
resources that are not assigned to any logical partition or processor resources that are assigned to another
logical partition but that are not being used by the other logical partition. (Some server models might
require you to enter an activation code before you can create logical partitions that use shared
processors.)

You can assign up to the entire processing capacity on the managed system to a single logical partition,
provided that the operating system and server model supports doing so. You can configure your
managed system so that it does not comply with the software license agreement for your managed
system, but you will receive out-of-compliance messages if you operate the managed system in such a
configuration.

Automatic redistribution of work when a processor fails

If the server firmware detects that a processor is about to fail, or if a processor fails when the processor is
not in use, then the server firmware creates a serviceable event. The server firmware can also deconfigure
the failing processor automatically, depending upon the type of failure and the deconfiguration policies
that you set up using the Advanced System Management Interface (ASMI). You can also deconfigure a
failing processor manually using the ASMI.

When the server firmware deconfigures a failing processor, and there are no unassigned or unlicensed
processors available on the managed system, the processor deconfiguration can cause the logical partition
to which the processor is assigned to shut down. To avoid shutting down mission-critical workloads
when your server firmware deconfigures a failing processor, you can use the HMC to set
partition-availablity priorities for the logical partitions on your managed system. A logical partition with
a failing processor can acquire a replacement processor from one or more logical partitions with a lower
partition-availability priority. The managed system can dynamically reduce the number of processors
used by shared processor partitions with lower partition-availability priorities and use the freed processor
resources to replace the failing processor. If this does not provide enough processor resources to replace
the failing processor, the managed system can shut down logical partitions with lower
partition-availability priorities and use those freed processor resources to replace the failing processor.
The acquisition of a replacement processor allows the logical partition with the higher
partition-availability priority to continue running after a processor failure.

A logical partition can take processors only from logical partitions with lower partition-availability
priorities. If all of the logical partitions on your managed system have the same partition-availability
priority, then a logical partition can replace a failed processor only if the managed system has unlicensed
or unassigned processors.

By default, the partition-availability priority of Virtual I/O Server logical partitions with virtual SCSI
adapters is set to 191. The partition-availablity priority of all other logical partitions is set to 127 by
default.
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Do not set the priority of Virtual I/O Server logical partitions to be lower than the priority of the logical
partitions that use the resources on the Virtual I/O Server logical partition. Do not set the priority of IBM
i logical partitions with virtual SCSI adapters to be lower than the priority of the logical partitions that
use the resources on the IBM i logical partition. If the managed system shuts down a logical partition
because of its partition-availability priority, all logical partitions that use the resources on that logical
partition are also shut down.

If a processor fails when the processor is in use, then the entire managed system shuts down. When a
processor failure causes the entire managed system to shut down, the system deconfigures the processor
and restarts. The managed system attempts to start the logical partitions that were running at the time of
the processor failure with their minimum processor values, in partition-availability priority order, with
the logical partition with the highest partition-availability priority being started first. If the managed
system does not have enough processor resources to start all of the logical partitions with their minimum
processor values, then the managed system starts as many logical partitions as it can with their minimum
processor values. If there are any processor resources remaining after the managed system has started the
logical partitions, then the managed system distributes any remaining processor resources to the running
logical partitions in proportion to their desired processor values.
Related concepts

“Software licensing for IBM licensed programs on logical partitions” on page 97
If you use IBM licensed programs such as AIX and IBM i on a server with logical partitions, consider
how many software licenses are required for your logical partition configuration. Careful consideration of
your software might help minimize the number of software licenses that you must purchase.
“Processor resource assignment in partition profiles” on page 9
When you create a partition profile for a logical partition, you set up the desired, minimum, and
maximum amounts of processor resources that you want for the logical partition.
Related tasks

“Setting partition-availability priorities for your managed system” on page 191
To avoid shutting down mission-critical workloads when your server firmware deconfigures a failing
processor, you can use the Hardware Management Console (HMC) to set partition-availablity priorities
for the logical partitions on your managed system. A logical partition with a failing processor can acquire
a replacement processor from logical partitions with a lower partition-availability priority. The acquisition
of a replacement processor allows the logical partition with the higher partition-availability priority to
continue running after a processor failure.
Related information

Setting deconfiguration policies
Deconfiguring hardware

Dedicated processors:

Dedicated processors are whole processors that are assigned to a single logical partition.

If you choose to assign dedicated processors to a logical partition, you must assign at least one processor
to that logical partition. Likewise, if you choose to remove processor resources from a dedicated logical
partition, you must remove at least one processor from the logical partition.

On systems that are managed by a Hardware Management Console (HMC), dedicated processors are
assigned to logical partitions using partition profiles.

By default, a powered-off logical partition using dedicated processors will have its processors available to
uncapped logical partitions that use shared processors. If the uncapped logical partition needs additional
processor resources, the uncapped logical partition can use the idle processors that belong to the
powered-off dedicated logical partition, provided that the total number of processors used by the
uncapped logical partition does not exceed the virtual processors assigned to the uncapped logical
partition, and provided that the use of these idle processors does not cause the shared processor pool to
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exceed its maximum processing units. When you power on the dedicated logical partition while the
uncapped logical partition is using the processors, the activated logical partition will regain all of its
processing resources. If you use the HMC, you can prevent dedicated processors from being used in the
shared processor pool by disabling this function in the partition properties panels.

You can also set the properties of a logical partition using dedicated processors so that unused processing
cycles on those dedicated processors can be made available to uncapped logical partitions while the
dedicated processor logical partition is running. You can change the processor sharing mode of the
dedicated processor logical partition at any time, without having to shut down and restart the logical
partition.
Related concepts

“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.

Shared processors:

Shared processors are physical processors whose processing capacity is shared among multiple logical
partitions. The ability to divide physical processors and share them among multiple logical partitions is
known as the Micro-Partitioning technology.

Note: For some models, the Micro-Partitioning technology is an option for which you must obtain and
enter a PowerVM Editions activation code.

By default, all physical processors that are not dedicated to specific logical partitions are grouped
together in a shared processor pool. You can assign a specific amount of the processing capacity in this
shared processor pool to each logical partition that uses shared processors. Some models allow you to use
the HMC to configure multiple shared processor pools. These models have a default shared processor pool
that contains all the processors that do not belong to logical partitions that use dedicated processors or
logical partitions that use other shared processor pools. The other shared processor pools on these models
can be configured with a maximum processing unit value and a reserved processing unit value. The
maximum processing unit value limits the total number of processing unit that can be used by the logical
partitions in the shared processor pool. The reserved processing unit value is the number of processing
units that are reserved for the use of uncapped logical partitions within the shared processor pool.

You can assign partial processors to a logical partition that uses shared processors. A minimum of 0.10
processing units can be configured for any logical partition that uses shared processors. Processing units
are a unit of measure for shared processing power across one or more virtual processors. One shared
processing unit on one virtual processor accomplishes approximately the same work as one dedicated
processor.

Some server models allow logical partitions to use only a portion of the total active processors on the
managed system, so you are not always able to assign the full processing capacity of the managed system
to logical partitions. This is particularly true for server models with one or two processors, where a large
portion of processor resources is used as overhead. The System Planning Tool (SPT) shows how many
shared processors are available for logical partitions to use on each server model, so use the SPT to
validate your logical partition plan.

On HMC-managed systems, shared processors are assigned to logical partitions using partition profiles.

Logical partitions that use shared processors can have a sharing mode of capped or uncapped. An
uncapped logical partition is a logical partition that can use more processor power than its assigned
processing capacity. The amount of processing capacity that an uncapped logical partition can use is
limited only by the number of virtual processors assigned to the logical partition or the maximum
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processing unit allowed by the shared processor pool that the logical partition uses. In contrast, a capped
logical partition is a logical partition that cannot use more processor power than its assigned processing
units.

For example, logical partitions 2 and 3 are uncapped logical partitions, and logical partition 4 is a capped
logical partition. Logical partitions 2 and 3 are each assigned 3.00 processing units and four virtual
processors. Logical partition 2 currently uses only 1.00 of its 3.00 processing units, but logical partition 3
currently has a workload demand that requires 4.00 processing units. Because logical partition 3 is
uncapped and has four virtual processors, the server firmware automatically allows logical partition 3 to
use 1.00 processing units from logical partition 2. This increases the processing power for logical partition
3 to 4.00 processing units. Soon afterwards, logical partition 2 increases its workload demand to 3.00
processing units. The server firmware therefore automatically returns 1.00 processing units to logical
partition 2 so that logical partition 2 can use its full, assigned processing capacity once more. Logical
partition 4 is assigned 2.00 processing units and three virtual processors, but currently has a workload
demand that requires 3.00 processing units. Because logical partition 4 is capped, logical partition 4
cannot use any unused processing units from logical partitions 2 or 3. However, if the workload demand
of logical partition 4 decreases below 2.00 processing units, logical partitions 2 and 3 could use any
unused processing units from logical partition 4.

By default, logical partitions that use shared processors are capped logical partitions. You can set a logical
partition to be an uncapped logical partition if you want the logical partition to use more processing
power than its assigned amount.

Although an uncapped logical partition can use more processor power than its assigned processing
capacity, the uncapped logical partition can never use more processing units than its assigned number of
virtual processors. Also, the logical partitions that use a shared processor pool can never use more
processing units than the maximum processing units configured for the shared processor pool.

If multiple uncapped logical partitions need additional processor capacity at the same time, the server
can distribute the unused processing capacity to all uncapped logical partitions. This distribution process
is determined by the uncapped weight of each of the logical partitions.

Uncapped weight is a number in the range of 0 through 255 that you set for each uncapped logical
partition in the shared processor pool. On the HMC, you can choose from any of the 256 possible
uncapped weight values. By setting the uncapped weight (255 being the highest weight), any available
unused capacity is distributed to contending logical partitions in proportion to the established value of
the uncapped weight. The default uncapped weight value is 128.

For example, logical partition 2 has an uncapped weight of 100, and logical partition 3 has an uncapped
weight of 200. If logical partitions 2 and 3 both require additional processing capacity, logical partition 3
would receive two additional processing units for every additional processing unit that logical partition 2
receives.
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Related concepts

“Sharing resources between logical partitions” on page 4
Although each logical partition acts as an independent server, the logical partitions on a server can share
some kinds of resources with each other. The ability to share resources among many logical partitions
allows you to increase resource utilization on the server and to move the server resources to where they
are needed.
“System Planning Tool” on page 89
The System Planning Tool (SPT) helps you design a managed system that can support a specified set of
workloads.
“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.

Virtual processors:

A virtual processor is a representation of a physical processor core to the operating system of a logical
partition that uses shared processors.

When you install and run an operating system on a server that is not partitioned, the operating system
calculates the number of operations that it can perform concurrently by counting the number of
processors on the server. For example, if you install an operating system on a server that has eight
processors, and each processor can perform two operations at a time, the operating system can perform
16 operations at a time. In the same way, when you install and run an operating system on a logical
partition that uses dedicated processors, the operating system calculates the number of operations that it
can perform concurrently by counting the number of dedicated processors that are assigned to the logical
partition. In both cases, the operating system can easily calculate how many operations it can perform at
a time by counting the whole number of processors that are available to it.

However, when you install and run an operating system on a logical partition that uses shared
processors, the operating system cannot calculate a whole number of operations from the fractional
number of processing units that are assigned to the logical partition. The server firmware must therefore
represent the processing power available to the operating system as a whole number of processors. This
allows the operating system to calculate the number of concurrent operations that it can perform. A
virtual processor is a representation of a physical processor to the operating system of a logical partition
that uses shared processors.

The server firmware distributes processing units evenly among the virtual processors assigned to a
logical partition. For example, if a logical partition has 1.80 processing units and two virtual processors,
each virtual processor has 0.90 processing units supporting its workload.

There are limits to the number of processing units that you can have for each virtual processor. The
minimum number of processing units that you can have for each virtual processor is 0.10 (or ten virtual
processors for every processing unit). The maximum number of processing units that you can have for
each virtual processor is always 1.00. This means that a logical partition cannot use more processing units
than the number of virtual processors that it is assigned, even if the logical partition is uncapped.

A logical partition generally performs best if the number of virtual processors is close to the number of
processing units available to the logical partition. This lets the operating system manage the workload on
the logical partition effectively. In certain situations, you might be able to increase system performance
slightly by increasing the number of virtual processors. If you increase the number of virtual processors,
you increase the number of operations that can run concurrently. However, if you increase the number of
virtual processors without increasing the number of processing units, the speed at which each operation
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runs will decrease. The operating system also cannot shift processing power between processes if the
processing power is split between many virtual processors.

On HMC-managed systems, virtual processors are assigned to logical partitions using partition profiles.
Related concepts

“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.

Memory
Processors use memory to temporarily hold information. Memory requirements for logical partitions
depend on the logical partition configuration, I/O resources assigned, and applications used.

Memory can be assigned in increments of 16 MB, 32 MB, 64 MB, 128 MB, and 256 MB. The default
memory block size varies according to the amount of configurable memory in the system.

Table 2. Default memory block size used for varying amounts of configurable memory

Amount of configurable memory Default memory block size

Less than 4 GB 16 MB

Greater than 4 GB up to 8 GB 32 MB

Greater than 8 GB up to 16 GB 64 MB

Greater than 16 GB up to 32 GB 128 MB

Greater than 32 GB 256 MB

There are limits on how big a logical partition can grow based on the amount of memory initially
allocated to it. Memory is added and removed to and from logical partitions in units of logical memory
blocks. For logical partitions that are initially sized less than 256 MB, the maximum size to which a
logical partition can grow is 16 times its initial size (up to the assigned maximum memory of the logical
partition). For logical partitions that are initially sized 256 MB or larger, the maximum size to which the
logical partition can grow is 64 times its initial size (up to the assigned maximum memory of the logical
partition). The smallest increment for adding or removing memory to or from a logical partition is 16 MB.

The memory block size can be changed by using the Integrated Virtualization Manager or the Logical
Memory Block Size option in the Advanced System Management Interface (ASMI). The machine default
value should only be changed under direction from your service provider. To change the memory block
size, you must be a user with administrator authority, and you must shut down and restart the managed
system for the change to take effect. If the minimum memory amount in any partition profile on the
managed system is less than the new memory block size, you must also change the minimum memory
amount in the partition profile.

Each logical partition has a hardware page table (HPT). The size of the HPT is determined by the
following factors:
v An HPT ratio of 1/64 for logical partitions that use dedicated memory
v An HPT ratio of 1/4 for logical partitions that use shared memory
v The maximum memory values that you establish for the logical partition (dedicated or shared)

On systems that are managed by a Hardware Management Console, memory is assigned to logical
partitions using partition profiles. On systems that are managed by the Integrated Virtualization Manager,
memory is assigned to logical partitions using the partition properties.
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Related concepts

“Memory resource assignment in partition profiles” on page 10
When you create a partition profile for a logical partition, you set up the desired, minimum, and
maximum amounts of memory resources that you want for the logical partition.

Dedicated memory:

Dedicated memory is physical system memory that you assign to a logical partition that uses dedicated
memory (hereafter referred to as a dedicated memory partition), and is reserved for use by the dedicated
memory partition until you remove the memory from the dedicated memory partition or delete the
dedicated memory partition.

Depending on the overall memory in your system and the maximum memory values you choose for each
logical partition, the server firmware must have enough memory to perform logical partition tasks. The
amount of memory required by the server firmware varies according to several factors. The following
factors influence server firmware memory requirements:
v Number of dedicated memory partitions
v Partition environments of the dedicated memory partitions
v Number of physical and virtual I/O devices used by the dedicated memory partitions
v Maximum memory values given to the dedicated memory partitions

Note: Firmware level updates can also change the server firmware memory requirements. Larger
memory block sizes can exaggerate the memory requirement change.

When selecting the maximum memory values for each dedicated memory partition, consider the
following:
v Maximum values affect the hardware page table (HPT) size for each dedicated memory partition
v The logical memory map size for each dedicated memory partition

If the server firmware detects that a memory module has failed or is about to fail, the server firmware
creates a serviceable event. The server firmware can also deconfigure the failing memory module
automatically, depending on the type of failure and the deconfiguration policies that you set up using the
Advanced System Management Interface (ASMI). You can also deconfigure a failing memory module
manually using the ASMI. If a memory module failure causes the entire managed system to shut down,
the managed system restarts automatically if the managed system is in normal IPL mode. When the
managed system restarts itself, or when you restart the managed system manually, the managed system
attempts to start the dedicated memory partitions that were running at the time of the memory module
failure with their minimum memory values. If the managed system does not have enough memory to
start all of the dedicated memory partitions with their minimum memory values, the managed system
starts as many dedicated memory partitions as it can with their minimum memory values. If any
memory is left over after the managed system has started as many dedicated memory partitions as it can,
the managed system distributes the remaining memory resources to the running dedicated memory
partitions in proportion to their desired memory values.

Setting huge-page memory values for AIX dedicated memory partitions:

Specify the number of 16 GB pages to allocate to an AIX huge-page memory pool.

On managed systems that support huge-page memory, you can use the Hardware Management Console
(HMC) to set the value for the huge-page memory pool. You can also specify values for the number of
huge pages to allocate to logical partitions.

Using huge pages can improve performance in specific environments that require a high degree of
parallelism, such as in DB2® database. You can specify huge-page memory that can be used for the
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shared-memory buffer pools in DB2. For logically partitioned systems, you can specify the minimum,
desired, and maximum number of huge pages to assign to a logical partition when you create the logical
partition or partition profile.

To set the huge-page memory values, the system must be in the powered-off state. The new value will
take effect when you restart the system.
Related tasks

“Creating additional logical partitions” on page 112
You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create
a new logical partition. When you create a logical partition, you also create a partition profile that
contains the resource allocations and settings for the logical partition.
Related information

IBM DB2 Enterprise 9 performance with POWER5+ and AIX 5L multipage support

Calculating huge-page memory requirements for AIX dedicated memory partitions:

Calculate the value for the number of pages to allocate to an AIX huge-page memory pool.

To use huge-page memory, you must ensure that your system has adequate memory resources to
dedicate to the huge-page memory pool. The huge-page memory pool is a region of system memory that
is mapped as 16 GB page segments and is managed separately from the system’s base memory. Before
you can specify the value for huge-page memory, you must determine which applications you are
running and what the huge-page requirements are for your applications.

Determining huge-page memory requirements for your application

The huge-page memory pool can be used to enhance performance for DB2 in AIX operating systems. To
determine this value, calculate the amount of memory required for the shared buffer pool to support
your DB2 applications. Refer to the DB2 recommendations for buffer pool memory for your particular
application.

Note: The huge page memory allocation cannot be changed dynamically. Changing the number of huge
pages on the server requires a server reboot, and changing the number of assigned huge pages for a
logical partition requires that you restart the logical partition.

Considerations for calculating the huge-page values

The amount of huge-page memory that you can allocate is dependent on the following factors:
v Total amount of licensed memory for your server
v Amount of available memory after configured memory resources are accounted for
v Number of physical IO connections to the server (each IO connection requires memory for the IO

tables, which can be distributed among the physical memory regions and reduces the memory
available for huge pages)

v Base memory configuration for logical partitions (huge pages are not calculated as part of the
configured-partition memory allocation)

v The requirements that define a huge page, that is each huge page requires 16 GB of contiguous real
memory and must start on a 16 GB memory boundary

v Huge pages cannot span memory affinity nodes. Each memory affinity node requires 32 GB to ensure
at least one 16 GB huge page when all of the other considerations listed above are taken into account.

Note:
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1. For the 8203-E4A, 8204-E8A, 9133-52A, 9133-55A, 9116-561, 9117-MMA, 9125-F2A, 9406-550,
9406-570, 9407-M15, 9408-M25, 9409-M50, and 9117-570 a physical processors card is a memory
affinity node, so the 32 GB must be put on a single 2-core processor card.

2. For the 9119-FHA, 9119-590, 9119-595, and 9406-595 each 4-core processor on the 16-core processor
backplane is a memory affinity node, so the 32 GB must be put into the slots on the same 4-core
processor on the backplane.

Attention: The server firmware will reduce the huge-page pool size to satisfy some of these
dependencies. When this occurs, error log entries are generated to indicate that the huge-page pool size
was reduced. The error log reference code is B700 5300. The reference code details will indicate
hexadecimal values that indicate why the huge-page pool size could not be satisfied. The following
example shows the possible entries and how to interpret the additional words in these entries:
v word 3 = 0x0000000100000106: This means that the huge-page pool was reduced to satisfy the system

hardware configuration
– word 4 = number of user-configured huge pages
– word 5 = number of huge pages that could be provided

v word 3 = 0x0000000100000105: This means that the huge-page pool was reduced to satisfy the memory
configuration of logical partitions
– word 4 = number of huge pages before logical partitions were created
– word 5 = firmware calculated number of huge pages after satisfying logical partition memory

requirements
– word 6 = number of huge pages in the pool

Calculating huge-page memory values

To calculate the server memory requirements to support huge pages, use the following steps:
1. Determine the amount of base system memory and round that figure to the next 16 GB value. To

determine the base server memory requirements, which includes the POWER Hypervisor and the
logical partition, but not huge pages, use the System Planning Tool. See Planning for logical partitions
for information about using these planning tools.

2. Determine the number of IO connection loops on your system and multiply the number by 16 GB.
This calculation is required because the server needs a memory table for each IO connection, and a 16
GB huge page cannot be located where an IO table exists.

3. Take the larger of the values determined in step 1 and step 2. This will be your base memory value.
4. Determine the number of huge pages that will be required for your AIX applications. To determine

this value, use the guidelines provided by your application documentation and the AIX Performance
Management. Multiply the number of anticipated huge pages by 16 GB. Add this figure to the base
figure determined in step 3. The resulting figure provides an estimate of the amount of licensed
memory required to satisfy the logical partition and huge-page pool memory requirements for your
system.

Related information

IBM DB2 Enterprise 9 performance with POWER5+ and AIX 5L multipage support

Viewing and setting huge-page memory values for AIX dedicated memory partitions:

View and set values for AIX huge-page memory allocation.

On systems that support huge-page (16 GB) memory allocation, you can set the current value in the
huge-page memory table. On a new system you must set this value initially to establish the huge-page
memory pool. You must set the value when the managed system is in the powered-off state. If this value
is already set, you might need to change the value to adjust for performance needs based on the
applications that you are running and your logical partition configurations. You can also change the
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values set for the number of huge pages allocated to your logical partitions. Use this task to set or adjust
the number of 16 GB pages for the huge-page allocation according to your needs.

Note: To change the values for logical partitions, you must shut down the logical partition. The new
value takes effect when you restart the logical partition.

To set huge-page memory values for a logical partition, do the following:
1. In the navigation pane, expand Systems Management → Servers.
2. Select the server that has the logical partition you want to configure.
3. In the work pane, select the logical partition for which you want to set huge-page memory values.
4. Select Configuration > Manage profiles. The Managed Profiles window opens.
5. Select the logical partition you want to configure.
6. Select Actions > Edit The Logical Partition Profile Properties window opens.
7. Click the Memory tab.
8. Assign Huge Page memory for this partition profile and click OK.
Related information

IBM DB2 Enterprise 9 performance with POWER5+ and AIX 5L multipage support

Shared memory:

You can configure your system so that multiple logical partitions share a pool of physical memory. A
shared memory environment includes the shared memory pool, logical partitions that use the shared
memory in the shared memory pool, logical memory, I/O entitled memory, at least one Virtual I/O
Server logical partition, and paging space devices.
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Related concepts

“Performance considerations for shared memory partitions” on page 217
You can learn about performance factors (such as shared memory overcommitment) that influence the
performance of a logical partition that uses shared memory (hereafter referred to as a shared memory
partition). You can also use shared memory statistics to help you determine how to adjust the
configuration of a shared memory partition to improve its performance.
“Sharing resources between logical partitions” on page 4
Although each logical partition acts as an independent server, the logical partitions on a server can share
some kinds of resources with each other. The ability to share resources among many logical partitions
allows you to increase resource utilization on the server and to move the server resources to where they
are needed.
Related tasks

“Configuring the shared memory pool” on page 134
You can configure the size of the shared memory pool, assign paging space devices to the shared memory
pool, and assign one or two Virtual I/O Server logical partitions (that provide access to the paging space
devices) to the shared memory pool using the Hardware Management Console (HMC).
“Creating logical partitions” on page 102
The Create Logical Partition wizard on the Hardware Management Console (HMC) guides you through
the procedure of creating logical partitions and partition profiles on your server.
“Managing the shared memory pool” on page 139
By using the Hardware Management Console (HMC), you can change the configuration of the shared
memory pool. For example, you can change the amount of physical memory assigned to the shared
memory pool, change the Virtual I/O Server logical partitions that are assigned to the shared memory
pool, and add or remove paging space devices to or from the shared memory pool.
“Managing shared memory dynamically” on page 165
You can dynamically add and remove logical memory and I/O entitled memory to and from a logical
partition that uses shared memory (hereafter referred to as a shared memory partition) using the Hardware
Management Console (HMC).
Related information

Defining the shared memory pool by using the Integrated Virtualization Manager
Configuring the management partition and client logical partitions
Managing the shared memory pool by using the Integrated Virtualization Manager
Dynamically managing memory by using the Integrated Virtualization Manager

Overview of shared memory:

Shared memory is physical memory that is assigned to the shared memory pool and shared among
multiple logical partitions. The shared memory pool is a defined collection of physical memory blocks that
are managed as a single memory pool by the hypervisor. Logical partitions that you configure to use
shared memory (hereafter referred to as shared memory partitions) share the memory in the pool with other
shared memory partitions.

For example, you create a shared memory pool with 16 GB of physical memory. You then create three
logical partitions, configure them to use shared memory, and activate the shared memory partitions. Each
shared memory partition can use the 16 GB that are in the shared memory pool.

The hypervisor determines the amount of memory allocated from the shared memory pool to each shared
memory partition based on the workload and memory configuration of each shared memory partition.
When allocating the physical memory to the shared memory partitions, the hypervisor ensures that each
shared memory partition can access only the memory allocated to the shared memory partition at any
given time. A shared memory partition cannot access the physical memory allocated to another shared
memory partition.
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The amount of memory that you assign to the shared memory partitions can be greater than the amount
of memory in the shared memory pool. For example, you can assign 12 GB to shared memory partition 1,
8 GB to shared memory partition 2, and 4 GB to shared memory partition 3. Together, the shared memory
partitions use 24 GB of memory, but the shared memory pool has only 16 GB of memory. In this
situation, the memory configuration is considered overcommitted.

Overcommitted memory configurations are possible because the hypervisor virtualizes and manages all
of the memory for the shared memory partitions in the shared memory pool as follows:
1. When shared memory partitions are not actively using their memory pages, the hypervisor allocates

those unused memory pages to shared memory partitions that currently need them. When the sum of
the physical memory currently used by the shared memory partitions is less than or equal to the
amount of memory in the shared memory pool, the memory configuration is logically overcommitted. In
a logically overcommitted memory configuration, the shared memory pool has enough physical
memory to contain the memory used by all shared memory partitions at one point in time. The
hypervisor does not need to store any data in auxiliary storage.

2. When a shared memory partition requires more memory than the hypervisor can provide to it by
allocating unused portions of the shared memory pool, the hypervisor stores some of the memory that
belongs to a shared memory partition in the shared memory pool and stores the remainder of the
memory that belongs to the shared memory partition in auxiliary storage. When the sum of the
physical memory currently used by the shared memory partitions is greater than the amount of
memory in the shared memory pool, the memory configuration is physically overcommitted. In a
physically overcommitted memory configuration, the shared memory pool does not have enough
physical memory to contain the memory used by all the shared memory partitions at one point in
time. The hypervisor stores the difference in auxiliary storage. When the operating system attempts to
access the data, the hypervisor might need to retrieve the data from auxiliary storage before the
operating system can access it.

Because the memory that you assign to a shared memory partition might not always reside in the shared
memory pool, the memory that you assign to a shared memory partition is logical memory. Logical
memory is the address space, assigned to a logical partition, that the operating system perceives as its
main storage. For a shared memory partition, a subset of the logical memory is backed up by physical
main storage (or physical memory from the shared memory pool) and the contents of the remaining
logical memory are kept in auxiliary storage.

A Virtual I/O Server logical partition provides access to the auxiliary storage, or paging space devices,
required for shared memory partitions in an overcommitted memory configuration. A paging space device
is a physical or logical device that is used by a Virtual I/O Server to provide the paging space for a
shared memory partition. The paging space is an area of nonvolatile storage used to hold portions of a
shared memory partition’s logical memory that do not reside in the shared memory pool. When the
operating system that runs in a shared memory partition attempts to access data, and the data is located
in the paging space device that is assigned to the shared memory partition, the hypervisor sends a
request to a Virtual I/O Server to retrieve the data and write it to the shared memory pool so that the
operating system can access it.

On systems that are managed by a Hardware Management Console (HMC), you can assign up to two
Virtual I/O Server (VIOS) logical partitions to the shared memory pool at a time (hereafter referred to as
paging VIOS partitions). When you assign two paging VIOS partitions to the shared memory pool, you
can configure the paging space devices such that both paging VIOS partitions have access to the same
paging space devices. When one paging VIOS partition becomes unavailable, the hypervisor sends a
request to the other paging VIOS partition to retrieve the data on the paging space device.

You cannot configure paging VIOS partitions to use shared memory. Paging VIOS partitions do not use
the memory in the shared memory pool. You assign paging VIOS partitions to the shared memory pool
so that they can provide access to the paging space devices for the shared memory partitions that are
assigned to the shared memory pool.
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Driven by workload demands from the shared memory partitions, the hypervisor manages
overcommitted memory configurations by continually performing the following tasks:
v Allocating portions of physical memory from the shared memory pool to the shared memory partitions

as needed
v Requesting a paging VIOS partition to read and write data between the shared memory pool and the

paging space devices as needed

The ability to share memory among multiple logical partitions is known as the PowerVM Active Memory
Sharing technology. The PowerVM Active Memory Sharing technology is available with the PowerVM
Enterprise Edition for which you must obtain and enter a PowerVM Editions activation code.

Example: A shared memory configuration that is logically overcommitted:

When the sum of the physical memory currently used by the shared memory partitions is less than or
equal to the amount of memory in the shared memory pool, the memory configuration is logically
overcommitted. In a logically overcommitted memory configuration, the shared memory pool has enough
physical memory to contain the memory used by all shared memory partitions at one point in time.

The following figure shows a server with shared memory configuration that is logically overcommitted.
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The figure shows a shared memory pool of 16.25 GB that is shared among three shared memory
partitions. The hypervisor uses a small portion (0.25 GB) of the shared memory pool to manage the
shared memory resources. The figure also shows one paging VIOS partition that owns all of the physical
storage in the system. The physical storage contains a paging space device for each shared memory
partition. The paging VIOS partition does not use the memory in the shared memory pool, but rather
receives dedicated memory of 1 GB. Of the remaining system memory, 1 GB is reserved for the
hypervisor so that it can manage other system resources, and 13.75 GB is free memory that is available
for system growth. For example, you can dynamically add more memory to the shared memory pool or
you can create additional dedicated memory partitions.

Shared memory partition 1 is assigned 12 GB of logical memory, Shared memory partition 2 is assigned 8
GB of logical memory, and Shared memory partition 3 is assigned 4 GB of logical memory. Together, the
shared memory partitions are assigned 24 GB of logical memory, which is more than the 16.25 GB
allocated to the shared memory pool. Therefore, the memory configuration is overcommitted.

Shared memory partition 1 currently uses 8 GB of physical memory, Shared memory partition 2 currently
uses 4 GB of physical memory, and Shared memory partition 3 currently uses 4 GB of physical memory.
Together, the shared memory partitions currently use 16 GB of physical memory, which is equal to the
amount of physical memory available to them in the shared memory pool. Therefore, the memory

Figure 1. A server with a shared memory configuration that is logically overcommitted
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configuration is logically overcommitted. In other words, the shared memory pool contains enough
physical memory for the hypervisor to allocate unused memory pages to shared memory partitions that
need them. All of the memory currently used by the shared memory partitions resides in the shared
memory pool.
Related concepts

“Performance considerations for overcommitted shared memory partitions” on page 217
Learn about how the degree to which the memory configuration of a logical partition that uses shared
memory (hereafter referred to as a shared memory partition) is overcommitted affects the performance of
the shared memory partition. In general, the less overcommitted the memory configuration of a shared
memory partition, the better its performance.

Example: A shared memory configuration that is physically overcommitted:

When the sum of the physical memory currently used by the shared memory partitions is greater than
the amount of memory in the shared memory pool, the memory configuration is physically overcommitted.
In a physically overcommitted memory configuration, the shared memory pool does not have enough
physical memory to contain the memory used by all the shared memory partitions at one point in time.
The hypervisor stores the difference in auxiliary storage.

The following figure shows a server with shared memory configuration that is physically overcommitted.
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The figure shows a shared memory pool of 16.25 GB that is shared among three shared memory
partitions. The hypervisor uses a small portion (0.25 GB) of the shared memory pool to manage the
shared memory resources. The figure also shows one paging VIOS partition that owns all of the physical
storage in the system. The physical storage contains a paging space device for each shared memory
partition. The paging VIOS partition does not use the memory in the shared memory pool, but rather
receives dedicated memory of 1 GB. Of the remaining system memory, 1 GB is reserved for the
hypervisor so that it can manage other system resources, and 13.75 GB is free memory that is available
for system growth. For example, you can dynamically add more memory to the shared memory pool or
you can create additional dedicated memory partitions.

Shared memory partition 1 is assigned 12 GB of logical memory, Shared memory partition 2 is assigned 8
GB of logical memory, and Shared memory partition 3 is assigned 4 GB of logical memory. Together, the
shared memory partitions are assigned 24 GB of logical memory, which is more than the 16.25 GB
allocated to the shared memory pool. Therefore, the memory configuration is overcommitted.

Shared memory partition 1 currently uses 8 GB of physical memory, Shared memory partition currently
uses 5 GB of physical memory, and Shared memory partition 3 currently uses 4 GB of physical memory.
Together, the shared memory partitions currently use 17 GB of physical memory, which is greater than
the amount of physical memory available to them in the shared memory pool, 16 GB. Therefore, the

Figure 2. A server with shared memory configuration that is physically overcommitted
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memory configuration is physically overcommitted. In other words, the shared memory pool does not
contain enough physical memory for the hypervisor to satisfy the memory needs of all the shared
memory partitions without storing some of the memory in the paging space devices. In this example, the
difference of 1 GB is stored in the paging space device that is assigned to Shared memory partition 2.
When Shared memory partition 2 needs to access data, the hypervisor might need to retrieve the data
from the paging space device before the operating system can access it.
Related concepts

“Performance considerations for overcommitted shared memory partitions” on page 217
Learn about how the degree to which the memory configuration of a logical partition that uses shared
memory (hereafter referred to as a shared memory partition) is overcommitted affects the performance of
the shared memory partition. In general, the less overcommitted the memory configuration of a shared
memory partition, the better its performance.

Data flow for shared memory partitions:

When the operating system that runs in a logical partition that uses shared memory (hereafter referred to
as a shared memory partition) needs to access data, the data must reside in the shared memory pool.
Systems with overcommitted memory configurations require the hypervisor and at least one Virtual I/O
Server (VIOS) logical partition that is assigned to the shared memory pool (hereafter referred to as paging
VIOS partition) to move data between the shared memory pool and the paging space devices as needed.

In a shared memory configuration that is physically overcommitted (where the sum of the logical
memory that is currently used by all the shared memory partitions is greater than the amount of memory
in the shared memory pool), the hypervisor stores some of the logical memory that belongs to a shared
memory partition in the shared memory pool and some of the logical memory in a paging space device.
In order for the operating system in a shared memory partition to access its memory, the memory must
be in the shared memory pool. Thus, when the operating system needs to access data that is stored on
the paging space device, the hypervisor works with a paging VIOS partition to move the data from the
paging space device to the shared memory pool so that the operating system can access it.

The following figure shows the data flow for shared memory.
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In general, the data flows as follows:
1. The operating system that runs in a shared memory partition attempts to access data.

v If the data is in the shared memory pool, processing continues with step 7 on page 34.
v If the data is not in the shared memory pool, a page fault occurred. The hypervisor inspects the

page fault and discovers that the hypervisor moved the data to the paging space device, thereby
causing the page fault. Processing continues with step 2. (If the operating system that runs in the
shared memory partition moved the data to auxiliary storage, thereby causing the page fault, then
the operating system must retrieve the data.)

2. The hypervisor sends a request to a paging VIOS partition to retrieve the data from the paging space
device and to write it to the shared memory pool.

Figure 3. The process of managing data in a shared memory configuration that is overcommitted
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3. The paging VIOS partition searches the paging space device that is assigned to the shared memory
partition and finds the data.

4. The paging VIOS partition writes the data to the shared memory pool.
5. The paging VIOS partition notifies the hypervisor that the data is in the shared memory pool.
6. The hypervisor notifies the operating system that it can access the data.
7. The operating system accesses the data in the shared memory pool.
Related concepts

“Logical memory”
Logical memory is the address space, assigned to a logical partition, that the operating system perceives as
its main storage. For a logical partition that uses shared memory (hereafter referred to as a shared memory
partition), a subset of the logical memory is backed up by physical main storage and the contents of the
remaining logical memory are kept in auxiliary storage.
“Paging space device” on page 44
You can learn about how the Hardware Management Console (HMC) and Integrated Virtualization
Manager allocate and manipulate paging space devices on systems that use shared memory.
“Shared memory distribution” on page 48
The hypervisor uses the memory weight of each logical partition that uses shared memory (hereafter
referred to as shared memory partitions) to help determine which logical partitions receive more physical
memory from the shared memory pool. To help optimize performance and memory use, the operating
systems that run in shared memory partitions provide the hypervisor with information about how the
operating system uses its memory to help the hypervisor determine which pages to store in the shared
memory pool and which pages to store in the paging space devices.

Logical memory:

Logical memory is the address space, assigned to a logical partition, that the operating system perceives as
its main storage. For a logical partition that uses shared memory (hereafter referred to as a shared memory
partition), a subset of the logical memory is backed up by physical main storage and the contents of the
remaining logical memory are kept in auxiliary storage.

You can configure minimum, maximum, desired, and assigned logical memory sizes for a shared memory
partition.

Table 3. Logical memory sizes

Logical memory size Description

Minimum The minimum amount of logical memory with which you want the shared memory
partition to operate. You can dynamically remove logical memory from the shared
memory partition down to this value.

Maximum The maximum amount of logical memory that the shared memory partition is
allowed to use. You can dynamically add logical memory to the shared memory
partition up to this value.

Desired The amount of logical memory with which you want the shared memory partition to
activate.

Assigned The amount of logical memory that the shared memory partition can use. A shared
memory partition does not have to use all of its assigned logical memory at any given
time.

On systems that are managed by a Hardware Management Console (HMC), you configure the minimum,
maximum, and desired logical memory sizes in the partition profile. When you activate the shared
memory partition, the HMC assigns the desired logical memory to the shared memory partition.
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On systems that are managed by the Integrated Virtualization Manager (IVM), you configure the
minimum, maximum, and desired logical memory sizes in the partition properties. When you create the
shared memory partition, the IVM assigns the desired logical memory to the shared memory partition.

The following figure shows a shared memory partition with its logical memory.

The figure shows a shared memory partition that is assigned 2.5 GB of logical memory. Its maximum
logical memory is 3 GB and its minimum logical memory is 1 GB. You can change the assigned logical
memory by dynamically adding or removing logical memory to or from the shared memory partition.
You can dynamically add logical memory to the shared memory partition up to the maximum logical
memory size, and you can dynamically remove logical memory from the shared memory partition down
to its minimum logical memory size.

The figure also shows that the amount of physical memory that is currently allocated to the shared
memory partition from the shared memory pool is 2.1 GB. If the workload that runs in the shared
memory partition currently uses 2.1 GB of memory and requires an additional 0.2 GB of memory, and the
shared memory pool is logically overcommitted, the hypervisor allocates an additional 0.2 GB of physical
memory to the shared memory partition by assigning memory pages that are not currently in use by
other shared memory partitions. If the shared memory pool is physically overcommitted, the hypervisor
stores 0.2 GB of the shared memory partition’s memory in a paging space device. When the shared
memory partition needs to access the data that resides in the paging space device, the hypervisor
retrieves the data for the operating system.

The amount of physical memory allocated to the shared memory partition can be less than the minimum
logical memory size. This is because the minimum logical memory size is a boundary for logical memory,
not for physical memory. In addition to the minimum logical memory size, the maximum, desired, and
assigned logical memory sizes also do not control the amount of physical memory assigned to the shared
memory partition. Likewise, dynamically adding or removing logical memory to or from a shared
memory partition does not change the amount of physical memory allocated to the shared memory

Figure 4. A shared memory partition that is assigned more logical memory than the amount of physical memory
currently allocated to it
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partition. When you set the logical memory sizes and dynamically add or remove logical memory, you
set or change the amount of memory that the operating system can use, and the hypervisor decides how
to distribute that memory between the shared memory pool and the paging space device.
Related concepts

“Data flow for shared memory partitions” on page 32
When the operating system that runs in a logical partition that uses shared memory (hereafter referred to
as a shared memory partition) needs to access data, the data must reside in the shared memory pool.
Systems with overcommitted memory configurations require the hypervisor and at least one Virtual I/O
Server (VIOS) logical partition that is assigned to the shared memory pool (hereafter referred to as paging
VIOS partition) to move data between the shared memory pool and the paging space devices as needed.
“Paging space device” on page 44
You can learn about how the Hardware Management Console (HMC) and Integrated Virtualization
Manager allocate and manipulate paging space devices on systems that use shared memory.
“Shared memory distribution” on page 48
The hypervisor uses the memory weight of each logical partition that uses shared memory (hereafter
referred to as shared memory partitions) to help determine which logical partitions receive more physical
memory from the shared memory pool. To help optimize performance and memory use, the operating
systems that run in shared memory partitions provide the hypervisor with information about how the
operating system uses its memory to help the hypervisor determine which pages to store in the shared
memory pool and which pages to store in the paging space devices.
“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.
Related tasks

“Preparing to configure shared memory” on page 92
Before you configure the shared memory pool and create logical partitions that use shared memory
(hereafter referred to as shared memory partitions), you need to plan for the shared memory pool, the
shared memory partitions, the paging space devices, and the Virtual I/O Server logical partitions
(hereafter referred to as paging VIOS partitions).
“Managing shared memory dynamically” on page 165
You can dynamically add and remove logical memory and I/O entitled memory to and from a logical
partition that uses shared memory (hereafter referred to as a shared memory partition) using the Hardware
Management Console (HMC).
“Changing the size of the shared memory pool” on page 139
You can increase or decrease the amount of physical memory assigned to the shared memory pool by
using the Hardware Management Console (HMC).
Related information

Dynamically managing memory by using the Integrated Virtualization Manager
Changing the shared memory pool size by using the Integrated Virtualization Manager

I/O entitled memory:

I/O entitled memory is the maximum amount of physical memory (from the shared memory pool) that is
guaranteed to be available to a logical partition that uses shared memory (hereafter referred to as a shared
memory partition) for its I/O devices at any given time.

Each shared memory partition is entitled to some portion of the shared memory pool so that the I/O
devices that are assigned to the shared memory partition have access to physical memory during I/O
operations. If the minimum amount of memory that I/O devices require for I/O operations does not
reside in the shared memory pool for as long as the device needs the memory, the device fails. Virtual
adapters that are entitled to physical memory from the shared memory pool include virtual SCSI
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adapters, virtual Ethernet adapters, and virtual fibre channel adapters. Virtual serial adapters are not
entitled to physical memory from the shared memory pool.

The following figure shows a shared memory partition with I/O entitled memory.

The figure shows a shared memory partition with 128 MB of I/O entitled memory. The shared memory
partition uses 64 MB of physical memory for its I/O devices, which is less than its I/O entitled memory
of 128 MB.

As depicted in the previous figure, a shared memory partition might not use all of its I/O entitled
memory at any given time. Unused portions of the I/O entitled memory assigned to a shared memory
partition are available to the hypervisor to allocate to other shared memory partitions, if necessary. The
hypervisor does not reserve unused portions of I/O entitled memory for the shared memory partition to
use in the future. However, the hypervisor guarantees that the shared memory partition can use the
entire portion of the I/O entitled memory that is assigned to it as needed. If the shared memory partition
later requires some of its unused I/O entitled memory, the hypervisor must allocate enough physical
memory from the shared memory pool to satisfy the new I/O memory requirement, without exceeding
the I/O entitled memory that is assigned to the shared memory partition.

For example, you assign 128 MB of I/O entitled memory to a shared memory partition. The shared
memory partition uses only 64 MB for its I/O devices. Thus, the hypervisor allocates 64 MB of physical
memory from the shared memory pool to the shared memory partition for its I/O devices. The remaining
64 MB is available to the hypervisor to allocate to other shared memory partitions, if necessary. Later, you
add two virtual adapters to the shared memory partition, each requiring 16 MB of memory. Thus, the
shared memory partition needs an additional 32 MB of physical memory for its I/O devices. Because the
shared memory partition currently uses only 64 MB of physical memory for its I/O devices and the
shared memory partition is entitled to use up to 128 MB for its I/O devices, the hypervisor allocates an
additional 32 MB of physical memory from the shared memory pool to the shared memory partition to

Figure 5. A shared memory partition whose I/O entitled memory is greater than the amount of physical memory that it
currently uses for its I/O devices
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accommodate the new virtual adapters. The shared memory partition now uses 96 MB of physical
memory from the shared memory pool for its I/O devices.

Because unused portions of I/O entitled memory are available to the hypervisor to allocate elsewhere, it
is possible for the amount of total physical memory that the hypervisor allocates from the shared
memory pool to a shared memory partition to be less than the I/O entitled memory of the shared
memory partition. The following figure shows this situation.

The figure shows a shared memory partition with 128 MB of I/O entitled memory. The shared memory
partition uses 64 MB of physical memory for its I/O devices. The unused portion of the I/O entitled
memory, 64 MB, is available to the hypervisor to allocate to other shared memory partitions, if necessary.
The hypervisor allocates a total of 96 MB of physical memory from the shared memory pool to the shared
memory partition, which is less than the I/O entitled memory of 128 MB.

When you create a shared memory partition, the Hardware Management Console (HMC) and the
Integrated Virtualization Manager (IVM) automatically set the I/O entitled memory for the shared
memory partition. When you activate a shared memory partition, the HMC and IVM set the I/O entitled
memory mode to the auto mode. In the auto mode, the HMC and IVM automatically adjust the I/O
entitled memory for the shared memory partition when you add or remove virtual adapters.

The I/O entitled memory mode can also be set to the manual mode. You can dynamically change the I/O
entitled memory mode to the manual mode and then dynamically change the I/O entitled memory for
the shared memory partition. When you add or remove a virtual adapter to or from the shared memory
partition in manual mode, the HMC and IVM do not automatically adjust the I/O entitled memory.
Therefore, you might need to dynamically adjust the I/O entitled memory when you dynamically add or
remove adapters to or from the shared memory partition. On HMC-managed systems, you use the
graphical interface to dynamically change the I/O entitled memory mode. When the I/O entitled
memory mode is in the manual mode, you can also use the graphical interface to dynamically change the
amount of I/O entitled memory that is assigned to a shared memory partition. On IVM-managed

Figure 6. A shared memory partition whose I/O entitled memory is greater than the total amount of physical memory
allocated to it
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systems, you use the chhwres command to dynamically change the I/O entitled memory mode. When
the I/O entitled memory mode is in the manual mode, you can also use the chhwres command to
dynamically change the amount of I/O entitled memory that is assigned to a shared memory partition.
When you restart a shared memory partition, the I/O entitled memory mode is set to the auto mode
regardless of what the I/O entitled memory mode was set to before you restarted the shared memory
partition.

When the amount of physical memory that a shared memory partition uses for its I/O devices is equal to
the I/O entitled memory that is assigned to the shared memory partition, the shared memory partition
cannot use any more physical memory for its I/O devices. In this situation, the following actions can
occur:
v The operating system that runs in the shared memory partition manages the I/O operations so that the

workload that runs in the shared memory partition operates within the I/O entitled memory that is
assigned to the shared memory partition. If the workload attempts to use more physical memory for
I/O operations than the I/O entitled memory that is assigned to the shared memory partition, the
operating system delays some I/O operations while it runs other I/O operations. In this situation, the
I/O entitled memory of the shared memory partition constrains the I/O configuration of the shared
memory partition because the operating system does not have enough physical memory to run all of
the I/O operations simultaneously.

v When you dynamically add a virtual adapter to the shared memory partition and the I/O entitled
memory mode is in the manual mode, the I/O configuation of the shared memory partition might
become constrained, or the adapter might fail when you attempt to configure it. If the adapter fails,
then there is not enough I/O entitled memory assigned to the shared memory partition to
accommodate the new adapter. To resolve the problem, you can dynamically increase the amount of
I/O entitled memory that is assigned to the shared memory partition, or you can remove some existing
virtual adapters from the shared memory partition. When you remove virtual adapters from the shared
memory partition, the physical memory that those adapters were using becomes available for the new
adapter.

v When you dynamically add a virtual adapter to the shared memory partition and the I/O entitled
memory mode is in the auto mode, the HMC and IVM automatically increase the I/O entitled memory
assigned to the shared memory partition to accommodate the new adapter. If the HMC and IVM
cannot increase the I/O entitled memory of the shared memory partition, there is not enough physical
memory available in the shared memory pool for the hypervisor to allocate to the shared memory
partition and the adapter cannot be assigned to the shared memory partition. To resolve the problem,
you can add physical memory to the shared memory pool, or you can remove some existing virtual
adapters from the shared memory partition. When you remove virtual adapters from the shared
memory partition, the physical memory that those adapters were using becomes available for the new
adapter.

To improve performance and memory use, HMC, IVM, AIX, IBM i, and Linux provide statistics about
how the operating system uses the physical memory allocated to it for its I/O devices. You can use these
statistics to manually adjust the I/O entitled memory that is assigned to a shared memory partition.

Paging VIOS partition:

A Virtual I/O Server (VIOS) logical partition that is assigned to the shared memory pool (hereafter
referred to as a paging VIOS partition) provides access to the paging space devices for the logical
partitions that are assigned to the shared memory pool (hereafter referred to as shared memory partitions).

When the operating system that runs in a shared memory partition attempts to access data, and the data
is located in the paging space device that is assigned to the shared memory partition, the hypervisor
sends a request to a paging VIOS partition to retrieve the data and write it to the shared memory pool so
that the operating system can access it.
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A paging VIOS partition is not a shared memory partition and does not use the memory in the shared
memory pool. A paging VIOS partition provides access to the paging space devices for the shared
memory partitions.

Integrated Virtualization Manager

On systems that are managed by the Integrated Virtualization Manager, the management partition is the
paging VIOS partition for the shared memory partitions that are assigned to the shared memory pool.
When you create the shared memory pool, you assign a paging storage pool to the shared memory pool.
The paging storage pool provides the paging space devices for the shared memory partitions that are
assigned to the shared memory pool.

HMC

On systems that are managed by a Hardware Management Console (HMC), you can assign one or two
paging VIOS partitions to the shared memory pool. When you assign a single paging VIOS partition to
the shared memory pool, the paging VIOS partition provides access to all of the paging space devices for
the shared memory partitions. The paging space devices can be located in physical storage in the server
or on a storage area network (SAN). When you assign two paging VIOS partitions to the shared memory
pool, you can configure each paging VIOS partition to access paging space devices in one of the
following ways:
v You can configure each paging VIOS partition to access independent paging space devices. Paging

space devices that are accessed by only one paging VIOS partition, or independent paging space
devices, can be located in physical storage in the server or on a SAN.

v You can configure both paging VIOS partitions to access the same, or common, paging space devices.
In this configuration, the paging VIOS partitions provide redundant access to paging space devices.
When one paging VIOS partition becomes unavailable, the hypervisor sends a request to the other
paging VIOS partition to retrieve the data on the paging space device. Common paging space devices
must be located on a SAN to enable symmetrical access from both paging VIOS partitions.

v You can configure each paging VIOS partition to access some independent paging space devices and
some common paging space devices.

If you configure the shared memory pool with two paging VIOS partitions, you can configure a shared
memory partition to use either a single paging VIOS partition or redundant paging VIOS partitions.
When you configure a shared memory partition to use redundant paging VIOS partitions, you assign a
primary paging VIOS partition and a secondary paging VIOS partition to the shared memory partition.
The hypervisor uses the primary paging VIOS partition to access the shared memory partition’s paging
space device. At this point, the primary paging VIOS partition is the current paging VIOS partition for
the shared memory partition. The current paging VIOS partition is the paging VIOS partition that the
hypervisor uses at any point in time to access data in the paging space device that is assigned to the
shared memory partition. If the primary VIOS partition becomes unavailable, the hypervisor uses the
secondary paging VIOS partition to access the shared memory partition’s paging space device. At this
point, the secondary paging VIOS partition becomes the current paging VIOS partition for the shared
memory partition and continues as the current paging VIOS partition even after the primary paging VIOS
partition becomes available again.

You do not need to assign the same primary and secondary paging VIOS partitions to all of the shared
memory partitions. For example, you assign paging VIOS partition A and paging VIOS partition B to the
shared memory pool. For one shared memory partition, you can assign paging VIOS partition A as the
primary paging VIOS partition and paging VIOS partition B as the secondary paging VIOS partition. For
a different shared memory partition, you can assign paging VIOS partition B as the primary paging VIOS
partition and paging VIOS partition A as the secondary paging VIOS partition.

The following figure shows an example of a system with four shared memory partitions, two paging
VIOS partitions, and four paging space devices.
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The example shows the configuration options for paging VIOS partitions and paging space devices as
described in the following table.
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Table 4. Examples of paging VIOS partition configurations

Configuration option Example

The paging space device that is assigned to a shared
memory partition is located in physical storage in the
server and is accessed by a single paging VIOS partition.

Paging space device 4 provides the paging space for
Shared memory partition 4. Shared memory partition 4 is
assigned to use Paging VIOS partition 2 to access Paging
space device 4. Paging space device 4 is located in
physical storage in the server and is assigned to Paging
VIOS partition 2. Paging VIOS partition 2 is the only
paging VIOS partition that can access Paging space
device 4 (This relationship is shown by the blue line that
connects Paging VIOS partition 2 to Paging space device
4.).

The paging space device that is assigned to a shared
memory partition is located on a SAN and is accessed by
a single paging VIOS partition.

Paging space device 1 provides the paging space for
Shared memory partition 1. Shared memory partition 1 is
assigned to use Paging VIOS partition 1 to access Paging
space device 1. Paging space device 1 is connected to the
SAN. Paging VIOS partition 1 is also connected to the
SAN and is the only paging VIOS partition that can
access Paging space device 1 (This relationship is shown
by the green line that connects Paging VIOS partition 1
to Paging space device 1.).
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Table 4. Examples of paging VIOS partition configurations (continued)

Configuration option Example

The paging space device that is assigned to a shared
memory partition is located on a SAN and is accessed
redundantly by two paging VIOS partitions.

Paging space device 2 provides the paging space for
Shared memory partition 2. Paging space device 2 is
connected to the SAN. Paging VIOS partition 1 and
Paging VIOS partition 2 are also connected to the SAN
and can both access Paging space device 2. (These
relationships are shown by the green line that connects
Paging VIOS partition 1 to Paging space device 2 and the
blue line that connects Paging VIOS partition 2 to Paging
space device 2.) Shared memory partition 2 is assigned to
use redundant paging VIOS partitions to access Paging
space device 2. Paging VIOS partition 1 is configured as
the primary paging VIOS partition and Paging VIOS
partition 2 is configured as the secondary paging VIOS
partition.

Similarly, Paging space device 3 provides the paging
space device for Shared memory partition 3. Paging
space device 3 is connected to the SAN. Paging VIOS
partition 1 and Paging VIOS partition 2 are also
connected to the SAN and can both access Paging space
device 3. (These relationships are shown by the green
line that connects Paging VIOS partition 1 to Paging
space device 3 and the blue line that connects Paging
VIOS partition 2 to Paging space device 3.) Shared
memory partition 3 is assigned to use redundant paging
VIOS partitions to access Paging space device 3. Paging
VIOS partition 2 is configured as the primary paging
VIOS partition and Paging VIOS partition 1 is configured
as the secondary paging VIOS partition.

Because Paging VIOS partition 1 and Paging VIOS
partition 2 both have access to Paging space device 2 and
Paging space device 3, Paging space device 2 and Paging
space device 3 are common paging space devices that are
accessed redundantly by Paging VIOS partition 1 and
Paging VIOS partition 2. If Paging VIOS partition 1
becomes unavailable and Shared memory partition 2
needs to access data on its paging space device, the
hypervisor sends a request to Paging VIOS partition 2 to
retrieve the data on Paging space device 2. Similarly, if
Paging VIOS partition 2 becomes unavailable and Shared
memory partition 3 needs to access the data on its
paging space device, the hypervisor sends a request to
Paging VIOS partition 1 to retrieve the data on Paging
space device 3.
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Table 4. Examples of paging VIOS partition configurations (continued)

Configuration option Example

A paging VIOS partition accesses both independent and
common paging space devices.

Paging space device 1 and Paging space device 4 are
independent paging space devices because only one
paging VIOS partition accesses each. Paging VIOS
partition 1 accesses Paging space device 1, and Paging
VIOS partition 2 accesses Paging space device 4. Paging
space device 2 and paging space device 3 are common
paging space devices because both paging VIOS
partitions access each. (These relationships are shown by
the green and blue lines that connect the paging VIOS
partitions to the paging space devices.)

Paging VIOS partition 1 accesses the independent paging
space device Paging space device 1, and also accesses the
common paging space devices Paging space device 2 and
Paging space device 3. Paging VIOS partition 2 accesses
the independent paging space device Paging space
device 4 and also accesses the common paging space
devices Paging space device 2 and Paging space device 3.

When a single paging VIOS partition is assigned to the shared memory pool, you must shut down the
shared memory partitions before you shut down the paging VIOS partition so that the shared memory
partitions are not suspended when they attempt to access their paging space devices. When two paging
VIOS partitions are assigned to the shared memory pool and the shared memory partitions are
configured to use redundant paging VIOS partitions, you do not need to shut down the shared memory
partitions to shut down a paging VIOS partition. When one paging VIOS partition is shut down, the
shared memory partitions use the other paging VIOS partition to access their paging space devices. For
example, you can shut down a paging VIOS partition and install VIOS updates without shutting down
the shared memory partitions.

You can configure multiple VIOS logical partitions to provide access to paging space devices. However,
you can only assign up to two of those VIOS partitions to the shared memory pool at any given time.

After you configure the shared memory partitions, you can later change the redundancy configuration of
the paging VIOS partitions for a shared memory partition by modifying the partition profile of the shared
memory partition and restarting the shared memory partition with the modified partition profile:
v You can change which paging VIOS partitions are assigned to a shared memory partition as the

primary and secondary paging VIOS partitions.
v You can change the number of paging VIOS partitions that are assigned to a shared memory partition.

Paging space device:

You can learn about how the Hardware Management Console (HMC) and Integrated Virtualization
Manager allocate and manipulate paging space devices on systems that use shared memory.

A paging space device is a physical or logical device that is used by a Virtual I/O Server to provide the
paging space for a logical partition that uses shared memory (hereafter referred to as a shared memory
partition). The paging space is an area of nonvolatile storage used to hold portions of the shared memory
partition’s memory that are not resident in the shared memory pool.
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Related concepts

“Data flow for shared memory partitions” on page 32
When the operating system that runs in a logical partition that uses shared memory (hereafter referred to
as a shared memory partition) needs to access data, the data must reside in the shared memory pool.
Systems with overcommitted memory configurations require the hypervisor and at least one Virtual I/O
Server (VIOS) logical partition that is assigned to the shared memory pool (hereafter referred to as paging
VIOS partition) to move data between the shared memory pool and the paging space devices as needed.
“Logical memory” on page 34
Logical memory is the address space, assigned to a logical partition, that the operating system perceives as
its main storage. For a logical partition that uses shared memory (hereafter referred to as a shared memory
partition), a subset of the logical memory is backed up by physical main storage and the contents of the
remaining logical memory are kept in auxiliary storage.

Paging space devices on systems that are managed by the Integrated Virtualization Manager:

You can learn about the paging storage pool on systems that are managed by the Integrated
Virtualization Manager.

When you create the shared memory pool, you assign a paging storage pool to the shared memory pool.
The paging storage pool provides the paging space devices for the shared memory partitions that are
assigned to the shared memory pool.

When you activate the shared memory partition, the Integrated Virtualization Manager allocates a paging
space device from the paging storage pool to the shared memory partition that best fits the size
requirements of the shared memory partition:
v For AIX and Linux shared memory partitions, the paging space device must be at least the size of the

maximum logical memory size of the shared memory partition.
v For IBM i shared memory partitions, the paging space device must be at least the size of the maximum

logical memory size of the shared memory partition plus 8 KB for every megabyte.

The Integrated Virtualization Manager automatically creates a paging space device for the shared
memory partition in one or more of the following situations:
v No paging space devices exist in the paging storage pool.
v No paging space devices that are in the paging storage pool meet the size requirements of the shared

memory partition.
v All of the paging space devices in the paging storage pool are assigned to other shared memory

partitions.

The Integrated Virtualization Manager allocates only one paging space device to a shared memory
partition at a time. If you do not assign a paging storage pool to the shared memory pool, you need to
assign a minimum of one paging space device to the shared memory pool for each shared memory
partition. After you create the shared memory pool, you can add or remove paging space devices to or
from the shared memory pool as needed.
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Related tasks

“Preparing to configure shared memory” on page 92
Before you configure the shared memory pool and create logical partitions that use shared memory
(hereafter referred to as shared memory partitions), you need to plan for the shared memory pool, the
shared memory partitions, the paging space devices, and the Virtual I/O Server logical partitions
(hereafter referred to as paging VIOS partitions).
Related reference

“Configuration requirements for shared memory” on page 90
Review the requirements for the system, Virtual I/O Server (VIOS), logical partitions, and paging space
devices so that you can successfully configure shared memory.
Related information

Adding or removing paging space devices by using the Integrated Virtualization Manager

Paging space devices on systems that are managed by an HMC:

Learn about the location requirements, size requirements, and redundancy preferences for paging space
devices on systems that are managed by a Hardware Management Console (HMC).

When you configure the shared memory pool, you assign paging space devices to the shared memory
pool. Paging space devices can be located in physical storage in the server or on a storage area network
(SAN) as follows:
v Paging space devices that are accessed by a single Virtual I/O Server (VIOS) logical partition (hereafter

referred to as a paging VIOS partition) can be located in physical storage in the server or on a SAN.
v Paging space devices that are accessed redundantly by two paging VIOS partitions, or common paging

space devices, must be located on a SAN.

When you activate a shared memory partition, the HMC allocates a paging space device (that is assigned
to the shared memory pool) to the shared memory partition. The HMC allocates only one paging space
device to a shared memory partition at a time. When you shut down a shared memory partition, its
paging space device becomes available to the HMC to allocate elsewhere. Thus, the fewest number of
paging space devices that must be assigned to the shared memory pool is equal to the number of shared
memory partitions that you plan to run simultaneously. After you create the shared memory pool, you
can add or remove paging space devices to or from the shared memory pool as needed.

The HMC assigns paging space devices to shared memory partitions based on the size requirements for
the shared memory partition and the redundancy preferences that you specify for partition activation.

Size requirements

The HMC allocates a paging space device to a shared memory partition that best fits the size
requirements of the shared memory partition:
v For AIX and Linux shared memory partitions, the paging space device must be at least the size of the

maximum logical memory size of the shared memory partition.
v For IBM i shared memory partitions, the paging space device must be at least the size of the maximum

logical memory size of the shared memory partition plus 8 KB for every megabyte.

Shared memory partitions might have several partition profiles that specify different maximum logical
memory sizes. To maintain flexibility, consider creating paging space devices that are large enough to be
used by shared memory partitions with multiple partition profiles. When you activate a shared memory
partition with a different partition profile, the shared memory partition already has a paging space device
allocated to it based on the size requirements of the previously activated partition profile. If you create a
paging space device that is large enough to meet the size requirements of multiple partition profiles and
you activate the shared memory partition with a different partition profile, the HMC can use the same
paging space device for the newly activated partition profile. If the paging space device does not meet
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the size requirements of the newly activated partition profile, the HMC frees the paging space device
currently allocated to the shared memory partition and allocates a different paging space device that
meets the size requirements specified in the newly activated partition profile.

Redundancy preferences

The HMC allocates a paging space device to a shared memory partition that satisfies the redundancy
preferences that you specify for partition activation:
v If you specify that the shared memory partition uses redundant paging VIOS partitions, the HMC uses

the following process to select a suitable paging space device for the shared memory partition:
1. The HMC assigns a paging space device that is common and available. (A paging space device is

available when it is not currently assigned to a shared memory partition and is inactive.)
2. If the HMC cannot find a paging space device that is common and available, it reassigns a paging

space device that is common and unavailable. (A paging space device is unavailable when it is active
and currently assigned to a shared memory partition that is shut down.)

3. If the HMC cannot find a paging space device that is common and unavailable, it cannot activate
the shared memory partition.

v If you specify that the shared memory partition does not use redundant paging VIOS partitions, the
HMC uses the following process to select a suitable paging space device for the shared memory
partition:
1. The HMC assigns a paging space device that is independent and available. (A paging space device

is independent when it is accessed by only one paging VIOS partition that is assigned to the shared
memory partition.)

2. If the HMC cannot find a paging space device that is independent and available, the HMC
reassigns a paging space device that is independent and unavailable.

3. If the HMC cannot find a paging space device that is independent and unavailable, and two paging
VIOS partitions are assigned to the shared memory pool, then the HMC assigns a paging space
device that is common and available. In this situation, the shared memory partition does not use
redundant paging VIOS partitions even though its paging space device can be accessed by both
paging VIOS partitions. Also, the partition profile does not need to specify the second paging VIOS
partition.

4. If the HMC cannot find a paging space device that is common and available, and two paging VIOS
partitions are assigned to the shared memory pool, then the HMC reassigns a paging space device
that is common and unavailable. In this situation, the shared memory partition does not use
redundant paging VIOS partitions even though its paging space device can be accessed by both
paging VIOS partitions. Also, the partition profile does not need to specify the second paging VIOS
partition.

5. If the HMC cannot find a paging space device that is common and unavailable, it cannot activate
the shared memory partition.

v If you specify that the shared memory partition use redundant paging VIOS partitions, if possible, the
HMC uses the following process to select a suitable paging space device for the shared memory
partition:
1. The HMC assigns a paging space device that is common and available.
2. If the HMC cannot find a paging space device that is common and available, it assigns a paging

space device that is common and unavailable.
3. If the HMC cannot find a paging space device that is common and unavailable, it assigns a paging

space device that is independent and available to the primary paging VIOS partition. In this
situation, the shared memory partition does not use redundant paging VIOS partitions and the
primary paging VIOS partition is the only paging VIOS partition that is assigned to the shared
memory partition.

4. If the HMC cannot find a paging space device that is independent and available to the primary
paging VIOS partition, it assigns a paging space device that is independent and unavailable to the
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primary paging VIOS partition. In this situation, the shared memory partition does not use
redundant paging VIOS partitions and the primary paging VIOS partition is the only paging VIOS
partition that is assigned to the shared memory partition.

5. If the HMC cannot find a paging space device that is independent and unavailable to the primary
paging VIOS partition, it assigns a paging space device that is independent and available to the
secondary paging VIOS partition. In this situation, the shared memory partition does not use
redundant paging VIOS partitions and the secondary paging VIOS partition is the only paging
VIOS partition that is assigned to the shared memory partition.

6. If the HMC cannot find a paging space device that is independent and available to the secondary
paging VIOS partition, it assigns a paging space device that is independent and unavailable to the
secondary paging VIOS partition. In this situation, the shared memory partition does not use
redundant paging VIOS partitions and the secondary paging VIOS partition is the only paging
VIOS partition that is assigned to the shared memory partition.

7. If the HMC cannot find a paging space device that is independent and unavailable to the secondary
paging VIOS partition, it cannot activate the shared memory partition.

Related concepts

“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.
Related tasks

“Preparing to configure shared memory” on page 92
Before you configure the shared memory pool and create logical partitions that use shared memory
(hereafter referred to as shared memory partitions), you need to plan for the shared memory pool, the
shared memory partitions, the paging space devices, and the Virtual I/O Server logical partitions
(hereafter referred to as paging VIOS partitions).
“Adding and removing paging space devices to and from the shared memory pool” on page 147
After you create the shared memory pool, you can add and remove paging space devices to and from the
shared memory pool by using the Hardware Management Console (HMC).
Related reference

“Configuration requirements for shared memory” on page 90
Review the requirements for the system, Virtual I/O Server (VIOS), logical partitions, and paging space
devices so that you can successfully configure shared memory.

Shared memory distribution:

The hypervisor uses the memory weight of each logical partition that uses shared memory (hereafter
referred to as shared memory partitions) to help determine which logical partitions receive more physical
memory from the shared memory pool. To help optimize performance and memory use, the operating
systems that run in shared memory partitions provide the hypervisor with information about how the
operating system uses its memory to help the hypervisor determine which pages to store in the shared
memory pool and which pages to store in the paging space devices.

In a shared memory configuration that is physically overcommitted (where the sum of the logical
memory that is currently used by of all shared memory partitions is greater than the amount of memory
in the shared memory pool), the hypervisor stores a portion of the logical memory in the shared memory
pool and stores the remainder of the logical memory in the paging space devices. The hypervisor
determines the amount of physical memory to allocate from the shared memory pool to each shared
memory partition and the amount of logical memory to store in the paging space devices. The hypervisor
also determines which pieces, or pages, of memory to store in each location.

The smallest amount of physical memory that the hypervisor can allocate from the shared memory pool
to a shared memory partition at any given time is the amount of physical memory that the shared

48 Logical partitioning



memory partition requires for its I/O devices. The hypervisor guarantees to each shared memory
partition that the shared memory partition can use a portion of the shared memory pool for its I/O
devices, up to the I/O entitled memory that is assigned to the shared memory partition. The largest
amount of physical memory that the hypervisor can allocate from the shared memory pool to a shared
memory partition at any given time is the amount of logical memory assigned to the shared memory
partition.

The amount of physical memory from the shared memory pool that the hypervisor allocates to the shared
memory partitions is determined by the workloads that are running in the shared memory partitions and
the amount of logical memory that is assigned to each shared memory partition. You can influence how
much physical memory the hypervisor allocates from the shared memory pool to each shared memory
partition by specifying a memory weight for each shared memory partition. Memory weight is a relative
value that is one of the factors that the hypervisor uses to allocate physical memory from the shared
memory pool to the shared memory partitions. A higher memory weight relative to the memory weights
of other shared memory partitions increases the probability that the hypervisor allocates more physical
memory to a shared memory partition.

To help maintain the best possible performance, the operating system that runs in a shared memory
partition continually attempts to operate within the amount of physical memory allocated to it from the
shared memory pool by moving its overcommitted logical memory to a paging space. In general, the
operating system moves its memory to a paging space more often when it runs in a shared memory
partition than when it runs in a dedicated memory partition. Therefore, the paging space that the
operating system uses to manage its memory needs to be larger when the logical partition uses shared
memory than when the logical partition uses dedicated memory.

The operating systems that run in shared memory partitions provide information to the hypervisor about
how the operating system uses its pages. When the hypervisor manages the overcommitted logical
memory, it uses this information to determine which pages to store in the paging space device and which
pages to store in the shared memory pool. When the hypervisor needs to deallocate physical memory
from the shared memory partition and move it to the paging space device, the hypervisor requests the
operating system to release pages. The operating system might mark the pages that it will not use, and
the hypervisor moves the marked pages first. This enables the hypervisor to select the most optimal
pages to move out of the shared memory pool, which improves memory use and performance. For
example, the operating system uses one page for kernel data and another page for cache and the
hypervisor needs to move one page to the paging space device. The hypervisor moves the cache page to
the paging space device to optimize performance.
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Related concepts

“Paging space device” on page 44
You can learn about how the Hardware Management Console (HMC) and Integrated Virtualization
Manager allocate and manipulate paging space devices on systems that use shared memory.
“Data flow for shared memory partitions” on page 32
When the operating system that runs in a logical partition that uses shared memory (hereafter referred to
as a shared memory partition) needs to access data, the data must reside in the shared memory pool.
Systems with overcommitted memory configurations require the hypervisor and at least one Virtual I/O
Server (VIOS) logical partition that is assigned to the shared memory pool (hereafter referred to as paging
VIOS partition) to move data between the shared memory pool and the paging space devices as needed.
“Performance considerations for overcommitted shared memory partitions” on page 217
Learn about how the degree to which the memory configuration of a logical partition that uses shared
memory (hereafter referred to as a shared memory partition) is overcommitted affects the performance of
the shared memory partition. In general, the less overcommitted the memory configuration of a shared
memory partition, the better its performance.
“Logical memory” on page 34
Logical memory is the address space, assigned to a logical partition, that the operating system perceives as
its main storage. For a logical partition that uses shared memory (hereafter referred to as a shared memory
partition), a subset of the logical memory is backed up by physical main storage and the contents of the
remaining logical memory are kept in auxiliary storage.
Related tasks

“Changing the memory weight of a shared memory partition” on page 183
You can use the Hardware Management Console (HMC) to change the memory weight of a logical
partition that uses shared memory (hereafter referred to as a shared memory partition). Changing the
memory weight changes the probability that the shared memory partition receives physical memory from
the shared memory pool in relation to other shared memory partitions.
Related information

Managing memory properties for shared memory partitions by using the Integrated Virtualization
Manager

Terminal and console options for logical partitions
You can initiate a terminal or console session to the logical partitions on your managed system using a
variety of methods. Your choice of terminal or console depends on your operating system and business
needs.

The following choices of terminal or console are available for each operating system.

Table 5. Terminal and console options for logical partitions

Operating system Terminal or console options

AIX v Hardware Management Console (HMC)

v Telnet

v OpenSSH with OpenSSL (included in the AIX expansion pack)

v Direct serial connection (ASCII terminal or PC connected with null modem cable)

v IBM i virtual console (for AIX logical partitions that use IBM i resources)

v When on a system with a Virtual I/O Server (VIOS) logical partition, the console can be
provided by the VIOS logical partition when using VIOS 1.2.0 or later.

IBM i v HMC

v Operations Console

– Operations Console LAN

– Operations Console Directly attached

v Twinaxial console
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Table 5. Terminal and console options for logical partitions (continued)

Operating system Terminal or console options

Linux v HMC

v Telnet

v OpenSSH with OpenSSL (included in the Linux distribution)

v Direct serial connection (ASCII terminal or PC connected with null modem cable)

v IBM i virtual console (for Linux logical partitions that use IBM i resources)

v When on a system with a Virtual I/O Server (VIOS) logical partition, the console can be
provided by the VIOS logical partition when using VIOS 1.2.0 or later.

Virtual I/O Server v Hardware Management Console (HMC)

v Telnet

v OpenSSH with OpenSSL (included in the AIX expansion pack)

v Direct serial connection (ASCII terminal or PC connected with null modem cable)

v IBM i virtual console (for AIX logical partitions that use IBM i resources)

v When on a system with a Virtual I/O Server (VIOS) logical partition, the console can be
provided by the VIOS logical partition when using VIOS 1.2.0 or later.

Hardware Management Console terminal and console options:

The HMC provides virtual terminal emulation for AIX and Linux logical partitions and virtual 5250
console emulation for IBM i logical partitions.

The HMC connects to the server firmware. You use the HMC to specify to the server firmware how you
want resources to be allocated among the logical partitions on the managed system. You also use the
HMC to start and stop the logical partitions, update the server firmware code, manage Capacity on
Demand, and transmit service information to service and support if there are any hardware problems
with your managed system.

You can create virtual terminal and virtual 5250 console sessions locally on the HMC by using the Server
Management commands on the HMC. If you configure the HMC to allow remote access, you can also
create virtual terminal and virtual 5250 console sessions remotely through the HMC. You can create
remote virtual terminal sessions on AIX and Linux logical partitions by using the Server Management
commands. You can also create virtual 5250 console sessions on IBM i logical partitions. You must
configure the HMC to allow remote access, and you must configure encryption on the logical partitions
for the session to be secure.

The HMC communicates with servers using service applications to detect, consolidate, and send
information to IBM for analysis.

The following figure shows a partitioned server being managed by an HMC.
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Operations Console for IBM i logical partitions:

Operations Console allows you to use a local or remote PC to access IBM i on logical partitions.
Operations Console is an installable component of System i Access for Windows® licensed program.

You can use Operations Console to connect to IBM i logical partitions either over a network (LAN
connect) or through a console that is attached to a serial port that is owned by the IBM i logical partition
(directly attached).

The management tasks that you can perform using Operations Console depend upon whether you are
managing your logical partitions using a Hardware Management Console (HMC) or using the Virtual
Partition Manager on IBM i:
v If you are using an HMC to manage your logical partitions, you can use Operations Console to access

IBM i on your IBM i logical partitions.
v If you are using the Virtual Partition Manager on IBM i to manage your logical partitions, you can use

Operations Console to access IBM i on your IBM i logical partitions. In turn, you can use Operations
Console to access the Virtual Partition Manager on your IBM i logical partitions. This allows you to
create up to four Linux logical partitions on the managed system and manage the resources for all
logical partitions on the managed system.

The following figure shows a partitioned IBM System i model with an HMC and local console on a
network.
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The following figure shows a partitioned IBM System i model with an HMC and local consoles directly
attached to the server.

Note: Directly attached Operations Console does not support the remote control panel. For remote
control panel support, you will need either LAN or the virtual control panel that uses the serial cable
from the existing console.
Related information

Managing Operations Console

Twinaxial console for IBM i logical partitions:

The twinaxial console uses a basic command-line interface to access IBM i on logical partitions. It does not
require the use of a PC to act as a console.
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You can connect a twinaxial console to a serial port that is owned by the IBM i logical partition and use
the twinaxial console to access the IBM i operating system on the IBM i logical partition.

The management tasks that you can perform using a twinaxial console depend upon whether you are
managing your logical partitions using a Hardware Management Console (HMC) or using the Virtual
Partition Manager on IBM i:
v If you are using an HMC to manage your logical partitions, you can use the twinaxial console to access

IBM i on your IBM i logical partitions.
v If you are using the Virtual Partition Manager on IBM i to manage your logical partitions, you can use

a twinaxial console to access IBM i on your IBM i logical partition. In turn, you can use the twinaxial
console to access the Virtual Partition Manager on the IBM i logical partition. This allows you to create
up to four Linux logical partitions on the managed system and manage the resources for all logical
partitions on the managed system.

Twinaxial console and an HMC

The following figure shows a partitioned IBM System i model with a Hardware Management Console
(HMC) connected to the server firmware and twinaxial consoles connected to each IBM i logical partition.
Use the HMC to create and manage logical partitions. Use the twinaxial console to access i on your i
logical partitions.

Twinaxial console and the Virtual Partition Manager

The following figure shows a partitioned System i model with a twinaxial console connected to i on your
i logical partition. Use the twinaxial console to access the Virtual Partition Manager and create and
manage the logical partitions on your managed system.
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Related information

Virtual Partition Manager: A Guide to Planning and Implementation RedPaper

Managing the twinaxial console

I/O devices
I/O devices allow your managed system to gather, store, and transmit data. I/O devices are found in the
server unit itself and in expansion units that are attached to the server. I/O devices can be embedded
into the unit, or they can be installed into physical slots.

Not all types of I/O devices are supported for all operating systems or on all server models. For
example, Switch Network Interface (SNI) adapters are supported only on certain server models, and are
not supported for IBM i logical partitions. Also, I/O processors (IOPs) are supported only on IBM i
logical partitions.

Attention: Some PCI adapters and imbedded controllers require multiple PCI or PCI-E slots to be
associated with them. Carefully review the PCI or PCI-E slot assignments for each logical partition to
ensure that the slot configuration of the logical partition meets the adapter functional requirements. For
details, see Managing PCI adapters and PCI adapter placement for machine types 82xx and 91xx or PCI
adapter placement for machine type 94xx.

Virtual adapters:

With virtual adapters, you can connect logical partitions with each other without using physical
hardware. Operating systems can display, configure, and use virtual adapters just like they can display,
configure, and use physical adapters. Depending on the operating environment used by the logical
partition, you can create virtual Ethernet adapters, virtual fibre channel adapters, virtual Small Computer
Serial Interface (SCSI) adapters, and virtual serial adapters for a logical partition.

The system administrator uses the following tools to create virtual adapters:
v Hardware Management Console (HMC)
v Integrated Virtualization Manager
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v Virtual Partition Manager

Adapters can be added while the system is running using dynamic logical partitioning. The virtual
adapters are recorded in system inventory and management utilities. Converged location codes can be
used to correlate operating-system level or partition-level software entities to adapters, such as eth0,
CMN21, and en0. Similarly, the Ethernet adapters are visible in the same way as physical Ethernet
adapters.

By default, virtual Ethernet Media Access Control (MAC) addresses are created from the locally
administered range. Using the default MAC addresses, it is possible that different servers will have
virtual Ethernet adapters with the same addresses. This situation can present a problem if multiple,
virtual networks are bridged to the same physical network.

If a server logical partition providing I/O for a client logical partition fails, the client logical partition
might continue to function, depending on the significance of the hardware it is using. For example, if one
logical partition is providing the paging volume for another logical partition, a failure of the logical
partition providing that particular resource will be significant to the other logical partition. However, if
the shared resource is a tape drive, a failure of the server logical partition providing the resource will
have only minimal effects on the client logical partition.

Client support for virtual I/O

The following table summarizes operating system support for using virtual I/O devices.

Table 6. Client support for virtual I/O by operating system

Client
operating
system

Virtual
console

Virtual
Ethernet

Virtual fibre
channel

Virtual disk Virtual optical Virtual tape

AIX Yes Yes Yes Yes Yes, on
HMC-managed
systems, at
least one
Virtual I/O
Server logical
partition must
be present

Yes

IBM i Yes Yes No Yes Yes No

Linux Yes Yes Yes Yes Yes Yes

AIX logical partitions support booting from virtual devices, including disk boot from virtual disk,
network boot from virtual Ethernet, and tape boot from virtual tape.

The firmware running in AIX and Linux logical partitions recognizes virtual I/O and can start the logical
partition from virtual I/O. An IPL can be done either from the network over virtual Ethernet or from a
device such as virtual disk or virtual CD.

Server support for virtual I/O

The following table summarizes operating system support for providing virtual I/O to logical partitions.

Table 7. Server support for virtual I/O by operating system

Server Virtual optical Virtual console Virtual disk Virtual tape Virtual fibre
channel

IBM i Yes Yes Yes Yes No
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Table 7. Server support for virtual I/O by operating system (continued)

Server Virtual optical Virtual console Virtual disk Virtual tape Virtual fibre
channel

Linux Yes Yes No No No

Virtual I/O
Server

Yes Yes Yes Yes Yes

Virtual I/O Server provides SCSI disk, shared Ethernet, virtual fibre channel, virtual optical, and virtual
tape functions to logical partitions that use Virtual I/O Server resources. The Virtual I/O Server also
provides a virtual console to AIX and Linux logical partitions.

IBM i provides disk, CD, tape, and console functions to logical partitions that use IBM i resources. IBM i
uses standard IBM i network server storage and network server descriptions to provide disk, CD, and
tape resources to other logical partitions. An IBM i logical partition cannot simultaneously provide virtual
resources to other logical partitions and use virtual resources provided by another IBM i logical partition
or by the Virtual I/O Server logical partition.

To configure virtual I/O for the logical partitions on your managed system, you must create virtual I/O
adapters on the HMC or Integrated Virtualization Manager. Virtual I/O adapters are usually created
when you create your logical partitions. Alternatively, you can add virtual I/O adapters to running
logical partitions using dynamic logical partitioning. After you create a virtual I/O adapter, you can then
access the operating system used by the logical partition and complete the configuration of the virtual
I/O adapter in the operating system software. For Linux partitions, virtual adapters are listed in the
device tree. The device tree contains virtual SCSI adapters, not the devices under the adapter.

Logical Host Ethernet Adapter

A logical Host Ethernet Adapter (LHEA) is a special type of virtual adapter. Even though an LHEA is a
virtual resource, an LHEA can exist only if a physical Host Ethernet Adapter, or Integrated Virtual
Ethernet, provides its resources to the LHEA.
Related concepts

“I/O device assignment in partition profiles” on page 11
I/O devices are assigned to partition profiles on a slot-by-slot basis. Most I/O devices can be assigned to
a partition profile on the HMC as required or as desired.
“Host Ethernet Adapter” on page 66
A Host Ethernet Adapter (HEA) is a physical Ethernet adapter that is integrated directly into the GX+ bus
on a managed system. HEAs offer high throughput, low latency, and virtualization support for Ethernet
connections. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).
Related tasks

“Managing virtual adapters dynamically” on page 172
You can dynamically add and remove virtual adapters to and from running logical partitions using the
Hardware Management Console (HMC).

Virtual Ethernet:

Virtual Ethernet allows logical partitions to communicate with each other without having to assign
physical hardware to the logical partitions.

You can create virtual Ethernet adapters on each logical partition and connect these virtual Ethernet
adapters to virtual LANs. TCP/IP communications over these virtual LANs is routed through the server
firmware.
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A virtual Ethernet adapter provides similar function as a 1 Gb Ethernet adapter. A logical partition can
use virtual Ethernet adapters to establish multiple high-speed interpartition connections within a single
managed system. AIX, IBM i, Linux, and Virtual I/O Server logical partitions and Windows environments
integrated on the System i platform can communicate with each other using TCP/IP over the virtual
Ethernet communications ports.

Virtual Ethernet adapters are connected to an IEEE 802.1q (VLAN)-style virtual Ethernet switch. Using
this switch function, logical partitions can communicate with each other by using virtual Ethernet
adapters and assigning VIDs (VLAN ID) that enable them to share a common logical network. The
virtual Ethernet adapters are created and the VID assignments are done using the Hardware Management
Console (HMC). The system transmits packets by copying the packet directly from the memory of the
sender logical partition to the receive buffers of the receiver logical partition without any intermediate
buffering of the packet.

You can configure an Ethernet bridge between the virtual LAN and a physical Ethernet adapter that is
owned by a Virtual I/O Server or IBM i logical partition. The logical partitions on the virtual LAN can
communicate with an external Ethernet network through the Ethernet bridge. You can reduce the number
of physical Ethernet adapters required for a managed system by routing external communications
through the Ethernet bridge.

The number of virtual Ethernet adapters allowed for each logical partition varies by operating system.
v AIX 5.3 supports up to 256 virtual Ethernet adapters for each logical partition.
v IBM i supports up to 32 767 virtual Ethernet adapters for each logical partition. Each IBM i logical

partition can belong to a maximum of 4094 virtual LANs.
v Version 2.4 of the Linux kernel supports up to 100 virtual Ethernet adapters for each logical partition.

Each Linux logical partition can belong to a maximum of 4094 virtual LANs.
v Version 2.6 of the Linux kernel supports up to 32 768 virtual Ethernet adapters for each logical

partition. Each Linux logical partition can belong to a maximum of 4094 virtual LANs.

Besides a PVID, the number of additional VID values that can be assigned for each virtual Ethernet
adapter is 19, which indicates that each virtual Ethernet adapter can be used to access 20 networks. The
HMC generates a locally administered Ethernet MAC address for the virtual Ethernet adapters so that
these addresses do not conflict with physical Ethernet adapter MAC addresses.

After a specific virtual Ethernet is enabled for a logical partition, a network device is created in the
logical partition. This network device is named entX on AIX logical partitions, CMNXX on IBM i logical
partitions, and ethX on Linux logical partitions, where X represents sequentially assigned numbers. The
user can then set up TCP/IP configuration similar to a physical Ethernet device to communicate with
other logical partitions.

If a virtual Ethernet adapter is set for checksum offload, the virtual Ethernet adapter cannot generate a
checksum for any packet that the virtual Ethernet adapter sends to a multicast or broadcast MAC
address.

Some managed systems contain a Host Ethernet Adapter (HEA). A Host Ethernet Adapter (HEA) is a
physical Ethernet adapter that is integrated directly into the GX+ bus on a managed system. HEAs are
also known as Integrated Virtual Ethernet adapters (IVE adapters). Unlike most other types of I/O
devices, you can never assign the HEA itself to a logical partition. Instead, multiple logical partitions can
connect directly to the HEA and use the HEA resources. This allows these logical partitions to access
external networks through the HEA without having to go through an Ethernet bridge on another logical
partition.
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Related concepts

“Host Ethernet Adapter” on page 66
A Host Ethernet Adapter (HEA) is a physical Ethernet adapter that is integrated directly into the GX+ bus
on a managed system. HEAs offer high throughput, low latency, and virtualization support for Ethernet
connections. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).
Related tasks

“Configuring a virtual Ethernet adapter” on page 130
You can configure a virtual Ethernet adapter dynamically for a running logical partition by using the
Hardware Management Console (HMC). Doing so will connect the logical partition to a virtual LAN.

Virtual fibre channel:

With N_Port ID Virtualization (NPIV), you can configure the managed system so that multiple logical
partitions can access independent physical storage through the same physical fibre channel adapter.

To access physical storage in a typical storage area network (SAN) that uses fibre channel, the physical
storage is mapped to logical units (LUNs) and the LUNs are mapped to the ports of physical fibre
channel adapters. Each physical port on each physical fibre channel adapter is identified using one
worldwide port name (WWPN).

NPIV is a standard technology for fibre channel networks that enables you to connect multiple logical
partitions to one physical port of a physical fibre channel adapter. Each logical partition is identified by a
unique WWPN, which means that you can connect each logical partition to independent physical storage
on a SAN.

To enable NPIV on the managed system, you must create a Virtual I/O Server logical partition (version
2.1, or later) that provides virtual resources to client logical partitions. You assign the physical fibre
channel adapters (that support NPIV) to the Virtual I/O Server logical partition. Then, you connect
virtual fibre channel adapters on the client logical partitions to virtual fibre channel adapters on the
Virtual I/O Server logical partition. A virtual fibre channel adapter is a virtual adapter that provides client
logical partitions with a fibre channel connection to a storage area network through the Virtual I/O
Server logical partition. The Virtual I/O Server logical partition provides the connection between the
virtual fibre channel adapters on the Virtual I/O Server logical partition and the physical fibre channel
adapters on the managed system.

The following figure shows a managed system configured to use NPIV.
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The figure shows the following connections:
v A storage area network (SAN) connects three units of physical storage to a physical fibre channel

adapter that is located on the managed system. The physical fibre channel adapter is assigned to the
Virtual I/O Server and supports NPIV.

v The physical fibre channel adapter connects to three virtual fibre channel adapters on the Virtual I/O
Server. All three virtual fibre channel adapters on the Virtual I/O Server connect to the same physical
port on the physical fibre channel adapter.

v Each virtual fibre channel adapter on the Virtual I/O Server connects to one virtual fibre channel
adapter on a client logical partition. Each virtual fibre channel adapter on each client logical partition
receives a pair of unique WWPNs. The client logical partition uses one WWPN to log into the SAN at
any given time. The other WWPN is used when you move the client logical partition to another
managed system.

Using their unique WWPNs and the virtual fibre channel connections to the physical fibre channel
adapter, the operating systems that run in the client logical partitions discover, instantiate, and manage
their physical storage located on the SAN. In the previous figure, Client logical partition 1 accesses
Physical storage 1, Client logical partition 2 accesses Physical storage 2, and Client logical partition 3
accesses Physical storage 3. The Virtual I/O Server cannot access and does not emulate the physical
storage to which the client logical partitions have access. The Virtual I/O Server provides the client
logical partitions with a connection to the physical fibre channel adapters on the managed system.

There is always a one-to-one relationship between virtual fibre channel adapters on the client logical
partitions and the virtual fibre channel adapters on the Virtual I/O Server logical partition. That is, each
virtual fibre channel adapter on a client logical partition must connect to only one virtual fibre channel
adapter on the Virtual I/O Server logical partition, and each virtual fibre channel on the Virtual I/O
Server logical partition must connect to only one virtual fibre channel adapter on a client logical partition.
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Using SAN tools, you can zone and mask LUNs that include WWPNs that are assigned to virtual fibre
channel adapters on client logical partitions. The SAN uses WWPNs that are assigned to virtual fibre
channel adapters on client logical partitions the same way it uses WWPNs that are assigned to physical
ports.

You can configure virtual fibre channel adapters on client logical partitions that run the following
operating systems:
v AIX version 6.1 Technology Level 2, or later
v AIX 5.3 Technology Level 9
v SUSE Linux Enterprise Server 11, or later
Related information

Redundancy configuration using virtual fibre channel adapters

Virtual fibre channel for HMC-managed systems:

On systems that are managed by the Hardware Management Console (HMC), you can dynamically add
and remove virtual fibre channel adapters to and from the Virtual I/O Server logical partition and each
client logical partition. You can also view information about the virtual and physical fibre channel
adapters and the worldwide port names (WWPNs) by using Virtual I/O Server commands.

To enable N_Port ID Virtualization (NPIV) on the managed system, you create the required virtual fibre
channel adapters and connections as follows:
v You use the HMC to create virtual fibre channel adapters on the Virtual I/O Server logical partition

and associate them with virtual fibre channel adapters on the client logical partitions.
v You use the HMC to create virtual fibre channel adapters on each client logical partition and associate

them with virtual fibre channel adapters on the Virtual I/O Server logical partition. When you create a
virtual fibre channel adapter on a client logical partition, the HMC generates a pair of unique WWPNs
for the client virtual fibre channel adapter.

v You connect the virtual fibre channel adapters on the Virtual I/O Server to the physical ports of the
physical fibre channel adapter by running the vfcmap command on the Virtual I/O Server.

The HMC generates WWPNs based on the range of names available for use with the prefix in the vital
product data on the managed system. This 6–digit prefix comes with the purchase of the managed system
and includes 32 000 pairs of WWPNs. When you remove a virtual fibre channel adapter from a client
logical partition, the hypervisor deletes the WWPNs that are assigned to the virtual fibre channel adapter
on the client logical partition. The HMC does not reuse the deleted WWPNs when generating WWPNs
for virtual fibre channel adapters in the future. If you run out of WWPNs, you must obtain an activation
code that includes another prefix with another 32 000 pairs of WWPNs.

To avoid configuring the physical fibre channel adapter to be a single point of failure for the connection
between the client logical partition and its physical storage on the SAN, do not connect two virtual fibre
channel adapters from the same client logical partition to the same physical fibre channel adapter.
Instead, connect each virtual fibre channel adapter to a different physical fibre channel adapter.

You can dynamically add and remove virtual fibre channel adapters to and from the Virtual I/O Server
logical partition and to and from client logical partitions.

Table 8. Dynamic logical partitioning tasks and results for virtual fibre channel adapters

Dynamically add or remove virtual
fibre channel adapter

To or from a client logical partition
or a Virtual I/O Server logical
partition Result

Add a virtual fibre channel adapter To a client logical partition The HMC generates the a pair of
unique WWPNs for the client virtual
fibre channel adapter.

Logical partitioning 61



Table 8. Dynamic logical partitioning tasks and results for virtual fibre channel adapters (continued)

Dynamically add or remove virtual
fibre channel adapter

To or from a client logical partition
or a Virtual I/O Server logical
partition Result

Add a virtual fibre channel adapter To a Virtual I/O Server logical
partition

You need to connect the virtual fibre
channel adapter to a physical port on
a physical fibre channel adapter.

Remove a virtual fibre channel
adapter

From a client logical partition v The hypervisor deletes the
WWPNs and does not reuse them.

v You must either remove the
associated virtual fibre channel
adapter from the Virtual I/O
Server, or associate it with another
virtual fibre channel adapter on a
client logical partition.

Remove a virtual fibre channel
adapter

From a Virtual I/O Server logical
partition

v The Virtual I/O Server removes
the connection to the physical port
on the physical fibre channel
adapter.

v You must either remove the
associated virtual fibre channel
adapter from the client logical
partition, or associate it with
another virtual fibre channel
adapter on the Virtual I/O Server
logical partition.

The following table lists the Virtual I/O Server commands that you can run to view information about
the fibre channel adapters.

Table 9. Virtual I/O Server commands that display information about fibre channel adapters

Virtual I/O Server command Information displayed by command

lsmap v Displays the virtual fibre channel adapters on the
Virtual I/O Server that are connected to the physical
fibre channel adapter

v Displays attributes of the virtual fibre channel adapters
on the client logical partitions that are associated with
the virtual fibre channel adapters on the Virtual I/O
Server that are connected to the physical fibre channel
adapter

lsnports Displays information about the physical ports on the
physical fibre channel adapters that support NPIV, such
as:

v The name and location code of the physical port

v The number of available physical ports

v The total number of WWPNs that the physical port
can support

v Whether the switches, to which the physical fibre
channel adapters are cabled, support NPIV

You can also run the lshwres command on the HMC to display the remaining number of WWPNs and to
display the prefix that is currently used to generate the WWPNs.
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Related tasks

“Configuring a virtual fibre channel adapter” on page 131
You can configure a virtual fibre channel adapter dynamically for a running logical partition using the
Hardware Management Console (HMC).
“Managing virtual adapters dynamically” on page 172
You can dynamically add and remove virtual adapters to and from running logical partitions using the
Hardware Management Console (HMC).
“Obtaining additional WWPNs for the server” on page 190
When all of the worldwide port names (WWPNs) on the server are used, you can add more WWPNs to
the server using the Hardware Management Console (HMC). Adding WWPNs allows you to create
additional virtual fibre channel adapters on client logical partitions that use virtual resources provided by
the Virtual I/O Server.
Related information

Virtual I/O Server and Integrated Virtualization Manager Command Reference Guide

Virtual fibre channel on IVM-managed systems:

On systems that are managed by the Integrated Virtualization Manager (IVM), you can dynamically add
and remove worldwide port names (WWPNs) to and from logical partitions, and you can dynamically
change the physical ports to which the WWPNs are assigned. You can also view information about the
virtual and physical fibre channel adapters and the WWPNs by using the lsmap and lsnports commands.

To enable N_Port ID Virtualization (NPIV) on the managed system, you create a pair of WWPNs for a
logical partition and assign the pair directly to the physical ports of the physical fibre channel adapters.
You can assign multiple logical partitions to one physical port by assigning a pair of WWPNs for each
logical partition to the same physical port. When you assign a WWPN pair to a logical partition, the IVM
automatically creates the following connections:
v The IVM creates a virtual fibre channel adapter on the management partition and associates it with the

virtual fibre channel adapter on the logical partition.
v The IVM generates a pair of unique WWPNs and creates a virtual fibre channel adapter on the client

logical partition. The IVM assigns the WWPNs to the virtual fibre channel adapter on the client logical
partition, and associates the virtual fibre channel adapter on the client logical partition with the virtual
fibre channel adapter on the management partition.

When you assign the WWPNs for a logical partition to a physical port, the IVM connects the virtual fibre
channel adapter on the management partition to the physical port on the physical fibre channel adapter.

The IVM generates WWPNs based on the range of names available for use with the prefix in the vital
product data on the managed system. This 6–digit prefix comes with the purchase of the managed system
and includes 32 768 pairs of WWPNs. When you remove the connection between a logical partition and a
physical port, the hypervisor deletes the WWPNs that are assigned to the virtual fibre channel adapter on
the logical partition. The IVM does not reuse the deleted WWPNs when generating WWPNs for virtual
fibre channel adapters in the future. If you run out of WWPNs, you must obtain an activation code that
includes another prefix with 32 768 pairs of WWPNs.

To avoid configuring the physical fibre channel adapter to be a single point of failure for the connection
between the logical partition and its physical storage on the storage area network (SAN), do not assign a
logical partition to one physical fibre channel adapter twice. For example, do not assign a WWPN pair
for a logical partition to a physical port on a physical fibre channel adapter, and then assign another
WWPN pair for the same logical partition to another physical port on the same physical fibre channel
adapter. Instead, assign the WWPN pairs for each logical partition to different physical fibre channel
adapters.
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You can add WWPN pairs for a new logical partition without assigning them to a physical port. Being
able to generate WWPNs independently of a physical port assignment for a logical partition allows you
to communicate these names to the SAN administrator. This ensures that the SAN administrator can
configure the SAN connection appropriately such that the logical partition can connect successfully to the
SAN without regard for which physical port the partition uses for the connection.

You can dynamically add or remove a WWPN pair to and from a logical partition. You can also
dynamically change the physical port that is assigned to a WWPN pair.

Table 10. Dynamic logical partitioning tasks and results

Action Result

Dynamically add a WWPN pair to a logical partition v The IVM creates a virtual fibre channel adapter on the
management partition and associates it with the
virtual fibre channel adapter on the logical partition.

v The IVM generates a pair of unique WWPNs and
creates a virtual fibre channel adapter on the logical
partition. The IVM assigns the WWPNs to the virtual
fibre channel adapter on the logical partition, and
associates the virtual fibre channel adapter on the
logical partition with the virtual fibre channel adapter
on the management partition.

Dynamically assign a WWPN pair to a physical port The IVM connects the virtual fibre channel adapter on
the management partition to the physical port on the
physical fibre channel adapter.

Dynamically remove a WWPN pair from a logical
partition

v The IVM removes the connection between the virtual
fibre channel adapter on the management partition
and the physical port on the physical fibre channel
adapter.

v The IVM removes the virtual fibre channel adapter
from the management partition.

v The IVM removes the virtual fibre channel adapter
from the logical partition. The IVM deletes the
WWPNs and does not reuse them.

Dynamically change the physical port assignment of a
WWPN pair

The IVM changes the connection for the virtual fibre
channel adapter on the management partition to the
newly assigned physical port.

When you change the physical port to a value of None,
the IVM retains the virtual fibre channel adapter on the
management partition, but removes the connection to the
physical port on the physical fibre channel adapter. If
you later reassign a physical port to the WWPN pair, the
IVM reuses the original virtual fibre channel adapter on
the management partition and connects the adapter to
the newly assigned physical port.

The following table lists the Virtual I/O Server commands that you can run to view information about
the fibre channel adapters.
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Table 11. Virtual I/O Server commands that display information about fibre channel adapters

Virtual I/O Server command Information displayed by command

lsmap v Displays the virtual fibre channel adapters on the
Virtual I/O Server that are connected to the physical
fibre channel adapter

v Displays attributes of the virtual fibre channel adapters
on the client logical partitions that are associated with
the virtual fibre channel adapters on the Virtual I/O
Server that are connected to the physical fibre channel
adapter

lsnports Displays information about the physical ports on the
physical fibre channel adapters that support NPIV, such
as:

v The name and location code of the physical port

v The number of available physical ports

v The total number of WWPNs that the physical port
can support

v Whether the switches, to which the physical fibre
channel adapters are cabled, support NPIV

Related information

Managing virtual Fibre Channel on the Integrated Virtualization Manager
Virtual I/O Server and Integrated Virtualization Manager Command Reference Guide

Virtual SCSI adapters:

Virtual SCSI (Small Computer Systems Interface) adapters provide one logical partition with the ability to
use storage I/O (disk, CD, and tape) that is owned by another logical partition.

A virtual SCSI client adapter in one logical partition can communicate with a virtual SCSI server adapter
in another logical partition. The virtual SCSI client adapter allows a logical partition to access a storage
device being made available by the other logical partition. The logical partition owning the hardware is
the server logical partition, and the logical partition that uses the virtualized hardware is the client logical
partition. With this arrangement, the system can have many server logical partitions.

For example, logical partition A provides disk space to logical partitions B, C, and D. A logical partition
can simultaneously use virtual I/O from more than one logical partition. Therefore, using the example,
while logical partition A provides disk space to logical partitions B, C, and D, logical partitions A and B
can use a tape drive connected to logical partition D. In this case, A is serving D for disk space, while D
is serving A for the tape device.

Virtual SCSI allows you to simplify the backup and maintenance operations on your managed system.
When you back up the data on the server logical partition, you also back up the data on each client
logical partition.

Virtual SCSI server adapters can be created only in logical partitions of type IBM i and Virtual I/O
Server.

Disk unit, CD/DVD, and tape on an IBM System i model are based on the SCSI protocol using the ANSI
SCSI Remote DMA (Direct Memory Access) protocol. Therefore, Linux logical partitions can access data
among each other or by an adapter that is directly attached to the memory of other logical partitions.
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The virtual SCSI client device driver is not capable of storage protection using Redundant Arrays of
Independent Disks (RAID). While the Linux operating system allows software RAID protection of virtual
disks, the recommended technique for protecting disk storage is to configure the virtual I/O storage
server to perform the disk protection.

For HMC-managed systems, virtual SCSI adapters are created and assigned to logical partitions using
partition profiles.
Related concepts

“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.

Virtual serial adapters:

Virtual serial adapters provide a point-to-point connection from one logical partition to another, or from
the Hardware Management Console (HMC) to each logical partition on the managed system. Virtual
serial adapters are used primarily to establish terminal or console connections to logical partitions.

When you create a logical partition, the HMC automatically creates two virtual server serial adapters on
the logical partition. These virtual server serial adapters allow you to establish a terminal or console
connection to the logical partition through the HMC.

You can also create pairs of virtual serial adapters on logical partitions so that you can access and control
one logical partition directly from another logical partition. For example, one logical partition uses the
disk resources of another logical partition using virtual SCSI adapters. You can create a server serial
adapter on the logical partition that uses the disk resources and a client serial adapter on the logical
partition that owns the disk resources. This connection allows the logical partition that owns the disk
resources to shut down the logical partition that uses the disk resources before you back up data on the
logical partition that owns the disk resources.

On HMC-managed systems, virtual serial adapters are created and assigned to logical partitions using
partition profiles.
Related concepts

“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.

Host Ethernet Adapter:

A Host Ethernet Adapter (HEA) is a physical Ethernet adapter that is integrated directly into the GX+ bus
on a managed system. HEAs offer high throughput, low latency, and virtualization support for Ethernet
connections. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).

Unlike most other types of I/O devices, you can never assign the HEA itself to a logical partition.
Instead, multiple logical partitions can connect directly to the HEA and use the HEA resources. This
allows these logical partitions to access external networks through the HEA without having to go through
an Ethernet bridge on another logical partition.

To connect a logical partition to an HEA, you must create a logical Host Ethernet Adapter (LHEA) for the
logical partition. A logical Host Ethernet Adapter (LHEA) is a representation of a physical HEA on a logical
partition. An LHEA appears to the operating system as if it were a physical Ethernet adapter, just as a
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virtual Ethernet adapter appears as if it were a physical Ethernet adapter. When you create an LHEA for
a logical partition, you specify the resources that the logical partition can use on the actual physical HEA.
Each logical partition can have one LHEA for each physical HEA on the managed system. Each LHEA
can have one or more logical ports, and each logical port can connect to a physical port on the HEA.

You can create an LHEA for a logical partition using either of the following methods:
v You can add the LHEA to a partition profile, shut down the logical partition, and reactivate the logical

partition using the partition profile with the LHEA.
v You can add the LHEA to a running logical partition using dynamic logical partitioning. (This method

can be used for Linux logical partitions only if you install Red Hat Enterprise Linux version 5.1, Red
Hat Enterprise Linux version 4.6, or a later version of Red Hat Enterprise Linux on the logical
partition.)

When you activate a logical partition, the LHEAs in the partition profile are considered to be required
resources. If the physical HEA resources required by the LHEAs are not available, then the logical
partition cannot be activated. However, when the logical partition is active, you can remove any LHEAs
you want from the logical partition. For every active LHEA that you assign to an IBM i logical partition,
IBM i requires 40 MB of memory.

After you create an LHEA for a logical partition, a network device is created in the logical partition. This
network device is named entX on AIX logical partitions, CMNXX on IBM i logical partitions, and ethX on
Linux logical partitions, where X represents sequentially assigned numbers. The user can then set up
TCP/IP configuration similar to a physical Ethernet device to communicate with other logical partitions.

You can configure a logical partition so that it is the only logical partition that can access a physical port
of an HEA by specifying promiscuous mode for an LHEA that is assigned to the logical partition. When an
LHEA is in promiscuous mode, no other logical partitions can access the logical ports of the physical port
that is associated with the LHEA that is in promiscuous mode. You might want to configure a logical
partition to promiscuous mode in the following situations:
v If you want to connect more than 16 logical partitions to each other and to an external network

through a physical port on an HEA, you can create a logical port on a Virtual I/O Server logical
partition and configure an Ethernet bridge between the logical port and a virtual Ethernet adapter on a
virtual LAN. This allows all logical partitions with virtual Ethernet adapters on the virtual LAN to
communicate with the physical port through the Ethernet bridge. If you configure an Ethernet bridge
between a logical port and a virtual Ethernet adapter, the physical port that is connected to the logical
port must have the following properties:
– The physical port must be configured so that the Virtual I/O Server logical partition is the

promiscuous mode logical partition for the physical port.
– The physical port can have only one logical port.

v You want the logical partition to have dedicated access to a physical port.
v You want to use tools such as tcpdump or iptrace.

A logical port can communicate with all other logical ports that are connected to the same physical port
on the HEA. The physical port and its associated logical ports form a logical Ethernet network. Broadcast
and multicast packets are distributed on this logical network as though it was a physical Ethernet
network. You can connect up to 16 logical ports to a physical port using this logical network. By
extension, you can connect up to 16 logical partitions to each other and to an external network through
this logical network. The actual number of logical ports that you can connect to a physical port depends
upon the Multi-Core Scaling value of the physical port group and the number of logical ports that have
been created for other physical ports within the physical port group. By default, the Multi-Core Scaling
value of each physical port group is set to 4, which allows 4 logical ports to be connected to the physical
ports in the physical port group. To allow up to 16 logical ports to be connected to the physical ports in
the physical port group, you must change the Multi-Core Scaling value of the physical port group to 1
and restart the managed system.
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You can set each logical port to restrict or allow packets that are tagged for specific VLANs. You can set a
logical port to accept packets with any VLAN ID, or you can set a logical port to accept only the VLAN
IDs that you specify. You can specify up to 20 individual VLAN IDs for each logical port.

The physical ports on an HEA are always configured on the managed system level. If you use an HMC
to manage a system, you must use the HMC to configure the physical ports on any HEAs belonging to
the managed system. Also, the physical port configuration applies to all logical partitions that use the
physical port. (Some properties might require setup in the operating system as well. For example, the
maximum packet size for a physical port on the HEA must be set on the managed system level using the
HMC. However, you must also set the maximum packet size for each logical port within the operating
system.) By contrast, if a system is unpartitioned and is not managed by an HMC, you can configure the
physical ports on an HEA within the operating system just as if the physical ports were ports on a
regular physical Ethernet adapter.

HEA hardware does not support half duplex mode.

You can change the properties of a logical port on an LHEA by using dynamic logical partitioning to
remove the logical port from the logical partition and add the logical port back to the logical partition
using the changed properties. If the operating system of the logical partition does not support dynamic
logical partitioning for LHEAs, and you want to change any logical port property other than the VLANs
on which the logical port participates, you must set a partition profile for the logical partition so that the
partition profile contains the desired logical port properties, shut down the logical partition, and activate
the logical partition using the new or changed partition profile. If the operating system of the logical
partition does not support dynamic logical partitioning for LHEAs, and you want to change the VLANs
on which the logical port participates, you must remove the logical port from a partition profile
belonging to the logical partition, shut down and activate the logical partition using the changed partition
profile, add the logical port back to the partition profile using the changed VLAN configuration, and shut
down and activate the logical partition again using the changed partition profile.
Related concepts

“Virtual Ethernet” on page 57
Virtual Ethernet allows logical partitions to communicate with each other without having to assign
physical hardware to the logical partitions.
Related tasks

“Creating a logical Host Ethernet Adapter for a running logical partition” on page 135
If your managed system has a Host Ethernet Adapter (HEA), you can set up a logical partition to use
HEA resources by using the Hardware Management Console (HMC) to create a logical Host Ethernet
Adapter (LHEA) for the logical partition. A logical Host Ethernet Adapter (LHEA) is a representation of a
physical HEA on a logical partition. An LHEA allows the logical partition to connect to external networks
directly through the HEA. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).
“Configuring physical ports on a Host Ethernet Adapter” on page 132
You can use a Hardware Management Console (HMC) to configure the properties of each physical port
on a Host Ethernet Adapter (HEA). These properties include port speed, duplex mode, maximum packet
size, flow control setting, and the promiscuous logical partition for unicast packets. The physical port
properties are also used by the logical ports that are associated with each physical port. HEAs are also
known as Integrated Virtual Ethernet adapters (IVE adapters).
Related information

Shared Ethernet Adapters

Integrated Virtual Ethernet Adapter Technical Overview and Introduction

Tagged resources for IBM i logical partitions:

When you create an IBM i logical partition using the Hardware Management Console (HMC), you must
tag I/O processors (IOPs) or I/O adapters (IOAs) to perform specific functions for the IBM i logical
partition.
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A tagged resource is an IOP or IOA that is selected because it controls a device that performs a specific
function for a logical partition. The HMC and the IBM i operating system use this tagging to locate and
use the correct I/O device for each I/O function. For example, when you create an IBM i partition
profile, you must tag the I/O device that you want the IBM i logical partition to use as its load source.
The tag allows the HMC to locate the load source when you activate the logical partition using the
partition profile.

You can tag either the IOP or the IOA that controls the I/O device that you want to use. Tagging the IOA
allows you to specify the exact I/O device that you want to use. Tagging the IOP allows you to switch
between devices on the IOP using control panel functions.

Some I/O device types are required to create an IBM i logical partition, and other I/O device types are
optional. For example, IBM i always requires a load source from which you load the operating system.
However, the alternate console device is used only if you use a twinaxial console as your primary
console, so if you use another type of console as the primary console for IBM i, you do not need to tag
the alternate console device.

The following table lists and describes the device types that are tagged and indicates whether you must
tag the device type for IBM i logical partitions.

Table 12. Devices associated with tagged IOPs or IOAs

Device Description
Tagging required for IBM i logical
partitions?

Alternate restart device Can be a tape drive or an optical
device. The media in the alternate
restart device is what the system uses
to start from when you perform a
D-mode initial program load (IPL).
The alternate restart device loads the
Licensed Internal Code contained on
the removable media instead of the
code on the load source disk unit.

Yes

Logical partition console The first workstation that the system
activates in the logical partition and
the only device it activates on a
manual IPL. The logical partition
assumes that a console will always be
available for use.

Yes (if you are using a console device
other than the HMC)

Alternate console device The twinaxial console device that the
logical partition will look for if the
primary console fails during a
manual IPL. The alternate console
device is used only when the
primary console is twinaxial.

No

Operations Console direct connect
device

An adapter used to support either a
directly attached Operations Console
or to support an asynchronous
modem. This adapter does not apply
to LAN-attached Operations Console.
You can connect the Operations
Console device to an external line so
that your managed system can send
information to your support provider
if the managed system encounters
problems.

No
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Table 12. Devices associated with tagged IOPs or IOAs (continued)

Device Description
Tagging required for IBM i logical
partitions?

Load source disk unit Each IBM i logical partition must
have one disk unit designated as the
load source. The system uses the load
source to start the logical partition.
The system always identifies this disk
unit as unit number 1.

Yes

If you use the Virtual Partition Manager to create logical partition on your managed system, you do not
need to tag I/O devices for these I/O functions. The IBM i logical partition automatically owns all
physical I/O resources on the managed system, and the Virtual Partition Manager automatically tags the
I/O device to use for each I/O function. The Virtual Partition Manager tags I/O devices for I/O
functions based upon server model and location within the server. If you are partitioning a new server
using the Virtual Partition Manager and have ordered the server with preloaded IBM i, then you do not
need to verify the placement of I/O devices within your new server. Otherwise, use the System Planning
Tool (SPT) to verify the placement of I/O devices within your server before using the Virtual Partition
Manager to create logical partitions on the server.
Related concepts

“I/O device assignment in partition profiles” on page 11
I/O devices are assigned to partition profiles on a slot-by-slot basis. Most I/O devices can be assigned to
a partition profile on the HMC as required or as desired.

Load source placement rules for IBM i logical partitions:

You must properly place a disk unit within a system unit or expansion unit before you use the disk unit
as the load source for an IBM i logical partition. The placement rules depend upon the server unit or
expansion unit in which the load source is located and the I/O adapter (IOA) that controls the load
source.

Note: The information provided does not replace the System Planning Tool (SPT). Use this information as
a resource with the SPT output. Its purpose is to assist you in the load source placement for your IBM i
logical partitions.

The load source disk for an IBM i logical partition must be placed as follows.

Table 13. Load source placement rules

Server or expansion unit IOA Disk slot

520 Imbedded controller P3-D2, P3-D3, P3-D4

SCSI bus port 0 of Optional PCI
storage IOA controlling P2 disk slots

P2-D2, P2-D3, P2-D4

550 Imbedded controller P2-D2, P2-D3, P2-D4

SCSI bus port 0 of Optional PCI
storage IOA controlling P3 disk slots

P3-D2, P3-D3, P3-D4

570 Imbedded controller P3-D1, P3-D2, P3-D3, P3-D4, P3-D5,
P3-D6

5074 or 5079 IOA controlling device board slot 3 D31, D32, D33, D34

IOA controlling device board slot 1 D01, D02

IOA controlling device board slot 2 D06, D07
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Table 13. Load source placement rules (continued)

Server or expansion unit IOA Disk slot

5094 or 5294 SCSI bus port 0 of any storage IOA
to which a load source disk unit is
connected.

D01, D02, D11, D12, D21, D22, D06,
D07, D16, D17, D26, D27, D31, D32,
D33, D34

5095 IOA controlling device board slot 1 D01, D02, D03, D04

IOA controlling device board slot 2 D07, D08, D09, D10

5786 or 5787 SCSI bus port 0 of any storage IOA
to which a load source disk unit is
connected

P1-D1, P1-D2, P1-D3 can contain the
load source only if slot C3 contains a
single SCSI (506E) repeater card that
is connected to port 0 on a SCSI I/O
Adapter (IOA) in the system unit but
is not connected to slot C2.

P1-D7, P1-D8, P1-D9 can contain the
load source only if the SCSI repeater
card in slot C2 is connected to port 0
on a SCSI IOA in the system unit.

P2-D1, P2-D2, P2-D3 can contain the
load source only if slot C4 contains a
single SCSI (506E) repeater card that
is connected to port 0 on a SCSI IOA
in the system unit but is not
connected to slot C5.

P2-D7, P2-D8, P2-D9 can contain the
load source only if the SCSI repeater
card in slot C4 is connected to port 0
on a SCSI IOA in the system unit.

5790 or 5796 SCSI bus port 0 of any storage IOA
to which a load source disk unit in a
5786 or 5787 expansion unit is
connected

P1-D1, P1-D2, P1-D3 can contain the
load source only if slot C3 contains a
single SCSI (506E) repeater card that
is connected to port 0 on a SCSI I/O
Adapter (IOA) in the 5790 expansion
unit but is not connected to slot C2.

P1-D7, P1-D8, P1-D9 can contain the
load source only if the SCSI repeater
card in slot C2 is connected to port 0
on a SCSI IOA in the 5790 expansion
unit.

P2-D1, P2-D2, P2-D3 can contain the
load source only if slot C4 contains a
single SCSI (506E) repeater card that
is connected to port 0 on a SCSI IOA
in the 5790 expansion unit but is not
connected to slot C5.

P2-D7, P2-D8, P2-D9 can contain the
load source only if the SCSI repeater
card in slot C5 is connected to port 0
on a SCSI IOA in the 5790 expansion
unit.

Read the following rules about load source placement for IBM i logical partitions:
v The load-source IOP or IOA must be specified when you create your logical partition.
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v Disk compression must be disabled for the load source disk.
v Disk units must have at least 17 GB of usable capacity for IBM i V5R4M5 or later.
v Disk mirroring is the only method possible to protect serial-attached SCSI (SAS) disk units internal to

570 system units.
v Disk mirroring requires two load source disk devices in valid load-source positions.
v External disk units cannot be used (except for those located in a SAN or in an expansion unit).
v Any disk IOP or IOAs that can attach to a system capable of having logical partitions can be used for

additional storage capacity after the special requirements for the load-source disk are met.
v Each logical partition has its own single-level storage and hence its own ASP configuration. The ASP

configuration rules that apply to systems without logical partitions also apply to logical partitions.
v Disk protection can be defined for a logical partition in the same way as for a nonpartitioned system:

parity protection (RAID), mirroring, or mixed. Bus-level mirroring requires two buses in the logical
partition. IOP-level partitioning requires two disk IOPs in the logical partition.

v Disk units that are already in use by a logical partition cannot be easily added to a different logical
partition. You must first remove them from the configuration of the logical partition that is using the
disk units before you add them to a different logical partition. In doing this, the system automatically
moves any user or system data to other disk units in the same ASP.

v For a 5094 or 5294, you can attach load source disk units to a maximum of six storage IOAs. Also, a
5094 or 5294 can have load source disk units for up to six IBM i logical partitions.

Related concepts

“System Planning Tool” on page 89
The System Planning Tool (SPT) helps you design a managed system that can support a specified set of
workloads.

Alternate restart device placement rules for IBM i logical partitions:

You must properly place an optical or tape media device within a system unit or expansion unit before
you use the device to load the Licensed Internal Code and IBM i to the load source disk unit of an IBM i
logical partition. Also, you can use an optical or tape media device to load the Licensed Internal Code
and IBM i to a logical partition only if the feature code of the optical or tape media device supports
logical partitions.

Note: The information provided does not replace the System Planning Tool (SPT). Use this information as
a resource with the SPT output. Its purpose is to assist you in the alternate restart device placement for
your IBM i logical partitions.

SCSI-to-unit-address conversion

Note: When attaching an external SCSI device as an alternate restart device, it must be at hardware unit
address 5, 6, or 7. The following table shows the translation from SCSI to hardware unit addresses.

Table 14. SCSI-to-unit-address conversion

SCSI address Unit address

2 5

1 6

0 7

Supported internal CD-ROM and DVD-ROM devices

The following table shows the internal CD-ROM and DVD-ROM alternate restart devices that are
supported by logical partitions.
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Table 15. Supported internal CD-ROM and DVD-ROM devices

Internal optical device feature code 570 5074, 5079, 5094, 5294, 5790, and 9194

2640 X

4625 X

4630 X

4631 X

4633 X

5751 X

IBM i hardware requirements allow only certain IOPs to be used as the alternate restart IOP. Some of
these IOPs must be in specific card slots in the expansions units. The IOP, specified during logical
partition setup, must be in one of the following card slots.

Table 16. Supported IOPs and IOAs

PCI IOP PCI IOA 5074, 5079, 5094, 5294, 5790, and 9194

2843 and 2844

PCI WAN/LAN Workstation/Storage
IOP

2749 Any IOA slot

2757 Any IOA slot

2768 Any IOA slot

2780 Any IOA slot

4748 Any IOA slot

4778 Any IOA slot

5702 Any IOA slot

5703 Any IOA slot

571A Any IOA slot

571B Any IOA slot

571E Any IOA slot

IOPless 571A Any IOA slot

571B Any IOA slot

571E Any IOA slot

Placement for an internal alternate restart device

The alternate restart device is in the same expansion unit as its controlling IOP or IOA. It must be placed
as follows.

Table 17. Placement for an alternate restart device in an expansion unit

Expansion unit Removable media slot

5074, 5079, 5094, 5294, 5790, and 9194 D41 or D42

The alternate restart device for an IBM i logical partition in the system unit must be placed as follows:

Table 18. Placement for an alternate restart device in a system unit

Server IOA Removable media slot

550 Imbedded controller P4-D1 or P4-D2

570 Imbedded controller P4-D1
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Internal removable media devices are:
v Quarter-inch cartridge (QIC) 1/4-inch tape
v 8 mm tape
v LTO tape
v VXA tape
v 4mm tape
v CD-ROM or DVD

IBM i logical partitions have a few more rules for alternate restart devices:
v The alternate restart device must be connected to SCSI bus 0.
v The alternate restart IOP or IOA is specified during logical partition setup.
v IOAs 2757, 2780, 2782, 5702, and 5703 also support disk devices. These IOAs should not be used to

attach removable media that will be switched between logical partitions if disk devices are also
attached.

Related concepts

“System Planning Tool” on page 89
The System Planning Tool (SPT) helps you design a managed system that can support a specified set of
workloads.

I/O pools for IBM i logical partitions:

An I/O pool is a group of I/O adapters that form an independent auxiliary storage pool (ASP). Other
names for independent ASPs include I/O failover pool and switchable independent disk pool.

The independent ASP can be switched from a failed server to a backup server within the same cluster
without the active intervention of the Hardware Management Console (HMC). The I/O adapters within
the independent ASP can be used by only one logical partition at a time, but any of the other logical
partitions in the group can take over and use the I/O adapters within the independent ASP. The current
owning logical partition must power off the adapters before another logical partition can take ownership.

Independent ASPs are not suitable for sharing I/O devices between different logical partitions. If you
want to share an I/O device between different logical partitions, use the HMC to move the I/O device
dynamically between the logical partitions.

Switchable devices for IBM i logical partitions:

When you set up an I/O processor (IOP) so that it can be switched from one logical partition to another,
you can share the devices that are associated with that IOP among many IBM i logical partitions.

When you switch an IOP or an I/O adapter (IOA), you take the control of the devices away from one
logical partition and give it to another without restarting the server or the logical partition. Before
switching the IOP or the IOA to another logical partition, you must ensure that the device is not in use.

IOPs or IOAs that are good candidates for switching between logical partitions include IOPs or IOAs that
are attached to high-cost devices or low-use or low-demand devices.

Attention: When switching IOPs that control disk units, ensure that all disk units that belong to that
specific IOP are first removed from the auxiliary storage pool and are in a nonconfigured status.

High-speed link (HSL) OptiConnect for IBM i logical partitions:

The high-speed link (HSL) OptiConnect feature provides high-speed system-to-system communication
between managed systems.
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The HSL OptiConnect feature can be used only for communications between IBM i logical partitions on
IBM System i models. If you must enable communications with an System p® model, use an Ethernet
connection instead of the HSL OptiConnect feature.

To use the HSL OptiConnect feature on a logical partition, you must install OptiConnect for IBM i (a
priced optional feature) on each IBM i logical partition that is to use HSL OptiConnect. If you use the
Hardware Management Console (HMC) to create partition on your managed system, you must also check
the logical partition profile properties for each IBM i logical partition that is to use HSL OptiConnect and
ensure that the Use High Speed Link (HSL) OptiConnect option is selected on the OptiConnect tab.

You can use both the HSL OptiConnect feature and the virtual OptiConnect feature on the same IBM i
logical partition. If multiple paths are available between IBM i logical partitions, the OptiConnect
software automatically selects the virtual OptiConnect path instead of the HSL OptiConnect external
path.

The HSL OptiConnect feature requires only standard HSL cables to connect the systems to one another.
No additional hardware is required.
Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.
Related information

OptiConnect

Virtual OptiConnect for IBM i logical partitions:

The virtual OptiConnect feature provides high-speed interpartition communication within a managed
system. The Virtual OptiConnect feature emulates external OptiConnect hardware by providing a virtual
bus between logical partitions.

The virtual OptiConnect feature can be used only for communications between IBM i logical partitions on
IBM System i models. If you must enable communications with AIX or Linux logical partitions, use
virtual Ethernet instead of the virtual OptiConnect feature.

To use the virtual OptiConnect feature on a logical partition, you must install OptiConnect for IBM i (a
priced optional feature) on each IBM i logical partition that is to use virtual OptiConnect. If you use the
Hardware Management Console (HMC) to create logical partitions on your managed system, you must
also check the partition profile properties for each IBM i logical partition that is to use virtual
OptiConnect and ensure that the Use virtual OptiConnect option is selected on the OptiConnect tab.

You can use both the virtual OptiConnect feature and the High-Speed Link (HSL) OptiConnect feature on
the same IBM i logical partition. If multiple paths are available between IBM i logical partitions, the
OptiConnect software automatically selects the virtual OptiConnect path instead of the HSL OptiConnect
external path.

You can use the virtual OptiConnect feature without any additional hardware requirements.
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Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.
Related information

OptiConnect

Expansion unit:

You can add expansion units to many of the models to support additional features and devices. If you
want to create logical partitions on your server, you might need to add an expansion unit that contains
the additional hardware that you need for each logical partition.

Some expansion units can support only disk units (storage expansion unit), while others can support a
variety of hardware (system expansion unit). Expansion units generally contain one or more system I/O
buses with various I/O devices.

If you assign more than 144 I/O slots to an AIX or Linux logical partition, ensure that the boot device for
the logical partition is within the first 144 slots that are assigned to the logical partition. You can view the
devices that are assigned to the first 144 slots of a logical partition by viewing the partition properties of
the logical partition. Select the Hardware tab, then select the I/O tab, and then click the Bus column of
the table to sort the devices in ascending order.

5250 CPW for IBM i logical partitions
5250 commercial processing workload (5250 CPW) is the capacity to perform 5250 online transaction
processing (5250 OLTP) tasks on IBM i logical partitions.

A 5250 OLTP task is a task that uses the 5250 data stream. Examples of 5250 OLTP tasks include the
following:
v Any form of 5250 emulation, including Hardware Management Console (HMC) 5250, RUMBA/400, PC

Support/400 workstation function, and Binary Synchronous Communication (BSC) 3270 emulation
v 5250 Telnet or 5250 Display Station Pass-Through (DSPT) workstations
v 5250/HTML workstation gateway
v Screen scrapers
v Interactive system monitors
v Printer jobs that pass through twinaxial media, regardless of whether the printer is working in

dedicated mode or is printing spool files from an output queue

You can use the IBM WebFacing Tool to convert your 5250 OLTP applications into web-based applications
that no longer need to use the 5250 data stream.

Barrier-synchronization register
The barrier-synchronization register (BSR) is a memory register that is located on certain POWER
technology-based processors. You can write a parallel-processing application running on AIX so that the
application uses a BSR to perform barrier synchronization, which is a method for synchronizing the
threads in the parallel-processing application. If you use the Hardware Management Console (HMC) to
create logical partitions, you can divide BSRs into arrays and assign BSR arrays to partition profiles.

Each BSR array is 8 bytes long. The number of BSR arrays that are available on a managed system
depends on the type of processors used on the server model. You can see the number of BSR arrays that
are available on a managed system by viewing managed system properties on the HMC.
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Using an HMC, you can assign a whole number of BSR arrays to one or more partition profiles. When
you activate a logical partition using a partition profile that specifies a number of BSR arrays, the
managed system assigns the BSR arrays to the logical partition if the specified number of BSR arrays are
available. If the number of BSR arrays specified in the partition profile are not available, you cannot
activate the logical partition using that partition profile.

The Integrated Virtualization Manager does not allow you to assign BSR arrays to logical partitions.

The HMC allows you to assign BSR arrays to any logical partition. However, AIX is the only operating
system that currently supports the use of BSRs and BSR arrays. Also, you might not realize a
performance advantage if you use barrier synchronization on a logical partition that uses shared
processors.

You cannot add BSR arrays to or remove BSR arrays from logical partitions using dynamic logical
partitioning. To add or remove BSR arrays, you must change the partition profile or create a new
partition profile with the revised number of BSR arrays, shut down the logical partition, and restart the
logical partition using the partition profile with the new number of BSR arrays.

To take advantage of barrier synchronization, a parallel-processing application must be written
specifically to access and write to the BSR or a BSR array.
Related information

bsr_alloc Kernel Service

bsr_free Kernel Service

bsr_query Kernel Service

Application support for Linux logical partitions
Learn how to integrate Linux with IBM i applications and data.

Samba support with IBM i NetServer™

Server Message Block (SMB) is a file-sharing protocol that is commonly used by Windows PCs. Whenever
a network drive is mapped from a Windows PC to another Windows PC, the SMB TCP/IP protocol is
being used.

Samba implements the SMB/CIFS standard on UNIX® operating systems. This protocol enables file
sharing among SMB-enabled operating systems, including IBM i with NetServer.

Samba allows Linux PCs and servers to interact with existing Windows PCs and file servers without
requiring any additional software. IBM i NetServer supports Linux Samba clients.

You can use a Samba server to run printers and authenticate users, share files, and directories, just like
Microsoft® Windows. Samba can also act as a Primary Domain Controller (PDC) or as a Backup Domain
Controller (BDC) in your Windows network. You can use it to run OpenLDAP and add LDAP function to
your Windows Network without the expense. You can use Samba and NetServer to share printers and
files on IBM Systems or eServer™ Linux partitions.

Accessing IBM i data using Linux ODBC driver

The IBM System i Open Database Connectivity (ODBC) Driver for Linux allows you to access the IBM
System i database data from Linux applications written to the ODBC API. It is based on the ODBC driver
in the System i Access Express™ for Windows product.
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Related information

System i Access for Linux Open Database Connectivity

Examples: Logically partitioned systems
You can use the logical partitioning examples to consolidate servers, use computing resources more
efficiently, and increase the flexibility of your enterprise.

Creating multiple client environments

You provide high-availability e-commerce services to a number of clients. You provide computing
resources, applications, and technical support to each client, and each client can independently configure
and use the applications running on the computing resources that you provide. In such an environment,
it is essential to isolate the clients so that the clients have access only to their resources. However,
dedicating a physical server to each client is cost prohibitive, and does not allow you to easily increase or
decrease the amount of computing resources used by each client.

You therefore decide to create a logical partition for each client. You install an operating system and
applications on each logical partition. You can then use dynamic logical partitioning to add resources to
logical partitions or remove resources from logical partitions as needed. If a client stops using your
service, you can delete the logical partition for that client and reassign the resources to other logical
partitions.

Testing new applications

You are a furniture manufacturer that uses an application to track inventory at your plant. A new version
of the application is now available. You want to test this new version before using it on your production
server, but you do not have any money to buy separate test hardware.

You therefore decide to create a separate test environment on your managed system. You remove
resources from the existing production environment, and you create a new logical partition that contains
the resources that you removed from the production environment. You install an operating system and
the new version of the inventory application on the logical partition. You can then use dynamic logical
partitioning to move resources from the test logical partition to the production logical partition during
peak production demand, and then return the resources to the test logical partition during testing. When
you have finished testing, you can delete the test logical partition, add the resources back to the
production logical partition, and install the new version of the inventory application on the production
system.

Integrating new acquisitions

You have just acquired a new company. Your new acquisition does not use the same applications for
payroll, inventory, and billing that you do. You plan to consolidate your two companies onto a single set
of applications, but it will take time to implement this consolidation. In the meantime, you are under
pressure to reduce data center costs quickly.

You therefore decide to create logical partitions for the applications used by your new acquisition. You
install an operating system and the applications used by the new company on the logical partition. If the
combined workloads require more resources, you can use Capacity Upgrade on Demand (CUoD) to add
processors and memory to the managed system, and then use dynamic logical partitioning to add these
resources to the logical partitions. This solution allows you to save hardware costs immediately while you
determine the best way to consolidate onto a single set of applications.
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Scenarios: Logical partitions
One of the best ways to learn about logical partitions is to see examples illustrating how many of the
applications and functions can be used in a sample business environment. Use these scenarios to learn
how you can use logical partitions in your business.

Scenario: Creating a logical partition using the HMC
You can create a logical partition that acts as a virtual server on your managed system using the HMC.
When you create the logical partition, you specify the resources that the logical partition uses in a
partition profile.

Situation

As the system administrator of a medium-sized technology company, you are responsible for configuring
and managing the server that your company just purchased. Your server has arrived and you are ready
to start partitioning your model.

Objectives

The objective of this scenario is to create a logical partition and partition profile on a new server.

Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed and are operational
prior to beginning the configuration steps:
1. The Hardware Management Console (HMC) was set up and configured. For instructions, see

Installing and configuring the HMC.
2. You read and understand the “Logical partition overview” on page 3.
3. You completed the tasks recommended for logical partition planning. For instructions, see “Planning

for logical partitions” on page 87.
4. You removed the system from the manufacturing default configuration and moved the physical

hardware to support a partitioned configuration. For instructions, see “Creating logical partitions on a
new or nonpartitioned server” on page 102.

5. You logged into the HMC with one of the following user roles:
v Super administrator
v Operator

Configuration steps

Ensure that all the prerequisites for this scenario have been completed prior to completing these tasks.

To create a new logical partition on your server using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and choose Configuration →

Create Logical Partitions.
3. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition

profile.
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Related concepts

“System Planning Tool” on page 89
The System Planning Tool (SPT) helps you design a managed system that can support a specified set of
workloads.

Scenario: Using partition profiles with the HMC
With partition profiles, you can change the hardware configuration of a logical partition.

Situation

You are the system administrator for a business recovery service center. You use your server primarily to
test disaster-recovery strategies for your clients. Each of your clients has a different system configuration.
This means that, each time a client comes into the office, you must change the system configuration of
your managed system.

On each logical partition on your server, you create one profile for each client that uses the logical
partition. When a client returns to the business recovery service center, you can reconfigure the managed
system for that client simply by activating the partition profiles for that client.

You have just finished testing for Client 1. You must now reconfigure the server for Client 2, who comes
into the office tomorrow.

Note: This is one example of how to change your system configuration. Depending on your operating
system, business needs, and resource allocation, you could resolve this situation by dynamically moving
resources.

Objectives

The objective of this scenario is to change the configuration of your managed system by using partition
profiles.

Details

Your managed system has three logical partitions. The managed system has eight processors and 12 GB
of memory. Each logical partition has one or two partition profiles. The following table illustrates how the
logical partitions and partition profiles are set up.

Logical partition ID Name of logical
partition

Name of partition
profile

Processor resources Memory resources

Partition 1 Test 1 Profile 1: Client 1 5 dedicated
processors

8 GB dedicated
memory

Profile 2: Client 2 7 dedicated
processors

10 GB dedicated
memory

Partition 2 Test 2 Profile 1: Client 1 2 dedicated
processors

3 GB dedicated
memory

Profile 2: Client 2 1 dedicated processor 2 GB dedicated
memory

Partition 3 Test 3 Profile 1: Client 1 1 dedicated processor 1 GB dedicated
memory
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Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed prior to beginning the
configuration steps:
1. The Hardware Management Console (HMC) was set up and configured. For instructions, see

Installing and configuring the HMC.
2. You read and understand the “Logical partition overview” on page 3.
3. You completed the tasks recommended for logical partition planning. For instructions, see “Planning

for logical partitions” on page 87.
4. You moved and assigned the physical hardware according to the “System Planning Tool” on page 89

(SPT) output.
5. You logged in to the HMC with one of the following user roles:

v Super administrator
v Service representative
v Product engineer

6. You created the logical partitions and partition profiles. For instructions, see “Creating additional
logical partitions” on page 112.

7. You activated the partition profiles for Client 1. For instructions, see “Activating a logical partition”
on page 148.

The following table lists the partition profiles that are currently active for each logical partition on the
managed system.

Logical partition ID Name of logical
partition

Name of partition
profile

Processor resources Memory resources

Partition 1 Test 1 Profile 1: Client 1 5 dedicated
processors

8 GB dedicated
memory

Partition 2 Test 2 Profile 1: Client 1 2 dedicated
processors

3 GB dedicated
memory

Partition 3 Test 3 Profile 1: Client 1 1 dedicated processor 1 GB dedicated
memory

Configuration steps

To change the configuration of your managed system so that it is ready for Client 2, you must first shut
down the logical partitions by using usual operating system procedures.

After shutting down the logical partitions, you can activate the partition profiles for Client 2. To do this,
complete the following steps on your HMC:
1. In the navigation pane, open Systems Management → Servers, and click the system on which the Test

1 logical partition is located.
2. In the work pane, select the Test 1 logical partition, click the Tasks button, and click Operations →

Activate.
3. Select the Profile 2 partition profile and click OK.
4. In the work pane, select the Test 2 logical partition, click the Tasks button, and click Operations →

Activate.
5. Select the Profile 2 partition profile and click OK.

After activating the partition profile, the managed system is configured according to the needs of Client
2. The following table lists the partition profiles that are currently active for each logical partition on the
managed system.
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Logical partition ID Name of logical
partition

Name of partition
profile

Processor resources Memory resources

Partition 1 Test 1 Profile 2: Client 2 7 dedicated
processors

10 GB dedicated
memory

Partition 2 Test 2 Profile 2: Client 2 1 dedicated processor 2 GB dedicated
memory

Scenario: Using system profiles with the HMC
With system profiles, you can change the hardware configuration of an entire managed system quickly
and easily.

Situation

You are the system administrator for a business recovery service center. You use your server primarily to
test disaster-recovery strategies for your clients. Each of your clients has a different system configuration.
This means that, each time a client comes in, you must change the system configuration of your managed
system.

You decide to create and use system profiles to change the system configuration of your managed system.
First, on each logical partition on your server, you create a partition profile for each client that uses the
logical partition. Then, you create a system profile for each client. Each system profile contains the
partition profiles that you want to activate for the client. When a client returns to the business recovery
service center, you can reconfigure the managed system for that client simply by activating the system
profile for that client.

You have just finished testing for Client 1. You must now reconfigure the managed system for Client 2,
who comes in tomorrow.

Note: This is one example of how to change your system configuration. Depending on your operating
system, business needs, and resource allocation, you could resolve this situation by dynamically moving
resources.

Objectives

The objective of this scenario is to change the configuration of your managed system by using system
profiles.

Details

Your managed system has eight processors and 12 GB of memory. You have created two system profiles
on this managed system. Each system profile divides the resources of the managed system between two
or three logical partitions.

The following table shows how the system profiles are set up:

System Profile Logical partition
ID

Name of logical
partition

Name of
partition profile

Processor
resources

Memory
resources

Client 1 Partition 1 Test 1 Profile 1: Client 1 5 dedicated
processors

8 GB dedicated
memory

Partition 2 Test 2 Profile 1: Client 1 2 dedicated
processors

3 GB dedicated
memory

Partition 3 Test 3 Profile 1: Client 1 1 dedicated
processor

1 GB dedicated
memory
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System Profile Logical partition
ID

Name of logical
partition

Name of
partition profile

Processor
resources

Memory
resources

Client 2 Partition 1 Test 1 Profile 2: Client 2 7 dedicated
processors

10 GB dedicated
memory

Partition 2 Test 2 Profile 2: Client 2 1 dedicated
processor

2 GB dedicated
memory

Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed prior to beginning the
configuration steps:
1. The Hardware Management Console (HMC) was set up and configured. For instructions, see

Installing and configuring the HMC.
2. You understand the “Logical partition overview” on page 3.
3. You completed the tasks recommended for logical partition planning. For instructions, see “Planning

for logical partitions” on page 87.
4. You moved and assigned the physical hardware according to the “System Planning Tool” on page 89

(SPT) output.
5. You logged in to the HMC with one of the following user roles:

v Super administrator
v Service representative
v Product engineer

6. You created the logical partitions, partition profiles, and system profiles described. For instructions,
see “Creating additional logical partitions” on page 112 and “Creating a system profile” on page 114.

7. You activated the system profile for Client 1. For instructions, see “Activating a logical partition” on
page 148.

The following table lists the system profile that is currently active on the managed system.

System profile Logical partition
ID

Name of logical
partition

Name of
partition profile

Processor
resources

Memory
resources

Client 1 Partition 1 Test 1 Profile 1: Client 1 5 dedicated
processors

8 GB dedicated
memory

Partition 2 Test 2 Profile 1: Client 1 2 dedicated
processors

3 GB dedicated
memory

Partition 3 Test 3 Profile 1: Client 1 1 dedicated
processor

1 GB dedicated
memory

Configuration steps

To change the configuration of your managed system so that it is ready for Client 2, you must first shut
down the logical partitions by using usual operating system procedures.

After shutting down the logical partitions, you can activate the system profile for Client 2. To do this,
complete the following steps on your HMC:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and click Configuration →

Manage System Profiles.
3. Select the Client 2 system profile and click Activate.
4. Select the desired activation settings for the system profile and click Continue.
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After activating the system profile, the managed system is configured according to the needs of Client 2.
The following table lists the system profile that is currently active on the managed system.

System profile Logical partition
ID

Name logical
partition

Name of
partition profile

Processor
resources

Memory
resources

Client 2 Partition 1 Test 1 Profile 2: Client 2 7 dedicated
processors

10 GB dedicated
memory

Partition 2 Test 2 Profile 2: Client 2 1 dedicated
processor

2 GB dedicated
memory

Scenario: Dynamically moving processors and memory resources
using the HMC
When you dynamically move processor and memory resources between logical partitions, you can
maximize resource utilization on your managed system by moving resources to wherever the resources
are needed.

Situation

You are the system administrator for a business recovery service center with IBM Systems hardware. You
use IBM Systems hardware primarily to test disaster recovery strategies for your clients. Each of your
clients has a different system configuration. This means that, each time a client comes in, you must
change the system configuration of your managed system.

To change the system configuration of your managed system, you decide to use dynamic logical
partitioning. Whenever you need to move resources from one logical partition to another, you move the
resources directly between the logical partitions without shutting down the logical partitions.

You finished testing for Client 1. You must now reconfigure the logical partitions for Client 2, who comes
in tomorrow.

Note: This is one example of how to change your system configuration. Depending on your operating
system, business needs, and resource allocation, you could resolve this situation using partition profiles
or system profiles.

Objectives

The objective of this scenario is to change the configuration of the logical partitions by dynamically
moving resources.

Details

Your managed system has two logical partitions. It has eight processors and 12 GB of memory. The
following table shows the system configuration required for client 1.

Client Logical partition ID Name of logical
partition

Processor resources Memory resources

Client 1 Partition 1 Test 1 5 dedicated
processors

8 GB dedicated
memory

Partition 2 Test 2 3 dedicated
processors

4 GB dedicated
memory

The following table shows the system configuration required for client 2.
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Client Logical partition ID Name of logical
partition

Processor resources Memory resources

Client 2 Partition 1 Test 1 7 dedicated
processors

10 GB dedicated
memory

Partition 2 Test 2 1 dedicated processor 2 GB dedicated
memory

Prerequisites and assumptions

This scenario assumes that the following prerequisite steps have been completed and are operational
prior to beginning the configuration steps:
1. The Hardware Management Console (HMC) was set and configured. For instructions, see Installing

and configuring the HMC.
2. You read and understand the “Logical partition overview” on page 3.
3. You completed the tasks recommended for logical partition planning. For instructions, see “Planning

for logical partitions” on page 87.
4. You removed the system from the manufacturing default configuration and moved the physical

hardware to support a partitioned configuration. For instructions, see “Creating logical partitions on a
new or nonpartitioned server” on page 102.

5. You logged in to the HMC with one of the following user roles:
v Super administrator
v Service representative
v Product engineer

6. You created the logical partitions and partition profiles.
7. The managed system is configured for Client 1.

The following table displays the current configuration of each logical partition on the managed system.

Logical partition ID Name of logical
partition

Name of partition
profile

Processor resources Memory resources

Partition 1 Test 1 Profile 1 5 dedicated
processors

8 GB dedicated
memory

Partition 2 Test 2 Profile 1 3 dedicated
processors

4 GB dedicated
memory

Configuration steps

To change the configuration of your managed system so that it is ready for Client 2, you must complete
the following:
v Move two dedicated processors from the logical partition Test 2 to the logical partition Test 1.
v Move 2 GB of physical memory from the logical partition Test 2 to the logical partition Test 1.

To move two dedicated processors from one logical partition to another, complete the following steps on
your HMC.
1. In the navigation pane of the HMC, open Systems Management, open Servers, and click the

managed system on which the Test 2 logical partition is located.
2. In the work pane, select the Test 2 logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Processor → Move.
3. Specify two processors in the To move column, select the Test 1 logical partition in Select Destination

Partition, and click OK.
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To move two physical memory units from one logical partition to another, complete the following steps
on your HMC:
1. In the work pane, select the Test 2 logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Memory → Move.
2. Enter the amount of physical memory that you want to move from the logical partition. You can enter

the size in a combination of gigabytes (GB) plus megabytes (MB).
3. Select the logical partition to which you want to move the specified amount of physical memory and

click OK.

When this is completed, the managed system is configured according to the needs of Client 2. The
following table displays the current configuration of each logical partition on the managed system.

Logical partition ID Name of logical
partition

Name of partition
profile

Processor resources Memory resources

Partition 1 Test 1 Profile 1 7 dedicated
processors

10 GB dedicated
memory

Partition 2 Test 2 Profile 1 1 dedicated processor 2 GB dedicated
memory

Related concepts

“System Planning Tool” on page 89
The System Planning Tool (SPT) helps you design a managed system that can support a specified set of
workloads.

Scenario: Capacity on Demand for Linux
Learn the steps of planning, ordering, and using Capacity on Demand for Linux logical partitions on IBM
Systems hardware.

Note: Capacity on Demand is not available on all hardware models.

Capacity on Demand allows customers to activate inactive processors as their workload requires. The
following scenario walks through the steps of planning for, ordering, and using this feature.

Situation

A server is operating with eight active processors and four inactive processors. As the server workload
grows, the available processor resource utilization consistently approaches or exceeds 70% of the available
capacity. Anticipating the need for additional resources, the system administrator decides to consider
activating some of the inactive processors.

Objectives

The objectives of this scenario are as follows:
v To test the effectiveness of increasing the number of available processors
v To increase the number of processors (if that change will improve performance)

Capacity on Demand preparation and activation

The system administrator completes the following steps to prepare and configure the server for Capacity
on Demand:
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1. Before activating any processors, the system administrator prepares the server for Capacity on
Demand. This task involves performing a trend analysis to learn how many additional processors will
be required, preparing the server to activate additional processors, and preparing to order the new
capacity.

2. To investigate the benefits of activating the additional processors, the system administrator decides to
activate the processors for a trial period. The trial period lasts 14 days.

3. After deciding that the performance improvement gained by activating the additional processors
warrants purchasing the processors permanently, the system administrator contacts the IBM
marketing representative or IBM Business Partner, or visits http://www.ibm.com to place an order for
four processor activation features.

4. The IBM marketing representative places the order in the IBM configurator and receives a reminder to
send the vital product data (VPD) from the server with the order. The VPD can be faxed to IBM or
sent electronically with the Electronic Service Agent™ product. (The Electronic Service Agent product
is located on your HMC and is designed to monitor events and to transmit server inventory
information to IBM on a periodic, customer-definable timetable.)

5. The system administrator retrieves the activation codes from the Web and activates the permanent
capacity. This task involves entering the activation code on the target server and assigning the
processors to a logical partition.

The server now has all eight processors available for use.
Related information

Capacity on Demand

Planning for logical partitions
You can create logical partitions to distribute resources within a single server and make it function as if it
were two or more independent servers. Before creating logical partitions, you must assess your current
and future needs. You can then use this information to determine the hardware configuration that will
meet your current needs and serve as a base for meeting your future needs.

Planning for logical partitions is a multistep process. Here are the recommended tasks for planning for
logical partitions.
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__ Assess your needs

Compile a list of the questions that you must answer before you create logical partition on an existing system or
place your order for new hardware. These questions can include the following:

v What are your existing workloads? How many resources do these workloads currently require (during typical
usage and at peak usage)?

v What are your future needs? How will your existing workloads grow over the life of your system? How
many new workloads will you need to support over the life of your system?

v Do you have an existing system onto which you can consolidate the workloads? Must you upgrade the
existing system before you consolidate the workloads? Does it make more sense to purchase a new system for
these workloads?

v What sort of physical infrastructure will you need to support any new hardware? Can your current location
accommodate the new hardware? Must you upgrade your power infrastructure or your cooling
infrastructure?

v Will your new hardware work with your existing hardware?

v Which hardware features will you use? For example, do you want to use virtual I/O to consolidate I/O
resources? Must you obtain activation codes or enablement codes to use these features?

v Must you obtain additional licenses to run your applications? If so, how many additional licenses do you
need?

v Does the support strategy for you new hardware differ from the support strategy for your existing hardware?
If so, what changes must you make to maximize the effectiveness of the new support strategy?

v Must you migrate your workloads onto new hardware? If so, what must you do to migrate these workloads?
__ Learn about your system and its features

Your system has many features that allow you to use system resources more efficiently and simplify daily tasks.
For more information on what these features are and how these features work, see “Logical partition overview”
on page 3.

__ Learn about planning tools

IBM provides many tools that you can use to assess your needs, determine the hardware that you need to
accommodate existing and future needs, and compile an order for the hardware that you need. These tools
include:

IBM Prerequisite web site
The IBM Prerequisite web site provides you with compatibility information for hardware features. This
site helps you plan a successful system upgrade by providing you with the prerequisite information for
features that you currently have or plan to add to your system.

IBM Systems Workload Estimator
The IBM Systems Workload Estimator (WLE) estimates the computer resources that are required for
Domino®, WebSphere® Commerce, WebSphere, Web Serving and traditional workloads. The WLE
projects the most current server models that meet the capacity requirements that are within the CPU
percent utilization objectives.

IBM System Planning Tool
The IBM System Planning Tool (SPT) emulates a logical partition configuration and validates that the
planned logical partitions are valid. In addition, the SPT allows you to test the placement of AIX, IBM i
and Linux hardware within the system to ensure that the placement is valid.

AIX Performance Toolbox for POWER
The AIX Performance Toolbox (PTX®) for POWER is a licensed program product that provides a
comprehensive tool for monitoring and tuning system performance in distributed environments.

__ Take inventory of your current environment

Monitor resource usage on your existing servers to determine the amounts of resources that you currently use in
your operation. You will use this information as a basis for determining the resources that you will require on
the consolidated system. The Performance Monitor (PM) information that you gather from your existing systems
gives you the information that you need to analyze existing workloads.
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__ Perform capacity planning

Analyze the workloads that are to be consolidated onto your managed system and determine the amounts of
resources that these workloads require. You will also want to calculate the resources that you will need for
future growth and determine whether your hardware can accommodate this growth. To analyze your current
workloads, use your PM information as input for the WLE. The WLE uses this input to determine the resources
that you will need for the consolidated workloads. The WLE also allows you to project how many resources you
will need in the future.

__ Decide which tool you want to use to create logical partitions and manage the system

Determine whether you want to use the Hardware Management Console (HMC), the Integrated Virtualization
Manager, or the Virtual Partition Manager to create logical partitions and manage the system. To learn about
these tools, see “Logical partitioning tools” on page 7.

__ Decide if you want your operating systems to share I/O resources with each other

Determine whether you want to set your logical partitions to use virtual I/O resources from a Virtual I/O
Server logical partition. For more information, see Virtual I/O Server.

__ Design and validate your logical partition configuration

Design the logical partitions that you will create on the managed system, and assign resources to each logical
partition so that the logical partitions can perform their assigned tasks efficiently. The SPT and the WLE allow
you to design a system with logical partitions and develop a system plan. You can use this system plan to
automate the task of creating logical partitions on your system.

__ Design network infrastructure to connect logical partitions with each other and with external networks

Determine what types of physical and virtual adapters you want to use to connect logical partitions to each
other and to external networks. For information about the different methods that you can use to connect logical
partitions with each other and with external networks, see “I/O devices” on page 55.

__ Identify how the managed system communicates with the HMC

Determine how you want to connect your managed system and its logical partitions with the HMC that
manages the system. For more information on the ways in which you can connect your managed system with
the HMC, see HMC network connections.

__ Determine a service and support strategy

Determine how to apply fixes to your server and identify problems that need to be reported to your service
provider. The HMC can be configured to report most problems to your service provider automatically. For more
information on how to set up the HMC to report problems, see Configuring the HMC so that it can contact
service and support.

__ Plan for software licensing in a partitioned environment

Determine how many software licenses you need for your logical partition configuration. For instructions, see
“Software licensing for IBM licensed programs on logical partitions” on page 97.

System Planning Tool
The System Planning Tool (SPT) helps you design a managed system that can support a specified set of
workloads.

You can design a managed system based on workload data from your current systems, based on new
workloads that you want the managed system to support, based on sample systems that are provided
with the utility, or based on your own custom specifications. The SPT helps you design a system to fit
your needs, whether you want to design a logically partitioned system or want to design an
unpartitioned system. SPT incorporates the function from Workload Estimator to help you create an
overall system plan. The SPT opens the Workload Estimator to help you gather and integrate workload
data, and provides advanced users with the option of creating a system plan without the help of
additional tools.

Note: The SPT currently does not help you plan for high availability on logical partitions or Redundant
Array of Independent Disks (RAID) solutions.

Logical partitioning 89



There are a number of options available to help you get started with using the SPT:
v You can use the sample system plans that the SPTprovides as a starting point for planning your

system.
v You can create a system plan based on existing performance data.
v You can create a system plan based on new or anticipated workloads.
v You can create a system plan by using either the Hardware Management Console (HMC) or the

Integrated Virtualization Manager (IVM) . You can then use the SPT to convert the system plan to SPT
format, and modify the system plan for use in system ordering or system deployment.

v With SPT version 3.0, and later, you can copy logical partitions from a system in one system plan to
either another system in the same system plan or to a different system in another system plan. For
example, you can build up system plans that contain your own sample logical partitions, and then
copy one or more of these sample logical partitions into a new system plan that you are creating. You
also can copy a logical partition within the same system plan. For example, you can define the
attributes of a partition within a system plan and then make 7 copies of that partition within the same
plan.

v You can export a system plan as a .cfr file and import it into the marketing configurator (eConfig) tool
to use for ordering a system. When you import the .cfr file into the eConfig tool, the tool populates
your order with the information from the .cfr file. However, the .cfr file does not contain all the
information that the eConfig tool requires. You will need to enter all required information before you
can submit your order.

If you make any changes to the hardware assignments or placement in the system, the SPT validates the
changes to ensure that the resulting system fulfills the minimum hardware requirements and hardware
placement requirements for the logical partitions.

When you are done making changes to the system, you can save your work as a system plan. You can
import this file into your Hardware Management Console (HMC) or the management partition for the
Integrated Virtualization Manager (IVM). You then can deploy the system plan to a managed system that
the HMC or the IVM manages.. When you deploy the system plan, the HMC or the IVM creates the
logical partitions from the system plan on the managed system that is the target of the deployment.

To download the SPT, see the IBM System Planning Tool Web site.
Related information

System plan overview for the HMC
System plan overview for the Integrated Virtualization Manager

Configuration requirements for shared memory
Review the requirements for the system, Virtual I/O Server (VIOS), logical partitions, and paging space
devices so that you can successfully configure shared memory.

System requirements
v The server must be a POWER6 processor-based server.
v The server firmware must be at release 3.4.2, or later.
v The Hardware Management Console (HMC) must be at version 7 release 3.4.2, or later.
v The Integrated Virtualization Manager must be at version 2.1.1, or later.
v The PowerVM Active Memory Sharing technology must be activated. The PowerVM Active Memory

Sharing technology is available with the PowerVM Enterprise Edition for which you must obtain and
enter a PowerVM Editions activation code.
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Paging VIOS partition requirements
v Virtual I/O Server logical partitions that provide access to the paging space devices for the shared

memory partitions that are assigned to the shared memory pool (hereafter referred to as paging VIOS
partitions) cannot use shared memory. Paging VIOS partitions must use dedicated memory.

v Paging VIOS partitions must be at version 2.1.1, or later.
v On IVM-managed systems, all logical partitions that use shared memory (hereafter referred to as shared

memory partitions) must use virtual resources provided by the management partition.
v On HMC-managed systems, consider configuring separate Virtual I/O Server logical partitions as

server partitions and paging VIOS partitions. For example, configure one Virtual I/O Server logical
partition to provide virtual resources to the shared memory partitions and configure another Virtual
I/O Server logical partition as a paging VIOS partition.

v On HMC-managed systems, you can configure multiple Virtual I/O Server logical partitions to provide
access to paging space devices. However, you can only assign up to two of those Virtual I/O Server
logical partitions to the shared memory pool at any given time.

Requirements for shared memory partitions
v Shared memory partitions must use shared processors.
v You can assign only virtual adapters to shared memory partitions. This means that you can

dynamically add only virtual adapters to shared memory partitions. More specifically, you can assign
only virtual SCSI client adapters, virtual Ethernet adapters, virtual fibre channel client adapters, and
virtual serial adapters to AIX and Linux shared memory partitions. You can assign only virtual SCSI
client adapters, virtual Ethernet adapters, and virtual serial server adapters to IBM i shared memory
partitions. You cannot assign Host Ethernet Adapters (HEA) or host connection adapters (HCA) to
shared memory partitions.

v Shared memory partitions cannot use the barrier synchronization register.
v Shared memory partitions cannot use huge pages.
v AIX must be at version 6.1 Technology Level 3, or later, to run in a shared memory partition.
v IBM i must be at version 6 release 1 with PTF SI32798 to run in a shared memory partition.
v SUSE Linux Enterprise Server must be at version 11, or later, to run in a shared memory partition.
v You cannot configure IBM i logical partitions that provide virtual resources to other logical partitions

as shared memory partitions. Logical partitions that provide virtual resources to other logical partitions
in a shared memory environment must be Virtual I/O Server logical partitions.

Requirements for paging space devices
v The paging space devices for an AIX or Linux shared memory partitions must be at least the size of

the maximum logical memory of the shared memory partition.
v The paging space devices for IBM i shared memory partitions must be at least the size of the

maximum logical memory of the shared memory partition plus 8 KB for every megabyte. For example,
if the maximum logical memory of the shared memory partition is 16 GB, its paging space device must
be at least 16.125 GB.

v Paging space devices can only be assigned to one shared memory pool at a time. You cannot assign the
same paging space device to a shared memory pool on one system and to another shared memory pool
on another system at the same time.

v Paging space devices that are accessed by a single paging VIOS partition must meet the following
requirements:
– They can be physical or logical volumes.
– They can be located in physical storage on the server or on a storage area network (SAN).

v Paging space devices that are accessed redundantly by two paging VIOS partitions must meet the
following requirements:
– They must be physical volumes.
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– They must be located on a SAN.
– They must be configured with global IDs.
– They must be accessible to both paging VIOS partitions.
– The reserve attribute must be set to no reserve. (The Virtual I/O Server automatically sets the

reserve attribute to no reserve when you add the paging space device to the shared memory pool.)
v Physical volumes that are configured as paging space devices cannot belong to a volume group, such

as the rootvg volume group.
v Logical volumes that are configured as paging space devices must be located in a volume group that

is dedicated for paging space devices.
v Paging space devices must be available. You cannot use the physical volume or logical volume as a

paging space device if it is already configured as a paging space device or virtual disk for another
logical partition.

v Paging space devices cannot be used to boot a logical partition.
v After you assign a paging space device to the shared memory pool, you must manage the device by

using the Create/Modify Shared Memory Pool wizard on the HMC or the View/Modify Shared
Memory Pool page on the Integrated Virtualization Manager. Do not change or remove the device
using other management tools.

Related concepts

“Paging space devices on systems that are managed by an HMC” on page 46
Learn about the location requirements, size requirements, and redundancy preferences for paging space
devices on systems that are managed by a Hardware Management Console (HMC).
“Paging space devices on systems that are managed by the Integrated Virtualization Manager” on page
45
You can learn about the paging storage pool on systems that are managed by the Integrated
Virtualization Manager.
Related tasks

“Preparing to configure shared memory”
Before you configure the shared memory pool and create logical partitions that use shared memory
(hereafter referred to as shared memory partitions), you need to plan for the shared memory pool, the
shared memory partitions, the paging space devices, and the Virtual I/O Server logical partitions
(hereafter referred to as paging VIOS partitions).

Preparing to configure shared memory
Before you configure the shared memory pool and create logical partitions that use shared memory
(hereafter referred to as shared memory partitions), you need to plan for the shared memory pool, the
shared memory partitions, the paging space devices, and the Virtual I/O Server logical partitions
(hereafter referred to as paging VIOS partitions).
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Related concepts

“Paging space devices on systems that are managed by an HMC” on page 46
Learn about the location requirements, size requirements, and redundancy preferences for paging space
devices on systems that are managed by a Hardware Management Console (HMC).
“Paging space devices on systems that are managed by the Integrated Virtualization Manager” on page
45
You can learn about the paging storage pool on systems that are managed by the Integrated
Virtualization Manager.
“Logical memory” on page 34
Logical memory is the address space, assigned to a logical partition, that the operating system perceives as
its main storage. For a logical partition that uses shared memory (hereafter referred to as a shared memory
partition), a subset of the logical memory is backed up by physical main storage and the contents of the
remaining logical memory are kept in auxiliary storage.

Preparing to configure shared memory on a system that is managed by the
Integrated Virtualization Manager
Before you configure the shared memory pool and create logical partitions that use shared memory
(hereafter referred to as shared memory partitions), you need to determine the size of the shared memory
pool, the number of shared memory partitions to assign to the shared memory pool, and the amount of
memory to assign to each shared memory partition.

Before you start, verify that your system meets the requirements for configuring shared memory. For
instructions, see “Configuration requirements for shared memory” on page 90.

To prepare to configure the shared memory pool and shared memory partitions, complete the following
steps:
1. Assess your needs, take inventory of your current environment, and plan for capacity. For

instructions, see “Planning for logical partitions” on page 87. More specifically, determine the
following information:
a. Determine the number of shared memory partitions to assign to the shared memory pool.
b. Determine the amount of logical memory to assign as the desired, minimum, and maximum

logical memory for each shared memory partition. You can apply the same general guidelines that
you might use to assign the desired, minimum, and maximum dedicated memory to logical
partitions that use dedicated memory. For example:
v Do not assign the maximum logical memory to a value that is higher than the amount of logical

memory that you plan to dynamically add to the shared memory partition.
v Set the minimum logical memory to a value that is high enough for the shared memory

partition to successfully activate.
2. Determine the amount of physical memory to assign to the shared memory pool. For instructions, see

“Determining the size of the shared memory pool” on page 96.
3. Determine the paging storage pool to assign to the shared memory pool. The paging storage pool

provides the paging space devices for the shared memory partitions that are assigned to the shared
memory pool. The paging storage pool can contain paging space devices and virtual disks. However,
you cannot use the same logical volume as both a paging space device and as a virtual disk at the
same time. Consider reserving an entire storage pool for paging space devices.

4. Optional: Determine the number of paging space devices to assign to the shared memory pool and
the size of each device. If you do not assign paging space devices to the shared memory pool,
Integrated Virtualization Manager automatically creates them for you from the paging storage pool
when you create the shared memory partitions. If you decide to manually create the paging space
devices, consider the following requirements:
v You need to assign a minimum of one paging space device to the shared memory pool for each

shared memory partition.
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v For AIX and Linux shared memory partitions, the paging space device must be at least the size of
the maximum logical memory size of the shared memory partition that you identified in step 1b.
For example, you plan to create an AIX shared memory partition with a maximum logical memory
size of 16 GB. The paging space device must be at least 16 GB.

v For IBM i shared memory partitions, the paging space device must be the size of the maximum
logical memory size of the shared memory partition that you identified in step 1b multiplied by
129/128. For example, you plan to create an IBM i shared memory partition with a maximum
logical memory size of 16 GB. The paging space device must be at least 16.125 GB.

Related concepts

“Performance considerations for shared memory partitions” on page 217
You can learn about performance factors (such as shared memory overcommitment) that influence the
performance of a logical partition that uses shared memory (hereafter referred to as a shared memory
partition). You can also use shared memory statistics to help you determine how to adjust the
configuration of a shared memory partition to improve its performance.

Preparing to configure shared memory on a system that is managed by an HMC
Before you configure the shared memory pool and create logical partitions that use shared memory
(hereafter referred to as shared memory partitions), you need to determine the size of the shared memory
pool, the amount of memory to assign to each shared memory partition, the number of paging space
devices to assign to the shared memory pool, and the redundancy configuration of the Virtual I/O Server
logical partitions that you assign to the shared memory pool.

Before you start, verify that your system meets the requirements for configuring shared memory. For
instructions, see “Configuration requirements for shared memory” on page 90.

To prepare to configure the shared memory pool and shared memory partitions, complete the following
steps:
1. Assess your needs, take inventory of your current environment, and plan for capacity. For

instructions, see “Planning for logical partitions” on page 87. More specifically, determine the
following information:
a. Determine the number of shared memory partitions to assign to the shared memory pool.
b. Determine the amount of logical memory to assign as the desired, minimum, and maximum

logical memory for each shared memory partition. You can apply the same general guidelines that
you might use to assign the desired, minimum, and maximum dedicated memory to logical
partitions that use dedicated memory. For example:
v Do not assign the maximum logical memory to a value that is higher than the amount of logical

memory that you plan to dynamically add to the shared memory partition.
v Set the minimum logical memory to a value that is high enough for the shared memory

partition to successfully activate.
2. Determine the amount of physical memory to assign to the shared memory pool. For instructions, see

“Determining the size of the shared memory pool” on page 96.
3. Prepare for paging space devices:

a. Determine the number of paging space devices to assign to the shared memory pool. The HMC
assigns one paging space device to each shared memory partition that is active. Thus, the fewest
number of paging space devices that must be assigned to the shared memory pool is equal to the
number of shared memory partitions that you plan to run simultaneously. For example, you assign
ten shared memory partitions to the shared memory pool and you plan to run eight of the shared
memory partitions simultaneously. Thus, you assign at least eight paging space devices to the
shared memory pool.

b. Determine the size of each paging space device:
v For AIX and Linux shared memory partitions, the paging space device must be at least the size

of the maximum logical memory size of the shared memory partition that you identified in step
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1b. For example, you plan to create an AIX shared memory partition with a maximum logical
memory size of 16 GB. The paging space device must be at least 16 GB.

v For IBM i shared memory partitions, the paging space device must be the size of the maximum
logical memory size of the shared memory partition that you identified in step 1b multiplied by
129/128. For example, you plan to create an IBM i shared memory partition with a maximum
logical memory size of 16 GB. The paging space device must be at least 16.125 GB.

v Consider creating paging space devices that are large enough to be used by shared memory
partitions with multiple partition profiles.

c. Determine whether each paging space device resides in physical storage on the server or on a
storage area network (SAN). Paging space devices that are accessed by a single Virtual I/O Server
(VIOS) logical partition (hereafter referred to as a paging VIOS partition) can be located in physical
storage on the server or on a SAN. Paging space devices that are redundantly accessed by two
paging VIOS partitions must be located on a SAN.

4. Prepare for paging VIOS partitions:
a. Determine which Virtual I/O Server (VIOS) logical partitions can be assigned to the shared

memory pool as paging VIOS partitions. A paging VIOS partition provides access to the paging
space devices for the shared memory partitions that are assigned to the shared memory pool. A
paging VIOS partition can be any active Virtual I/O Server (version 2.1.1, or later) that has access
to the paging space devices that you plan to assign to the shared memory pool.

b. Determine the number of paging VIOS partitions to assign to the shared memory pool. You can
assign one or two paging VIOS partitions to the shared memory pool:
v When you assign a single paging VIOS partition to the shared memory pool, it must have

access to all of the paging space devices that you plan to assign to the shared memory pool.
v When you assign two paging VIOS partitions to the shared memory pool, each paging space

device that you plan to assign to the shared memory pool must be accessible to at least one
paging VIOS partition. However, usually when you assign two paging VIOS partitions to the
shared memory pool, they redundantly access one or more paging space devices.

c. If you plan to assign two paging VIOS partitions to the shared memory pool, determine how you
want to configure redundancy for the shared memory partitions:
1) Determine which shared memory partitions to configure with redundant paging VIOS

partitions. For each shared memory partition, this means that both paging VIOS partitions can
access the shared memory partition’s paging space device.

2) Determine which paging VIOS partition to assign as the primary paging VIOS partition and
which paging VIOS partition to assign as the secondary paging VIOS partition for each shared
memory partition. The hypervisor uses the primary paging VIOS partition to access the paging
space device that is assigned to the shared memory partition. If the primary VIOS partition
becomes unavailable, the hypervisor uses the secondary paging VIOS partition to access the
paging space device that is assigned to the shared memory partition.

5. Determine the number of additional processor resources that are needed for the paging VIOS
partitions. To read and write data between the paging space devices and the shared memory pool, the
paging VIOS partitions require additional processing resources. The amount of additional processing
resources that are needed depends on the frequency that the paging VIOS partition reads and writes
the data. The more frequently that the paging VIOS partition reads and writes the data, the more
frequently the paging VIOS partition performs I/O operations. More I/O operations require more
processing power. In general, the frequency that the paging VIOS partition reads and writes data can
be affected by the following factors:
v The degree to which the shared memory partitions are overcommitted. In general, greatly

overcommitted shared memory partitions require the paging VIOS partition to read and write data
more often than slightly overcommitted shared memory partitions.
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v The I/O rates of the storage subsystem on which the paging space devices are located. In general,
paging space devices with faster I/O rates (such as a SAN) enable the paging VIOS partition to
read and write data more often than paging space devices with slower I/O rates (such as storage in
the server).

You can use the IBM Systems Workload Estimator (WLE) to determine the number of processor
resources that are needed for paging VIOS partitions.

Related concepts

“Performance considerations for shared memory partitions” on page 217
You can learn about performance factors (such as shared memory overcommitment) that influence the
performance of a logical partition that uses shared memory (hereafter referred to as a shared memory
partition). You can also use shared memory statistics to help you determine how to adjust the
configuration of a shared memory partition to improve its performance.

Determining the size of the shared memory pool
You need to consider the degree to which you want to overcommit the physical memory in the shared
memory pool, the performance of the workloads when running in a shared memory configuration that is
overcommitted, and the minimum and maximum boundaries of the shared memory pool.

To determine the size of the shared memory pool, consider the following factors:
1. Consider the degree to which you want to overcommit the physical memory in the shared memory

pool.
v When the sum of the physical memory currently used by the shared memory partitions is less than

or equal to the amount of memory in the shared memory pool, the memory configuration is
logically overcommitted. In a logically overcommitted memory configuration, the shared memory pool
has enough physical memory to contain the memory used by all shared memory partitions at one
point in time.

v When the sum of the physical memory currently used by the shared memory partitions is greater
than the amount of memory in the shared memory pool, the memory configuration is physically
overcommitted. In a physically overcommitted memory configuration, the shared memory pool does
not have enough physical memory to contain the memory used by all the shared memory partitions
at one point in time. The hypervisor stores the difference in auxiliary storage.

2. Consider the performance of the workloads when running in a shared memory configuration that is
overcommitted. Some workloads perform well in a shared memory configuration that is logically
overcommitted, and some workloads can perform well in a shared memory configuration that is
physically overcommitted.

Tip: In general, more workloads perform better in logically overcommitted configurations than
physically overcommitted configurations. Consider limiting the degree to which you physically
overcommit the shared memory pool.

3. The shared memory pool must be large enough to meet the following requirements:
a. The shared memory pool must be large enough to provide each shared memory partition with its

I/O entitled memory when all of the shared memory partitions are active. When you create a
shared memory partition, the Hardware Management Console (HMC) and the Integrated
Virtualization Manager (IVM) automatically determine the I/O entitled memory for the shared
memory partition. After you activate the shared memory partitions, you can view statistics about
how the operating systems use their I/O entitled memory and adjust the I/O entitled memory of
the shared memory partitions accordingly.

b. A small portion of the physical memory in the shared memory pool is reserved for the hypervisor
so that it can manage shared memory resources. The hypervisor requires a small amount of
physical memory per shared memory partition plus 256 MB.

Tip: To ensure that you can successfully activate the shared memory partitions, assign at least the
following amount of physical memory to the shared memory pool: (the sum of the minimum logical
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memory that is assigned to all of the shared memory partitions that you plan to run concurrently) +
(the required 256 MB of reserved firmware memory).

4. When the shared memory pool is equal to or greater than the sum of the assigned logical memory of
all the shared memory partitions plus the required amount of reserved firmware memory, the initial
shared memory configuration is not overcommitted. Therefore, the amount of physical memory that
you assign to the shared memory pool need not exceed the sum of the assigned logical memory of all
the shared memory partitions plus the required amount of reserved firmware memory.

Related tasks

“Changing the size of the shared memory pool” on page 139
You can increase or decrease the amount of physical memory assigned to the shared memory pool by
using the Hardware Management Console (HMC).
“Preparing to configure shared memory on a system that is managed by the Integrated Virtualization
Manager” on page 93
Before you configure the shared memory pool and create logical partitions that use shared memory
(hereafter referred to as shared memory partitions), you need to determine the size of the shared memory
pool, the number of shared memory partitions to assign to the shared memory pool, and the amount of
memory to assign to each shared memory partition.
“Preparing to configure shared memory on a system that is managed by an HMC” on page 94
Before you configure the shared memory pool and create logical partitions that use shared memory
(hereafter referred to as shared memory partitions), you need to determine the size of the shared memory
pool, the amount of memory to assign to each shared memory partition, the number of paging space
devices to assign to the shared memory pool, and the redundancy configuration of the Virtual I/O Server
logical partitions that you assign to the shared memory pool.

Software licensing for IBM licensed programs on logical partitions
If you use IBM licensed programs such as AIX and IBM i on a server with logical partitions, consider
how many software licenses are required for your logical partition configuration. Careful consideration of
your software might help minimize the number of software licenses that you must purchase.

Software license behavior varies by software product. Each solution provider has its own licensing
strategy. If you use licensed programs from solution providers other than IBM, consult the documentation
from those solution providers to determine the licensing requirements for those licensed programs.

Some System i models allow you to purchase IBM i licenses on a per-user basis.

Many IBM licensed programs allow you to purchase licenses based upon the number of processors that
the licensed program uses on a managed system as a whole. An advantage of this processor-based
licensing method is that it allows you to create multiple logical partitions without having to purchase
separate licenses for each logical partition. Also, this method caps the number of licenses that you need
for a managed system. You need never obtain more licenses for a single licensed program than the
number of processors on the managed system.

The main complicating factor in calculating the number of licenses that are required on a managed
system with logical partitions using processor-based licensing is the fact that a logical partition that uses
uncapped shared processors can use up to its assigned number of virtual processors. When you use
processor-based licensing, ensure that the number of virtual processors on uncapped logical partitions are
set so that each IBM licensed program does not use more processors than the number of processor-based
licenses that you have purchased for that IBM licensed program.

The number of licenses required for a single IBM licensed program on a managed system using
processor-based licensing is the lesser of the following two values:

The total number of activated processors on the managed system.

OR
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The maximum number of processors that can be used by the IBM licensed program on the managed system. The maximum
number of processors that can be used by the IBM licensed program on the managed system is the sum of the following two
values:

v The total number of processors assigned to all logical partitions that use dedicated processors and that run the IBM licensed
program.

v The sum of the maximum number of processing units that can run the IBM licensed program on each shared processor pool,
rounded up to the next integer. The maximum number of processing units that can run the IBM licensed program on each
shared processor pool is the lesser of the following two values:

– The total number of processing units assigned to capped logical partitions that run the IBM licensed program, plus the total
number of virtual processors assigned to uncapped logical partitions that run the IBM licensed program.

– The maximum number of processing units specified for the shared processor pool. (For the default shared processor pool, this
number is the total number of activated processors on the managed system minus the total number of processors assigned to
all logical partitions that use dedicated processors and that are not set to share processors with shared processor logical
partitions. Use of Capacity on Demand (CoD) can increase the number of activated processors on the managed system, which
can cause the managed system to go out of compliance if you do not allow for CoD use. Also, if there are logical partitions
that use dedicated processors, that run the IBM licensed program, and that are set to share processors with shared processor
logical partitions, then you can deduct the processors for these dedicated processor logical partitions from the maximum
number of processing units for the default shared processor pool total, because you have already counted these dedicated
processors in the dedicated processor logical partition total.)

When you use processor-based licensing, ensure that the managed system is in compliance with the
license agreement for each IBM licensed program that is installed on the managed system. If you have a
managed system that is capable of using multiple shared processor pools, you can use the multiple
shared processor pool feature of the Hardware Management Console (HMC) to ensure that your
managed system remains in compliance with these license agreements. You can configure a shared
processor pool with a maximum processing unit value equal to the number of licenses that you have for
your managed system, and then set all logical partitions that use the IBM licensed program so that they
use that shared processor pool. The logical partitions in the shared processor pool cannot use more
processors than the maximum processing unit value that is set for the shared processor pool, so the
managed system remains in compliance with the per-processor license agreement.

For example, Company Y has obtained three processor-based IBM i licenses for a managed system with
four processors and four logical partitions. The managed system has only one shared processing pool,
and all four logical partitions use the shared processor pool, so all four of the processors on the managed
system are in the shared processor pool. The configuration of the logical partitions is as follows.

Table 19. Logical partition configuration in compliance with license agreement

Logical
partition
name

Operating
system

Processing
mode

Sharing
mode

Processing
units

Virtual
processors

Maximum number of processors that can be
used by the logical partition

Partition A IBM i Shared Uncapped 1.75 2 2.00 (the number of virtual processors for the
uncapped shared logical partition)

Partition B IBM i Shared Capped 0.60 1 0.60 (the number of processing units for the
capped shared logical partition)

Partition C IBM i Shared Capped 0.40 1 0.40 (the number of processing units for the
capped shared logical partition)

Partition D Linux Shared Uncapped 1.25 2 2.00 (the number of virtual processors for the
uncapped shared logical partition)

This configuration has three IBM i logical partitions and one Linux logical partition on the managed
system. The three IBM i logical partitions can use a maximum of 3.00 processors (2.00 for Partition A, 0.60
for Partition B, and 0.40 for Partition C). The managed system has three IBM i licenses, so the managed
system is in compliance with the IBM i license agreement.

For an example of a logical partition configuration that is out of compliance with a licensing agreement,
the system administrator at Company Y changes the sharing mode of Partition B and Partition C from
capped to uncapped. The following table shows the new logical partition configuration.
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Table 20. Logical partition configuration out of compliance with license agreement (first example)

Logical
partition
name

Operating
system

Processing
mode

Sharing
mode

Processing
units

Virtual
processors

Maximum number of processors that can be
used by the logical partition

Partition A IBM i Shared Uncapped 1.75 2 2.00 (the number of virtual processors for the
uncapped shared logical partition)

Partition B IBM i Shared Uncapped 0.60 1 1.00 (the number of virtual processors for the
uncapped shared logical partition)

Partition C IBM i Shared Uncapped 0.40 1 1.00 (the number of virtual processors for the
uncapped shared logical partition)

Partition D Linux Shared Uncapped 1.25 2 2.00 (the number of virtual processors for the
uncapped shared logical partition)

In this configuration, the three IBM i logical partitions can use a maximum of 4.00 processors (2.00 for
Partition A, 1.00 for Partition B, and 1.00 for Partition C). The managed system has only three IBM i
licenses, but requires a total of four IBM i licenses, so the managed system is out of compliance with the
IBM i license agreement.

If you have a managed system that is capable of using multiple shared processor pools, you can use the
Hardware Management Console (HMC) to configure a shared processor pool with a maximum processing
unit value of 3.00, and assign Partition A, Partition B, and Partition C to that shared processor pool. If
you do this, Partition A, Partition B, and Partition C can continue to be uncapped. You would remain in
compliance with the IBM i license agreement, because the maximum processing unit value would ensure
that IBM i uses no more than three processing units.

For another example of a logical partition configuration that is out of compliance with a licensing
agreement, the system administrator at Company Y changes the sharing mode of Partition B and Partition
C back to capped. However, the system administrator then moves 0.50 processing units from Partition D
to Partition A. Before the system administrator is allowed to do this, the system administrator must
increase the number of virtual processors on Partition A from 2 to 3. The following table shows the new
logical partition configuration.

Table 21. Logical partition configuration out of compliance with license agreement (second example)

Logical
partition
name

Operating
system

Processing
mode

Sharing
mode

Processing
units

Virtual
processors

Maximum number of processors that can be
used by the logical partition

Partition A IBM i Shared Uncapped 2.25 3 3.00 (the number of virtual processors for the
uncapped shared logical partition)

Partition B IBM i Shared Capped 0.60 1 0.60 (the number of processing units for the
capped shared logical partition)

Partition C IBM i Shared Capped 0.40 1 0.40 (the number of processing units for the
capped shared logical partition)

Partition D Linux Shared Uncapped 0.75 2 2.00 (the number of virtual processors for the
uncapped shared logical partition)

In this configuration, the three IBM i logical partitions can use a maximum of 4.00 processors (3.00 for
Partition A, 0.60 for Partition B, and 0.40 for Partition C). The managed system has only three IBM i
licenses, but requires a total of four IBM i licenses, so the managed system is out of compliance with the
IBM i license agreement.

Considerations other than licensed program agreements might constrain your ability to run IBM licensed
programs on certain server models.
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Related concepts

“Processors” on page 15
A processor is a device that processes programmed instructions. The more processors that you assign to a
logical partition, the greater the number of concurrent operations that the logical partition can run at any
given time.
Related information

Working with software agreements and licenses

Minimum hardware configuration requirements for logical partitions
Each logical partition requires at least a certain amount of hardware resources. You can assign hardware
resources directly to a logical partition, or you can set the logical partition to use the hardware resources
that are assigned to another logical partition. The minimum hardware configuration requirements for
each logical partition depend on the operating system or software installed on the logical partition.

The following table lists the minimum hardware requirements for logical partitions.

Table 22. Minimum hardware requirements for logical partitions

Minimum
requirement AIX and Linux IBM i

Processor 1 dedicated processor or
0.1 processing unit

1 dedicated processor or 0.1 processing unit

Memory
(physical or
logical)

v AIX 5.3 to AIX 6.0: 128
MB

v AIX 6.1 or later: 256
MB

v Linux: 128 MB

128 MB plus 40 MB for each active logical Host Ethernet Adapter
(LHEA)
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Table 22. Minimum hardware requirements for logical partitions (continued)

Minimum
requirement AIX and Linux IBM i

I/O v Physical or virtual
storage adapter (SCSI
card)

v Physical or virtual
network adapter

v Storage:

– AIX: 2 GB

– Linux:
Approximately 1 GB

v Load source

– Disk I/O processor (IOP) and I/O adapter (IOA) or disk IOA that
does not require an IOP

– Disk unit that is at least 17 GB in size

v Console: your choice of one of the following console types:

– Hardware Management Console (HMC) 5250 emulation (requires
an HMC)

– Operations Console: Requires either a LAN connection or an
asynchronous IOA that supports Operations Console connections.
The Operations Console LAN connection can be either an
embedded port, a LAN IOA with an associated IOP, or, if you
install i5/OS® Licensed Internal Code V5R3M5 or later or IBM i
V5R4 or later, a LAN IOA that does not require an IOP.

– Twinaxial console: Requires a twinaxial workstation IOA with an
associated IOP.

v Alternate restart device: your choice of tape, CD, or DVD. These
devices connect either to an embedded SCSI or IDE controller, a SCSI
or IDE controller with an associated IOP, or, if you install i5/OS
Licensed Internal Code V5R3M5 or later or IBM i V5R4 or later, a
SCSI or IDE controller that does not require an IOP.

v Physical or virtual LAN adapter that can be used for serviceable
event reporting and connection monitoring. At least one IBM i logical
partition in the managed system must have a physical LAN adapter
that the IBM i logical partition can use for serviceable event reporting
and connection monitoring. You can then create a virtual LAN that
connects the IBM i logical partition with the physical LAN adapter to
the other logical partitions on the managed system, and bridge the
physical LAN adapter to the virtual LAN. If the system is managed
using an HMC, the physical LAN adapter must be able to
communicate with the HMC so that serviceable event reporting can
be routed through the HMC.

Related information

PowerVM Editions

Partitioning with the HMC
The Hardware Management Console (HMC) is a system that controls managed systems, including the
management of logical partitions and use of Capacity Upgrade on Demand. Using service applications,
the HMC communicates with managed systems to detect, consolidate, and forward information to IBM
for analysis.

The HMC features a browser-based user interface. You can use the HMC locally by connecting a
keyboard and mouse to the HMC. You can also configure the HMC so that you can connect to the HMC
remotely using a supported browser.
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Related concepts

“Hardware Management Console” on page 7
The Hardware Management Console (HMC) is a hardware appliance that you can use to configure and
control one or more managed systems. You can use the HMC to create and manage logical partitions and
activate Capacity Upgrade on Demand. Using service applications, the HMC communicates with
managed systems to detect, consolidate, and send information to service and support for analysis.
Related information

Installing and configuring the Hardware Management Console

Creating logical partitions
The Create Logical Partition wizard on the Hardware Management Console (HMC) guides you through
the procedure of creating logical partitions and partition profiles on your server.

Creating logical partitions on a new or nonpartitioned server
Use these procedures to create logical partitions on your new or nonpartitioned server using the
Hardware Management Console (HMC).

When you receive your server, the server is in what is known as the manufacturing default configuration.
You can install an operating system on the server and use the server in a nonpartitioned configuration.
However, if you want to create logical partitions on the managed system, you must develop a logical
partition plan for the server, add hardware to the server or move the hardware within the server
according to your logical partition plan, and validate the hardware on the server. When the server is
ready, you can then create the logical partitions using the HMC.

The procedure used to create logical partitions on a new or nonpartitioned server varies by server type.

Creating IBM i logical partitions on a new or nonpartitioned managed system:

Use this procedure to create IBM i logical partitions on a new or nonpartitioned managed system using
the Hardware Management Console (HMC). In this procedure, you will validate the hardware on the
managed system, create the logical partitions on the managed system, and designate the service logical
partition for the managed system.

Use this procedure in the following cases:
v You have just received your managed system and want to create logical partitions on the managed

system immediately.
v You have used the managed system as a nonpartitioned server, and now want to create logical

partitions on the managed system.

If you want to create a new logical partition on a managed system that has already been partitioned, then
you do not need to perform all of the steps in this procedure. For instructions about creating a new
logical partition on a managed system that has already been partitioned, see “Creating additional logical
partitions” on page 112.

Before you begin, complete the following tasks:
v Use the System Planning Tool (SPT) to ensure that your hardware configuration supports your desired

logical partition configuration.
v If necessary, install additional hardware resources on your managed system to support the logical

partition plan specified by the SPT.
v Set up the HMC to manage your logical partition and the managed system. For instructions, see

Installing and configuring the HMC.
v If you have used the managed system prior to creating logical partitions, back up all data on the

managed system.
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To create logical partitions on a new or nonpartitioned managed system from the HMC, complete the
following steps:
1. Ensure that the managed system is in a state of Standby. Complete the following:

a. In the navigation pane, open Systems Management and click Servers.
b. In the work pane, find the state of the managed system as displayed in the work pane under the

Status heading.
c. If the managed system is in a Power off state, select the managed system in the work pane, click

the Tasks button, click Operations → Power On, select the power-on mode of Partition Standby,
click OK, and wait until the work pane displays a Standby state for the managed system.

If the managed system does not display in the work pane, or if the managed system is in any state
other than Standby or Operating, you must fix the problem before continuing.

2. Verify that a single logical partition exists on the managed system.
When you connect a new or nonpartitioned managed system to an HMC, a single logical partition is
displayed in the HMC user interface. All system resources belong to this logical partition. In this
procedure, you will use this logical partition to validate the hardware on the managed system. After
you validate the hardware on the managed system, you will delete this logical partition and create
the logical partitions according to your logical partition plan.
a. In the navigation pane of the HMC, open Servers and click the managed system.
b. In the work pane, verify that there is only one logical partition in the list of logical partitions.

The name of this logical partition will be the serial number of the managed system, and the
logical partition will have one partition profile called default_profile.

If the logical partition that is described in this step exists, continue to step 4. Otherwise, continue to
step 3 to reset the managed system.

3. Reset the managed system so that a single logical partition exists on the managed system. Complete
the following steps at your HMC (not remotely) to create this logical partition:
a. Ensure that the hardware placement in the managed system supports the manufacturing default

configuration. If the hardware placement in the managed system does not support the
manufacturing default configuration, you must move the hardware so that the hardware
placement supports the manufacturing default configuration. For more information on placing
the hardware in your managed system to support the manufacturing default configuration,
contact your marketing representative or business partner.

b. In the navigation pane, click Servers.
c. In the work pane, select the managed system, click the Tasks button, click Configuration →

Manage Partition Data → Initialize, and click Yes.
d. In the navigation pane, click HMC Management.
e. In the work pane, click Open Restricted Shell Terminal. The Restricted shell command-line

interface is displayed.
f. Type: lpcfgop -m managed_system_name -o clear where managed_system_name is the name of

managed system as it is displayed in the work pane.
g. Enter 1 to confirm. This step takes several seconds to complete.

4. Ensure that the logical partition is in a Not Activated state.
In the navigation pane of the HMC, select the managed system if it is not already selected, and
review the state of the logical partition on the managed system. If the logical partition is in a
Running state, shut down the logical partition by completing the following steps:
a. In the work pane, select the logical partition, click the Tasks button, and click Properties.
b. Ensure that Power off the system after all the logical partitions are powered off is cleared, and

click OK.
c. Shut down the logical partition using operating system procedures. For instructions, see

“Shutting down IBM i logical partitions” on page 151.
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If the logical partition is in an Error state, complete the following:
a. In the work pane, select the logical partition, click the Tasks button, and click Serviceability →

Reference Code History.
b. Click the Reference Code tab and use the reference codes displayed on the Reference Code tab

to diagnose and fix the problem. For information about using reference codes, see Reference
Code finder.

5. Identify (or tag) the load source device, alternate restart device, and console device to use for system
setup. Identify the HMC as the console device for system setup, regardless of the types of console
device that you ultimately plan to use for the logical partitions on your system. The HMC provides
the easiest, most reliable method to access a console session during system setup. When you create
your logical partitions, you can specify the console of your choice for each logical partition. Also,
when you select the load source device and alternate restart device, select the devices that will be
used by the first IBM i logical partition in your SPT plan.
To identify the devices to use for system setup, complete the following:
a. In the work pane, select the logical partition, click the Tasks button, and click Configuration →

Manage Profiles.
b. Select the partition profile, click Actions, and click Edit.
c. Click the Tagged I/O tab.
d. Under Load source, click Select.
e. Select the slot in which the load source I/O Adapter (IOA) or the load source I/O Processor

(IOP) is installed and click OK.
f. Under Alternate restart device, click Select.
g. Select the slot in which the alternate restart device IOA or IOP is installed and click OK.
h. Select Use HMC console and click OK.
i. Click Close.

6. If Licensed Internal Code was not preinstalled on the server, or if you want to install Licensed
Internal Code yourself, install Licensed Internal Code at this time. When the Licensed Internal Code
installation is complete, continue to step 8.

7. Activate the logical partition:
a. In the work pane, select the logical partition, click the Tasks button, and click Operations →

Activate.
b. Click OK to exit manufacturing default configuration if prompted.
c. Click Advanced.
d. Select Manual in the Keylock position field, select B: IPL from the second side of the load

source in the IPL type field, and click OK.
e. If you are performing this procedure from the HMC, select Open a terminal window or console

session and click OK. If you are performing this procedure remotely, click OK and then open an
HMC 5250 console session remotely on the logical partition.

f. Type 1 and press Enter to start a dedicated HMC 5250 console session.
8. Verify that the physical adapters are connected and reporting to the managed system using the

Failed and non-reporting hardware resources option in the Hardware Service Manager. The Failed
and non-reporting hardware resource option displays a list of the logical hardware resources that
either failed or did not report to the system at the last IPL.
Attention: Incorrect use of the Failed and non-reporting hardware resource option can cause
damage to data in your system.
a. In the HMC 5250 console session, type 3 and press Enter to select option 3 [Use Dedicated

Service Tools (DST)].
b. Sign onto DST with a valid user ID and password.
c. Type 7 and press Enter to select option 7 [Start a service tool].
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d. Type 4 and press Enter to select option 4 [Hardware service manager].
e. Type 4 and press Enter to select option 4 [Failed and non-reporting hardware resources].
f. Verify that there are no failed or non-reporting resources. If no failed resources or non-reporting

resources exist, the informational message No failed or non-reporting logical hardware
resources were found opens. If there are failed resources, contact your service provider.

Note: You can verify only the adapters that are supported by IBM i. Any adapter that is not
supported by IBM i might have an error of unknown or failed hardware.

g. Press F3 until the Use Dedicated Service Tools (DST) display opens.
h. Type 7 and press Enter to select option 7 [Start a service tool].
i. Type 7 and press Enter to select option 7 [Operator panel functions].
j. Press F10 to power off, press Enter to confirm, close the 5250 console session window, and wait

until the logical partition shuts down.
9. If the hardware in the managed system is already in the configuration specified in your SPT

configuration plan, continue to step 15 on page 106.
10. Power off the managed system using your HMC:

a. In the navigation pane, open Systems Management and click Servers.
b. In the work pane, select the managed system in the work pane, click the Tasks button, and click

Operations → Power Off.
c. Select the Normal power off option and click OK.

11. Move the hardware in the managed system according to your SPT configuration plan.
12. Power on the managed system to the Standby state using your HMC.

a. In the navigation pane, open Systems Management and click Servers.
b. In the work pane, select the managed system in the work pane, click the Tasks button, and click

Operations → Power On.
c. Select Partition standby as the power-on mode and click OK.

13. Activate the logical partition:
a. In the navigation pane, open Systems Management, open Servers, and click the managed

system.
b. In the work pane, select the logical partition, click the Tasks button, and click Operations →

Activate.
c. Click Advanced.
d. Select Manual in the Keylock position field, select B: IPL from the second side of the load

source in the IPL type field, and click OK.
e. If you are performing this procedure from the HMC, select Open a terminal window or console

session and click OK. If you are performing this procedure remotely, click OK and then open an
HMC 5250 console session remotely on the logical partition.

f. Type 1 and press Enter to start a dedicated HMC 5250 console session.
14. Verify that the physical adapters are connected and reporting to the managed system using the

Failed and non-reporting hardware resources option in the Hardware Service Manager:
Attention: Incorrect use of the Failed and non-reporting hardware resource option can cause
damage to data in your system.
a. Type 3 and press Enter to select option 3 [Use Dedicated Service Tools (DST)].
b. Sign onto DST with a valid user ID and password.
c. Type 7 and press Enter to select option 7 [Start a service tool].
d. Type 4 and press Enter to select option 4 [Hardware service manager].
e. Type 4 and press Enter to select option 4 [Failed and non-reporting hardware resources].
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f. Verify that there are no failed or non-reporting hardware resources. If no failed or non-reporting
hardware resources exist, the informational message No failed or non-reporting logical
hardware resources were found opens. If there are failed resources, contact your service provider.

Note: You can verify only the adapters that are supported by IBM i. Any adapter that is not
supported by IBM i might have an error of unknown or failed hardware.

g. Press F3 until the Use Dedicated Service Tools (DST) display opens.
h. Type 7 and press Enter to select option 7 [Start a service tool].
i. Type 7 and press Enter to select option 7 [Operator panel functions].
j. Press F10 to power off, press Enter to confirm, close the 5250 console session window, and wait

until the logical partition shuts down.
15. Delete the logical partition that owns all of the system resources:

Attention: This procedure erases the logical partition and the logical partition configuration data
stored on the partition profiles. This procedure does not affect any of the data stored on the
managed system.
a. In the navigation pane, open Systems Management → Servers, and click the managed system.
b. In the work pane, ensure that the logical partition is powered off.
c. Select the logical partition, click the Tasks button, and click Operations → Delete.
d. Click Yes to confirm.

16. Create each logical partition on your managed system according to your logical partition plan:

Note: If you plan to create logical partitions that use shared memory, you must first configure the
shared memory pool. For instructions, see “Configuring the shared memory pool” on page 134.
a. In the navigation pane, open Systems Management and click Servers.
b. In the work pane, select the managed system, click the Tasks button, and click Configuration →

Create Logical Partition.
c. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition

profile.

Alternatively, you can create logical partitions by importing a system plan file into your HMC and
deploying the system plan to the managed system. For instructions, see Deploying a system plan
using the HMC.

17. Designate one of the IBM i logical partitions on your managed system as the service logical partition
for the managed system.
a. In the navigation pane, open Systems Management and click Servers.
b. In the work pane, select the managed system, click the Tasks button, and click Configuration →

Properties.
c. In the Service partition field, select the logical partition that you want to designate as the service

logical partition, and click OK.
18. Ensure that there is at least one LAN adapter on the HMC that is configured to connect with the

logical partitions on your managed system:
a. In the navigation pane, open HMC Management.
b. Select HMC Configuration.
c. In the work pane, click Change Network Settings.
d. Click the LAN Adapters tab.
e. Select any LAN adapter other than the eth0 adapter that connects the HMC with the service

processor, and click Details.
f. On the LAN Adapter tab, under Local area network information, select Open, and select

Partition communication.
g. Click the Firewall Settings tab.
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h. Ensure that the Resource Monitoring and Control (RMC) application is one of the applications
displayed in Allowed Hosts. If it is not displayed in Allowed Hosts, select the RMC application
under Available Applications and click Allow Incoming. The RMC application is displayed in
Allowed Hosts to signify that it has been selected.

i. Click OK.

After you have created the logical partitions on your managed system, complete the following tasks:
1. Install operating systems and system software on the logical partitions. If you created logical

partitions by deploying a system plan, some operating systems and system software might already
have been installed as part of the system plan deployment process. For installation instructions for the
AIX, IBM i, and Linux operating systems, see Working with operating systems and software
applications for POWER6 processor-based systems. For installation instructions for the Virtual I/O
Server, see Installing the Virtual I/O Server and client logical partitions.

2. Change the console device on each IBM i logical partition to the console device of your choice. For
procedures on how to change the console on IBM i logical partitions, see Changing consoles.

3. Connect the logical partitions on your managed system to the LAN adapter that you have just
configured on the HMC. You can create a virtual LAN to connect the logical partitions on your
managed system with each other, bridge the virtual LAN to a physical Ethernet adapter on an
external network, and connect the LAN adapter on the HMC to the same external network.
Alternatively, you can configure a physical Ethernet adapter on each logical partition, connect the
physical Ethernet adapters on the logical partitions to an external network, and connect the LAN
adapter on the HMC to the same external network. For instructions, see “Configuring a virtual
Ethernet adapter” on page 130.

Creating AIX or Linux logical partitions on a new or nonpartitioned managed system:

Use this procedure to create AIX or Linux logical partitions on a new or nonpartitioned managed system
using the Hardware Management Console (HMC). In this procedure, you will validate the hardware on
the managed system and create the logical partitions on the managed system.

Use this procedure in the following cases:
v You have just received your managed system and want to create logical partitions on the managed

system immediately.
v You have used the managed system as a nonpartitioned server, and now want to create logical

partitions on the managed system.

If you want to create a new logical partition on a managed system that has already been partitioned, then
you do not need to perform all of the steps in this procedure. For instructions about creating a new
logical partition on a managed system that has already been partitioned, see “Creating additional logical
partitions” on page 112.

Before you begin, complete the following:
v Use the System Planning Tool (SPT) to ensure that your hardware configuration supports your desired

logical partition configuration.
v If necessary, install additional hardware resources on your managed system to support the logical

partition plan specified by the SPT .
v Set up the HMC to manage your logical partition and the managed system. For instructions, see

Installing and configuring the HMC.
v If you have used the managed system prior to creating logical partitions, back up all data on the

managed system.

To create logical partitions on a new or nonpartitioned managed system using the HMC, complete the
following steps:
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1. Ensure that the managed system is in a state of Standby. Complete the following:
a. In the navigation pane, open Systems Management and click Servers.
b. In the work pane, find the state of the managed system as displayed in the work pane under the

Status heading.
c. If the managed system is in a Power off state, select the managed system in the work pane, click

the Tasks button, click Operations → Power on, select the power-on mode of Partition Standby,
click OK, and wait until the work pane displays a Standby state for the managed system.

If the managed system does not display in the work pane, or if the managed system is in any state
other than Standby or Operating, you must fix the problem before continuing.

2. Verify that a single logical partition exists on the managed system.
When you connect a new or nonpartitioned managed system to an HMC, a single logical partition is
displayed in the HMC user interface. All system resources belong to this logical partition. In this
procedure, you will use this logical partition to validate the hardware on the managed system. After
you validate the hardware on the managed system, you will delete this logical partition and create
the logical partitions according to your logical partition plan.
a. In the navigation pane of the HMC, open Servers and click on the managed system.
b. In the work pane, verify that there is only one logical partition in the list of logical partitions.

The name of this logical partition will be the serial number of the managed system, and the
logical partition will have one partition profile named default_profile.

If the logical partition that is described in this step exists, continue to step 4. Otherwise, continue to
step 3 to reset the managed system.

3. Reset the managed system so that a single logical partition exists on the managed system. Complete
the following steps at your HMC (not remotely) to create this logical partition:
a. Ensure that the hardware placement in the managed system supports the manufacturing default

configuration.
If the hardware placement in the managed system does not support the manufacturing default
configuration, you must move the hardware so that the hardware placement supports the
manufacturing default configuration. For more information about placing the hardware in your
managed system to support the manufacturing default configuration, contact your marketing
representative or business partner.

b. In the navigation pane, click Servers.
c. In the work pane, select the managed system in the work pane, click the Tasks button, click

Configuration → Manage Partition Data → Initialize and click Yes.
d. In the navigation pane, click HMC Management.
e. In the work pane, click Open Restricted Shell Terminal. The Restricted shell command-line

interface displays.
f. Type: lpcfgop -m managed_system_name -o clear where managed_system_name is the name of

managed system as it displays in the work pane.
g. Enter 1 to confirm. This step takes several seconds to complete.

4. Ensure that the logical partition is in a Not Activated state.
In the navigation pane of the HMC, select the managed system if it is not already selected, and
review the state of the logical partition on the managed system. If the logical partition is in a
Running state, shut down the logical partition by completing the following steps:
a. In the work pane, select the logical partition, click the Tasks button, and click Properties.
b. Ensure that Power off the system after all the logical partitions are powered off is cleared, and

click OK.
c. Shut down the logical partition using operating system procedures. For more information about

shutting down logical partitions using operating system procedures, see the following
information:
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v For managed systems running AIX, see “Shutting down AIX logical partitions” on page 150.
v For managed systems running Linux, see “Shutting down Linux logical partitions” on page

155.

If the logical partition is in an Error state, complete the following:
a. In the work pane, select the logical partition, click the Tasks button, and click Serviceability →

Reference Code History.
b. Click the Reference Code tab and use the reference codes displayed on the Reference Code tab

to diagnose and fix the problem. For information about using reference codes, see Reference
Code finder.

5. Activate the logical partition and verify that the physical adapters on the managed system are
connected and reporting to the managed system using the configuration manager.
If AIX is not installed on your managed system, continue with step 6. You can use the configuration
manager in AIX to view all of the available devices. When AIX boots and the configuration manager
runs, the configuration manager displays all the working adapters. The recognized adapters will be
in the Available state if they are configured correctly.
a. In the work pane, select the logical partition, click the Tasks button, and click Operations →

Activate.
b. Click OK to exit manufacturing default configuration if prompted.
c. Click Advanced.
d. In the Boot mode field, select Normal and click OK.
e. Select Open a terminal window or console session and click OK. A virtual terminal (vterm)

window opens for the logical partition.
f. Ensure that all the resources are attached and powered on.
g. Log in to AIX using a valid user name and password.
h. Enter the following command at the command prompt to list all of the adapters on AIX: # lsdev

-Cc adapter. If any adapters do not display as Available, contact service and support.

Note: You can verify only the adapters that are recognized by AIX. Any adapter that is not
recognized by AIX might have an error of unknown or failed hardware.

i. Shut down the logical partition using operating system procedures and close the terminal session
window. For information on how to shut down AIX, see “Shutting down AIX logical partitions”
on page 150.

6. Activate the logical partition and verify that the physical adapters on the managed system are
connected and reporting to the managed system using the System Management Services (SMS)
interface. (If Linux is installed on the managed system, or if no operating system is on the managed
system, you can use the SMS interface to view the available devices.) When the logical partition is
activated, the bus is scanned to determine what device adapters are attached. The recognized
adapters are listed.
a. In the work pane, select the logical partition, click the Tasks button, and click Operations →

Activate.
b. Click Advanced.
c. In the Boot mode field, select SMS and click OK.
d. Select Open a terminal window or console session and click OK. A virtual terminal (vterm)

window opens for the logical partition.
e. When the SMS interface is displayed, type 5 and press Enter to select option 5 [Select Boot

Options].
f. Type 1 and press Enter to select option 1 [Select Install or Boot a Device]
g. Type 7 and press Enter to select option 7 [List all Devices]. All of the recognized devices in the

logical partition are listed. If any devices are not displayed, contact service and support.

Logical partitioning 109



Note: You can verify only the adapters that are recognized by SMS. Any adapter that is not
recognized by SMS might have an error of unknown or failed hardware.

h. Close the terminal session window, click the Tasks button, and click Operations → Shut down,
and click OK.

7. If the hardware in the managed system is already in the configuration specified in your SPT
configuration plan, continue to step 13 on page 111.

8. Power off the managed system using your HMC:
a. In the navigation pane, open Systems Management and click Servers.
b. In the work pane, select the managed system in the work pane, click the Tasks button, and click

Operations → Power Off.
c. Select the Normal power off option and click OK.

9. Move the hardware in the managed system according to your SPT configuration plan.
10. Power on the managed system to the Standby state using your HMC:

a. In the navigation pane, open Systems Management and click Servers.
b. In the work pane, select the managed system in the work pane, click the Tasks button, and click

Operations → Power On.
c. Select Partition standby as the power-on mode and click OK.

11. Activate the logical partition and verify that the physical adapters on the managed system are
connected and reporting to the managed system using the configuration manager.
If AIX is not installed on the managed system, continue with step 12. You can use the configuration
manager in AIX to view all of the available devices. When AIX boots and the configuration manager
runs, the configuration manager displays all the working adapters. The recognized adapters will be
in the Available state if they are configured correctly.
a. In the navigation pane, open Systems Management → Servers, and click the managed system.
b. In the work pane, select the logical partition, click the Tasks button, and click Operations →

Activate.
c. Click Advanced.
d. In the Boot mode field, select Normal and click OK.
e. Select Open a terminal window or console session and click OK. A virtual terminal (vterm)

window opens for the logical partition.
f. Ensure that all the resources are attached and powered on.
g. Log in to AIX using a valid user name and password.
h. Enter the following command at the command prompt to list all of the adapters on AIX: # lsdev

-Cc adapter. If any adapters are not displayed as Available, contact service and support.

Note: You can verify only the adapters that are recognized by AIX. Any adapter that is not
recognized by AIX might have an error of unknown or failed hardware.

i. Shut down the logical partition using operating system procedures and close the terminal session
window. For information about how to shut down AIX, see “Shutting down AIX logical
partitions” on page 150.

12. Activate the logical partition and verify that the physical adapters on the managed system are
connected and reporting to the managed system using the System Management Services (SMS)
interface. (If Linux is installed on the managed system, or if no operating system is on the managed
system, you can use the SMS interface to view the available devices.) When the logical partition is
activated, the bus is scanned to determine what device adapters are attached. The recognized
adapters are listed.
a. In the navigation pane, open Systems Management → Servers, and click the managed system.
b. In the work pane, select the logical partition, click the Tasks button, and click Operations →

Activate.
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c. Click Advanced.
d. In the Boot mode field, select SMS and click OK.
e. Select Open a terminal window or console session and click OK. A virtual terminal (vterm)

window opens for the logical partition.
f. When the SMS interface is displayed, type 5 and press Enter to select option 5 [Select Boot

Options].
g. Type 1 and press Enter to select option 1 [Select Install or Boot a Device]
h. Type 7 and press Enter to select option 7 [List all Devices]. All of the recognized devices in the

logical partition are listed. If there are any devices that do not display, contact service and
support.

Note: You can verify only the adapters that are recognized by SMS. Any adapter that is not
recognized by SMS might have an error of unknown or failed hardware.

i. Close the terminal session window, click the Tasks button, and click Operations → Shut down,
and click OK.

13. Delete the logical partition that owns all of the system resources:
Attention: This procedure erases the logical partition and the logical partition configuration data
stored on the logical partition profiles. This procedure does not affect any of the data stored on the
managed system.
a. In the navigation pane, open Systems Management → Servers, and click the managed system.
b. In the work pane, ensure that the logical partition is powered off.
c. Select the logical partition, click the Tasks button, and click Operations → Delete.
d. Click Yes to confirm.

14. Create each logical partition on your managed system according to your logical partition plan:

Note: If you plan to create logical partitions that use shared memory, you must first configure the
shared memory pool. For instructions, see “Configuring the shared memory pool” on page 134.
a. In the navigation pane, open Systems Management and click Servers.
b. In the work pane, select the managed system, click the Tasks button, and click Configuration →

Create Logical Partition.
c. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition

profile.

Alternatively, you can create logical partitions by importing a system plan file into your HMC and
deploying the system plan to the managed system. For instructions, see Deploying a system plan
using the HMC.

15. Ensure that at least one LAN adapter on the HMC is configured to connect with the logical
partitions on your managed system. To do this, complete the following:
a. In the navigation pane, open HMC Management.
b. Click HMC Configuration.
c. In the work pane, click Change Network Settings.
d. Click the LAN Adapters tab.
e. Select any LAN adapter other than the eth0 adapter that connects the HMC with the service

processor and click Details.
f. On the LAN Adapter tab, under Local area network information, click Open, and select Partition

communication.
g. Click the Firewall Settings tab.
h. Ensure that the Resource Monitoring and Control (RMC) application is one of the applications

displayed in Allowed Hosts. If it is not displayed in Allowed Hosts, select the RMC application
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under Available Applications and click Allow Incoming. The RMC application is displayed in
Allowed Hosts to signify that it has been selected.

i. Click OK.

After you have created the logical partitions on your managed system, complete the following tasks:
1. Install operating systems and system software on the logical partitions. If you created logical

partitions by deploying a system plan, some operating systems and system software might already
have been installed as part of the system plan deployment process. For installation instructions for the
AIX, IBM i, and Linux operating systems, see Working with operating systems and software
applications for POWER6 processor-based systems. For installation instructions for the Virtual I/O
Server, see Installing the Virtual I/O Server and client logical partitions.

2. Connect the logical partitions on your managed system to the LAN adapter that you have just
configured on the HMC in one of the following ways:
v On POWER6 processor-based systems, create a logical Host Ethernet Adapter for each logical

partition, which specifies the resources that the logical partition can use on the actual physical Host
Ethernet Adapter, or Integrated Virtual Ethernet. The Host Ethernet Adapter connects the logical
partitions to an external network without having to go through an Ethernet bridge on another
logical partition. For instructions, see “Creating a logical Host Ethernet Adapter for a running
logical partition” on page 135.

v Create a virtual LAN to connect the logical partitions on your managed system with each other,
bridge the virtual LAN to a physical Ethernet adapter on an external network, and connect the
LAN adapter on the HMC to the same external network. For instructions, see “Configuring a
virtual Ethernet adapter” on page 130.

v Configure a physical Ethernet adapter on each logical partition, connect the physical Ethernet
adapters on the logical partitions to an external network, and connect the LAN adapter on the
HMC to the same external network.

Related tasks

“Creating additional logical partitions”
You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create
a new logical partition. When you create a logical partition, you also create a partition profile that
contains the resource allocations and settings for the logical partition.

Creating additional logical partitions
You can use the Create Logical Partition wizard on the Hardware Management Console (HMC) to create
a new logical partition. When you create a logical partition, you also create a partition profile that
contains the resource allocations and settings for the logical partition.

Use this procedure only if you are creating logical partitions on a managed system that has already been
partitioned. If you are creating logical partitions on a new or nonpartitioned managed system, you must
test the hardware on your managed system to ensure that the hardware is in working order. Testing the
hardware helps you detect potential problems with your managed system and makes such problems
easier to correct. After you test the hardware, you can create logical partitions on a new or nonpartitioned
managed system by deploying a system plan to the managed system.

You can also create logical partitions on a managed system by deploying a system plan to the managed
system. A system plan automates the process of creating logical partitions and ensures that each logical
partition gets the resources that are specified within the system plan.

Before you create a logical partition, have the System Planning Tool (SPT) output available. Use the
output from this tool as a guide as you start to create partition profiles on your server.

If you plan to create logical partitions that use shared memory, you must first configure the shared
memory pool. For instructions, see “Configuring the shared memory pool” on page 134.
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To create a logical partition and a partition profile on your server using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and click Configuration →

Create Logical Partitions.
3. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition

profile.

After creating your logical partition and partition profile, you must install an operating system. For
installation instructions for the AIX, IBM i, and Linux operating systems, see Working with operating
systems and software applications for POWER6 processor-based systems. For installation instructions for
the Virtual I/O Server, see Installing the Virtual I/O Server and client logical partitions.
Related tasks

“Creating AIX or Linux logical partitions on a new or nonpartitioned managed system” on page 107
Use this procedure to create AIX or Linux logical partitions on a new or nonpartitioned managed system
using the Hardware Management Console (HMC). In this procedure, you will validate the hardware on
the managed system and create the logical partitions on the managed system.
Related information

System plan overview for the HMC
Deploying a system plan using the HMC

Creating additional partition profiles
You can create more than one partition profile for a logical partition using the Hardware Management
Console (HMC). Each partition profile can specify a different amount of system resources and different
logical partition startup attributes. You can change the attributes used by a logical partition by shutting
down the logical partition and restarting the logical partition using a different partition profile.

Before you create a partition profile, ensure that you have the System Planning Tool (SPT) output
available. Use the output from this tool as a guide as you start to create partition profiles on your server.

To create a partition profile using the HMC, follow these steps:
1. In the navigation pane, open Systems Management, open Servers, and click the name of the

managed system.
2. In the work pane, select the logical partition for which you want to create the partition profile, click

the Tasks button, and select Configuration → Manage Profiles.
3. Click Actions → New.
4. Follow the steps in the Create Partition Profile wizard to create the partition profile.

If you created at least one virtual fibre channel adapter, complete the following tasks to connect the
logical partition to its storage:
1. Activate the logical partition. When you activate the logical partition, the HMC assigns a pair of

worldwide port names (WWPNs) to the virtual fibre channel adapter. For instructions, see “Activating
a logical partition” on page 148.

2. Restart the Virtual I/O Server (that provides the connection to a physical fibre channel adapter) or
run the syscfg command. This enables the Virtual I/O Server to recognize the WWPNs of the virtual
fibre channel adapter on the client logical partition For instructions, see “Restarting Virtual I/O Server
logical partitions using the HMC” on page 157.

3. Assign the virtual fibre channel adapter on the client logical partition to a physical port of a physical
fibre channel adapter. For instructions, see “Changing virtual fibre channel for a Virtual I/O Server
using the Hardware Management Console” on page 181.
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Related concepts

“System Planning Tool” on page 89
The System Planning Tool (SPT) helps you design a managed system that can support a specified set of
workloads.

Creating a system profile
You can create a system profile using the Hardware Management Console (HMC). A system profile is an
ordered list of partition profiles. When you activate a system profile, the managed system attempts to
activate the partition profiles in the system profile in the order in which the partition profiles are listed.

System profiles are also useful for validating your partition profiles to ensure that you have not
overcommitted the resources on your managed system.

Restriction: You cannot create system profiles that contain logical partitions that use shared memory.

To create a system profile using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and click Configuration →

Manage System Profiles.
3. Click Actions → New.
4. Enter the name of the new system profile into System profile name.
5. For each partition profile that you want to add to the system profile, open the logical partition to

which the partition profile belongs, select the partition profile, and click Add.
6. Click OK.

Creating an AIX logical partition that uses IBM i virtual I/O resources
You can create an AIX logical partition that uses IBM i virtual I/O resources on IBM Power 520, Power
550, Power 570, and IBM System i models that are managed by a Hardware Management Console
(HMC). This allows you to maximize utilization of the physical hardware and simplify the backup
procedure for your managed system.

To set this up, you must create virtual SCSI adapters that connect the AIX logical partition with the IBM
i. You can then set up IBM i to provide disk resources to the AIX logical partition through the virtual
SCSI connection. You can also create a virtual serial connection between the IBM i logical partition and
the AIX logical partition. A virtual serial connection allows you to connect to the AIX logical partition
from the IBM i logical partition.

You cannot create a AIX logical partition that uses IBM i virtual I/O resources on IBM System p servers.
On IBM System p servers, you can create a Virtual I/O Server logical partition and configure the AIX
logical partition to use the virtual SCSI and virtual Ethernet resources of the Virtual I/O Server logical
partition. You might need to enter an PowerVM Editions activation code to create a Virtual I/O Server
logical partition on your IBM System p server.

To create an AIX logical partition that uses IBM i virtual I/O resources using the HMC, follow these steps
on your HMC:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and choose Configuration →

Create Logical Partition.
3. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition

profile.
4. Create a network server description (NWSD) and network server storage space. For instructions, see

“Creating a network-server description and a network-server storage space for an AIX logical
partition” on page 115.
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5. Set up the console for your AIX partition. For instructions, see “Connecting to the virtual console for
an AIX logical partition” on page 117.

6. Start the NWSD. For instructions, see “Starting the network-server description for an AIX logical
partition” on page 117.

7. Install the AIX operating system on your new logical partition. For instructions, see Installing AIX.
Related information

Virtual I/O Server

Creating a network-server description and a network-server storage space for an AIX logical partition:

A network-server description (NWSD) is an IBM i object that describes the storage resources that are used
by an integrated operating environment. An NWSD can be linked to one or more network-server storage
spaces. Create an NWSD to assign storage to an AIX logical partition that uses IBM i resources.

To create an NWSD and a network-server storage space for an AIX logical partition that uses IBM i
resources, follow these steps:
1. Determine the correct SCSI server resource name.

v If there is only one SCSI server adapter corresponding to a given client logical partition, and that
adapter has its remote logical partition and remote slot configured correctly, you can specify *AUTO
as the RSRCNAME in your NWSD.

v Otherwise, you must determine the actual resource name. At an IBM i command line, type
WRKHDWRSC *CMN, and find a controller resource with type 290B and a converged location code that
corresponds to the SCSI server adapter at the Hardware Management Console (HMC). This
resource name will be used later to specify the SCSI server resource.

2. At an IBM i command line on the logical partition that shares resources, type CRTNWSD and press F4
for prompts.

3. Specify the following information: The default or suggested parameter values are provided within the
parentheses. These settings are relevant only to a logical partition. After the installation, if your root
file system (/) is not installed on the first partition of the first disk, you must set a root parameter.
v NWSD (Provide a name for the NWSD)

v RSRCNAME (*AUTO or the resource name of the SCSI server resource

v TYPE(*GUEST)

v ONLINE (*NO or *YES)

v PARTITION ('Provide the name of your AIX logical partition')

As an alternative to the Partition parameter, you can also specify a logical partition number by
typing PTNNBR(integer) where integer is the number of the logical partition you are specifying.

v CODEPAGE (437)

v TCPPORTCFG (*NONE)

v RSTDDEVRSC (for virtual CD and tape devices) (*NONE)

v SYNCTIME (*TYPE)

v IPLSRC (*NWSSTG)

– You can store a kernel in a disk partition of a virtual disk (a network-server storage space
(NWSSTG)). By specifying the IPLSRC (*NWSSTG) parameter, you are specifying that the AIX
logical partition will start from a disk partition on that virtual disk. The disk partition on the
virtual disk must be formatted as type PReP Boot (type 0x41) and marked as a device that starts.

– To start an NWSD with a kernel from a stream file, set the IPLSRC parameter to *STMF and set the
IPLSTMF parameter to point to the kernel. You must have read access to the file and the path
leading to the file to use the vary on command. This value only loads the kernel. After the
kernel is running, it must find a root file system. In an initial installation, the root file system
might be a RAM disk that is physically attached to the kernel.
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v IPLSTMF (*NONE)

v IPLPARM (*NONE)

v PWRCTL (*YES)

– If you specify PWRCTL (*YES), perform the following steps:
a. Ensure that the server adapter in the IBM i logical partition specifies the remote logical

partition and remote slot in its configuration.
b. Ensure that the client logical partition has the IBM i logical partition as the power-controlling

logical partition in the profile.
c. Ensure before you activate the NWSD that the client logical partition’s profile has been saved

to the server by activating the logical partition from the HMC, even if the client operating
system does not activate correctly because of the absence of virtual devices.

– If you specify PWRCTL(*NO), virtual devices will be available to the logical partition. You must
shut down and restart the logical partition using the HMC.

4. If you use System i Navigator, create the network-server storage space using System i Navigator.
a. Expand My Connections → your server → Network → Windows Administration .
b. Right-click the Disk Drives and select New Disk.
c. In the Disk drive name field, specify the name that you want to give to the disk drive.
d. In the Description field, specify a meaningful description for the disk drive.
e. In the Capacity field, specify the size of the new disk drive in megabytes.
f. Click OK.
g. Continue with step 6.

5. If you use a character-based interface, create the network-server storage space using a character-based
interface:
a. At an IBM i command line, type the command CRTNWSSTG and press F4. The Create NWS

Storage Space (CRTNWSSTG) display opens.
b. In the Network-server storage space field, specify the name you want to give to the storage space.
c. In the Size field, specify the size in megabytes for the new storage space.
d. In the Text description field, specify a meaningful description for the storage space.
e. Press Enter.
f. Continue with step 7.

6. If you use System i Navigator, link the network-server storage space using System i Navigator.
a. Expand My Connections → your server → Network → Windows Administration .
b. Click Disk Drives, right-click an available network-server storage space, and select Add Link.
c. Select the server to which you want to link the network-server storage space.
d. Select the link sequence position you want to use.
e. Select one of the available data access types.
f. Click OK.

The procedure is complete. Do not complete step 7.
7. If you use a character-based interface, link the network-server storage space using a character-based

interface:
a. At an IBM i command line, type the command ADDNWSSTGL and press F4. The Add

Network-Server Storage Link (ADDNWSSTGL) display opens.
b. In the Network server description field, specify the name of the network server description

(NWSD).
c. In the Dynamic storage link field, specify *YES to make the network-server storage space

dynamically available to the logical partition (that is, available without rebooting the AIX logical
partition).
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d. In the Drive sequence number field, specify the link sequence position you want to use.
e. Press Enter.

Connecting to the virtual console for an AIX logical partition:

You can connect to the virtual console for an AIX logical partition so that you can install the operating
system or access the command line interface for the AIX logical partition.

You must have one of the following privileges to use the AIX virtual console:
v Remote Panel
v System Partitions - Administration

The virtual console provides the console function for an AIX server. It is used primarily during the initial
installation of the operating system. The virtual console can also be used to view server errors or to
restore communication to the LAN. This console connection is used prior to configuring TCP/IP.

Any Telnet client can be used as the AIX console. Multiple Telnet clients can share access to the same
virtual console. To connect to a console, use Telnet to connect to port 2301 of the logical partition that is
sharing its resources. TCP/IP must be configured and running on at least one IBM i logical partition.
Complete one of the following procedures:
v If you use IBM Personal Communications, connect to a virtual console using IBM Personal

Communications.
1. Click Start → IBM Personal Communications → Start or Configure Session.
2. From the Customize Communication window, select ASCII as your type of host and select Link

Parameters.
3. From the Telnet ASCII window, enter the host name or the IP address of the logical partition that is

sharing its resources, and enter port number 2301 of the logical partition sharing its resources. Click
OK.

4. If you are not using an Integrated xSeries® Server, go to the next step. If you are using both AIX
logical partitions and Integrated xSeries Server consoles, select IBM i Guest Partition Consoles
from the IBM i Virtual Consoles window.

5. From the IBM i Guest Partition Consoles window, select the logical partition to which you want to
connect as the console.

6. Enter the IBM i service tools ID and password to connect to the AIX logical partition.
v If you use Telnet, connect to the virtual console using Telnet from an MS-DOS command prompt.

1. From an MS-DOS command prompt, use the Telnet command to connect to your server and port
2301 (telnet xxxxxx 2301).

2. If you are not using an Integrated xSeries Server, go to the next step. If you are using both AIX
logical partitions and Integrated xSeries Server consoles, select IBM i Guest Partition Consoles
from the IBM i Virtual Consoles window.

3. From the IBM i Guest Partition Consoles window, select the logical partition to which you want to
connect as the console.

4. Enter the IBM i service tools ID and password to connect to the AIX logical partition.

Starting the network-server description for an AIX logical partition:

You can start the network-server description (NWSD) for an AIX logical partition that uses IBM i
resources to make the resources defined in the NWSD available to the AIX logical partition.

To start (vary on) the NWSD for an AIX logical partition, complete the following tasks:
1. If you use System i Navigator, start the NWSD using System i Navigator.

a. Click Network → Windows Administration → Integrated xSeries Servers
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b. Right-click the name of the NWSD that you want to start.
c. Click Start.

2. If you use the character-based interface, start the NWSD using the character-based interface:
a. Type WRKCFGSTS *NWS and press Enter.
b. Type 1 next to the NWSD that you want to start and press Enter.

Creating an IBM i logical partition that uses IBM i virtual I/O resources
You can create an IBM i logical partition that uses IBM i virtual I/O resources on IBM Power 520, Power
550, Power 570, and IBM System i POWER6 processor-based models that are managed by a Hardware
Management Console (HMC). This allows you to maximize utilization of the physical hardware and
simplify the backup procedure for your managed system.

To set up an IBM i logical partition that uses IBM i virtual I/O resources, configure the following items:
v You must create a virtual server SCSI adapter for the IBM i logical partition that provides virtual SCSI

disk resources, and create a virtual client SCSI adapter for the IBM i that uses virtual SCSI disk
resources. You can then set up the IBM i logical partition with the virtual server SCSI adapter to
provide disk resources to the IBM i logical partition with the virtual client SCSI adapter through the
virtual SCSI connection.

v You can create a virtual serial connection between the IBM i logical partition that provides the virtual
resources and the IBM i logical partition that uses the virtual resources. A virtual serial connection
allows you to connect to the IBM i logical partition that uses the virtual resources from the IBM i
logical partition that provides the virtual resources.

v If you want to use virtual Ethernet, create two virtual Ethernet adapters on the IBM i logical partition
that uses virtual I/O resources. Both virtual Ethernet adapters must be set to connect to a virtual
Ethernet adapter on the IBM i logical partition that provides the virtual I/O resources. In other words,
all three virtual Ethernet adapters must be set to the same virtual LAN ID.

Both logical partitions must use IBM i V6R1M0 or later.

Alternatively, you can create a Virtual I/O Server logical partition and configure the IBM i logical
partition to use the virtual SCSI and virtual Ethernet resources of the Virtual I/O Server logical partition.
You might need to enter a PowerVM Editions activation code to create a Virtual I/O Server logical
partition on your server.

To create an IBM i logical partition that uses IBM i virtual I/O resources using the HMC, follow these
steps on your HMC:
1. Create a virtual server SCSI adapter on the IBM i logical partition that will provide virtual I/O

resources to the new IBM i logical partition (if there is not already an available virtual server SCSI
adapter). To create the virtual server SCSI adapter, complete the following:
a. In the navigation pane, open Systems Management, open Servers, and click the managed system

on which the IBM i logical partition resides.
b. Select the IBM i logical partition that will provide virtual I/O resources to the new IBM i logical

partition, click the Tasks button, and choose Dynamic Logical Partitioning → Virtual Adapters.
c. Click Actions and choose Create → SCSI Adapter.
d. In Type of adapter, select Server, and click OK.
e. Click OK. Ensure that you also create the virtual server SCSI adapter within the partition profile

for the IBM i logical partition that provides virtual I/O resources so that the virtual server SCSI
adapter continues to exist after you restart the IBM i logical partition. When you create the virtual
server SCSI adapter within the partition profile, specify the logical partition and slot of the virtual
client SCSI adapter for better performance. For more information, see “Changing partition profile
properties” on page 159.

2. In the navigation pane, open Systems Management and click Servers.
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3. In the work pane, select the managed system, click the Tasks button, and choose Configuration →
Create Logical Partition.

4. Follow the steps in the Create Logical Partition wizard to create the logical partition and partition
profile of the IBM i logical partition that uses IBM i virtual I/O resources. Review the following
points and bear them in mind when using the Create Logical Partition wizard:
v At the step where you create virtual adapters, create a virtual client SCSI adapter for the new

logical partition, and specify that it is a required adapter. Also, if you want to use virtual Ethernet
on the new logical partition, create two virtual Ethernet adapters on the new logical partition. Both
virtual Ethernet adapters on the IBM i logical partition that uses virtual I/O resources must be set
to connect to a virtual Ethernet adapter on the IBM i logical partition that provides the virtual I/O
resources. In other words, all three virtual Ethernet adapters must be set to the same virtual LAN
ID.

v At the step where you select the load source device for the new logical partition, select Virtual
Adapter in the Adapter Type field and choose the virtual client SCSI adapter that you created for
the new logical partition.

v At the step where you select the alternate restart device for the new logical partition, you can select
the same virtual client SCSI adapter as the adapter used by the load source device if you plan to
use virtual tape or virtual optical disk for your alternate restart device.

5. Create a network server description (NWSD) and network-server storage space on the IBM i logical
partition that provides resources to the other IBM i logical partition. For more information, see
“Creating a network-server description and a network-server storage space for an IBM i logical
partition that uses IBM i resources.”

6. Connect to the console for the IBM i logical partition that uses the virtual I/O resources. For more
information, see “Connecting to the virtual console for an IBM i logical partition that uses IBM i
virtual I/O resources” on page 122.

7. Start the NWSD. For more information, see “Starting the network-server description for an IBM i
logical partition that uses IBM i virtual I/O resources” on page 122.

8. Install the IBM i operating system on your new logical partition. For installation procedures, see
Installing IBM i and related software on a new system or logical partition.

Related information

Virtual I/O Server

Creating a network-server description and a network-server storage space for an IBM i logical
partition that uses IBM i resources:

A network-server description (NWSD) is an IBM i object that describes the storage resources that are used
by an integrated operating environment. An NWSD can be linked to one or more network-server storage
spaces. Create an NWSD to assign storage to an IBM i logical partition that uses IBM i virtual I/O
resources.

If you assign multiple NWSDs to an IBM i logical partition that uses IBM i virtual I/O resources, ensure
that only one of those NWSDs is set to provide virtual optical disk resources. Restrict the optical devices
on all of the other NWSDs by adding RSTDDEVRSC(*ALLOPT) to the CRTNWSD parameters for those NWSDs.

To create an NWSD and a network-server storage space for an IBM i logical partition that uses IBM i
resources, follow these steps:
1. Determine the correct SCSI server resource name.

v If there is only one SCSI server adapter corresponding to a given client logical partition, and that
adapter has its remote logical partition and remote slot configured correctly, you can specify *AUTO
as the RSRCNAME in your NWSD.

v Otherwise, you must determine the actual resource name. At an IBM i command line on the IBM i
logical partition that provides virtual resources, type WRKHDWRSC *CMN, and find a controller resource
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with type 290B and a converged location code that corresponds to the SCSI server adapter at the
Hardware Management Console (HMC). This resource name will be used later to specify the SCSI
server resource.

2. At an IBM i command line on the logical partition that provides resources, type CRTNWSD to create a
network server description, and press F4 for prompts.

3. Specify the following information: The default or suggested parameter values are provided within the
parentheses. These settings are relevant only to a logical partition. After the installation, if your root
file system (/) is not installed on the first partition of the first disk, you must set a root parameter.
v NWSD (Provide a name for the NWSD)

v RSRCNAME (*AUTO or the resource name of the SCSI server resource)

v TYPE(*GUEST *OPSYS)

v ONLINE (*NO or *YES)

v PARTITION ('Provide the name of your IBM i logical partition that uses IBM i resources')

As an alternative to the Partition parameter, you can also specify a logical partition number by
typing PTNNBR(integer) where integer is the number of the logical partition you are specifying.

v CODEPAGE (437)

v TCPPORTCFG (*NONE)

v RSTDDEVRSC (for virtual CD and tape devices) (*NONE for the NWSD that is to provide
virtual optical disc resources, *ALLOPT for all other NWSDs)

v SYNCTIME (*TYPE)

v IPLSRC (*NWSSTG)

– You can store a kernel in a disk partition of a virtual disk (a network-server storage space
(NWSSTG)). By specifying the IPLSRC (*NWSSTG) parameter, you are specifying that the IBM i
logical partition will start from a disk partition on that virtual disk. The disk partition on the
virtual disk must be formatted as type PReP Boot (type 0x41) and marked as a device that starts.

– To start an NWSD with a load source from a stream file, set the IPLSRC parameter to *STMF and
set the IPLSTMF parameter to point to the load source. You must have read access to the file and
the path leading to the file to use the vary on command.

v IPLSTMF (*NONE)

v IPLPARM (*NONE)

v PWRCTL (*YES)

– If you specify PWRCTL (*YES), perform the following steps:
a. Ensure that the server adapter in the IBM i logical partition that provides the virtual

resources specifies the remote logical partition and remote slot in its configuration.
b. Ensure that the client logical partition has the IBM i logical partition that provides the virtual

resources as the power-controlling logical partition in the profile.
c. Ensure before you activate the NWSD that the partition profile for the IBM i logical partition

that uses IBM i virtual I/O resources has been saved by activating the logical partition from
the HMC, even if the logical partition does not activate correctly because of the absence of
virtual devices.

– If you specify PWRCTL(*NO), virtual devices will be available to the logical partition. You must
shut down and restart the logical partition using the HMC.
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4. Create the network-server storage space using the interface that you prefer.

Interface Actions

System i Navigator 1. Expand My Connections → your server → Network →
Windows Administration .

2. Right-click the Disk Drives and select New Disk.

3. In the Disk drive name field, specify the name that
you want to give to the disk drive.

4. In the Description field, specify a meaningful
description for the disk drive.

5. In the Capacity field, specify the size of the new disk
drive in megabytes.

6. Click OK.

IBM i character-based interface 1. At an IBM i command line on the IBM i logical
partition that provides the virtual I/O resources, type
the command CRTNWSSTG and press F4. The Create
NWS Storage Space (CRTNWSSTG) display opens.

2. In the Network-server storage space field, specify the
name you want to give to the storage space.

3. In the Size field, specify the size in megabytes for the
new storage space.

4. In the Format field, specify *OPEN.

5. In the Text description field, specify a meaningful
description for the storage space.

6. Press Enter.

5. List the network server storage spaces on the logical partition using the Work with Network Server
Storage Spaces command.

6. If you use System i Navigator, link the network-server storage space using System i Navigator.

Interface Actions

System i Navigator 1. Expand My Connections → your server → Network →
Windows Administration .

2. Click Disk Drives, right-click an available
network-server storage space, and select Add Link.

3. Select the server to which you want to link the
network-server storage space.

4. Select the link sequence position you want to use.

5. Select one of the available data access types.

6. Click OK.
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Interface Actions

IBM i character-based interface 1. At an IBM i command line on the IBM i logical
partition that provides the virtual I/O resources, type
the command ADDNWSSTGL and press F4. The Add
Network-Server Storage Link (ADDNWSSTGL)
display opens.

2. In the Network server description field, specify the
name of the network server description (NWSD).

3. In the Dynamic storage link field, specify *YES to
make the network-server storage space dynamically
available to the IBM i logical partition that uses IBM i
virtual I/O resources (that is, available without
restarting the IBM i logical partition).

4. In the Drive sequence number field, specify the link
sequence position you want to use.

5. Press Enter.

Connecting to the virtual console for an IBM i logical partition that uses IBM i virtual I/O resources:

You can connect to the virtual console for an IBM i logical partition that uses IBM i virtual I/O resources
so that you can install the operating system or access the command line interface for the IBM i logical
partition that uses IBM i virtual I/O resources.

The virtual console provides the console function for an IBM i logical partition that uses IBM i virtual
I/O resources. It is used primarily during the initial installation of the operating system. The virtual
console can also be used to view server errors or to restore communication to the LAN. This console
connection is used prior to configuring TCP/IP.
1. In the navigation pane, open Systems Management, open Servers, and click the server on which the

IBM i logical partition that uses IBM i virtual I/O resources resides.
2. In the work pane, select the IBM i logical partition that uses IBM i virtual I/O resources, click the

Tasks button, and choose Console Window → Open Dedicated 5250 Console..

Starting the network-server description for an IBM i logical partition that uses IBM i virtual I/O
resources:

You can start the network-server description (NWSD) for an IBM i logical partition that uses IBM i
resources to make the resources defined in the NWSD available to the IBM i logical partition that uses
IBM i resources.

To start (vary on) the NWSD for an IBM i logical partition that uses IBM i resources, complete the
following tasks:
1. If you use System i Navigator, start the NWSD using System i Navigator.

a. Click Network → Windows Administration → Integrated xSeries Servers

b. Right-click the name of the NWSD that you want to start.
c. Click Start.

2. If you use the character-based interface, start the NWSD using the character-based interface:
a. Type WRKCFGSTS *NWS and press Enter.
b. Type 1 next to the NWSD that you want to start and press Enter.
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Creating a Linux logical partition that uses IBM i virtual I/O resources
You can create a Linux logical partition that uses IBM i virtual I/O resources on IBM Power 520, Power
550, Power 570, and IBM System i models that are managed by a Hardware Management Console
(HMC). This allows you to maximize utilization of the physical hardware and simplify the backup
procedure for your managed system.

To set this up, you must create virtual SCSI adapters that connect the logical partitions with each other.
You can then set up the IBM i logical partition to provide disk resources to the Linux logical partition
through the virtual SCSI connection. You can also create a virtual serial connection between the IBM i
logical partition and the Linux logical partition. A virtual serial connection allows you to connect to the
Linux logical partition from the IBM i logical partition.

You cannot create a Linux logical partition that uses IBM i virtual I/O resources on IBM System p
servers. On IBM System p servers, you can create a Virtual I/O Server logical partition and configure the
Linux logical partition to use the virtual SCSI and virtual Ethernet resources of the Virtual I/O Server
logical partition. You might need to enter an PowerVM Editions activation code to create a Virtual I/O
Server logical partition on your IBM System p server.

To create a Linux logical partition that uses IBM i virtual I/O resources using the HMC, follow these
steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and choose Configuration →

Create Logical Partition.
3. Follow the steps in the Create Logical Partition wizard to create a logical partition and a partition

profile. When you reach the step that allows you to create virtual adapters, create a virtual client SCSI
adapter for the new logical partition.

4. Create a network server description (NWSD) and network server storage space. For instructions, see
“Creating an NWSD and a network-server storage space for a Linux logical partition.”

5. Set up the console for your Linux logical partition. For instructions, see “Connecting to the virtual
console for a Linux logical partition” on page 125.

6. Start the NWSD. For instructions, see “Starting the network-server description for a Linux logical
partition” on page 126.

7. Install the Linux operating system on your new logical partition. For instructions, see Installing Linux.
Related information

Virtual I/O Server

Creating an NWSD and a network-server storage space for a Linux logical partition:

A network-server description (NWSD) is an IBM i object that describes the storage resources that are used
by an integrated operating environment. An NWSD can be linked to one or more network-server storage
spaces. Create an NWSD to assign storage to a Linux logical partition that uses IBM i resources.

To create an NWSD and a network-server storage space for a Linux logical partition that uses IBM i
resources, follow these steps:
1. Determine the correct SCSI server resource name.

v If there is only one SCSI server adapter corresponding to a given client logical partition, and that
adapter has its remote logical partition and remote slot configured correctly, you can specify
*AUTO as the RSRCNAME in your NWSD.

v Otherwise, you must determine the actual resource name. At an IBM i command line, type
WRKHDWRSC *CMN, and find a controller resource with type 290B and a converged location code that
corresponds to the SCSI server adapter at the Hardware Management Console (HMC). This
resource name will be used later to specify the SCSI server resource.
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2. At an IBM i command line on the logical partition that shares resources, type CRTNWSD and press F4
for prompts.

3. Specify the following information. The default or suggested parameter values are provided within the
parentheses. These settings are relevant only to a logical partition. After the installation, if your root
file system (/) is not installed on the first partition of the first disk, you must set a root parameter.
v NWSD (Provide a name for the NWSD)

v RSRCNAME (*AUTO or the resource name of the SCSI server resource

v TYPE(*GUEST)

v ONLINE (*NO or *YES)

v PARTITION ('Provide the name of your Linux logical partition')

As an alternative to the Partition parameter, you can also specify a logical partition number by
typing PTNNBR(integer) where integer is the number of the logical partition you are specifying.

v CODEPAGE (437)

v TCPPORTCFG (*NONE)

v RSTDDEVRSC (for virtual CD and tape devices) (*NONE)

v SYNCTIME (*TYPE)

v IPLSRC (*NWSSTG)

– You can store a kernel in a disk partition of a virtual disk (a network-server storage space
(NWSSTG)). By specifying the IPLSRC (*NWSSTG) parameter, you are specifying that the Linux
logical partition will start from a disk partition on that virtual disk. The disk partition on the
virtual disk must be formatted as type PReP Boot (type 0x41) and marked as a device that starts.
You can format a disk partition as type PReP Boot by using the Linux fdisk command with the -t
option. You can specify that the disk partition starts by using the fdisk command with the -a
option.

– To start an NWSD with a kernel from a stream file, set the IPLSRC parameter to *STMF and set the
IPLSTMF parameter to point to the kernel. You must have read access to the file and the path
leading to the file to use the vary on command. This value only loads the kernel. After the
kernel is running, it must find a root file system. In an initial installation, the root file system
might be a RAM disk that is physically attached to the kernel.

v IPLSTMF (*NONE)

v IPLPARM (*NONE)

v PWRCTL (*YES)

– If you specify PWRCTL (*YES), perform the following steps:
a. Ensure that the server adapter in the IBM i logical partition specifies the remote logical

partition and remote slot in its configuration.
b. Ensure that the client logical partition has the IBM i logical partition as the power-controlling

logical partition in the profile.
c. Ensure before you activate the NWSD that the client logical partition’s profile has been saved

to the server by activating the logical partition from the HMC, even if the client operating
system does not activate correctly because of the absence of virtual devices.

– If you specify PWRCTL(*NO), virtual devices will be available to the logical partition. You must
shut down and restart the logical partition using the HMC.

4. If you use System i Navigator, create the network-server storage space using System i Navigator.
a. Expand My Connections → your server → Network → Windows Administration .
b. Right-click the Disk Drives and select New Disk.
c. In the Disk drive name field, specify the name that you want to give to the disk drive.
d. In the Description field, specify a meaningful description for the disk drive.
e. In the Capacity field, specify the size of the new disk drive in megabytes. Refer to your preferred

Linux distributor installation documentation to determine the size you want to use.
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f. Click OK.
g. Continue with step 6.

5. If you use a character-based interface, create the network-server storage space using the
character-based interface:
a. At an IBM i command line, type the command CRTNWSSTG and press F4. The Create NWS

Storage Space (CRTNWSSTG) display opens.
b. In the Network-server storage space field, specify the name you want to give to the storage space.
c. In the Size field, specify the size in megabytes for the new storage space. Refer to your preferred

Linux distributor installation documentation to determine the size you want to use.
d. In the Text description field, specify a meaningful description for the storage space.
e. Press Enter.
f. Continue with step 7.

6. If you use System i Navigator, link the network-server storage space using System i Navigator:
a. Expand My Connections → your server → Network → Windows Administration .
b. Click Disk Drives, right-click an available network-server storage space, and select Add Link.
c. Select the server to which you want to link the network-server storage space.
d. Select the link sequence position you want to use.
e. Select one of the available data access types.
f. Click OK.

The procedure is complete. Do not complete step 7.
7. If you use a character-based interface, link the network-server storage space using the character-based

interface:
a. At an IBM i command line, type the command ADDNWSSTGL and press F4. The Add

Network-Server Storage Link (ADDNWSSTGL) display opens.
b. In the Network server description field, specify the name of the network server description

(NWSD).
c. In the Dynamic storage link field, specify *YES to make the network-server storage space

dynamically available to the logical partition (that is, available without rebooting the Linux logical
partition).

d. In the Drive sequence number field, specify the link sequence position you want to use. If you
want the system to find the next available position for you, specify *CALC.

e. Press Enter.

Connecting to the virtual console for a Linux logical partition:

You can connect to the virtual console for a Linux logical partition so that you can install the operating
system or access the command line interface for the Linux logical partition.

You must have one of the following privileges to use the Linux virtual console.
v Remote Panel
v System Partitions - Administration

The virtual console provides the console function for a Linux server. It is used primarily during the initial
installation of the operating system. The virtual console can also be used to view server errors or to
restore communication to the LAN. This console connection is used prior to configuring TCP/IP.

Any Telnet client can be used as the Linux console. Multiple Telnet clients can share access to the same
virtual console. To connect to a console, use Telnet to connect to port 2301 of the logical partition that is
sharing its resources. TCP/IP must be configured and running on at least one IBM i logical partition.
Complete one of the following procedures:
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v If you use IBM Personal Communications, connect to a virtual console using IBM Personal
Communications.
1. Click Start → IBM Personal Communications → Start or Configure Session.
2. From the Customize Communication window, select ASCII as your type of host and select Link

Parameters.
3. From the Telnet ASCII window, enter the host name or the IP address of the logical partition that is

sharing its resources, and enter port number 2301 of the logical partition sharing its resources. Click
OK.

4. If you are not using an Integrated xSeries Server, go to the next step. If you are using both Linux
logical partitions and Integrated xSeries Server consoles, select IBM i Guest Partition Consoles
from the IBM i Virtual Consoles window.

5. From the IBM i Guest Partition Consoles window, select the logical partition to which you want to
connect as the console.

6. Enter the IBM i service tools ID and password to connect to the Linux logical partition.
v If you use Telnet, connect to the virtual console using Telnet from an MS-DOS command prompt.

1. From an MS-DOS command prompt, use the Telnet command to connect to your server and port
2301 (telnet xxxxxx 2301).

2. If you are not using an Integrated xSeries Server, go to the next step. If you are using both Linux
logical partitions and Integrated xSeries Server consoles, select IBM i Guest Partition Consoles
from the IBM i Virtual Consoles window.

3. From the IBM i Guest Partition Consoles window, select the logical partition to which you want to
connect as the console.

4. Enter the IBM i service tools ID and password to connect to the Linux logical partition.

Starting the network-server description for a Linux logical partition:

You can start the network-server description (NWSD) for a Linux logical partition that uses IBM i
resources to make the resources defined in the NWSD available to the Linux logical partition.

To start (vary on) the NWSD for a Linux logical partition, complete the following steps:
1. If you use System i Navigator, start the NWSD using System i Navigator.

a. Click Network → Windows Administration → Integrated xSeries Servers

b. Right-click the name of the NWSD that you want to start.
c. Click Start.

2. If you use the character-based interface, start the NWSD using a character-based interface:
a. Type WRKCFGSTS *NWS and press Enter.
b. Type 1 next to the NWSD that you want to start and press Enter.

Designating the service logical partition for your managed system
The service logical partition is the IBM i logical partition on an IBM System i server that you can configure
to apply server firmware updates to the service processor or to the hypervisor and to communicate
server common hardware errors to IBM. These abilities are useful if the Hardware Management Console
(HMC) is undergoing maintenance or is otherwise unable to perform these functions.

The preferred method for applying server firmware updates and communicating server common
hardware errors to IBM is by using the HMC.

IBM System p servers do not have a service logical partition. If an IBM System p server is managed by
an HMC, then you must use the HMC to update the server firmware, and the server can contact service
and support only through the HMC. If you use an HMC to manage IBM System p servers, then use a
backup HMC to ensure that the servers have redundant methods for contacting service and support and
for applying fixes.
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You can designate only one logical partition at a time as the service logical partition for your managed
system. The service logical partition for your IBM System i server must be an IBM i logical partition.

Before you can designate a logical partition as the service logical partition for your managed system, you
must shut down the logical partition. You must also shut down the logical partition before you remove
the service logical partition designation from the logical partition. If you want to change the service
logical partition from one logical partition to another logical partition, you must shut down both logical
partitions before using this procedure.

Note: You must designate a service logical partition on a server only after you use the HMC to create,
change, delete, copy, or activate any logical partitions on the managed system. You can set up the
operating system on an unpartitioned server to contact service and support, and you can use the
operating system on an unpartitioned server to apply server firmware updates.

To designate one of your logical partitions as the service logical partition for your managed system using
the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system whose service logical partition you want to designate,

click the Tasks button, and select Properties.
3. In the Service partition field, select the logical partition that you want to designate as the service

logical partition. If you do not want to designate another logical partition as the service logical
partition, select None.

4. Click OK.
Related tasks

“Shutting down and restarting logical partitions” on page 150
You can shut down and restart logical partitions running on systems that are managed by a Hardware
Management Console (HMC).
“Deleting a logical partition” on page 129
You can use the Hardware Management Console (HMC) to delete a logical partition and all of the
partition profiles associated with the logical partition.

Resetting the managed system to a nonpartitioned configuration
You can use the Hardware Management Console (HMC) and the Advanced System Management
Interface (ASMI) to erase all of your logical partitions and reset the managed system to a nonpartitioned
configuration. When you reset the managed system, all of the physical hardware resources are assigned
to a single logical partition. This allows you to use the managed system as if it were a single,
nonpartitioned server.

Attention: By resetting a partitioned managed system to a nonpartitioned configuration, you will lose
all of your logical partition configuration data. However, resetting the managed system does not erase the
operating systems and data from disk units on that managed system.

Before you reset the managed system, ensure that the hardware placement in the managed system
supports a nonpartitioned configuration. If the hardware placement in the managed system does not
support a nonpartitioned configuration, you must move the hardware so that the hardware placement
supports a nonpartitioned configuration. For more information about how to place the hardware in your
managed system to support a nonpartitioned configuration, contact your marketing representative or
business partner.

Also, if you plan to use an operating system that is already installed on one of the logical partitions on
the managed system (instead of reinstalling the operating system after you reset the managed system),
consider how the console used by that operating system will change when you reset the managed
system. If the operating system that you want to use is AIX, log into AIX and enable the login prompt for
the virtual serial port vty0 using either the System Management Interface Tool (SMIT) or the chdev
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command. You can then reset the managed system, use a physical serial console to log into AIX, and use
SMIT or the chcons command to change the console device to the console device you want to use.

You must have an ASMI login profile with an administrator authority level.

Parts of this procedure must be performed at your HMC (not connected remotely). Ensure that you have
physical access to the HMC before you begin.

To reset a managed system with logical partitions to a nonpartitioned configuration using the HMC,
follow these steps:
1. Shut down all logical partitions on your managed system using operating system procedures. For

more information about shutting down logical partitions using operating system procedures, see the
following information:
v For logical partitions running AIX, see “Shutting down AIX logical partitions” on page 150.
v For logical partitions running IBM i, see “Shutting down IBM i logical partitions” on page 151.
v For logical partitions running Linux, see “Shutting down Linux logical partitions” on page 155.
v For logical partitions running Virtual I/O Server, see “Shutting down Virtual I/O Server logical

partitions using the HMC” on page 156.
2. If the managed system powered off automatically when you shut down the last logical partition,

power on the managed system to the Standby state. Complete the following:
a. In the navigation pane of your HMC, open Systems Management and click Servers.
b. In the work pane, select the managed system, click the Tasks button, and click Operations →

Power On.
c. Select the power-on mode of Partition Standby and click OK.
d. Wait until the work pane displays a Standby state for the managed system.

3. Initialize the profile data on the HMC. Complete the following:
a. In the work pane, select the managed system, click the Tasks button, and click Configuration →

Manage Partition Data → Initialize.
b. Click Yes to confirm.

4. Clear the logical partition configuration data on the managed system. Complete the following at your
HMC (not connected remotely):
a. In the navigation pane, click HMC Management.
b. In the work pane, click Open Restricted Shell Terminal.
c. Type the command: lpcfgop -m managed_system_name -o clear, where managed_system_name is

the name of the managed system as it is displayed in the work pane.
d. Enter 1 to confirm. This step takes several seconds to complete.

5. Optional: If you no longer intend to manage the system using the HMC, remove the connection
between the HMC and the managed system. To remove the connection between the HMC and the
managed system, complete the following:
a. In the work pane, select the managed system, click the Tasks button, and click Connections →

Reset or Remove Connection.
b. Select Remove connection and click OK.

6. Access the Advanced System Management Interface (ASMI) using a Web browser on a PC. If you do
not already have a PC that is set up to access the ASMI on the managed system, you need to set up
the PC at this point. For instructions, see Accessing the ASMI using a Web browser.

7. On the ASMI Welcome pane, log in using the admin user ID (enter admin into User ID, enter the
admin password into Password, and click Log In).

8. In the navigation pane, expand Power/Restart Control and click Power On/Off System.
9. Set Boot to server firmware to Running.
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10. Click Save settings and power off.
11. Click Power On/Off System periodically to refresh the window. Repeat this step until Current

system power state: Off is displayed in the navigation pane.
12. Click Save settings and power on.
13. Wait for the managed system to restart. It can take several minutes for the managed system and

operating system to restart completely.
Related concepts

“Manufacturing default configuration” on page 6
The manufacturing default configuration is the initial single partition setup of the managed system as
received from your service provider.

Deleting a logical partition
You can use the Hardware Management Console (HMC) to delete a logical partition and all of the
partition profiles associated with the logical partition.

You cannot delete a logical partition if it is the service logical partition of your managed system. Before
you can delete such a logical partition, you must designate another logical partition as the service logical
partition of your managed system or remove the service logical partition designation from the logical
partition.

Before you delete a logical partition, complete the following steps:
1. Shut down the logical partition that you plan to delete. For instructions, see “Shutting down and

restarting logical partitions” on page 150.
2. If the logical partition that you plan to delete is a Virtual I/O Server logical partition that is assigned

to the shared memory pool (hereafter referred to as a paging VIOS partition), remove the paging VIOS
partition from the shared memory pool. For instructions, see “Removing a paging VIOS partition from
the shared memory pool” on page 144.

When you delete a logical partition that uses shared memory (hereafter referred to as a shared memory
partition), the HMC automatically performs the following tasks:
v The HMC removes the shared memory partition from the shared memory pool.
v The HMC returns the physical memory that was allocated to the shared memory partition for its I/O

devices to the shared memory pool so that the hypervisor can allocate the physical memory to other
shared memory partitions.

v The HMC releases the paging space device that was allocated to the shared memory partition so that it
becomes available for other shared memory partitions to use.

Attention: This procedure erases the logical partition and the logical partition configuration data stored
on the partition profiles.

To delete a logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the partition profile is located.
2. In the work pane, select the logical partition on which the partition profile is located, click the Tasks

button, and click Operations → Delete.
3. Click OK to confirm.
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Related tasks

“Designating the service logical partition for your managed system” on page 126
The service logical partition is the IBM i logical partition on an IBM System i server that you can configure
to apply server firmware updates to the service processor or to the hypervisor and to communicate
server common hardware errors to IBM. These abilities are useful if the Hardware Management Console
(HMC) is undergoing maintenance or is otherwise unable to perform these functions.

Configuring virtual resources for logical partitions
You can use the Hardware Management Console (HMC) to configure virtual resources such as virtual
Ethernet adapters, Host Ethernet Adapter, and shared processor pools. Configure virtual resources to help
optimize the use of physical system resources.

Configuring a virtual Ethernet adapter
You can configure a virtual Ethernet adapter dynamically for a running logical partition by using the
Hardware Management Console (HMC). Doing so will connect the logical partition to a virtual LAN.

You can dynamically configure a virtual Ethernet adapter for a Linux logical partition only if the
following conditions are met:
v A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical

partition. Distributions that support dynamic logical partitioning include SUSE Linux Enterprise Server
9 and later versions.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

If you plan to configure an Ethernet adapter for a logical partition that uses shared memory (hereafter
referred to as a shared memory partition), you might need to adjust the amount of I/O entitled memory
assigned to the shared memory partition before you configure the adapter:
v If the I/O entitled memory mode of the shared memory partition is set to the auto mode, you do not

need to take action. When you configure the new Ethernet adapter, the HMC automatically increases
the I/O entitled memory of the shared memory partition to accommodate the new adapter.

v If the I/O entitled memory mode of the shared memory partition is set to the manual mode, you must
increase the I/O entitled memory that is assigned to the shared memory partition to accommodate the
new adapter. For instructions, see “Adding and removing I/O entitled memory dynamically to and
from a shared memory partition” on page 166.

To configure a virtual Ethernet adapter dynamically for a running logical partition using the HMC, follow
these steps:
1. In the navigation pane, open Systems Management → Servers, and click the system on which the

logical partition is located.
2. In the work pane, select the logical partition on which you want to configure the virtual Ethernet

adapter, click the Tasks button, and click Dynamic Logical Partitioning → Virtual Adapters.
3. Click Actions and choose Create → Ethernet Adapter.
4. Enter the slot number for the virtual Ethernet adapter into Adapter ID.
5. Enter the Port Virtual LAN ID (PVID) for the virtual Ethernet adapter into VLAN ID. The PVID

allows the virtual Ethernet adapter to communicate with other virtual Ethernet adapters that have the
same PVID.

6. Select IEEE 802.1 compatible adapter if you want to configure the virtual Ethernet adapter to
communicate over multiple virtual LANs. If you leave this option unchecked and you want this
logical partition to connect to multiple virtual networks, you must create multiple virtual adapters by
creating additional virtual LAN IDs.

7. Click OK.

130 Logical partitioning

http://www14.software.ibm.com/webapp/set2/sas/f/lopdiags/home.html


After you have finished, access any existing partition profiles for the logical partition and add the virtual
Ethernet adapters to those partition profiles. The virtual Ethernet adapter will be lost if you shut down
the logical partition and activate that logical partition using a partition profile that does not have the
virtual Ethernet adapter in it.
Related concepts

“Virtual Ethernet” on page 57
Virtual Ethernet allows logical partitions to communicate with each other without having to assign
physical hardware to the logical partitions.
Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.
“Adding virtual adapters dynamically” on page 172
You can dynamically add a virtual adapter to a running logical partition using the Hardware
Management Console (HMC).

Configuring a virtual fibre channel adapter
You can configure a virtual fibre channel adapter dynamically for a running logical partition using the
Hardware Management Console (HMC).

A Linux logical partition supports the dynamic addition of virtual fibre channel adapters only if the
DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM tool
package, see the Service and productivity tools for Linux on POWER systems Web site.

If you plan to configure a virtual fibre channel adapter for a logical partition that uses shared memory
(hereafter referred to as a shared memory partition), you might need to adjust the amount of I/O entitled
memory assigned to the shared memory partition before you configure the adapter:
v If the I/O entitled memory mode of the shared memory partition is set to the auto mode, you do not

need to take action. When you configure the new virtual fibre channel adapter, the HMC automatically
increases the I/O entitled memory of the shared memory partition to accommodate the new adapter.

v If the I/O entitled memory mode of the shared memory partition is set to the manual mode, you must
increase the I/O entitled memory that is assigned to the shared memory partition to accommodate the
new adapter. For instructions, see “Adding and removing I/O entitled memory dynamically to and
from a shared memory partition” on page 166.

When you dynamically configure a virtual fibre channel adapter on a client logical partition that uses
Virtual I/O Server resources, the virtual fibre channel adapter is lost when you restart the logical
partition because the partition profile does not include the virtual fibre channel adapter. You cannot add
the virtual fibre channel adapter to a partition profile after you dynamically configure it on the logical
partition because the virtual fibre channel adapter that you add to the partition profile is assigned a
different pair of worldwide port names (WWPNs) than the virtual fibre channel adapter that you
dynamically configured on the logical partition. If you want to include the virtual fibre channel adapter
in a partition profile, then do not dynamically configure the virtual fibre channel adapter on the logical
partition. Instead, create the virtual fibre channel adapter in a partition profile and then start the logical
partition using that partition profile. For instructions, see “Changing partition profile properties” on page
159.

To configure a virtual fibre channel adapter dynamically for a running logical partition using the HMC,
follow these steps:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the server on which the logical partition is located.
3. In the work pane, select the logical partition on which you want to configure the virtual fibre channel

adapter.
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4. From the Tasks menu, click Dynamic Logical Partitioning → Virtual Adapters. The Virtual Adapters
window is displayed.

5. Click Actions → Create → Fibre Channel Adapter. The Create Virtual Fibre Channel Adapter window
is displayed.

6. Enter the slot number for the virtual fibre channel adapter into the Adapter field.
7. Select the remote logical partition and enter the ID of the remote virtual fibre channel adapter as

follows:
v If you create a virtual fibre channel adapter on the Virtual I/O Server logical partition, select the

client logical partition that uses this server adapter to connect to a physical port on a physical fibre
channel adapter. Then, enter the ID of the virtual fibre channel adapter on the client logical
partition that uses this server adapter to connect to a physical port on a physical fibre channel
adapter.

v If you create a virtual fibre channel adapter on a client logical partition, select the Virtual I/O
Server logical partition that contains the virtual fibre channel adapter to which this client adapter
connects. Then, enter the ID of the virtual fibre channel adapter on the Virtual I/O Server to which
this client adapter connects.

8. Click OK to close the Create Virtual Fibre Channel Adapter window.
9. Click OK to close the Virtual Adapter window and create the virtual fibre channel adapter. If you

create a virtual fibre channel adapter on a client logical partition, the HMC generates a pair of
WWPNs for the virtual fibre channel adapter. If all of the WWPNs on the server are used, you can
reset the WWPN prefix to add WWPNs to the server. For instructions, see “Obtaining additional
WWPNs for the server” on page 190. After you reset the WWPN prefix, repeat this procedure to add
a virtual fibre channel adapter to a client logical partition.

If you created a virtual fibre channel adapter on a Virtual I/O Server logical partition, complete the
following tasks:
1. Access any existing partition profiles for the Virtual I/O Server logical partition and add the virtual

fibre channel adapter to those partition profiles. The virtual fibre channel adapter is lost when you
shut down the Virtual I/O Server logical partition and activate it using a partition profile that does
not include the virtual fibre channel adapter.

2. Assign the virtual fibre channel adapter to a physical port on the physical fibre channel adapter that
is connected to the physical storage that you want the associated client logical partition to access. For
instructions, see Assigning the virtual fibre channel adapter to a physical fibre channel adapter.

Related concepts

“Virtual fibre channel” on page 59
With N_Port ID Virtualization (NPIV), you can configure the managed system so that multiple logical
partitions can access independent physical storage through the same physical fibre channel adapter.
Related tasks

“Adding virtual adapters dynamically” on page 172
You can dynamically add a virtual adapter to a running logical partition using the Hardware
Management Console (HMC).
“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.
Related information

Redundancy configuration using virtual fibre channel adapters

Configuring physical ports on a Host Ethernet Adapter
You can use a Hardware Management Console (HMC) to configure the properties of each physical port
on a Host Ethernet Adapter (HEA). These properties include port speed, duplex mode, maximum packet
size, flow control setting, and the promiscuous logical partition for unicast packets. The physical port
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properties are also used by the logical ports that are associated with each physical port. HEAs are also
known as Integrated Virtual Ethernet adapters (IVE adapters).

To configure physical ports on an HEA using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system whose HEAs you want to configure, click the Tasks

button, and select Hardware (Information) → Adapters → Host Ethernet.
3. Select the HEA in Choose a Physical Location Code to view / modify that Host Ethernet Adapter’s

information.
4. In the Current Status table, select a physical port that you want to configure and click Configure.
5. Change the HEA physical port configuration settings as necessary and click OK.
6. Repeat steps 4 and 5 for any other physical ports that you want to configure.
7. When you are done configuring physical ports, click OK.

After this procedure is complete, you might need to reconfigure any logical ports that are associated with
the changed physical ports. For example, if you change the maximum packet size on the physical port,
you might also need to access the operating systems that use the resources on that physical port and
change the maximum packet size for the corresponding logical ports.
Related concepts

“Host Ethernet Adapter” on page 66
A Host Ethernet Adapter (HEA) is a physical Ethernet adapter that is integrated directly into the GX+ bus
on a managed system. HEAs offer high throughput, low latency, and virtualization support for Ethernet
connections. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).
Related tasks

“Creating a logical Host Ethernet Adapter for a running logical partition” on page 135
If your managed system has a Host Ethernet Adapter (HEA), you can set up a logical partition to use
HEA resources by using the Hardware Management Console (HMC) to create a logical Host Ethernet
Adapter (LHEA) for the logical partition. A logical Host Ethernet Adapter (LHEA) is a representation of a
physical HEA on a logical partition. An LHEA allows the logical partition to connect to external networks
directly through the HEA. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).

Configuring shared processor pools
If your managed system supports more than one shared processor pool, you can use the Hardware
Management Console (HMC) to configure shared processor pools on your managed system in addition to
the default shared processor pool. These additional shared processor pools allow you to limit the
processor usage of the logical partitions that belong to the shared processor pools. All shared processor
pools other than the default shared processor pool must be configured before you can assign logical
partitions to these shared processor pools.

You can use this procedure only if the managed system supports more than one shared processor pool
and the HMC is at version 7 release 3.2.0, or later.

The default shared processor pool is preconfigured, and you cannot change the properties of the default
shared processor pool.

To configure shared processor pools using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system whose shared processor pools you want to configure,

click the Tasks button, and select Configuration → Shared Processor Pool Management.
3. Click the name of the shared processor pool that you want to configure.
4. Enter the maximum number of processing units that you want the logical partitions in the shared

processor pool to use in the Maximum processing units field. If desired, change the name of the
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shared processor pool in the Pool name field and enter the number of processing units that you want
to reserve for uncapped logical partitions in the shared processor pool in the Reserved processing
units field. (The name of the shared processor pool must be unique on the managed system.) When
you are done, click OK.

5. Repeat steps 3 on page 133 and 4 on page 133 for any other shared processor pools that you want to
configure.

6. Click OK.

After this procedure is complete, assign logical partitions to the configured shared processor pools. You
can assign a logical partition to a shared processor pool at the time that you create the logical partition,
or you can reassign existing logical partitions from their current shared processor pools to the shared
processor pools that you configured using this procedure. For instructions, see “Reassigning logical
partitions to shared processor pools” on page 138.

When you no longer want to use a shared processor pool, you can deconfigure the shared processor pool
by using this procedure to set the maximum number of processing units and reserved number of
processing units to 0. Before you can deconfigure a shared processor pool, you must reassign all logical
partitions that use the shared processor pool to other shared processor pools.

Configuring the shared memory pool
You can configure the size of the shared memory pool, assign paging space devices to the shared memory
pool, and assign one or two Virtual I/O Server logical partitions (that provide access to the paging space
devices) to the shared memory pool using the Hardware Management Console (HMC).

Before you start, complete the following tasks:
1. Enter the activation code for the PowerVM Enterprise Edition. For instructions, see Entering the

activation code for PowerVM Editions using the HMC version 7. The ability to share memory among
multiple logical partitions is known as the PowerVM Active Memory Sharing technology. The
PowerVM Active Memory Sharing technology is available with the PowerVM Enterprise Edition for
which you must obtain and enter a PowerVM Editions activation code.

2. Ensure that your configuration meets the configuration requirements for shared memory. To review
the requirements, see “Configuration requirements for shared memory” on page 90.

3. Complete the required preparation tasks. For instructions, see “Preparing to configure shared
memory” on page 92.

4. Create the Virtual I/O Server (VIOS) logical partitions (hereafter referred to as paging VIOS partitions)
that you plan to assign to the shared memory pool, and then install the Virtual I/O Server. For
instructions, see “Creating additional logical partitions” on page 112 and Installing the Virtual I/O
Server and client logical partitions.

5. Create and configure the paging space devices that are owned by the paging VIOS partitions that you
plan to assign to the shared memory pool. If you plan to use logical volumes as paging space devices,
then create the logical volumes. For instructions, see “Creating a virtual disk for a VIOS logical
partition using the HMC” on page 137.

6. Verify that the HMC is at version 7 release 3.4.2, or later. For instructions, see Upgrading your HMC
software.

7. Ensure that you are a super administrator or operator of the HMC.

If there is not enough physical memory available in the system to allocate to the shared memory pool,
you can release to the hypervisor the physical memory that is currently assigned to logical partitions that
use dedicated memory and that are shutdown. The hypervisor can then assign the released physical
memory to the shared memory pool.

To configure the shared memory pool, complete the following steps using the HMC:
1. In the navigation pane, expand Systems Management and click Servers.
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2. In the work pane, select the server on which you want to configure the shared memory pool.
3. From the Tasks menu, click Configuration → Virtual Resources → Shared Memory Pool Management.

The Shared Memory Pool wizard is displayed.
4. Follow the steps in the Shared Memory Pool wizard to configure the shared memory pool.

Tip: If you expect to see a particular device on the list of eligible devices to add to the shared
memory pool, but the device does not appear, you can run the prepdev command from the Virtual
I/O Server command line to determine why the device does not meet the requirements for paging
space devices and learn what tasks need to be performed on the device to satisfy the requirements.

If a device was used by a logical partition and then the logical partition was removed, the device
might not meet the requirements for a paging space device, even though the logical partition was
removed. The prepdev command detects this situation and provides instructions about how to change
the device so that it meets the requirements for a paging space device.

After you create the shared memory pool, you can create logical partitions that use shared memory. For
instructions, see “Creating additional logical partitions” on page 112.
Related concepts

“Shared memory” on page 25
You can configure your system so that multiple logical partitions share a pool of physical memory. A
shared memory environment includes the shared memory pool, logical partitions that use the shared
memory in the shared memory pool, logical memory, I/O entitled memory, at least one Virtual I/O
Server logical partition, and paging space devices.

Creating a logical Host Ethernet Adapter for a running logical partition
If your managed system has a Host Ethernet Adapter (HEA), you can set up a logical partition to use
HEA resources by using the Hardware Management Console (HMC) to create a logical Host Ethernet
Adapter (LHEA) for the logical partition. A logical Host Ethernet Adapter (LHEA) is a representation of a
physical HEA on a logical partition. An LHEA allows the logical partition to connect to external networks
directly through the HEA. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).

You can add an LHEA dynamically to a running Linux logical partition only if you install Red Hat
Enterprise Linux version 5.1, Red Hat Enterprise Linux version 4.6, or a later version of Red Hat
Enterprise Linux on the logical partition. To add an LHEA to a Linux logical partition with a distribution
other than these distributions, you must shut down the logical partition and reactivate the logical
partition using a partition profile that specifies the LHEA.

If a logical partition is not currently running, you can create an LHEA for the logical partition by
changing the partition profiles for the logical partition.

To create an LHEA for a running logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management, open Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition for which you want to create the LHEA, click the Tasks

button, and select Dynamic Logical Partitioning → Host Ethernet → Add.
3. Select the HEA whose resources you want the logical partition to use in Choose an HEA to select

Logical Ports from.
4. In the table that lists HEA physical ports, select a physical port whose resources you want the logical

partition to use, and click Configure.
5. In the Choose Logical Ports table, select the logical port (LHEA port) that you want the logical

partition to use.
6. Set the logical port to accept packets with any virtual LAN ID (VLAN ID) or to accept only packets

with specific VLAN IDs.

Logical partitioning 135



v If you want the logical port to accept packets with any VLAN ID, select Allow all VLAN IDs.
v If you want the logical port to accept only packets with specific VLAN IDs, enter each VLAN ID

into VLAN to add and click Add. You can repeat this step to allow up to 20 VLAN IDs to be
accepted on the logical port.

7. Click OK.
8. Repeat steps 4 on page 135 through 7 for each additional physical port whose resources you want the

logical partition to use.
9. Adjust the values in Timeout (minutes) and Detail level if necessary and click OK.

When you are done, one or more new Ethernet adapters will be visible to the operating system of the
logical partition.
Related concepts

“Host Ethernet Adapter” on page 66
A Host Ethernet Adapter (HEA) is a physical Ethernet adapter that is integrated directly into the GX+ bus
on a managed system. HEAs offer high throughput, low latency, and virtualization support for Ethernet
connections. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).
Related tasks

“Configuring physical ports on a Host Ethernet Adapter” on page 132
You can use a Hardware Management Console (HMC) to configure the properties of each physical port
on a Host Ethernet Adapter (HEA). These properties include port speed, duplex mode, maximum packet
size, flow control setting, and the promiscuous logical partition for unicast packets. The physical port
properties are also used by the logical ports that are associated with each physical port. HEAs are also
known as Integrated Virtual Ethernet adapters (IVE adapters).
“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.

Creating a shared Ethernet adapter for a VIOS logical partition using the HMC
You can create a Shared Ethernet Adapter on the Virtual I/O Server logical partition by using the
Hardware Management Console.

To create a Shared Ethernet Adapter, be sure you meet the following requirements:
v The Hardware Management Console must be at version 7 release 3.4.2 or later.
v Ensure the Virtual I/O Server has one or more physical network devices or Logical Host Ethernet

Adapters (LHEA) assigned to the logical partition.
v Ensure a virtual Ethernet adapter is created on the Virtual I/O Server. For instructions, see Configuring

a virtual Ethernet adapter using the HMC.
v If the physical Ethernet adapter that you want to use as the shared adapter has TCP/IP configured, the

Virtual I/O Server must be at version 2.1.1.0 or later. If TCP/IP is not configured, the Virtual I/O
Server can be at any version.

v Ensure that there is a resource monitoring and control connection between the Hardware Management
Console and the Virtual I/O Server.

Note: If you are using a prior release of the Hardware Management Console or a prior version of a
Virtual I/O Server (with TCP/IP configured for the virtual Ethernet adapter), see Configuring virtual
Ethernet on the Virtual I/O Server to create a Shared Ethernet Adapter by using the Virtual I/O Server
command-line interface.

To create a Shared Ethernet Adapter, complete the following steps:
1. In the navigation area, expand Systems Management > Servers, and select the server on which the

Virtual I/O Server logical partition is located.
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2. In the Tasks pane, click Configuration > Virtual Resources > Virtual Network Management. The
Virtual Network Management page is displayed.

3. From the Virtual Network Management menu, select the virtual Ethernet network (VLAN) that you
want to connect to the virtual Ethernet adapter.

4. Click Create shared Ethernet adapter. The Create shared Ethernet adapter page is displayed.
5. From the Create shared Ethernet adapter page, select the Virtual I/O Server and physical adapter on

which to configure the shared Ethernet adapter. You can also enable and select a failover Virtual I/O
Server and physical adapter.

Note: If you select a failover Virtual I/O Server, consider the following:
v The two Virtual I/O Server logical partitions used in the failover configuration need to have

different trunk priorities.
v Shared Ethernet Adapter failover requires an additional virtual Ethernet adapter on both Virtual

I/O Server logical partitions to be used as a control channel. The control channel allows the Virtual
I/O Server logical partitions to communicate with one another and know when one of the Virtual
I/O Server loses its connection.

v The Hardware Management Console graphical interface automatically selects a suitable virtual
Ethernet control channel by numerical order (from highest to lowest) from the port VLAN IDs
assigned to the virtual Ethernet adapters. For example, if both Virtual I/O Server logical partitions
use VLAN 99 and VLAN 50, and the Virtual I/O Server logical partitions in each VLAN have
virtual Ethernet adapters without a trunk adapter enabled, then VLAN 99 is selected instead of
VLAN 50. If you intend to use a virtual Ethernet adapter as a control channel adapter, do not select
the Access external network option in the adapter properties.

6. Click OK to create the Shared Ethernet Adapter.
Related information

Shared Ethernet Adapter failover

Creating a virtual disk for a VIOS logical partition using the HMC
You can use the Hardware Management Console to create a virtual disk on your managed system. Virtual
disks are also known as logical volumes.

To modify virtual optical media, be sure you meet the following requirements:
v The Hardware Management Console must be at version 7 release 3.4.2 or later.
v The Virtual I/O Server must be at version 2.1.1.0 or later.
v Ensure that there is a resource monitoring and control connection between the Hardware Management

Console and the Virtual I/O Server to manage storage.

To create a virtual disk, complete the following steps in the Hardware Management Console:
1. In the navigation area, expand Systems Management > Servers, and select the server on which the

Virtual I/O Server logical partition is located.
2. In the Tasks pane, click Configuration > Virtual Resources > Virtual Storage Management. The

Virtual Storage Management page is displayed.
3. Select a Virtual I/O Server logical partition.
4. On the Virtual Disks tab, click Create virtual disk. The Create virtual disk page is displayed.
5. Enter a virtual disk name, select a storage pool, enter a size for the new virtual disk, and optionally

assign the disk to a logical partition. Click OK. The Hardware Management Console creates the new
virtual disk with your specifications, and the Virtual Disks page is displayed.

Tip: If possible, do not create virtual disks within the rootvg storage pool. Create one or more
additional storage pools and create the virtual disks using the additional storage pools.

6. Repeat this procedure for each virtual disk that you want to create.
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7. To view or change the properties of virtual disks that you created, see “Changing a virtual disk for a
VIOS logical partition using the Hardware Management Console” on page 178.

These steps are equivalent to using themkbdsp command in the command-line interface.

If there is not enough disk space for the virtual disk, increase the size of the storage pool. For
instructions, see “Changing a storage pool for a VIOS logical partition using the Hardware Management
Console” on page 180

Creating storage pools
You can use the Hardware Management Console to create a volume-group-based or file-based storage
pool on your managed system.

To create a volume-group-based storage pool, you must assign at least one physical volume to the storage
pool. When you assign physical volumes to a storage pool, the Virtual I/O Server erases the information
on the physical volumes, divides the physical volumes into physical partitions, and adds the capacity of
the physical partitions to the storage pool. Do not add a physical volume to the storage pool if the
physical volume contains data that you want to preserve.

To create storage pools, be sure you meet the following requirements:
v The Hardware Management Console must be at version 7 release 3.4.2 or later.
v The Virtual I/O Server must be at version 2.1.1.0 or later.
v Ensure that there is a resource monitoring and control connection between the Hardware Management

Console and the Virtual I/O Server.

To create a storage pool, complete the following steps in the Hardware Management Console:
1. In the navigation area, expand Systems Management > Servers, and select the server on which the

Virtual I/O Server logical partition is located.
2. In the Tasks pane, click Configuration > Virtual Resources > Virtual Storage Management. The

Virtual Storage Management page is displayed.
3. Select a Virtual I/O Server logical partition.
4. Click the Storage Pools tab.
5. From the Select Action menu, click Create Storage Pool. The Create Storage Pool page is displayed.
6. Enter a name for the storage pool and select the storage pool type.
7. Enter or select the information required to create the volume-group-based or file-based storage pool,

and click OK to return to the Storage Pools page.

Note: The new storage pool appears in the table. If you select one or more physical volumes that
might belong to a different volume group, the Hardware Management Console displays a warning
message to indicate that adding them to the new storage pool can result in data loss. To create the
new storage pool with the selected physical volumes, select the Force option, and click OK.

Reassigning logical partitions to shared processor pools
If you use more than one shared processor pool on your managed system, you can use the Hardware
Management Console (HMC) to reassign logical partitions from one shared processor pool to another
shared processor pool on your managed system.

You can use this procedure only if the managed system supports more than one shared processor pool
and the HMC is at version 7 release 3.2.0, or later.

Any shared processor pool other than the default shared processor pool must be configured before you
can assign a logical partition to the shared processor pool. (The default shared processor pool is
preconfigured.) For instructions, see “Configuring shared processor pools” on page 133.
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The HMC never allows the sum of the number of reserved processing units for a shared processor pool
and the total number of processing units committed to the logical partitions that use the shared processor
pool to be greater than the maximum number of processing units for the shared processor pool. (The
default shared processor pool has no configured maximum number of processing units. The maximum
number of processors available to the default shared processor pool is the total number of active, licensed
processors on the managed system minus the number of processors that are assigned to dedicated
processor partitions that are set not to share their dedicated processors.)

A shared processor pool cannot contain logical partitions that belong to different workload management
groups. You therefore cannot reassign a logical partition with a defined workload management group to a
shared processor pool that contains logical partitions that belong to another workload management
group. (However, you can reassign a logical partition with a defined workload management group to a
shared processor pool that contains only logical partitions that do not have a defined workload
management group or that have the same workload management group as the reassigned logical
partition.)

To reassign logical partitions from one shared processor pool to another shared processor pool by using
the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system whose logical partitions you want to reassign, click the

Tasks button, and select Configuration → Shared Processor Pool Management.
3. Click Partitions.
4. Click the name of a logical partition that you want to reassign from one shared processor pool to

another shared processor pool.
5. Select the new shared processor pool for the logical partition in the Pool name (ID) field and click

OK.
6. Repeat steps 4 and 5 for any other logical partitions that you want to reassign from one shared

processor pool to another shared processor pool.
7. Click OK.

Managing the shared memory pool
By using the Hardware Management Console (HMC), you can change the configuration of the shared
memory pool. For example, you can change the amount of physical memory assigned to the shared
memory pool, change the Virtual I/O Server logical partitions that are assigned to the shared memory
pool, and add or remove paging space devices to or from the shared memory pool.
Related concepts

“Shared memory” on page 25
You can configure your system so that multiple logical partitions share a pool of physical memory. A
shared memory environment includes the shared memory pool, logical partitions that use the shared
memory in the shared memory pool, logical memory, I/O entitled memory, at least one Virtual I/O
Server logical partition, and paging space devices.

Changing the size of the shared memory pool
You can increase or decrease the amount of physical memory assigned to the shared memory pool by
using the Hardware Management Console (HMC).

You must be a super administrator of operator of the HMC to change the size of the shared memory
pool.

If there is not enough physical memory available in the system by which to increase the amount of
memory assigned to the shared memory pool, you can release to the hypervisor the physical memory
that is currently assigned to dedicated memory partitions that are shut down. The hypervisor can then
assign the released physical memory to the shared memory pool.
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If the shared memory pool has insufficient physical memory by which to decrease the amount of memory
in the shared memory pool, you can release to the hypervisor the I/O entitled memory that is currently
assigned to shared memory partitions that are shut down. The hypervisor can then remove the released
physical memory from the shared memory pool.

To change the size of the shared memory pool, complete the following steps:
1. In the navigation pane, expand Systems Management and click Servers.
2. In the work pane, select the server on which the shared memory pool is configured.
3. From the Tasks menu, click Configuration → Virtual Resources → Shared Memory Pool Management.

The Pool Properties window is displayed.
4. In the Pool Size field, enter a new value for the pool size and click OK. You can enter the size in a

combination of gigabytes (GB) plus megabytes (MB). If you need to assign more memory to the
shared memory pool than the current maximum pool size, you can also enter a new value for the
maximum pool size.
v If there is not enough physical memory available in the system by which to increase the maximum

pool size, the Release Memory Resources window is displayed. Select dedicated memory partitions
that are shut down until the available memory is equal to or greater than the requested memory
and click OK.

v If the amount of memory by which you want to decrease the size of the shared memory pool is
greater than the amount of available physical memory in the shared memory pool, the Release
Memory Resources window is displayed. (For example, the amount of available physical memory
in the shared memory pool is 8 GB and you want to decrease the size of the shared memory pool
from 32 GB to 20 GB, a difference of 12 GB, which is greater than 8 GB.) Select shared memory
partitions that are shut down until the amount of memory by which you want to decrease the size
of the shared memory pool is equal to or less than the available physical memory in the shared
memory pool, and click OK.

Related tasks

“Determining the size of the shared memory pool” on page 96
You need to consider the degree to which you want to overcommit the physical memory in the shared
memory pool, the performance of the workloads when running in a shared memory configuration that is
overcommitted, and the minimum and maximum boundaries of the shared memory pool.

Adding a paging VIOS partition to the shared memory pool
You can use the Hardware Management Console (HMC) to assign a second Virtual I/O Server (VIOS)
logical partition (hereafter referred to as a paging VIOS partition) to the shared memory pool.

Before you assign a paging VIOS partition to the shared memory pool, complete the following steps:
1. Verify that only one paging VIOS partition is currently assigned to the shared memory pool.
2. Verify that the paging VIOS partition that is currently assigned to the shared memory pool is running.
3. Verify that the Virtual I/O Server logical partition that you plan to assign to the shared memory pool

is running.
4. Verify that you are a super administrator or an operator of the HMC.

When you assign a paging VIOS partition to the shared memory pool and both paging VIOS partitions
have access to the same paging space devices, those paging space devices become common.

To assign a paging VIOS partition to the shared memory pool, complete the following steps from the
HMC:
1. In the navigation pane, expand Systems Management and click Servers.
2. In the work pane, select the server on which the shared memory pool is configured.
3. From the Tasks menu, click Configuration → Virtual Resources → Shared Memory Pool Management.

The Pool Properties window is displayed.
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4. Click the Paging Space Devices tab.
5. Click Add/Remove Devices. The Shared Memory Pool wizard is displayed.
6. Follow the steps in the Shared Memory Pool wizard to assign a paging VIOS partition to the shared

memory pool.

After you assign a second paging VIOS partition to the shared memory pool, complete the following
steps:
1. If no common paging space devices are assigned to the shared memory pool, assign them to the

shared memory pool. For instructions, see “Adding and removing paging space devices to and from
the shared memory pool” on page 147.

2. Configure the logical partitions that use shared memory to use the paging VIOS partition that you
assigned to the shared memory pool. For instructions, see “Changing the paging VIOS partitions
assigned to a shared memory partition” on page 182.

Related concepts

“Paging space device” on page 44
You can learn about how the Hardware Management Console (HMC) and Integrated Virtualization
Manager allocate and manipulate paging space devices on systems that use shared memory.
Related tasks

“Changing the paging VIOS partitions assigned to the shared memory pool”
You can use the Hardware Management Console (HMC) to change the Virtual I/O Server (VIOS) logical
partitions (hereafter referred to as paging VIOS partitions) that are assigned to the shared memory pool.
“Removing a paging VIOS partition from the shared memory pool” on page 144
You can use the Hardware Management Console (HMC) to remove a Virtual I/O Server (VIOS) logical
partition (hereafter referred to as a paging VIOS partition) from the shared memory pool.

Changing the paging VIOS partitions assigned to the shared memory pool
You can use the Hardware Management Console (HMC) to change the Virtual I/O Server (VIOS) logical
partitions (hereafter referred to as paging VIOS partitions) that are assigned to the shared memory pool.

Before you modify the paging VIOS partitions that are assigned to the shared memory pool, complete the
following steps:
1. Shut down all of shared memory partitions that use the paging VIOS partition that you plan to

change. You must shut down all of the shared memory partition that use the paging VIOS partition
(that you plan to change) as the primary paging VIOS partition, and you must shut down all of the
shared memory partitions that use the paging VIOS partition (that you plan to change) as the
secondary paging VIOS partition. For instructions, see “Shutting down and restarting logical
partitions” on page 150.

2. Verify that the Virtual I/O Server logical partition that you plan to assign to the shared memory pool
as a paging VIOS partition is running. (This is the Virtual I/O Server logical partition to which you
plan to change the VIOS assignment of a paging VIOS partition.)

3. Verify that you are a super administrator or an operator of the HMC.

The following table describes the situations in which you can change a paging VIOS partition.

Table 23. Changing paging VIOS partitions

State of one paging VIOS partition
State of the other paging VIOS
partition Change options

Running or shut down None. Only one paging VIOS
partition is assigned to the shared
memory pool.

You can change the VIOS assignment
of the paging VIOS partition. In this
situation, you also need to add the
paging space devices to which the
changed paging VIOS partition has
access.
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Table 23. Changing paging VIOS partitions (continued)

State of one paging VIOS partition
State of the other paging VIOS
partition Change options

Running Running You can change the VIOS assignment
of one of the paging VIOS partitions.
You cannot change the VIOS
assignment of both paging VIOS
partitions at the same time.

Running Shut down You can change the VIOS assignment
of only the paging VIOS partition
that is shut down.

Shut down Running You can change the VIOS assignment
of only the paging VIOS partition
that is shut down.

Shut down Shut down You cannot change the VIOS
assignment of either paging VIOS
partition. Instead, you can remove
the paging VIOS partition that you
do not want to change and then
change the VIOS assignment of the
remaining paging VIOS partition. In
this situation, you also need to add
the paging space devices to which
the changed paging VIOS partition
has access.

When you change the VIOS assignment of a paging VIOS partition, the following configuration changes
occur to the paging space devices:
v Paging space devices that were common become independent if only one paging VIOS partition can

access them.
v Paging space devices that were common remain common if both paging VIOS partitions can access

them. (These are paging space devices to which all three VIOS logical partitions have access. The three
VIOS logical partitions are the two VIOS logical partitions that were originally assigned to the shared
memory pool as paging VIOS partitions plus the VIOS logical partition that you assigned as a paging
VIOS partition when you changed the VIOS assignment of a paging VIOS partition.)

v Paging space devices that were independent become common if both paging VIOS partitions can access
them.

When you change the VIOS assignment of a paging VIOS partition, the HMC changes the configuration
of the shared memory partitions to use the VIOS logical partition that you assign as the paging VIOS
partition. When you activate the shared memory partition, the HMC automatically reflects the name of
the VIOS logical partition that you assigned as the paging VIOS partition in the partition profile. The
following examples explain this automatic change in more detail:
v A shared memory partition uses only one paging VIOS partition and you change the VIOS assignment

of that paging VIOS partition from VIOS_A to VIOS_B. When you activate the shared memory
partition, the HMC automatically shows VIOS_B as the paging VIOS partition in the partition profile.

v Two paging VIOS partitions are assigned to the shared memory pool. VIOS_A is assigned to the shared
memory pool as PVP1 and VIOS_B is assigned to the shared memory pool as PVP2. A shared memory
partition uses PVP1 as the primary paging VIOS partition and PVP2 as the secondary paging VIOS
partition. You change the VIOS assignment of PVP1 from VIOS_A to VIOS_C. When you activate the
shared memory partition, the HMC automatically shows VIOS_C as the primary paging VIOS partition
and VIOS_B as the secondary paging VIOS partition.
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To change the Virtual I/O Server logical partitions that are assigned to the shared memory pool as
paging VIOS partitions, complete the following steps from the HMC:
1. In the navigation pane, expand Systems Management and click Servers.
2. In the work pane, select the server on which the shared memory pool is configured.
3. From the Tasks menu, click Configuration → Virtual Resources → Shared Memory Pool Management.

The Pool Properties window is displayed.
4. Click the Paging Space Devices tab.
5. Click Add/Remove Devices. The Shared Memory Pool wizard is displayed.
6. Follow the steps in the Shared Memory Pool wizard to change the paging VIOS partitions that are

assigned to the shared memory pool.

After you change the VIOS assignement of a paging VIOS partition that is assigned to the shared
memory pool, complete the following steps:
1. If necessary, assign paging space devices to the shared memory pool. For instructions, see “Adding

and removing paging space devices to and from the shared memory pool” on page 147. You might
need to add paging space devices in the following situations:
v You changed the VIOS assignment of the only paging VIOS partition that is assigned to the shared

memory pool. The VIOS logical partition that you assigned as the paging VIOS partition has access
to different paging space devices than the VIOS logical partition that was previously assigned as
the paging VIOS partition. The paging space devices to which the current paging VIOS partition
has access must be assigned to the shared memory pool for the shared memory partitions to use
them.

v You removed a paging VIOS partition that was shut down and then changed the VIOS assignment
of the other paging VIOS partition that was also shut down. Because you removed a paging VIOS
partition from the shared memory pool, you changed the VIOS assignment of the only paging VIOS
partition that is assigned to the shared memory pool. The VIOS logical partition that you assigned
as the paging VIOS partition has access to different paging space devices than the VIOS logical
partition that was previously assigned as the paging VIOS partition. The paging space devices to
which the current paging VIOS partition has access must be assigned to the shared memory pool
for the shared memory partitions to use them.

v You changed the VIOS assignment of a paging VIOS partition that provided independent paging
space devices to shared memory partitions. The VIOS logical partition that you assigned as the
paging VIOS partition has access to different paging space devices than the VIOS logical partition
that was previously assigned as the paging VIOS partition. The independent paging space devices
to which the current paging VIOS partition has access must be assigned to the shared memory pool
for the shared memory partitions to continue to use independent paging space devices.

2. Activate all of the shared memory partitions that you previously shut down so that the changes that
you made can take effect. For instructions, see “Activating a logical partition” on page 148.
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Related concepts

“Paging space device” on page 44
You can learn about how the Hardware Management Console (HMC) and Integrated Virtualization
Manager allocate and manipulate paging space devices on systems that use shared memory.
Related tasks

“Removing a paging VIOS partition from the shared memory pool”
You can use the Hardware Management Console (HMC) to remove a Virtual I/O Server (VIOS) logical
partition (hereafter referred to as a paging VIOS partition) from the shared memory pool.
“Adding a paging VIOS partition to the shared memory pool” on page 140
You can use the Hardware Management Console (HMC) to assign a second Virtual I/O Server (VIOS)
logical partition (hereafter referred to as a paging VIOS partition) to the shared memory pool.

Removing a paging VIOS partition from the shared memory pool
You can use the Hardware Management Console (HMC) to remove a Virtual I/O Server (VIOS) logical
partition (hereafter referred to as a paging VIOS partition) from the shared memory pool.

Before you remove a paging VIOS partition from the shared memory pool, complete the following steps:
1. Verify that two paging VIOS partitions are currently assigned to the shared memory pool.
2. Shut down all of the shared memory partitions that use the paging VIOS partition that you plan to

remove. You must shut down all of the shared memory partitions that use the paging VIOS partition
(that you plan to remove) as the primary paging VIOS partition, and you must shut down all of the
shared memory partitions that use the paging VIOS partition (that you plan to remove) as the
secondary paging VIOS partition. For instructions, see “Shutting down and restarting logical
partitions” on page 150.

3. Verify that you are a super administrator or an operator of the HMC.

The following table describes the situations in which you can remove a paging VIOS partition.

Table 24. Removing paging VIOS partitions

State of one paging VIOS partition
State of the other paging VIOS
partition Removal options

Running Running You can remove either paging VIOS
partition.

Running Shut down You can remove only the paging
VIOS partition that is shut down.

Shut down Running You can remove only the paging
VIOS partition that is shut down.

Shut down Shut down You can remove either paging VIOS
partition; however, you need to
reassign the paging space devices to
the shared memory pool when you
activate the remaining paging VIOS
partition.

To avoid adding the paging space
devices again, you can activate one of
the paging VIOS partitions and then
remove the other paging VIOS
partition.

When you remove a paging VIOS partition from the shared memory pool, the following configuration
changes occur:
v Paging space devices that were common become independent.
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v The HMC changes the configuration of each shared memory partition to use the remaining paging
VIOS partition as the primary and only paging VIOS partition:
– If a shared memory partition uses only one paging VIOS partition and you remove that paging

VIOS partition, the HMC changes the configuration of the shared memory partition to use the
remaining paging VIOS partition. When you activate the shared memory partition, the HMC
automatically reflects the name of the current paging VIOS partition in the partition profile.
For example, two paging VIOS partitions, VIOS_A and VIOS_B, are assigned to the shared memory
pool. A shared memory partition, SMP1, uses only VIOS_A as its paging VIOS partition. You remove
VIOS_A from the shared memory pool. When you activate SMP1, the HMC automatically shows
VIOS_B as the primary and only paging VIOS partition in the partition profile.

– If a shared memory partition uses two paging VIOS partitions and you remove a paging VIOS
partition, the HMC changes the configuration of the shared memory partition to use the remaining
paging VIOS partition as the primary and only paging VIOS partition. When you activate the shared
memory partition, the HMC ignores the primary and secondary settings in the partition profile and
assigns the remaining paging VIOS partition as the primary and only paging VIOS partition for the
shared memory partition. If you want to save the configuration, you can update the partition profile
or save the logical partition configuration to a new partition profile.

To remove a paging VIOS partition from the shared memory pool, complete the following steps from the
HMC:
1. In the navigation pane, expand Systems Management and click Servers.
2. In the work pane, select the server on which the shared memory pool is configured.
3. From the Tasks menu, click Configuration → Virtual Resources → Shared Memory Pool Management.

The Pool Properties window is displayed.
4. Click the Paging Space Devices tab.
5. Click Add/Remove Devices. The Shared Memory Pool wizard is displayed.
6. Follow the steps in the Shared Memory Pool wizard to remove a paging VIOS partition from the

shared memory pool.

After you remove a paging VIOS partition from the shared memory pool, complete the following steps:
1. If you removed a paging VIOS partition that was shut down and the other paging VIOS partition was

also shut down, complete the following steps:
a. Activate the remaining paging VIOS partition. For instructions, see “Activating a logical partition”

on page 148.
b. Remove the remaining paging space devices from the shared memory pool and assign them again

to the shared memory pool. Even though the paging space devices become independent when you
remove a paging VIOS partition from the shared memory pool, they cannot be recognized as such
until you reassign them to the shared memory pool. For instructions, see “Adding and removing
paging space devices to and from the shared memory pool” on page 147.

2. If the paging VIOS partition that you removed was the only paging VIOS partition used by a shared
memory partition and the remaining paging VIOS partition does not have access to an available
paging space device that meets the size requirements of the shared memory partition, assign such a
paging space device to the shared memory pool. For instructions, see “Adding and removing paging
space devices to and from the shared memory pool” on page 147.

3. Activate all of the shared memory partitions that you previously shut down so that the changes that
you made can take effect. For instructions, see “Activating a logical partition” on page 148.
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Related concepts

“Paging space device” on page 44
You can learn about how the Hardware Management Console (HMC) and Integrated Virtualization
Manager allocate and manipulate paging space devices on systems that use shared memory.
Related tasks

“Saving the logical partition configuration to a partition profile” on page 177
You can save the current configuration of a logical partition to a new partition profile using the
Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical
partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate
the logical partition. This procedure allows you to save the changed configuration to a new partition
profile instead of having to enter the changed resource allocations manually.
“Changing the paging VIOS partitions assigned to the shared memory pool” on page 141
You can use the Hardware Management Console (HMC) to change the Virtual I/O Server (VIOS) logical
partitions (hereafter referred to as paging VIOS partitions) that are assigned to the shared memory pool.
“Adding a paging VIOS partition to the shared memory pool” on page 140
You can use the Hardware Management Console (HMC) to assign a second Virtual I/O Server (VIOS)
logical partition (hereafter referred to as a paging VIOS partition) to the shared memory pool.

Reinstalling the Virtual I/O Server of a paging VIOS partition
When you reinstall the Virtual I/O Server (VIOS) that is assigned to the shared memory pool (hereafter
referred to as a paging VIOS partition), you need to reconfigure the shared memory environment. For
example, you might need to add the paging space devices again to the shared memory pool.

The paging VIOS partitions store information about the paging space devices that are assigned to a
shared memory pool. The Hardware Management Console (HMC) obtains information about the paging
space devices that are assigned to the shared memory pool from the paging VIOS partitions. When you
reinstall the VIOS, the information about the paging space devices is lost. For the paging VIOS partitions
to regain the information, you must assign the paging space devices again to the share memory pool after
you reinstall the VIOS.

The following table shows the reconfiguration tasks that you must perform in the shared memory
environment when you resinstall the Virtual I/O Server of a paging VIOS partition.

Table 25. Shared memory reconfiguration tasks for reinstalling the Virtual I/O Server of a paging VIOS partition

Number of paging VIOS
partitions that are assigned
to the shared memory pool

Number of paging VIOS
partitions for which you
want to reinstall the VIOS Reconfiguration steps Instructions

1 1 1. Shut down all logical
partitions that use
shared memory
(hereafter referred to as
shared memory partitions).

2. Reinstall the VIOS.

3. Add the paging space
devices again to the
shared memory pool.

1. “Shutting down and
restarting logical
partitions” on page 150

2. Installing the Virtual
I/O Server manually
using the HMC version
7

3. “Adding and removing
paging space devices to
and from the shared
memory pool” on page
147

146 Logical partitioning



Table 25. Shared memory reconfiguration tasks for reinstalling the Virtual I/O Server of a paging VIOS
partition (continued)

Number of paging VIOS
partitions that are assigned
to the shared memory pool

Number of paging VIOS
partitions for which you
want to reinstall the VIOS Reconfiguration steps Instructions

2 1 1. Shut down each shared
memory partition that
uses the paging VIOS
partition (that you plan
to reinstall) as the
primary or secondary
paging VIOS partition.

2. Remove the paging
VIOS partition from the
shared memory pool.

3. Reinstall the VIOS.

4. Add the paging VIOS
partition again to the
shared memory pool.

1. “Shutting down and
restarting logical
partitions” on page 150

2. “Removing a paging
VIOS partition from the
shared memory pool”
on page 144

3. Installing the Virtual
I/O Server manually
using the HMC version
7

4. “Adding a paging VIOS
partition to the shared
memory pool” on page
140

2 2 1. Shut down all the
shared memory
partitions.

2. Reinstall the VIOS of
each paging VIOS
partition.

3. Add the paging space
devices again to the
shared memory pool.

1. “Shutting down and
restarting logical
partitions” on page 150

2. Installing the Virtual
I/O Server manually
using the HMC version
7

3. “Adding and removing
paging space devices to
and from the shared
memory pool”

Adding and removing paging space devices to and from the shared memory pool
After you create the shared memory pool, you can add and remove paging space devices to and from the
shared memory pool by using the Hardware Management Console (HMC).

Before you add a paging space device, complete the following tasks:
1. Configure the paging space device to the Virtual I/O Server logical partitions (hereafter referred to as

paging VIOS partitions) that are assigned to the shared memory pool. If you plan to use logical
volumes as paging space devices, then create the logical volumes. For instructions, see “Creating a
virtual disk for a VIOS logical partition using the HMC” on page 137.

2. Verify that all paging VIOS partitions are running.

Before you remove a paging space device, complete the following tasks:
v If no logical partition that uses shared memory (hereafter referred to as a shared memory partition) is

using the paging space device, verify that the paging space device is inactive.
v If a shared memory partition is using the paging space device, verify that the shared memory partition

is shut down.
v Verify that all paging VIOS partitions are running.

You must be a super administrator or operator of the HMC to add and remove paging space devices to
and from the shared memory pool.
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To add and remove paging space devices, complete the following steps from the HMC:
1. In the navigation pane, expand Systems Management and click Servers.
2. Select the server on which the shared memory pool is configured.
3. From the Tasks menu, click Configuration → Virtual Resources → Shared Memory Pool Management.

The Pool Properties window is displayed.
4. Click the Paging Space Devices tab.
5. Click Add/Remove Devices. The Shared Memory Pool wizard is displayed.
6. Follow the steps in the Shared Memory Pool wizard to add and remove paging space devices to and

from the shared memory pool.

Tip: If you expect to see a particular device on the list of eligible devices to add to the shared
memory pool, but the device does not appear, you can run the prepdev command from the Virtual
I/O Server command line to determine why the device does not meet the requirements for paging
space devices and learn what tasks need to be performed on the device to satisfy the requirements.

If a device was used by a logical partition and then the logical partition was removed, the device
might not meet the requirements for a paging space device, even though the logical partition was
removed. The prepdev command detects this situation and provides instructions about how to change
the device so that it meets the requirements for a paging space device.

Related concepts

“Paging space devices on systems that are managed by an HMC” on page 46
Learn about the location requirements, size requirements, and redundancy preferences for paging space
devices on systems that are managed by a Hardware Management Console (HMC).

Deleting the shared memory pool
If you no longer want any of the logical partitions to use shared memory, you can delete the shared
memory pool by using the Hardware Management Console (HMC).

Before you start, remove all of the logical partitions that use shared memory (hereafter referred to as
shared memory partitions) from the shared memory pool by completing one of the following tasks:
v Delete all of the shared memory partitions. For instructions, see “Deleting a logical partition” on page

129
v Change all of the shared memory partitions to dedicated memory partitions. For instructions, see

“Changing the memory mode of a logical partition” on page 184.

To delete the shared memory pool, complete the following steps from the HMC:
1. In the navigation pane, expand Systems Management and click Servers.
2. In the work pane, select the server from which you want to delete the shared memory pool.
3. From the Tasks menu, click Configuration → Virtual Resources → Shared Memory Pool Management.

The Pool Properties window is displayed.
4. Click Delete Memory Pool. The Delete Memory Pool window is displayed.
5. Click OK to delete the shared memory pool.

Managing logical partitions
You can manage the configuration of your logical partitions using the Hardware Management Console
(HMC). The HMC allows you to adjust the hardware resources that are used by each logical partition.

Activating a logical partition
You must activate a logical partition before you can use the logical partition. When you activate a logical
partition by using the Hardware Management Console (HMC), the system commits resources to the
logical partition and starts the operating system or software that is installed on the logical partition.
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When you activate a logical partition, you must select a partition profile. A partition profile is a record on
the HMC that specifies a possible configuration for a logical partition.

If you plan to activate a logical partition that uses virtual resources provided by the Virtual I/O Server,
you must first activate the Virtual I/O Server logical partition that provides the virtual resources.

If you plan to activate a logical partition that uses shared memory (hereafter referred to as a shared
memory partition), you must first activate at least one Virtual I/O Server logical partition that meets the
following criteria:
v The Virtual I/O Server (VIOS) logical partition (hereafter referred to as a paging VIOS partition) must

provide access to an available paging space device that meets the size requirements of the shared
memory partition.

v The paging VIOS partition must be assigned to the shared memory pool.

If the shared memory partition is configured with redundant paging VIOS partitions, activate both
paging VIOS partitions before you activate the shared memory partition.

When you activate a shared memory partition and the shared memory pool does not contain enough
physical memory required for activation, you can release to the hypervisor the physical memory that is
currently assigned to other shared memory partitions that are shut down. The hypervisor can then assign
the released physical memory to the shared memory partition that you want to activate.

To activate a logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the system on which the

logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and click Operations → Activate.
3. Select the partition profile that you want to use to activate the logical partition.
4. If you want the HMC to open a terminal window or console session for the logical partition when the

logical partition is activated, click Open a terminal window or console session.
5. If you want to use a keylock position, boot mode, or paging VIOS redundancy configuration that is

different from the keylock position, boot mode, or paging VIOS redundancy configuration that is
specified in the partition profile, complete the following steps:
a. Click Advanced.
b. Select the desired keylock position, boot mode, or paging VIOS redundancy configuration.
c. Click OK.

6. Click OK. If the logical partition that you want to activate is a shared memory partition and there is
not enough physical memory in the shared memory pool by which to activate the shared memory
partition, the Release Memory Resources window is displayed.

7. Select shared memory partitions that are shut down until the available memory is equal to or greater
than the requested memory and click OK.

Related concepts

“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.

Activating a system profile
You can activate many logical partitions at a time by using the Hardware Management Console (HMC) to
activate a system profile. A system profile is an ordered list of partition profiles. When you activate a
system profile, the managed system attempts to activate the partition profiles in the system profile in the
order in which the partition profiles are listed.
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Restriction: You cannot activate a system profile that contains partition profiles that specify shared
memory.

To activate a system profile using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and choose Configuration →

Manage System Profiles.
3. Select the system profile and click Activate.
4. Select the desired activation settings for the system profile and click Continue.

Shutting down and restarting logical partitions
You can shut down and restart logical partitions running on systems that are managed by a Hardware
Management Console (HMC).

Shutting down and restarting AIX in a logical partition:

You can shut down and restart AIX in a logical partition using the Hardware Management Console
(HMC).

Shutting down AIX logical partitions:

You can shut down AIX logical partitions using the Hardware Management Console (HMC).

To shut down an AIX logical partition, complete the following steps from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the managed system on which the logical partition is located.
3. In the work pane, select the logical partition.
4. From the Tasks menu, click Operations → Shut Down.
5. Select one of the following options:

Option Description

Operating System The HMC issues the AIX shutdown command to shut
down the logical partition. This option is available only
when the operating system is running, and not when the
logical partition is in an Open Firmware state.

Operating System Immediate The HMC issues the AIX shutdown -F command to shut
down the logical partition as quickly as possible,
bypassing messages to other users. This option is
available only when the operating system is running,
and not when the logical partition is in an Open
Firmware state.

Delayed The logical partition waits a predetermined amount of
time to shut down. This allows the logical partition time
to end jobs and write data to disks.

Immediate The logical partition shuts down without any preset
delay.

6. Click OK.

Restarting AIX logical partitions:

You can restart AIX logical partitions using the Hardware Management Console (HMC). Restarting a
logical partition shuts the logical partition down and then starts it again.
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To restart an AIX logical partition, complete the following steps from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the managed system on which the logical partition is located.
3. In the work pane, select the logical partition.
4. From the Tasks menu, click Operations → Restart.
5. Select one of the following options:

Option Description

Operating System The HMC issues the AIX shutdown -r command to shut
down and restart the logical partition. This option is
available only when the operating system is running,
and not when the logical partition is in an Open
Firmware state.

Operating System Immediate The HMC issues the AIX shutdown -F -r command to
shut down and restart the AIX logical partition as
quickly as possible, bypassing messages to other users.
This option is available only when the operating system
is running, and not when the logical partition is in an
Open Firmware state.

Immediate The logical partition is restarted as quickly as possible,
without notifying the logical partition.

Dump The HMC initiates a main storage or system memory
dump on the logical partition and restarts the logical
partition after the dump.

6. Click OK.

Shutting down IBM i logical partitions:

The correct way to shut down an IBM i logical partition safely is from an IBM i command line.

If you cannot shut down the IBM i logical partition from an IBM i command line, you can shut down the
IBM i logical partition from the Shut Down Partition window on your HMC or from the remote control
panel on the Operations Console. Using these methods can cause an abnormal shutdown and can result
in loss of data.

Before you shut down an IBM i logical partition, you must perform all of the basic IBM i shutdown tasks.
For example, all other users must be signed off of the IBM i logical partition before you can shut it down.
If you shut down the IBM i logical partition without completing all of the required tasks, you can cause
damage to data or cause the system to behave in unpredictable ways. For instructions, see Basic system
operations.

Shutting down IBM i logical partitions using the HMC:

You can shut down IBM i logical partitions using the Hardware Management Console (HMC).

Before you shut down the IBM i logical partition, complete the following tasks:
1. If an integrated server is active on the system, shut down the integrated server using IBM i options.
2. Ensure that all jobs are completed and all applications are ended.
3. Ensure that your partition profiles are updated with any dynamic logical partitioning resource

changes that you want to keep when you restart the logical partition.

The correct way to shut down an IBM i logical partition from the HMC is to open an HMC 5250
emulator session and run the Power Down System (PWRDWNSYS) command.
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To shut down an IBM i logical partition from the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and choose Console Window →

Open Dedicated 5250 Console.
3. From the IBM i command line in the emulator session, type PWRDWNSYS OPTION (*CNTRLD)

DELAY (600) and press Enter. The system will only shut down the IBM i logical partition you
selected. The PWRDWNSYS command does not affect other IBM i logical partitions on your system. If
you enter the PWRDWNSYS command with the RESTART(*YES) option, the operating system
restarts, and the resource specifications of the logical partition remain the same. If you do not use the
RESTART(*YES) option, then the logical partition shuts down completely, and other logical partitions
will be able to take and use the resources that were used by the logical partition. Also, when you
reactivate the logical partition using a partition profile, the partition profile overlays the resource
specifications of the logical partition with the resource specifications in the partition profile. Any
resource changes that you made to the logical partition using dynamic logical partitioning are lost
when you reactivate the logical partition using a partition profile. If the logical partition is set to start
automatically when the managed system starts, you can preserve the resource specifications on that
logical partition by restarting the entire managed system using the Partition autostart power-on mode.
When the logical partitions start automatically, the logical partitions have the resource specifications
that the logical partitions had when you shut down the managed system.

4. If the PWRDWNSYS command does not work, you can use either a delayed shutdown or an
immediate shutdown to shut down the IBM i logical partition.
Attention: Using these methods can cause an abnormal shutdown and can result in loss of data.

Performing a delayed shutdown of an IBM i logical partition:

You can perform a delayed shutdown of a logical partition using the Hardware Management Console
(HMC). Using delayed shutdown is equivalent to using the power button on the remote control panel.
Use delayed shutdown only when you must shut down a logical partition, and the PWRDWNSYS
command does not work.

When you use the delayed shutdown option, the logical partition waits a predetermined amount of time
to shut down. This allows the logical partition time to end jobs and write data to disks. If the logical
partition is unable to shut down within the predetermined amount of time, it will end abnormally and
the next restart might take a long time.

To perform a delayed shutdown of an IBM i logical partition using the HMC, complete the following:
1. In the navigation pane, open Systems Management, open Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and choose Operations → Shut

Down.
3. Select Delayed and click OK.

Performing an immediate shutdown of an IBM i logical partition:

When you perform the immediate shutdown option by using the Hardware Management Console
(HMC), the system shuts down without any preset delay. Using immediate shutdown is equivalent to
using function 8 on the remote control panel.

Attention: Using immediate shutdown can cause an abnormal IPL of the IBM i logical partition and
possibly cause loss of data. Use immediate shutdown only when an IBM i logical partition cannot shut
down using PWRDWNSYS or delayed shutdown.

To perform an immediate shutdown of an IBM i logical partition using the HMC, complete the following:
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1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the
managed system on which the logical partition is located.

2. In the work pane, select the logical partition, click the Tasks button, and choose Operations → Shut
Down.

3. Select Immediate and click OK.

Shutting down IBM i logical partitions using Operations Console:

You can shut down IBM i logical partitions using Operations Console.

Before you shut down the IBM i logical partition, complete the following:
1. If an integrated server is active on the system, shut down the integrated server using IBM i options.
2. Ensure that all jobs are completed and all applications are ended.
3. Ensure that your partition profiles are updated with any dynamic logical partitioning resource

changes that you want to keep when you restart the logical partition.

The correct way to shut down a logical partition is by using the control language (CL) command Power
Down System (PWRDWNSYS).

From an IBM i command line, type PWRDWNSYS OPTION (*CNTRLD) DELAY (600) and press Enter.
The system will only shut down the IBM i logical partition you selected. The PWRDWNSYS command
does not affect other IBM i logical partitions on your system.

If you enter the PWRDWNSYS command with the RESTART(*YES) option, the operating system restarts,
and the resource specifications of the logical partition remain the same. If you do not use the
RESTART(*YES) option, then the logical partition shuts down completely, and other logical partitions will
be able to take and use the resources that were used by the logical partition. Also, when you reactivate
the logical partition using a partition profile, the partition profile overlays the resource specifications of
the logical partition with the resource specifications in the partition profile. Any resource changes that
you made to the logical partition using dynamic logical partitioning are lost when you reactivate the
logical partition using a partition profile. If the logical partition is set to start automatically when the
managed system starts, you can preserve the resource specifications on that logical partition by restarting
the entire managed system using the Partition autostart power-on mode. When the logical partitions start
automatically, the logical partitions have the resource specifications that the logical partitions had when
you shut down the managed system.

If the PWRDWNSYS command does not work, you can use the remote control panel through Operations
Console to use control panel functions through a PC. The graphical user interface of the remote control
panel looks similar to the physical control panel. The remote control panel installs through Operations
Console. Using the remote control panel to shut down the IBM i logical partition can result in an
abnormal IPL and loss of data.

Delayed shutdown

Use delayed shutdown only when you must shut down a logical partition, and when the PWRDWNSYS
command does not work.

When you use the delayed shutdown option, the logical partition waits a predetermined amount of time
to shut down. This allows the logical partition time to end jobs and write data to disks. If the logical
partition is unable to shut down within the predetermined amount of time, it will end abnormally and
the next restart might take a long time.
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Immediate shutdown

Use immediate shutdown only when an IBM i logical partition cannot shut down using PWRDWNSYS or
delayed shutdown.

When you use the immediate shutdown option, the system powers down without any preset delay.

Attention: This might cause an abnormal IPL of the IBM i logical partition and possibly cause loss of
data.

Use the remote control panel to perform a delayed shutdown or an immediate shutdown. The power
button will start a delayed shutdown and function 8 will start an immediate shutdown of a system.
Related information

Remote control panel

Restarting and shutting down IBM i in a logical partition:

At times you will need to perform an initial program load (IPL) or shut down an IBM i logical partition.
For example, if you want to apply a delayed fix to IBM i, you must perform an IPL before IBM i can
apply the fix.

The preferred method for restarting and shutting down IBM i logical partitions is through the IBM i
command line. The Hardware Management Console (HMC) does not shut down the IBM i operating
system before it shuts down the logical partition. Using the HMC to restart or shut down an IBM i logical
partition can result in an abnormal IPL and the loss of data. However, you might need to use the HMC
to change the operating mode or IPL type of the IBM i logical partition before you restart or shut down
the IBM i logical partition using the IBM i command line.

It is important to remember that, when you perform an IPL of an IBM i logical partition, you are
powering off only the logical partition and not the entire managed system. Other logical partitions on
your managed system continue to run when you perform an IPL on the IBM i logical partition. However,
when you shut down the last logical partition that is running on a managed system, then the managed
system is set to power off automatically by default. If you want, you can set the managed system
properties on the HMC so that the managed system remains powered on when you shut down the last
running logical partition.
Related information

Basic system operations

Changing the operating mode for an IBM i logical partition:

You can change the operating mode for an IBM i logical partition using the Hardware Management
Console (HMC). The operating mode for an IBM i logical partition determines the number of options that
are presented to the operator for consideration during and after the initial program load (IPL). It can also
secure (lock) the control panel to prevent an unauthorized or inadvertent IPL from the control panel.

To change the IBM i operating mode of a logical partition using the HMC, follow these steps:
1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the

managed system on which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and choose Properties.
3. Click Settings, set IBM i Keylock position to your preference, and click OK.
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Related information

Operating mode of an IPL

Changing the IPL type for an IBM i logical partition:

When you use the Hardware Management Console (HMC) to change the IPL type, the managed system
loads the Licensed Internal Code and IBM i from the location specified by the IPL type. The IPL type is
also known as the IPL source, because each IPL type is associated with a different IPL source.

You can choose a separate IPL type for each IBM i logical partition.

Attention: Only use IPL type C under the direction of your service representative. Severe data loss can
occur with incorrect use of this function.

To change the IBM i IPL type of a logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and click Properties.
3. Click Settings, set IBM i IPL source to your preference, and click OK.
Related information

IPL type

Shutting down and restarting Linux in a logical partition:

You can shut down and restart Linux using the Hardware Management Console (HMC).
Related information

PowerVM Editions

Shutting down Linux logical partitions:

You can shut down Linux logical partitions and the Linux operating system using the Hardware
Management Console (HMC).

To shut down a Linux logical partition, complete the following steps from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the managed system on which the logical partition is located.
3. In the work pane, select the logical partition.
4. From the Tasks menu, click Operations → Shut Down.
5. Select one of the following options:

Option Description

Operating System The HMC issues the Linux shutdown -h +1 command to
shut down the logical partition. This option is available
only when the operating system is running, and not
when the logical partition is in an Open Firmware state.

Operating System Immediate The HMC issues the Linux shutdown -h now command
to shut down the logical partition as quickly as possible,
bypassing messages to other users. This option is
available only when the operating system is running,
and not when the logical partition is in an Open
Firmware state.
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Option Description

Delayed The logical partition waits a predetermined amount of
time to shut down. This allows the logical partition time
to end jobs and write data to disks.

Immediate The logical partition shuts down without any preset
delay.

6. Click OK.

Restarting Linux logical partitions:

You can restart Linux logical partitions or the Linux operating system using the Hardware Management
Console (HMC). Restarting a logical partition shuts the logical partition down and then starts it again.

To restart a Linux logical partition, complete the following steps from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the managed system on which the logical partition is located.
3. In the work pane, select the logical partition.
4. From the Tasks menu, click Operations → Restart.
5. Select one of the following options:

Option Description

Operating System The HMC issues the Linux shutdown -r +1 command to
shut down and restart the logical partition. This option is
available only when the operating system is running,
and not when the logical partition is in an Open
Firmware state.

Operating System Immediate The HMC issues the Linux shutdown -r now command
to shut down and restart the logical partition as quickly
as possible, bypassing messages to other users.

Immediate The logical partition is restarted as quickly as possible,
without notifying the logical partition.

Dump The HMC allows the Linux operating system on the
Linux logical partition to run a diagnostic procedure.
After the diagnostic procedure is complete, the logical
partition restarts.

The exact diagnostic procedure depends upon which
Linux operating system is installed on the logical
partition and how the operating system is set to do. The
operating system might run an OS debugger, the
operating system might perform a main storage or
system memory dump on the logical partition, or the
operating system might not be set to run any diagnostic
procedure at all.

6. Click OK.

Shutting down and restarting Virtual I/O Server in a logical partition:

You can shut down and restart Virtual I/O Server using the Hardware Management Console (HMC).

Shutting down Virtual I/O Server logical partitions using the HMC:
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You can shut down Virtual I/O Server logical partitions using the Hardware Management Console
(HMC). You can shut down the Virtual I/O Server immediately or delay the shutdown.

Before you shut down the Virtual I/O Server logical partition, complete the following tasks:
v If the client logical partitions that use storage and networking virtual resources provided by the Virtual

I/O Server are not configured to use virtual resources provided by a redundant Virtual I/O Server,
then shut down the client logical partitions.

v Shut down each shared memory partition that accesses its paging space device using only the Virtual
I/O Server logical partition that you plan to shut down. If you shut down the Virtual I/O Server
(VIOS) logical partition (hereafter referred to as a paging VIOS partition) before you shut down the
shared memory partitions and a shared memory partition attempts to access memory that is located on
its paging space device, the shared memory partition might fail.
If a shared memory partition accesses its paging space device redundantly through two paging VIOS
partitions, you do not need to shut down the shared memory partition. When you shut down the
paging VIOS partition, the shared memory partition accesses its paging space device through the other
paging VIOS partition.

To shut down a Virtual I/O Server logical partition, complete the following steps from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the managed system on which the logical partition is located.
3. In the work pane, select the logical partition.
4. From the Tasks menu, click Operations → Shut Down.
5. Select one of the following options:

Option Description

Operating System The HMC issues the Virtual I/O Server shutdown
command to shut down the logical partition. This option
is available only when the operating system is running,
and not when the logical partition is in an Open
Firmware state.

Operating System Immediate The HMC issues the Virtual I/O Server shutdown -force
command to shut down the logical partition as quickly
as possible, bypassing messages to other users. This
option is available only when the operating system is
running, and not when the logical partition is in an
Open Firmware state.

Delayed The logical partition waits a predetermined amount of
time to shut down. This allows the logical partition time
to end jobs and write data to disks.

Immediate The logical partition shuts down without any preset
delay.

6. Click OK.
Related tasks

“Shutting down and restarting logical partitions” on page 150
You can shut down and restart logical partitions running on systems that are managed by a Hardware
Management Console (HMC).

Restarting Virtual I/O Server logical partitions using the HMC:

You can restart Virtual I/O Server logical partitions using the Hardware Management Console (HMC).
Restarting a Virtual I/O Server logical partition shuts down the Virtual I/O Server logical partition and
then starts it again.
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Before you shut down the Virtual I/O Server logical partition, complete the following tasks:
v If the client logical partitions that use storage and networking virtual resources provided by the Virtual

I/O Server are not configured to use virtual resources provided by a redundant Virtual I/O Server,
then shut down the client logical partitions.

v Shut down each shared memory partition that accesses its paging space device using only the Virtual
I/O Server logical partition that you plan to shut down. If you shut down the Virtual I/O Server
(VIOS) logical partition (hereafter referred to as a paging VIOS partition) before you shut down the
shared memory partitions and a shared memory partition attempts to access memory that is located on
its paging space device, the shared memory partition might fail.
If a shared memory partition accesses its paging space device redundantly through two paging VIOS
partitions, you do not need to shut down the shared memory partition. When you shut down the
paging VIOS partition, the shared memory partition accesses its paging space device through the other
paging VIOS partition.

To restart a Virtual I/O Server logical partition, complete the following steps from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the managed system on which the logical partition is located.
3. In the work pane, select the logical partition.
4. From the Tasks menu, click Operations → Restart.
5. Select one of the following options:

Option Description

Operating System The HMC issues the Virtual I/O Server shutdown
-restart command to shut down and restart the logical
partition. This option is available only when the
operating system is running, and not when the logical
partition is in an Open Firmware state.

Operating System Immediate The HMC issues the Virtual I/O Server shutdown -force
-restart command to shut down and restart the logical
partition as quickly as possible, bypassing messages to
other users. This option is available only when the
operating system is running, and not when the logical
partition is in an Open Firmware state.

Immediate The logical partition is restarted as quickly as possible,
without notifying the logical partition.

Dump The HMC initiates a main storage or system memory
dump on the logical partition and restarts the logical
partition after the dump.

6. Click OK.

After the Virtual I/O Server restarts, complete the following tasks:
v Activate the client logical partitions that use storage and networking virtual resources provided to

them by the Virtual I/O Server.
v Activate each shared memory partition that accesses its paging space device by using only the paging

VIOS partition that you restarted.
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Related tasks

“Activating a logical partition” on page 148
You must activate a logical partition before you can use the logical partition. When you activate a logical
partition by using the Hardware Management Console (HMC), the system commits resources to the
logical partition and starts the operating system or software that is installed on the logical partition.
“Shutting down and restarting logical partitions” on page 150
You can shut down and restart logical partitions running on systems that are managed by a Hardware
Management Console (HMC).

Managing partition profiles for logical partitions
You can manage the partition profiles for your logical partitions using the Hardware Management
Console (HMC). You can change the resource specifications stored in your partition profiles as your needs
change.

Copying a partition profile:

You can create a copy of an existing partition profile using the Hardware Management Console (HMC).
After you create a copy of the existing partition profile, you can change the resource allocations within
the new partition profile. This allows you to create multiple, nearly identical partition profiles without
having to re-enter all of the resource allocations repeatedly.

To copy a partition profile using the HMC, follow these steps:
1. In the navigation pane, open Systems Management, open Servers, and click the name of the

managed system.
2. In the work pane, select the logical partition whose partition profile you want to copy, click the Tasks

button, and select Configuration → Manage Profiles.
3. Select the partition profile that you want to copy and click Actions → Copy.
4. Enter the name of the new partition profile into New profile name and click OK.

Changing partition profile properties:

You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.

A partition profile stores the required number of processors, memory, and hardware resources assigned to
that profile. Any partition profile property changes are not applied to the logical partition until you
activate the partition profile.

If you plan to change a partition profile that specifies dedicated memory to a partition profile that
specifies shared memory, be aware of the following actions:
v The HMC automatically deletes all of the physical I/O adapters specified in the partition profile. You

can assign only virtual adapters to logical partitions that use shared memory.
v You must specify shared processors. Logical partitions that use shared memory must also use shared

processors.

To change partition profile properties using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the name of the managed

system.
2. In the work pane, select the logical partition whose partition profile you want to change, click the

Tasks button, and click Configuration → Manage Profiles.
3. Select the partition profile that you want to change and click Actions → Edit.
4. Make the appropriate changes and click OK.
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If you created at least one virtual fibre channel adapter, complete the following tasks to connect the
logical partition to its storage:
1. Activate the logical partition. When you activate the logical partition, the HMC assigns a pair of

worldwide port names (WWPNs) to the virtual fibre channel adapter. For instructions, see “Activating
a logical partition” on page 148.

2. Restart the Virtual I/O Server (that provides the connection to a physical fibre channel adapter) or
run the syscfg command. This enables the Virtual I/O Server to recognize the WWPNs of the virtual
fibre channel adapter on the client logical partition For instructions, see “Restarting Virtual I/O Server
logical partitions using the HMC” on page 157.

3. Assign the virtual fibre channel adapter on the client logical partition to a physical port of a physical
fibre channel adapter. For instructions, see “Changing virtual fibre channel for a Virtual I/O Server
using the Hardware Management Console” on page 181.

Related concepts

“Managing logical partition resources dynamically” on page 162
You use the Hardware Management Console (HMC) to add, remove, or move processor, memory, and
I/O resources between running logical partitions without restarting the logical partitions or the managed
system.
“High-speed link (HSL) OptiConnect for IBM i logical partitions” on page 74
The high-speed link (HSL) OptiConnect feature provides high-speed system-to-system communication
between managed systems.
“Virtual OptiConnect for IBM i logical partitions” on page 75
The virtual OptiConnect feature provides high-speed interpartition communication within a managed
system. The Virtual OptiConnect feature emulates external OptiConnect hardware by providing a virtual
bus between logical partitions.
Related tasks

“Configuring a virtual fibre channel adapter” on page 131
You can configure a virtual fibre channel adapter dynamically for a running logical partition using the
Hardware Management Console (HMC).
“Configuring a virtual Ethernet adapter” on page 130
You can configure a virtual Ethernet adapter dynamically for a running logical partition by using the
Hardware Management Console (HMC). Doing so will connect the logical partition to a virtual LAN.
“Creating a logical Host Ethernet Adapter for a running logical partition” on page 135
If your managed system has a Host Ethernet Adapter (HEA), you can set up a logical partition to use
HEA resources by using the Hardware Management Console (HMC) to create a logical Host Ethernet
Adapter (LHEA) for the logical partition. A logical Host Ethernet Adapter (LHEA) is a representation of a
physical HEA on a logical partition. An LHEA allows the logical partition to connect to external networks
directly through the HEA. HEAs are also known as Integrated Virtual Ethernet adapters (IVE adapters).
“Saving the logical partition configuration to a partition profile” on page 177
You can save the current configuration of a logical partition to a new partition profile using the
Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical
partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate
the logical partition. This procedure allows you to save the changed configuration to a new partition
profile instead of having to enter the changed resource allocations manually.

Deleting a partition profile:

You can delete a partition profile using the HMC Hardware Management Console (HMC). This allows
you to remove partition profiles that you no longer use.

Note: You cannot delete a partition profile that is the default partition profile for the logical partition. If
the partition profile you want to delete is the default partition profile, you must first change the default
profile to another partition profile.
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To delete a partition profile using the HMC, follow these steps:
1. In the navigation pane, open Systems Management, open Servers, and click the managed system on

which the partition profile is located.
2. In the work pane, select the logical partition on which the partition profile is located, click the Tasks

button, and choose Configuration → Manage Profiles.
3. Select the partition profile that you want to delete and click Actions → Delete.
4. Click OK to confirm.

Managing system profiles
You can manage the system profiles on your managed system using the Hardware Management Console
(HMC). You can change the logical partitions and partition profiles specified within the system profiles as
the logical partitions change on your managed system.

Copying a system profile:

You can use the Hardware Management Console (HMC) to create a copy of an existing system profile.
After you create a copy of the existing system profile, you can change the partition profiles that are
contained within the new system profile. This allows you to create multiple, nearly identical system
profiles quickly and easily.

To copy a system profile using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and choose Configuration →

Manage System Profiles.
3. Select the system profile and click Actions → Copy.
4. Enter the name that you want to use for the copy into New profile name and click OK.

Changing a system profile:

You can change which partition profiles are included in a system profile using the Hardware
Management Console (HMC).

Restriction: You cannot add logical partitions that use shared memory to system profiles.

To change a system profile using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and click Configuration →

Manage System Profiles.
3. Select the system profile that you want to change and click Actions → Edit.
4. In the System Profile window, select each partition profile that you want to remove from the system

profile and click Remove.
5. For each partition profile that you want to add to the system profile, open the logical partition to

which the partition profile belongs, select the partition profile, and click Add.
6. Click OK.

Validating a system profile:

When you validate a system profile, the Hardware Management Console (HMC) compares the resources
defined in the system profile with the resources available on the managed system. If the system profile
requires more resources than are available on the managed system, a message is displayed on the HMC.

To validate a system profile using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
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2. In the work pane, select the managed system, click the Tasks button, and choose Configuration →
Manage System Profiles.

3. Select the system profile and click Validate.
4. When validation is complete, click OK.
Related concepts

“System profile” on page 12
A system profile is an ordered list of partition profiles that is used by the Hardware Management Console
(HMC) to start the logical partitions on a managed system in a specific configuration.

Deleting a system profile:

You can delete a system profile using the Hardware Management Console (HMC). This allows you to
remove system profiles that you no longer use.

A system profile helps you activate or change the managed system from one complete set of logical
partition configurations to another.

To delete a system profile using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system, click the Tasks button, and choose Configuration →

Manage System Profiles.
3. Select the system profile and click Actions → Delete.
4. Click Yes to confirm.

Managing logical partition resources dynamically
You use the Hardware Management Console (HMC) to add, remove, or move processor, memory, and
I/O resources between running logical partitions without restarting the logical partitions or the managed
system.

Dynamic resource management is used only for running logical partitions. If a logical partition is not
running, you cannot add resources to that logical partition dynamically or remove resources from that
logical partition dynamically. Also, if you shut down a logical partition, you cannot move resources
dynamically to or from that logical partition. (However, the resources that were used by that logical
partition can be added dynamically to running logical partitions.) You can change the resource allocations
for an idle logical partition by changing the properties of the partition profiles used by that logical
partition. When you start the logical partition using one of the changed partition profiles, the managed
system applies the changes to the logical partition.

Managing dedicated memory dynamically:

You can add, remove, and move physical memory dynamically to and from running logical partitions
that use dedicated memory using the Hardware Management Console (HMC). This allows you to adjust
the physical memory allocated to each logical partition that uses dedicated memory without having to
shut down the logical partitions.

Dynamic memory changes on IBM i logical partitions affect the base memory pool of the logical
partitions (*BASE pool). Private memory pools or shared memory pools are not affected. Dynamic
memory changes cannot cause the amount of memory in the base pool to fall below the minimum
amount of memory required in the base pool (as determined by the base storage minimum size
(QBASPOOL) system value). If a dynamic memory change would cause the base pool to fall below this
amount, the system releases excess memory pages only after keeping the minimum amount of memory
required in the base pool.
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To prevent any data loss during dynamic memory movement, the system first writes any data from
memory pages to disk before making the memory pages available to another logical partition. Depending
on the amount of memory you have requested to move, this might take some time.

Memory in each logical partition operates within its assigned minimum and maximum values. The full
amount of memory that you assign to a logical partition might not be available for the logical partition to
use. Static memory overhead that is required to support the assigned maximum memory affects the
reserved or hidden memory amount. This static memory overhead also influences the minimum memory
size of a logical partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in
the partition profile. This means that all configuration changes will be lost the next time the partition
profile is activated. If you want to save your new logical partition configuration, either change the
partition profile or save the logical partition configuration to a new partition profile.
Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.
“Saving the logical partition configuration to a partition profile” on page 177
You can save the current configuration of a logical partition to a new partition profile using the
Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical
partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate
the logical partition. This procedure allows you to save the changed configuration to a new partition
profile instead of having to enter the changed resource allocations manually.

Adding dedicated memory dynamically:

You can dynamically add physical memory to a running logical partition that uses dedicated memory
using the Hardware Management Console (HMC). This allows you to increase the physical memory
available to a logical partition that uses dedicated memory without having to shut down the logical
partition.

A Linux logical partition supports the dynamic addition of memory resources only if the following
conditions are met:
v A Linux distribution that supports the dynamic addition of memory resources is installed on the Linux

logical partition. Distributions that support the dynamic addition of memory resources include SUSE
Linux Enterprise Server 10, and later.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

To add memory to a Linux logical partition that uses an earlier version of these distributions, you must
shut down the Linux logical partition and reactivate the logical partition using a partition profile that
specifies a greater amount of memory.

To add memory dynamically to a running logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Memory → Add or Remove.
3. In the Assigned Memory field, enter the total amount of physical memory that you want to assign to

the logical partition. You can enter the size in a combination of gigabytes (GB) plus megabytes (MB).
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4. Adjust the settings in the Options area if necessary. You might need to increase the value in the
Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system adds memory dynamically. These settings are not retained after the
addition is completed.)

5. Click OK.

Moving dedicated memory dynamically:

You can dynamically move physical memory from one running logical partition that uses dedicated
memory to another using the Hardware Management Console (HMC). This allows you to reassign
physical memory directly to a logical partition that uses dedicated memory that needs additional physical
memory.

You cannot dynamically move memory from a running Linux logical partition. To remove memory from
a Linux logical partition, you must shut down the Linux logical partition and reactivate the logical
partition using a partition profile that specifies a lesser amount of memory.

You can dynamically move memory to a running Linux only if the following conditions are met:
v A Linux distribution that supports the dynamic addition of memory resources is installed on the Linux

logical partition. Distributions that support the dynamic movement of memory resources include
Novell SUSE Linux Enterprise Server 10, and later.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

To move memory to a Linux logical partition that uses an earlier version of these distributions, you must
shut down the Linux logical partition and reactivate the logical partition using a partition profile that
specifies a greater amount of memory.

To dynamically move memory from one running logical partition to another using the HMC, follow these
steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partitions are located.
2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Memory → Move.
3. Enter the amount of physical memory that you want to move from the logical partition. You can enter

the size in a combination of gigabytes (GB) plus megabytes (MB).
4. Select the logical partition to which you want to move the specified amount of physical memory.
5. Adjust the settings in the Options area if necessary. You might need to increase the value in the

Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system moves memory dynamically. These settings are not retained after
the move operation is completed.)

6. Click OK.

Removing dedicated memory dynamically:

You can dynamically remove physical memory from a running AIX, IBM i, or Virtual I/O Server logical
partition that uses dedicated memory using the Hardware Management Console (HMC). This allows you
to reassign the physical memory to other logical partitions that use dedicated memory.

You cannot dynamically remove memory from a running Linux logical partition. To remove memory
from a Linux logical partition, you must shut down the logical partition and reactivate the logical
partition using a partition profile that specifies a lesser amount of memory.

To dynamically remove memory from a running logical partition using the HMC, follow these steps:
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1. In the navigation pane, open Systems Management → Servers, and click the managed system on
which the logical partition is located.

2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical
Partitioning → Memory → Add or Remove.

3. In the Assigned Memory field, enter the total amount of physical memory that you want to assign to
the logical partition. You can enter the size in a combination of gigabytes (GB) plus megabytes (MB).

4. Adjust the settings in the Options area if necessary. You might need to increase the value in the
Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system removes memory dynamically. These settings are not retained after
the removal is completed.)

5. Click OK.

Managing shared memory dynamically:

You can dynamically add and remove logical memory and I/O entitled memory to and from a logical
partition that uses shared memory (hereafter referred to as a shared memory partition) using the Hardware
Management Console (HMC).

Dynamic memory changes on IBM i logical partitions affect the base memory pool of the logical
partitions (*BASE pool). Private memory pools or shared memory pools are not affected. Dynamic
memory changes cannot cause the amount of memory in the base pool to fall below the minimum
amount of memory required in the base pool (as determined by the base storage minimum size
(QBASPOOL) system value). If a dynamic memory change would cause the base pool to fall below this
amount, the system releases excess memory pages only after keeping the minimum amount of memory
required in the base pool.

To prevent any data loss during dynamic memory movement, the system first writes any data from
memory pages to disk before making the memory pages available to another logical partition. Depending
on the amount of memory you have requested to move, this might take some time.

Memory in each logical partition operates within its assigned minimum and maximum values. The full
amount of memory that you assign to a logical partition might not be available for the logical partition to
use. Static memory overhead that is required to support the assigned maximum memory affects the
reserved or hidden memory amount. This static memory overhead also influences the minimum memory
size of a logical partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in
the partition profile. This means that all configuration changes will be lost the next time the partition
profile is activated. If you want to save your new logical partition configuration, either change the
partition profile or save the logical partition configuration to a new partition profile.
Related concepts

“Shared memory” on page 25
You can configure your system so that multiple logical partitions share a pool of physical memory. A
shared memory environment includes the shared memory pool, logical partitions that use the shared
memory in the shared memory pool, logical memory, I/O entitled memory, at least one Virtual I/O
Server logical partition, and paging space devices.

Adding and removing logical memory dynamically to and from a shared memory partition:

You can dynamically add and remove logical memory to and from a running logical partition that uses
shared memory (hereafter referred to as a shared memory partition) using the Hardware Management
Console (HMC). This allows you to increase and decrease the logical memory assigned to the shared
memory partition without having to shut down the logical partition.
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A Linux shared memory partition supports the dynamic addition and removal of logical memory
resources only if the DynamicRM tool package is installed on the Linux shared memory partition. To
download the DynamicRM tool package, see the Service and productivity tools for Linux on POWER
systems Web site.

To dynamically add and remove logical memory to and from a running logical partition using the HMC,
you must be a super administrator, service representative, product engineer, or operator of the HMC.

To add or remove logical memory to or from a shared memory partition, complete the following steps
from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the server on which the shared memory partition runs.
3. In the work pane, select the shared memory partition to which you want to add or remove logical

memory.
4. From the Tasks menu, click Dynamic Logical Partitioning → Memory → Add or Remove. The

Add/Remove Memory Resources window is displayed.
5. In the Assigned Memory field, enter the total amount of logical memory that you want to assign to

the shared memory partition. You can enter the size in a combination of gigabytes (GB) plus
megabytes (MB).

6. Click OK.
Related concepts

“Logical memory” on page 34
Logical memory is the address space, assigned to a logical partition, that the operating system perceives as
its main storage. For a logical partition that uses shared memory (hereafter referred to as a shared memory
partition), a subset of the logical memory is backed up by physical main storage and the contents of the
remaining logical memory are kept in auxiliary storage.

Adding and removing I/O entitled memory dynamically to and from a shared memory partition:

You can dynamically add and remove I/O entitled memory to and from a running logical partition that
uses shared memory (hereafter referred to as a shared memory partition) using the Hardware Management
Console (HMC). This allows you to increase and decrease the maximum amount of physical memory that
is assigned to the shared memory partition for its I/O devices without having to shut down the shared
memory partition.

A Linux shared memory partition supports the dynamic addition and removal of I/O entitled memory
resources only if the DynamicRM tool package is installed on the Linux shared memory partition. To
download the DynamicRM tool package, see the Service and productivity tools for Linux on POWER
systems Web site.

You can increase the amount of I/O entitled memory that is assigned to a shared memory partition when
the sum of I/O entitled memory that is assigned to all shared memory partitions in the shared memory
pool is less than the size of the shared memory pool minus the required amount of reserved firmware
memory. If there is not enough physical memory in the shared memory pool by which to increase the
I/O entitled memory to the amount specified, you can release to the hypervisor the physical memory that
is currently assigned to other shared memory partitions that are shut down. The hypervisor can then
assign the released physical memory to the shared memory partition that needs more I/O entitled
memory.

You can decrease the amount of I/O entitled memory that is assigned to a shared memory partition only
when the shared memory partition requires less physical memory for its I/O devices than the amount of
I/O entitled memory that is assigned to the shared memory partition. For example, you assign 128 MB of
I/O entitled memory to a shared memory partition. The shared memory partition requires a minimum of
64 MB for its I/O devices. Thus, you can decrease the I/O entitled memory that is assigned to the shared
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memory partition by up to 64 MB. For instructions about how to view the assigned, minimum, optimal,
and maximum I/O entitled memory used by a shared memory partition, see “Determining the I/O
entitled memory for a shared memory partition” on page 225.

To dynamically add and remove I/O entitled memory to and from a running shared memory partition
using the HMC, you must be a super administrator, service representative, product engineer, or operator
of the HMC.

To add and remove I/O entitled memory to or from a shared memory partition, complete the following
steps from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the server on which the shared memory partition runs.
3. In the work pane, select the shared memory partition to which you want to add or remove logical

memory.
4. From the Tasks menu, click Dynamic Logical Partitioning → Memory → Add or Remove. The

Add/Remove Memory Resources window is displayed.
5. If Auto is selected, deselect Auto. This changes the I/O entitled memory mode to the manual mode.
6. In the I/O Entitled Memory field, enter the total amount of I/O entitled memory that you want to

assign to the shared memory partition. You can enter the size in a combination of gigabytes (GB) plus
megabytes (MB).

7. Adjust the settings in the Options area if necessary. You might need to increase the value in the
Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system adds memory dynamically. These settings are not retained after the
addition completes.

8. Click OK. If there is not enough physical memory in the shared memory pool by which to increase
the I/O entitled memory to the amount specified in step 6, the Release Memory Resources window is
displayed.

9. Select shared memory partitions that are shut down until the available memory is equal to or greater
than the requested memory and click OK.

If you want to later change the I/O entitled memory mode back to the auto mode so that the HMC and
IVM automatically adjust the I/O entitled memory for the shared memory partition when you add or
remove virtual adapters, repeat this procedure and select Auto. Alternatively, you can restart the shared
memory partition. When you restart a shared memory partition, the I/O entitled memory mode is set to
the auto mode regardless of what the I/O entitled memory mode was set to before you restarted the
shared memory partition.
Related tasks

“Managing virtual adapters dynamically” on page 172
You can dynamically add and remove virtual adapters to and from running logical partitions using the
Hardware Management Console (HMC).

Managing processor resources dynamically:

You can dynamically add, remove, and move processor resources to and from running logical partitions
using the Hardware Management Console (HMC). This allows you to adjust the processor resources
allocated to each logical partition without having to shut down the logical partitions.

The ability to move processor resources dynamically becomes important when you need to adjust to
changing workloads. Processor resources can be moved based on the minimum and maximum values
that you created for the partition profile. You can move processor resources as long as the processor
resources for each logical partition remains within the range specified by the minimum and maximum
values for the logical partition. If the managed system uses more than one shared processor pool, you
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must also ensure that the number of processors used in each shared processor pool is less than or equal
to the maximum number of processing units specified for each shared processor pool.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in
the partition profile. This means that all configuration changes will be lost the next time the partition
profile is activated. If you want to save your new logical partition configuration, either change the
partition profile or save the logical partition configuration to a new partition profile.
Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.
“Saving the logical partition configuration to a partition profile” on page 177
You can save the current configuration of a logical partition to a new partition profile using the
Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical
partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate
the logical partition. This procedure allows you to save the changed configuration to a new partition
profile instead of having to enter the changed resource allocations manually.

Adding processor resources dynamically:

You can dynamically add processor resources to a running logical partition using the Hardware
Management Console (HMC). This allows you to increase the processing capacity of a running logical
partition without having to shut down the logical partition.

A Linux logical partition supports the dynamic addition of processor resources only if the following
conditions are met:
v A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical

partition. Distributions that support dynamic logical partitioning include SUSE Linux Enterprise Server
9 and later versions.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

To add processor resources dynamically to a running logical partition using the HMC, follow these steps:
1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the

managed system on which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and choose Dynamic Logical

Partitioning → Processor → Add or Remove.
3. Enter the amounts of processor resources that you want the logical partition to have into the fields in

the Current column. If the logical partition uses shared processors, you might need to adjust the
number of virtual processors so that it is greater than the number of processing units.

4. Adjust the settings in the Options area if necessary. You might need to increase the value in the
Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system adds processor resources dynamically. These settings are not
retained after the addition completes.)

5. Click OK.

Moving processor resources dynamically:

You can dynamically move processor resources from one running logical partition to another using the
Hardware Management Console (HMC). This allows you to reassign processor resources directly to a
logical partition that needs additional processor resources.
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A Linux logical partition supports the dynamic movement of processor resources only if the following
conditions are met:
v A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical

partition. Distributions that support dynamic logical partitioning include SUSE Linux Enterprise Server
9 and later versions.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

To move processor resources dynamically from one running logical partition to another using the HMC,
follow these steps:
1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the

managed system on which the logical partitions are located.
2. In the work pane, select the logical partition, click the Tasks button, and choose Dynamic Logical

Partitioning → Processor → Move.
3. Select the logical partition to which you want to move the processor resources in Select Destination

Partition.
4. Enter the amounts of processor resources that you want to move into the fields in the To move

column.
5. Adjust the settings in the Options area if necessary. You might need to increase the value in the

Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system moves processor resources dynamically. These settings are not
retained after the move completes.)

6. Click OK.

Removing processor resources dynamically:

You can dynamically remove processor resources from a running logical partition using the Hardware
Management Console (HMC). This allows you to reassign the processor resources to other logical
partitions.

A Linux logical partition supports the dynamic removal of processor resources only if the following
conditions are met:
v A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical

partition. Distributions that support dynamic logical partitioning include SUSE Linux Enterprise Server
9 and later versions.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

To dynamically remove processor resources from a running logical partition using the HMC, follow these
steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Processor → Add or Remove.
3. Enter the amounts of processor resources that you want to the logical partition to have into the fields

in the Current column. If the logical partition uses shared processors, you might need to adjust the
number of virtual processors so that it is greater than the number of processing units.

4. Adjust the settings in the Options area if necessary. You might need to increase the value in the
Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system removes processor resources dynamically. These settings are not
retained after the removal is completed.)

5. Click OK.
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Managing physical I/O devices and slots dynamically:

You can dynamically add, remove, and move physical I/O devices and slots to and from running logical
partitions using the Hardware Management Console (HMC). This allows logical partitions to share
infrequently used I/O devices (such as optical disk drives).

Logical partitions can have desired or required I/O devices or slots. When you specify that an I/O device
or slot is desired (or shared), this means either that the I/O device or slot is meant to be shared with
other logical partitions, or that the I/O device or slot is optional. When you specify that an I/O device or
slot is required (or dedicated), then you cannot activate the logical partition if the I/O device or slot is
unavailable or in use by another logical partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in
the partition profile. This means that all configuration changes will be lost the next time the partition
profile is activated. If you want to save your new logical partition configuration, either change the
partition profile or save the logical partition configuration to a new partition profile.
Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.
“Saving the logical partition configuration to a partition profile” on page 177
You can save the current configuration of a logical partition to a new partition profile using the
Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical
partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate
the logical partition. This procedure allows you to save the changed configuration to a new partition
profile instead of having to enter the changed resource allocations manually.

Adding physical I/O devices and slots dynamically:

You can dynamically add a physical I/O slot (and the adapter and devices that are connected to that slot)
to a running logical partition using the Hardware Management Console (HMC). This allows you to add
I/O capabilities to a running logical partition without having to shut down the logical partition.

A Linux logical partition supports the dynamic addition of physical I/O slots only if the following
conditions are met:
v A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical

partition. Distributions that support dynamic logical partitioning include SUSE Linux Enterprise Server
9, and later.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

You cannot add physical I/O devices and slots to logical partitions that use shared memory. You can
assign only virtual adapters to logical partitions that use shared memory.

To add a physical I/O slot dynamically to a running logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Physical Adapters → Add.
3. Select the physical I/O slot that you want to add to the logical partition.
4. If you want to assign the physical I/O slot to an I/O pool, select the I/O pool for the physical I/O

slot in I/O Pool ID.
5. Click OK.
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Related tasks

“Adding virtual adapters dynamically” on page 172
You can dynamically add a virtual adapter to a running logical partition using the Hardware
Management Console (HMC).

Moving physical I/O devices and slots dynamically:

You can dynamically move a physical I/O slot (and the adapter and devices that are connected to that
slot) from one running logical partition to another using the Hardware Management Console (HMC).
This allows you to share a physical I/O device, such as a DVD drive, among many logical partitions.

Before you begin, vary off any devices that are attached to the managed system through the physical I/O
slot that you want to move. You can vary off devices by using operating system commands.

Attention: The dynamic movement of a physical I/O slot that controls disk drives can cause
unpredictable results, such as logical partition failure or loss of data.

A Linux logical partition supports the dynamic movement of physical I/O slots only if the following
conditions are met:
v A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical

partition. Distributions that support dynamic logical partitioning include SUSE Linux Enterprise Server
9, and later.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

You cannot dynamically move physical I/O devices and slots to logical partitions that use shared
memory. You can assign only virtual adapters to logical partitions that use shared memory.

To dynamically move a physical I/O slot from one running logical partition to another using the HMC,
follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partitions are located.
2. In the work pane, select the logical partition that currently owns the physical I/O slot, click the Tasks

button, and click Dynamic Logical Partitioning → Physical Adapters → Move or Remove.
3. Select the physical I/O slot that you want to move from the list.
4. Select the running logical partition to which you want to move the selected physical I/O slot in Move

to partition.
5. If you want to assign the physical I/O slot to an I/O pool on the logical partition to which the

physical I/O slot will be moved, select the I/O pool for the physical I/O slot in I/O Pool ID.
6. Ensure that any devices that are attached to the managed system through the physical I/O slot are

not busy. The devices should be varied off.
7. Click OK.
Related tasks

“Adding virtual adapters dynamically” on page 172
You can dynamically add a virtual adapter to a running logical partition using the Hardware
Management Console (HMC).
“Removing virtual adapters dynamically” on page 173
You can dynamically remove a virtual adapter from a running logical partition using the Hardware
Management Console (HMC).

Removing physical I/O devices and slots dynamically:
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You can dynamically remove a physical I/O slot and the adapter and devices that are connected to that
slot from a running logical partition using the Hardware Management Console (HMC). This allows you
to reassign the physical I/O slot to other logical partitions.

Before you begin, vary off any devices that are attached to the managed system through the physical I/O
slot that you want to remove. You can vary off devices using operating system commands.

Attention: The dynamic removal of a physical I/O slot that controls disk drives can cause unpredictable
results, such as logical partition failure or loss of data.

A Linux logical partition supports the dynamic removal of physical I/O slots only if the following
conditions are met:
v A Linux distribution that supports dynamic logical partitioning is installed on the Linux logical

partition. Distributions that support dynamic logical partitioning include SUSE Linux Enterprise Server
9, and later.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

To remove a physical I/O slot dynamically from a running logical partition using the HMC, follow these
steps:
1. In the navigation pane of your HMC, open Systems Management, open Servers, and click the

managed system on which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and choose Dynamic Logical

Partitioning → Physical Adapters → Move or Remove.
3. Select the physical I/O slot that you want to remove from the list.
4. Ensure that any devices that are attached to the managed system through the physical I/O slot are

not busy. The devices should be varied off.
5. Click OK.

Managing virtual adapters dynamically:

You can dynamically add and remove virtual adapters to and from running logical partitions using the
Hardware Management Console (HMC).

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in
the partition profile. This means that all configuration changes will be lost the next time the partition
profile is activated. If you want to save your new logical partition configuration, either change the
partition profile or save the logical partition configuration to a new partition profile.
Related reference

“Virtual adapters” on page 55
With virtual adapters, you can connect logical partitions with each other without using physical
hardware. Operating systems can display, configure, and use virtual adapters just like they can display,
configure, and use physical adapters. Depending on the operating environment used by the logical
partition, you can create virtual Ethernet adapters, virtual fibre channel adapters, virtual Small Computer
Serial Interface (SCSI) adapters, and virtual serial adapters for a logical partition.

Adding virtual adapters dynamically:

You can dynamically add a virtual adapter to a running logical partition using the Hardware
Management Console (HMC).

A Linux logical partition supports the dynamic addition of virtual adapters only if the DynamicRM tool
package is installed on the Linux logical partition. To download the DynamicRM tool package, see the
Service and productivity tools for Linux on POWER systems Web site.
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To dynamically add a virtual adapter to a running logical partition using the HMC, you must be a super
administrator, service representative, product engineer, or operator of the HMC.

If you plan to add a virtual adapter to a logical partition that uses shared memory (hereafter referred to
as a shared memory partition), you might need to adjust the amount of I/O entitled memory assigned to
the shared memory partition before you add the adapter.
v If the I/O entitled memory mode of the shared memory partition is set to the auto mode, then you do

not need to take action. When you add the new virtual adapter, the HMC automatically increases the
I/O entitled memory of the shared memory partition to accommodate the new virtual adapter.

v If the I/O entitled memory mode of the shared memory partition is set to the manual mode, then you
must increase the I/O entitled memory that is assigned to the shared memory partition to
accommodate the new adapter. For instructions, see “Adding and removing I/O entitled memory
dynamically to and from a shared memory partition” on page 166.

To dynamically add a virtual adapter to a running logical partition, follow these steps:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the server on which the logical partition is located.
3. In the work pane, select the logical partition to which you want to add a virtual adapter.
4. From the Tasks menu, click Dynamic Logical Partitioning → Virtual Adapters. The Virtual Adapters

window is displayed.
5. Click Actions → Create and click the type of virtual adapter that you want to create. The Create

Virtual Adapter window is displayed.
6. Specify the configuration information for the new adapter and click OK.
7. Click OK. If you create a virtual fibre channel adapter on a client logical partition (that uses virtual

resources provided by a Virtual I/O Server logical partition), the HMC generates a pair of worldwide
port names (WWPNs) for the virtual fibre channel adapter. If all of the WWPNs on the server are
used, you can reset the WWPN prefix to add WWPNs to the server. For instructions, see “Obtaining
additional WWPNs for the server” on page 190. After you reset the WWPN prefix, repeat this
procedure to dynamically add a virtual fibre channel adapter to a client logical partition.

If you created a virtual fibre channel adapter on a Virtual I/O Server logical partition, configure the
virtual fibre channel adapter to a physical port on the physical fibre channel adapter that is connected to
the physical storage that you want the associated client logical partition to access. For instructions, see
Assigning the virtual fibre channel adapter to a physical fibre channel adapter.
Related concepts

“Virtual fibre channel for HMC-managed systems” on page 61
On systems that are managed by the Hardware Management Console (HMC), you can dynamically add
and remove virtual fibre channel adapters to and from the Virtual I/O Server logical partition and each
client logical partition. You can also view information about the virtual and physical fibre channel
adapters and the worldwide port names (WWPNs) by using Virtual I/O Server commands.
Related tasks

“Configuring a virtual fibre channel adapter” on page 131
You can configure a virtual fibre channel adapter dynamically for a running logical partition using the
Hardware Management Console (HMC).
“Configuring a virtual Ethernet adapter” on page 130
You can configure a virtual Ethernet adapter dynamically for a running logical partition by using the
Hardware Management Console (HMC). Doing so will connect the logical partition to a virtual LAN.

Removing virtual adapters dynamically:

You can dynamically remove a virtual adapter from a running logical partition using the Hardware
Management Console (HMC).
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If you plan to dynamically remove a virtual SCSI adapter, vary off any devices that are attached to the
managed system through the virtual SCSI adapter that you want to remove. You can vary off devices
using operating system commands.

Attention: The dynamic removal of a virtual adapter that controls disk drives can cause unpredictable
results, such as logical partition failure or loss of data.

A Linux logical partition supports the dynamic removal of virtual adapters only if the DynamicRM tool
package is installed on the Linux logical partition. To download the DynamicRM tool package, see the
Service and productivity tools for Linux on POWER systems Web site.

To dynamically remove a virtual adapter from a running logical partition using the HMC, you must be a
super administrator, service representative, product engineer, or operator of the HMC.

To dynamically remove a virtual adapter from a running logical partition, follow these steps:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the server on which the logical partition is located.
3. In the work pane, select the logical partition from which you want to remove a virtual adapter.
4. From the Tasks menu, click Dynamic Logical Partitioning → Virtual Adapters. The Virtual Adapters

window is displayed.
5. Select the virtual adapter that you want to remove.
6. Click Actions → Delete.
7. Click OK.

If you removed a virtual adapter from a logical partition that uses shared memory (hereafter referred to
as a shared memory partition), you might want to adjust the amount of I/O entitled memory that is
assigned to the shared memory partition.
v If the I/O entitled memory mode of the shared memory partition is set to the auto mode, then you do

not need to take action. When you remove the new virtual adapter, the HMC automatically decreases
the I/O entitled memory of the shared memory partition accordingly.

v If the I/O entitled memory mode of the shared memory partition is set to the manual mode, consider
decreasing the I/O entitled memory that is assigned to the shared memory partition to improve
performance. For instructions, see “Determining the I/O entitled memory for a shared memory
partition” on page 225.

If you removed a virtual fibre channel adapter from a client logical partition, the hypervisor deletes the
worldwide port names (WWPNs) assigned to the virtual fibre channel adapter and does not reuse the
WWPNs. You must either repeat this procedure to remove the associated virtual fibre channel adapter
from the Virtual I/O Server, or edit the partition profile properties to associate it with another virtual
fibre channel adapter on a client logical partition.

If you removed a virtual fibre channel adapter from a Virtual I/O Server logical partition, you must do
one of the following tasks:
v Repeat this procedure to remove the associated virtual fibre channel adapter on the client logical

partition.
v Edit the partition profile properties to associate the virtual fibre channel adapter on the client logical

partition with another virtual fibre channel adapter on the Virtual I/O Server logical partition.
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Related concepts

“Virtual fibre channel for HMC-managed systems” on page 61
On systems that are managed by the Hardware Management Console (HMC), you can dynamically add
and remove virtual fibre channel adapters to and from the Virtual I/O Server logical partition and each
client logical partition. You can also view information about the virtual and physical fibre channel
adapters and the worldwide port names (WWPNs) by using Virtual I/O Server commands.
Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.

Managing 5250 CPW dynamically:

You can dynamically add, remove, and move 5250 commercial processing workload (5250 CPW) to and
from running logical partitions using the Hardware Management Console (HMC).

5250 CPW is the capacity to perform 5250 online transaction processing (5250 OLTP) tasks on IBM i
logical partitions. Certain IBM System i models allow you to assign a percentage of the total 5250 CPW
available on the managed system to each IBM i logical partition. The ability to assign 5250 CPW to IBM i
logical partitions is available only for Express Configurations and Value Editions.

5250 CPW can be moved based on the desired, minimum, and maximum percentages you created for the
partition profile. The desired 5250 CPW percentage you establish is the amount of 5250 CPW that you get
if you do not overcommit the available 5250 CPW. The minimum and maximum values enable you to
establish a range within which you can dynamically move the 5250 CPW.

Attention: If resources are moved dynamically, the configuration change is temporary and is not
reflected in the partition profile. This means that all configuration changes will be lost the next time the
partition profile is activated. If you want to save your new logical partition configuration, you should
change the partition profile or save the logical partition configuration to a new partition profile.

Adding 5250 CPW for IBM i logical partitions dynamically:

You can dynamically add 5250 commercial processing workload (5250 CPW) to a running IBM i logical
partition using the Hardware Management Console (HMC). This allows you to increase the ability of the
IBM i logical partition to run 5250 online transaction processing (5250 OLTP) tasks.

This procedure applies only to Express Configurations and Value Editions, which provide a fixed amount
of processing capability for 5250 OLTP tasks.

To add 5250 CPW to a running IBM i logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition resides.
2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Processor → Add or Remove.
3. Enter the amounts of 5250 CPW that you want the logical partition to have into the 5250 CPW

(percent) field in the Current column.
4. Adjust the settings in the Options area if necessary. You might need to increase the value in the

Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system adds 5250 CPW dynamically. These settings are not retained after
the addition is completed.)

5. Click OK.
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Moving 5250 CPW for IBM i logical partitions dynamically:

You can dynamically move 5250 commercial processing workload (5250 CPW) from one running IBM i
logical partition to another using the Hardware Management Console (HMC). This allows you to use the
limited amount of 5250 CPW that is available on your managed system efficiently.

This procedure applies only to Express Configurations and Value Editions, which provide a fixed amount
of processing capability for 5250 online transaction processing (5250 OLTP) tasks.

To move 5250 CPW from one running IBM i logical partition to another using the HMC, follow these
steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partitions reside.
2. In the work pane, select the logical partition from which you want to move 5250 CPW, click the Tasks

button, and click Dynamic Logical Partitioning → Processor → Move.
3. Enter the amounts of 5250 CPW that you want to move into the 5250 CPW (percent) field in the To

move column.
4. Select the logical partition to which you want to move 5250 CPW in Select Destination Partition.
5. Adjust the settings in the Options area if necessary. You might need to increase the value in the

Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system moves 5250 CPW dynamically. These settings are not retained after
the move is completed.)

6. Click OK.

Removing 5250 CPW for IBM i logical partitions dynamically:

You can dynamically remove 5250 commercial processing workload (5250 CPW) dynamically from a
running IBM i logical partition using the Hardware Management Console (HMC). This allows you to
make 5250 CPW available for assignment to other IBM i logical partitions on the managed system.

This procedure applies only to Express Configurations and Value Editions, which provide a fixed amount
of processing capability for 5250 online transaction processing (5250 OLTP) tasks.

To remove 5250 CPW from a running IBM i logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition resides.
2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Processor → Add or Remove.
3. Enter the amounts of 5250 CPW that you want the logical partition to have into the 5250 CPW

(percent) field in the Current column.
4. Adjust the settings in the Options area if necessary. You might need to increase the value in the

Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system removes 5250 CPW dynamically. These settings are not retained
after the removal is completed.)

5. Click OK.

Scheduling the movement of resources to and from logical partitions:

You can use the Hardware Management Console (HMC) to schedule the movement of dedicated memory,
logical memory, dedicated processors, shared processors, and I/O devices between running logical
partitions on a managed system. This allows you to move resources between running logical partitions
without user intervention.

176 Logical partitioning



To schedule the movement of resources to or from a running logical partition using the HMC, follow
these steps:
1. In the navigation pane, open Systems Management → Servers, and click the system on which the

logical partition is located.
2. In the work pane, select the logical partition for which you want to schedule the movement of

resources, click the Tasks button, and click Operations → Schedule Operations. (If you want to
schedule the movement of resources from one logical partition to another, select the logical partition
from which you are moving resources.)

3. Click Options and click New.
4. Select Dynamic Reconfiguration, and click OK.
5. Select the date and time on which you want the movement to occur.
6. Select the Options tab and select the resource type (I/O, memory, or processor), the type of

movement (Add, Remove, or Move to), the destination logical partition (if you are moving resources
to another logical partition), and the quantity (in processors or in megabytes) or the I/O slot that you
want to move.

Note: You can add or remove logical memory to or from a logical partition. You cannot move logical
memory from one logical partition to another logical partition.

7. If you want the operation to be repeated, select the Repeat tab and specify how you want the
operation to be repeated.

8. Click Save.
9. When the message dialog displays, click OK to continue.

When this procedure is completed, the managed system is set to perform the dynamic logical partitioning
task at the date and time that you specify.

Saving the logical partition configuration to a partition profile:

You can save the current configuration of a logical partition to a new partition profile using the
Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical
partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate
the logical partition. This procedure allows you to save the changed configuration to a new partition
profile instead of having to enter the changed resource allocations manually.

You can perform this procedure at any time after you initially activate a logical partition.

You can perform this procedure on active logical partitions and on logical partitions that are shut down.
In either of these cases, the HMC reads the logical configuration that is stored for the logical partition in
the server firmware and saves this logical configuration to the specified partition profile. For active
logical partitions, the logical configuration that is stored in the server firmware is the current logical
configuration of the logical partition. For logical partitions that are shut down, the logical configuration
that is stored in the server firmware is the logical configuration at the time that you shut down the
logical partition. Regardless of the state of the logical partition at the time that you perform this
procedure, the procedure allows you to save the dynamic logical partitioning changes to a partition
profile and use the partition profile to reactivate the logical partition without losing those changes.

After you shut down a logical partition, other logical partitions can use the resources that were used by
that logical partition when the logical partition was active. Therefore, the resources available on the
managed system might not support the logical partition configuration that is stored in the server
firmware for the inactive logical partition. After you save the logical configuration of a logical partition
that is shut down, verify that the resources available on the managed system can support the logical
partition configuration that you saved to a partition profile.
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When you save the logical configuration to a new partition profile, the desired amounts of memory,
processors, processing units, and virtual processors in the new partition profile are set to the current
amounts from the logical configuration. The minimum and maximum amounts of memory, processors,
processing units, and virtual processors in the new partition profile are set to the minimum and
maximum amounts from the logical configuration. For example, you start a logical partition using a
partition profile that specifies a minimum of 512 MB of dedicated memory, a maximum of 2 GB of
dedicated memory, and 1 GB as the desired amount of dedicated memory. The managed system has over
1 GB of physical memory available, so the logical partition has 1 GB of physical memory when it starts.
You then add 1 GB of physical memory to the logical partition for a total of 2 GB of physical memory. If
you shut down the logical partition and then save the logical configuration, the resulting partition profile
specifies a minimum of 512 MB of dedicated memory, a maximum of 2 GB of dedicated memory, and 2
GB as the desired amount of dedicated memory.

The physical and virtual I/O devices that are set as required in the active partition profile are saved as
required devices in the new partition profile. The physical and virtual I/O devices that are set as desired
in the active partition profile or that were added to the logical partition through dynamic logical
partitioning are saved as desired devices in the new partition profile. The partition workload group on
the logical partition (if any) is saved as the partition workload group on the new partition profile.

To save the current configuration of a logical partition to a new partition profile using the HMC,
complete the following:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and click Configuration → Save

Current Configuration.
3. Enter the name of the new partition profile into New profile and click OK.

After you save the logical configuration to a new partition profile, verify that the new partition profile is
set the way that you want. In particular, verify that the required and desired settings are set correctly for
your I/O devices. By default, physical and virtual I/O devices that are added to the logical partition
using dynamic logical partitioning are saved as desired devices in the new partition profile. If you want
any of these I/O devices to be required, you must change the partition profile so that the I/O device is
required.
Related concepts

“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.
Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.

Managing virtual resources for Virtual I/O Server logical partitions using the
Hardware Management Console
Use the Hardware Management Console to manage virtual storage that is associated with Virtual I/O
Server logical partitions.

Changing a virtual disk for a VIOS logical partition using the Hardware Management Console:

You can use the Hardware Management Console to view the properties of the virtual disks on your
managed system, as well as to start virtual disk management tasks.
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Virtual disks are also known as logical volumes. To assign the virtual disk to a client partition, ensure
that the client partition owns one or more virtual SCSI adapters and that the Virtual I/O Server owns
corresponding virtual SCSI adapters that host the client adapter.

To change a virtual disk, be sure you meet the following requirements:
v The Hardware Management Console must be at version 7 release 3.4.2 or later.
v The Virtual I/O Server must be at version 2.1.1.0 or later.
v Ensure that there is a resource monitoring and control connection between the Hardware Management

Console and the Virtual I/O Server.

To view and to change virtual disks, complete the following steps in the Hardware Management Console:
1. In the navigation area, expand Systems Management > Servers, and select the server on which the

Virtual I/O Server logical partition is located.
2. In the Tasks pane, click Configuration > Virtual Resources > Virtual Storage Management. The

Virtual Storage Management page is displayed.
3. Select a Virtual I/O Server logical partition.
4. Click the Virtual Disks tab to display a list of virtual disks on the managed system.
5. Select the virtual disk from the table that you want to change. If a virtual disk is defined as a paging

space device and is assigned to a shared memory pool, it is dedicated to providing this function and
is no longer available for any other purpose. Consequently, such a virtual disk is not listed here.

6. From the Select Action menu bar of the Virtual Disks table, select the storage management task you
want to perform:
v Properties to view the properties of the selected virtual disks.
v Extend to add storage capacity to the selected virtual disks.
v Delete to delete the selected virtual disk and make the storage resources that belonged to that

virtual disk available to other virtual disks.
v Modify assignment to change the logical partition to which the selected virtual disk is assigned, or

to set the selected virtual disk so it is not assigned to any logical partitions.

Changing an optical device for a VIOS logical partition by using the Hardware Management
Console:

You can use the Hardware Management Console to view and to change physical optical devices and
virtual optical media.

You can add optical devices to, or remove optical devices from, any logical partition, whether or not the
logical partition is active. If you remove an optical device from an active logical partition, the Hardware
Management Console prompts you to confirm the removal before removing the optical device. To assign
an optical device to a client partition, ensure that the client partition owns one or more virtual SCSI
adapters and that the VIOS owns corresponding virtual SCSI adapters that host the client adapter.

To change virtual optical media, be sure you meet the following requirements:
v The Hardware Management Console must be at version 7 release 3.4.2 or later.
v The Virtual I/O Server must be at version 2.1.1.0 or later.
v Ensure that there is a resource monitoring and control connection between the Hardware Management

Console and the Virtual I/O Server.
v Verify that a virtual media library exists before you manage, create, or assign virtual optical devices.

To view and change optical devices, complete the following steps in the Hardware Management Console:
1. In the navigation area, expand Systems Management > Servers, and select the server on which the

Virtual I/O Server logical partition is located.
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2. In the Tasks pane, click Configuration > Virtual Resources > Virtual Storage Management. The
Virtual Storage Management page is displayed.

3. Select a Virtual I/O Server logical partition.
4. Click the Optical Devices tab.
5. To change the logical partition assignment for a physical optical device, complete the following steps.

(You cannot assign a physical optical device to an IBM i logical partition. An IBM i logical partition
must use virtual optical devices instead.)
a. From the Physical Optical Devices table, select the optical device that you want to change and

click Modify assignment. The Modify Physical Optical Device Assignment page is displayed.
b. Either change the logical partition to which the optical device is assigned, or set the optical device

so it is not assigned to any logical partition, and click OK. The list of optical devices reflects the
changes you made.

6. To change virtual optical media, click one of the following tasks in the Virtual Optical Media section:
v Create/Extend Library to extend the size of the media library.
v Delete Library to delete the media library and the files within the library.
v Add Media to add an optical media file to the media library and make it available for assignment

to a partition.
v Modify partition assignment to change the partition assignment for a media file by changing the

virtual optical device to which a media file is assigned. You can assign read-only media to more
than one partition.

v Delete to delete the selected media files from the media library.

Changing a storage pool for a VIOS logical partition using the Hardware Management Console:

You can use the Hardware Management Console to extend a storage pool, to reduce or remove a storage
pool, and to assign a storage pool as the default storage pool for the managed system.

To view and change storage pools, be sure you meet the following requirements:
v The Hardware Management Console must be at version 7 release 3.4.2 or later.
v The Virtual I/O Server must be at version 2.1.1.0 or later.
v Ensure that there is a resource monitoring and control connection between the Hardware Management

Console and the Virtual I/O Server.

To view and to change storage pools, complete the following steps in the Hardware Management
Console:
1. In the navigation area, expand Systems Management > Servers, and select the server on which the

Virtual I/O Server logical partition is located.
2. In the Tasks pane, click Configuration > Virtual Resources > Virtual Storage Management. The

Virtual Storage Management page is displayed.
3. Select a Virtual I/O Server logical partition.
4. Click the Storage Pools tab to display a list of storage pools defined for the managed system.
5. Select the storage pool from the table that you want to change.
6. From the Select Action menu bar of the Storage Pools table, select the storage management task that

you want to perform:
v Properties to view the properties of the selected storage pool.
v Extend to add storage capacity to the selected storage pool. To extend logical volume-based storage

pools, add physical volumes to the storage pool. To extend file-based storage pools, add space from
the parent storage pool to the file-based storage pool.

Note: You cannot add a physical volume to a storage pool if it is already assigned to a partition.
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v Reduce to reduce the size of the selected storage pool. To reduce logical volume-based storage
pools, remove physical volumes from the storage pool. To reduce the file-based storage pool, the
storage pool is deleted.
Attention: Reducing a storage pool that contains virtual disks could potentially destroy data
stored on the virtual disks.

Changing a physical volume for a VIOS logical partition using the Hardware Management Console:

You can use the Hardware Management Console to view the properties of the physical volumes on your
managed system, as well as to start physical volume management tasks.

A physical volume can be a hard disk or a logical device on a storage area network (SAN). You can either
assign a physical volume directly to a logical partition, or you can add a physical volume to a storage
pool and create virtual disks to assign to logical partitions from the storage pool.

To change physical volumes, be sure you meet the following requirements:
v The Hardware Management Console must be at version 7 release 3.4.2 or later.
v The Virtual I/O Server must be at version 2.1.1.0 or later.
v Ensure that there is a resource monitoring and control connection between the Hardware Management

Console and the Virtual I/O Server.

To view and to modify physical volumes, complete the following steps in the Hardware Management
Console:
1. In the navigation area, expand Systems Management > Servers, and select the server on which the

Virtual I/O Server logical partition is located.
2. In the Tasks pane, click Configuration > Virtual Resources > Virtual Storage Management. The

Virtual Storage Management page is displayed.
3. Select a Virtual I/O Server logical partition.
4. Click the Physical Volumes tab to display a list of physical volumes on the managed system.
5. Select the physical volume from the table that you want to change. If a physical volume is defined as

a paging space device and is assigned to a shared memory pool, it is dedicated to providing this
function and is not available for any other purpose. Consequently, such a physical volume is not
listed here.

6. From the Select Action menu bar of the Physical Volumes table, select the storage management task
that you want to perform:
v Properties to view or change the properties of the selected physical volume.
v Modify partition assignment to change the logical partition to which the selected physical volume

is assigned, or to set the physical volume so it is not assigned to any logical partition.
v Add to storage pool to add the selected physical volume to a storage pool.
v Remove from storage pool to remove the selected physical volume from the selected storage pool.

Changing virtual fibre channel for a Virtual I/O Server using the Hardware Management Console:

You can use the Hardware Management Console to dynamically manage virtual fibre channel on your
managed system and the partition connections for the associated physical fibre channel ports. Assigning
one or more physical ports to a logical partition enables the partition to communicate with storage
devices in a storage area network (SAN). Configuring this type of storage resource is available only when
the system supports the use of virtual fibre channel adapters and has a physical fibre channel adapter
installed and connected that supports N_Port ID Virtualization (NPIV) ports.

To assign the virtual fibre channel adapter to a physical port, ensure that the client logical partition owns
one or more virtual fibre channel adapters and that the Virtual I/O Server owns corresponding virtual
fibre channel adapters to host the client adapter.
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To change a port connection assignment for a logical partition, the partition must be either in the Not
activated or the Running state. If the partition is in the Running state, the partition must also be capable
of dynamic LPAR (DLPAR).

To avoid configuring the physical fibre channel adapter to be a single point of failure for the connection
between the client logical partition and its physical storage on the SAN, do not connect two virtual fibre
channel adapters from the same client logical partition to the same physical fibre channel adapter.
Instead, connect each virtual fibre channel adapter to a different physical fibre channel adapter.

To change virtual fibre channel, be sure you meet the following requirements:
v The Hardware Management Console must be at version 7 release 3.4.2 or later.
v The Virtual I/O Server must be at version 2.1.1.0 or later.
v Ensure that there is a resource monitoring and control connection between the Hardware Management

Console and the Virtual I/O Server.

Note: IBM i client partitions do not support the use of virtual fibre channel.

To configure the physical port connections for virtual fibre channel, complete the following steps in the
Hardware Management Console:
1. In the navigation area, expand Systems Management > Servers, and select the server on which the

Virtual I/O Server logical partition is located.
2. In the Tasks pane, click Configuration > Virtual Resources > Virtual Storage Management. The

Virtual Storage Management page is displayed.
3. Select a Virtual I/O Server logical partition.
4. Click the Virtual Fibre Channel tab.
5. Select a port with at least one available connection and click Modify partition connections. The

Modify Virtual Fibre Channel Partition Assignment page is displayed.
6. Select one or more logical partitions that you want to connect to the fibre channel port, and click OK.

Note: If you delete the client virtual fibre channel adapter from the partition or the partition profile,
the worldwide port names associated with the port and the storage area network (SAN) are lost. If
you only change the port assignment, the worldwide port names are preserved inside the partition
profile. The Hardware Management Console does not reuse them when it generates port names in the
future. If you run out of port names, you must obtain a code key to enable an additional prefix and
range of port names for use on your system.

7. Click OK. To determine the actual number of port names available on the managed system, use the
Hardware Management Console to view the partition properties or partition profile properties of the
client logical partition.

Managing the memory configuration of a logical partition
You can use the Hardware Management Console (HMC) to change the memory configuration of a logical
partition. For example, you can change the Virtual I/O Server logical partitions that are assigned to a
logical partition that uses shared memory, change the memory mode of a logical partition, and
dynamically add and remove dedicated or shared memory to and from a logical partition.

Changing the paging VIOS partitions assigned to a shared memory partition:

You can use the Hardware Management Console (HMC) to change the primary and secondary Virtual
I/O Server logical partitions (hereafter referred to as paging VIOS partitions) that are assigned to a logical
partition that uses shared memory. You can also add or remove a secondary paging VIOS partition to or
from a logical partition that uses shared memory (hereafter referred to as a shared memory partition).

Before you change the paging VIOS partitions that are assigned to a shared memory partition, complete
the following tasks:
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1. Ensure that the Virtual I/O Server logical partitions (that you plan to assign to the shared memory
partition as paging VIOS partitions) are assigned to the shared memory pool. For instructions, see
“Changing the paging VIOS partitions assigned to the shared memory pool” on page 141.

2. Ensure that the paging space device (that is accessed through the paging VIOS partitions that you
plan to assign to the shared memory partition) is assigned to the shared memory pool. For
instructions, see “Adding and removing paging space devices to and from the shared memory pool”
on page 147.

To change the paging VIOS partitions that are assigned to a shared memory partition, complete the
following steps:
1. In the navigation pane, open Systems Management → Servers, and click the system on which the

shared memory partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and click Configuration →

Manage Profiles. The Managed Profiles window is displayed.
3. Select the partition profile that you want to change.
4. Click Actions, and click Edit. The Logical Partition Profile Properties window is displayed.
5. Click the Memory tab.
6. Specify a Virtual I/O Server logical partition for VIOS 1 and VIOS 2.

Table 26. Change options for the paging VIOS partitions

Desired change Field to change

Change the Virtual I/O Server logical partition that is
assigned as the primary or the only paging VIOS
partition.

Select a different Virtual I/O Server logical partition for
VIOS 1.

Define a secondary paging VIOS partition. Select a Virtual I/O Server logical partition for VIOS 2.

Change the Virtual I/O Server logical partition that is
assigned as the secondary paging VIOS partition.

Select a different Virtual I/O Server logical partition for
VIOS 2.

Remove the secondary paging VIOS partition. Select None for VIOS 2.

7. Click OK.
8. Shut down the shared memory partition and reactivate it with the changed partition profile.

After you change the paging VIOS partitions that are assigned to a shared memory partition, restart the
shared memory partition with the changed partition profile. For instructions, see “Shutting down and
restarting logical partitions” on page 150.

Changing the memory weight of a shared memory partition:

You can use the Hardware Management Console (HMC) to change the memory weight of a logical
partition that uses shared memory (hereafter referred to as a shared memory partition). Changing the
memory weight changes the probability that the shared memory partition receives physical memory from
the shared memory pool in relation to other shared memory partitions.

A Linux shared memory partition supports changing the memory weight only if the DynamicRM tool
package is installed on the Linux shared memory partition. To download the DynamicRM tool package,
see the Service and productivity tools for Linux on POWER systems Web site.

To change the memory weight assigned to the shared memory partition, complete the following steps
from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the server on which the shared memory partition runs.
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3. In the work pane, select the shared memory partition to which you want to add or remove logical
memory.

4. From the Tasks menu, click Dynamic Logical Partitioning → Memory → Add or Remove. The
Add/Remove Memory Resources window is displayed.

5. In the Memory Capacity Weight (0–255) field, enter the memory weight that you want to assign to
the shared memory partition.

6. Click OK.

Changing the memory weight of a shared memory partition is temporary and is not reflected in the
partition profile. The new memory weight that you assigned to the shared memory partition will be lost
the next time you activate the partition profile. If you want to save the changes that you made to the
memory weight of the shared memory partition, either change the partition profile or save the logical
partition configuration to a new partition profile.
Related concepts

“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.
“Shared memory distribution” on page 48
The hypervisor uses the memory weight of each logical partition that uses shared memory (hereafter
referred to as shared memory partitions) to help determine which logical partitions receive more physical
memory from the shared memory pool. To help optimize performance and memory use, the operating
systems that run in shared memory partitions provide the hypervisor with information about how the
operating system uses its memory to help the hypervisor determine which pages to store in the shared
memory pool and which pages to store in the paging space devices.

Changing the memory mode of a logical partition:

You can create multiple partition profiles for a logical partition by using the Hardware Management
Console (HMC). Some of the partition profiles can specify dedicated memory and some of the partition
profiles can specify shared memory. By creating partition profiles that specify both dedicated memory
and shared memory for the same logical partition, you can change the memory mode of the logical
partition by activating different partition profiles.

To change the memory mode of a logical partition, complete the following steps from the HMC:
1. Create a new partition profile for the logical partition. For instructions, see “Creating additional

partition profiles” on page 113.
v If you plan to change a dedicated memory partition to a shared memory partition, specify the

shared memory mode in the new partition profile.
v If you plan to change a shared memory partition to a dedicated memory partition, specify the

dedicated memory mode in the new partition profile.
2. Shut down the logical partition. For instructions, see “Shutting down and restarting logical partitions”

on page 150.
3. Activate the logical partition with the new partition profile. For instructions, see “Activating a logical

partition” on page 148.
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Related concepts

“Memory” on page 21
Processors use memory to temporarily hold information. Memory requirements for logical partitions
depend on the logical partition configuration, I/O resources assigned, and applications used.
“Partition profile” on page 8
A partition profile is a record on the Hardware Management Console (HMC) that specifies a possible
configuration for a logical partition. When you activate a logical partition using a partition profile, the
managed system attempts to start the logical partition using the configuration information in the partition
profile.
Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.

Managing dedicated memory dynamically:

You can add, remove, and move physical memory dynamically to and from running logical partitions
that use dedicated memory using the Hardware Management Console (HMC). This allows you to adjust
the physical memory allocated to each logical partition that uses dedicated memory without having to
shut down the logical partitions.

Dynamic memory changes on IBM i logical partitions affect the base memory pool of the logical
partitions (*BASE pool). Private memory pools or shared memory pools are not affected. Dynamic
memory changes cannot cause the amount of memory in the base pool to fall below the minimum
amount of memory required in the base pool (as determined by the base storage minimum size
(QBASPOOL) system value). If a dynamic memory change would cause the base pool to fall below this
amount, the system releases excess memory pages only after keeping the minimum amount of memory
required in the base pool.

To prevent any data loss during dynamic memory movement, the system first writes any data from
memory pages to disk before making the memory pages available to another logical partition. Depending
on the amount of memory you have requested to move, this might take some time.

Memory in each logical partition operates within its assigned minimum and maximum values. The full
amount of memory that you assign to a logical partition might not be available for the logical partition to
use. Static memory overhead that is required to support the assigned maximum memory affects the
reserved or hidden memory amount. This static memory overhead also influences the minimum memory
size of a logical partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in
the partition profile. This means that all configuration changes will be lost the next time the partition
profile is activated. If you want to save your new logical partition configuration, either change the
partition profile or save the logical partition configuration to a new partition profile.

Logical partitioning 185



Related tasks

“Changing partition profile properties” on page 159
You can change the properties of a partition profile using the Hardware Management Console (HMC).
Changing the properties of a partition profile changes the resource amounts that are assigned to a logical
partition when you shut down and restart the logical partition using the changed partition profile.
“Saving the logical partition configuration to a partition profile” on page 177
You can save the current configuration of a logical partition to a new partition profile using the
Hardware Management Console (HMC). Use this procedure if you change the configuration of a logical
partition using dynamic logical partitioning and you do not want to lose the changes when you reactivate
the logical partition. This procedure allows you to save the changed configuration to a new partition
profile instead of having to enter the changed resource allocations manually.

Adding dedicated memory dynamically:

You can dynamically add physical memory to a running logical partition that uses dedicated memory
using the Hardware Management Console (HMC). This allows you to increase the physical memory
available to a logical partition that uses dedicated memory without having to shut down the logical
partition.

A Linux logical partition supports the dynamic addition of memory resources only if the following
conditions are met:
v A Linux distribution that supports the dynamic addition of memory resources is installed on the Linux

logical partition. Distributions that support the dynamic addition of memory resources include SUSE
Linux Enterprise Server 10, and later.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

To add memory to a Linux logical partition that uses an earlier version of these distributions, you must
shut down the Linux logical partition and reactivate the logical partition using a partition profile that
specifies a greater amount of memory.

To add memory dynamically to a running logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Memory → Add or Remove.
3. In the Assigned Memory field, enter the total amount of physical memory that you want to assign to

the logical partition. You can enter the size in a combination of gigabytes (GB) plus megabytes (MB).
4. Adjust the settings in the Options area if necessary. You might need to increase the value in the

Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system adds memory dynamically. These settings are not retained after the
addition is completed.)

5. Click OK.

Moving dedicated memory dynamically:

You can dynamically move physical memory from one running logical partition that uses dedicated
memory to another using the Hardware Management Console (HMC). This allows you to reassign
physical memory directly to a logical partition that uses dedicated memory that needs additional physical
memory.

You cannot dynamically move memory from a running Linux logical partition. To remove memory from
a Linux logical partition, you must shut down the Linux logical partition and reactivate the logical
partition using a partition profile that specifies a lesser amount of memory.
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You can dynamically move memory to a running Linux only if the following conditions are met:
v A Linux distribution that supports the dynamic addition of memory resources is installed on the Linux

logical partition. Distributions that support the dynamic movement of memory resources include
Novell SUSE Linux Enterprise Server 10, and later.

v The DynamicRM tool package is installed on the Linux logical partition. To download the DynamicRM
tool package, see the Service and productivity tools for Linux on POWER systems Web site.

To move memory to a Linux logical partition that uses an earlier version of these distributions, you must
shut down the Linux logical partition and reactivate the logical partition using a partition profile that
specifies a greater amount of memory.

To dynamically move memory from one running logical partition to another using the HMC, follow these
steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partitions are located.
2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Memory → Move.
3. Enter the amount of physical memory that you want to move from the logical partition. You can enter

the size in a combination of gigabytes (GB) plus megabytes (MB).
4. Select the logical partition to which you want to move the specified amount of physical memory.
5. Adjust the settings in the Options area if necessary. You might need to increase the value in the

Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system moves memory dynamically. These settings are not retained after
the move operation is completed.)

6. Click OK.

Removing dedicated memory dynamically:

You can dynamically remove physical memory from a running AIX, IBM i, or Virtual I/O Server logical
partition that uses dedicated memory using the Hardware Management Console (HMC). This allows you
to reassign the physical memory to other logical partitions that use dedicated memory.

You cannot dynamically remove memory from a running Linux logical partition. To remove memory
from a Linux logical partition, you must shut down the logical partition and reactivate the logical
partition using a partition profile that specifies a lesser amount of memory.

To dynamically remove memory from a running logical partition using the HMC, follow these steps:
1. In the navigation pane, open Systems Management → Servers, and click the managed system on

which the logical partition is located.
2. In the work pane, select the logical partition, click the Tasks button, and click Dynamic Logical

Partitioning → Memory → Add or Remove.
3. In the Assigned Memory field, enter the total amount of physical memory that you want to assign to

the logical partition. You can enter the size in a combination of gigabytes (GB) plus megabytes (MB).
4. Adjust the settings in the Options area if necessary. You might need to increase the value in the

Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system removes memory dynamically. These settings are not retained after
the removal is completed.)

5. Click OK.

Managing shared memory dynamically:
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You can dynamically add and remove logical memory and I/O entitled memory to and from a logical
partition that uses shared memory (hereafter referred to as a shared memory partition) using the Hardware
Management Console (HMC).

Dynamic memory changes on IBM i logical partitions affect the base memory pool of the logical
partitions (*BASE pool). Private memory pools or shared memory pools are not affected. Dynamic
memory changes cannot cause the amount of memory in the base pool to fall below the minimum
amount of memory required in the base pool (as determined by the base storage minimum size
(QBASPOOL) system value). If a dynamic memory change would cause the base pool to fall below this
amount, the system releases excess memory pages only after keeping the minimum amount of memory
required in the base pool.

To prevent any data loss during dynamic memory movement, the system first writes any data from
memory pages to disk before making the memory pages available to another logical partition. Depending
on the amount of memory you have requested to move, this might take some time.

Memory in each logical partition operates within its assigned minimum and maximum values. The full
amount of memory that you assign to a logical partition might not be available for the logical partition to
use. Static memory overhead that is required to support the assigned maximum memory affects the
reserved or hidden memory amount. This static memory overhead also influences the minimum memory
size of a logical partition.

Note: If resources are moved dynamically, the configuration change is temporary and is not reflected in
the partition profile. This means that all configuration changes will be lost the next time the partition
profile is activated. If you want to save your new logical partition configuration, either change the
partition profile or save the logical partition configuration to a new partition profile.
Related concepts

“Shared memory” on page 25
You can configure your system so that multiple logical partitions share a pool of physical memory. A
shared memory environment includes the shared memory pool, logical partitions that use the shared
memory in the shared memory pool, logical memory, I/O entitled memory, at least one Virtual I/O
Server logical partition, and paging space devices.

Adding and removing logical memory dynamically to and from a shared memory partition:

You can dynamically add and remove logical memory to and from a running logical partition that uses
shared memory (hereafter referred to as a shared memory partition) using the Hardware Management
Console (HMC). This allows you to increase and decrease the logical memory assigned to the shared
memory partition without having to shut down the logical partition.

A Linux shared memory partition supports the dynamic addition and removal of logical memory
resources only if the DynamicRM tool package is installed on the Linux shared memory partition. To
download the DynamicRM tool package, see the Service and productivity tools for Linux on POWER
systems Web site.

To dynamically add and remove logical memory to and from a running logical partition using the HMC,
you must be a super administrator, service representative, product engineer, or operator of the HMC.

To add or remove logical memory to or from a shared memory partition, complete the following steps
from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the server on which the shared memory partition runs.
3. In the work pane, select the shared memory partition to which you want to add or remove logical

memory.
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4. From the Tasks menu, click Dynamic Logical Partitioning → Memory → Add or Remove. The
Add/Remove Memory Resources window is displayed.

5. In the Assigned Memory field, enter the total amount of logical memory that you want to assign to
the shared memory partition. You can enter the size in a combination of gigabytes (GB) plus
megabytes (MB).

6. Click OK.
Related concepts

“Logical memory” on page 34
Logical memory is the address space, assigned to a logical partition, that the operating system perceives as
its main storage. For a logical partition that uses shared memory (hereafter referred to as a shared memory
partition), a subset of the logical memory is backed up by physical main storage and the contents of the
remaining logical memory are kept in auxiliary storage.

Adding and removing I/O entitled memory dynamically to and from a shared memory partition:

You can dynamically add and remove I/O entitled memory to and from a running logical partition that
uses shared memory (hereafter referred to as a shared memory partition) using the Hardware Management
Console (HMC). This allows you to increase and decrease the maximum amount of physical memory that
is assigned to the shared memory partition for its I/O devices without having to shut down the shared
memory partition.

A Linux shared memory partition supports the dynamic addition and removal of I/O entitled memory
resources only if the DynamicRM tool package is installed on the Linux shared memory partition. To
download the DynamicRM tool package, see the Service and productivity tools for Linux on POWER
systems Web site.

You can increase the amount of I/O entitled memory that is assigned to a shared memory partition when
the sum of I/O entitled memory that is assigned to all shared memory partitions in the shared memory
pool is less than the size of the shared memory pool minus the required amount of reserved firmware
memory. If there is not enough physical memory in the shared memory pool by which to increase the
I/O entitled memory to the amount specified, you can release to the hypervisor the physical memory that
is currently assigned to other shared memory partitions that are shut down. The hypervisor can then
assign the released physical memory to the shared memory partition that needs more I/O entitled
memory.

You can decrease the amount of I/O entitled memory that is assigned to a shared memory partition only
when the shared memory partition requires less physical memory for its I/O devices than the amount of
I/O entitled memory that is assigned to the shared memory partition. For example, you assign 128 MB of
I/O entitled memory to a shared memory partition. The shared memory partition requires a minimum of
64 MB for its I/O devices. Thus, you can decrease the I/O entitled memory that is assigned to the shared
memory partition by up to 64 MB. For instructions about how to view the assigned, minimum, optimal,
and maximum I/O entitled memory used by a shared memory partition, see “Determining the I/O
entitled memory for a shared memory partition” on page 225.

To dynamically add and remove I/O entitled memory to and from a running shared memory partition
using the HMC, you must be a super administrator, service representative, product engineer, or operator
of the HMC.

To add and remove I/O entitled memory to or from a shared memory partition, complete the following
steps from the HMC:
1. In the navigation pane, expand Systems Management → Servers.
2. Click the server on which the shared memory partition runs.
3. In the work pane, select the shared memory partition to which you want to add or remove logical

memory.
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4. From the Tasks menu, click Dynamic Logical Partitioning → Memory → Add or Remove. The
Add/Remove Memory Resources window is displayed.

5. If Auto is selected, deselect Auto. This changes the I/O entitled memory mode to the manual mode.
6. In the I/O Entitled Memory field, enter the total amount of I/O entitled memory that you want to

assign to the shared memory partition. You can enter the size in a combination of gigabytes (GB) plus
megabytes (MB).

7. Adjust the settings in the Options area if necessary. You might need to increase the value in the
Timeout (minutes) field to allow enough time for the HMC to complete the operation. (These settings
relate to how the managed system adds memory dynamically. These settings are not retained after the
addition completes.

8. Click OK. If there is not enough physical memory in the shared memory pool by which to increase
the I/O entitled memory to the amount specified in step 6 on page 167, the Release Memory
Resources window is displayed.

9. Select shared memory partitions that are shut down until the available memory is equal to or greater
than the requested memory and click OK.

If you want to later change the I/O entitled memory mode back to the auto mode so that the HMC and
IVM automatically adjust the I/O entitled memory for the shared memory partition when you add or
remove virtual adapters, repeat this procedure and select Auto. Alternatively, you can restart the shared
memory partition. When you restart a shared memory partition, the I/O entitled memory mode is set to
the auto mode regardless of what the I/O entitled memory mode was set to before you restarted the
shared memory partition.
Related tasks

“Managing virtual adapters dynamically” on page 172
You can dynamically add and remove virtual adapters to and from running logical partitions using the
Hardware Management Console (HMC).

Obtaining additional WWPNs for the server
When all of the worldwide port names (WWPNs) on the server are used, you can add more WWPNs to
the server using the Hardware Management Console (HMC). Adding WWPNs allows you to create
additional virtual fibre channel adapters on client logical partitions that use virtual resources provided by
the Virtual I/O Server.

The server contains 32 000 pairs of WWPNs that all contain the same 6–digit prefix. Each virtual fibre
channel adapter that you create on a client logical partition requires one pair of WWPNs. When all of the
WWPNs on the server are used, you cannot create additional virtual fibre channel adapters on any client
logical partitions until you add more WWPNs to the server. You add more WWPNs to the server by
generating an activation code that contains a new WWPN prefix that contains 32 000 new pairs of
WWPNs.

To obtain additional WWPNs for the server, complete the following steps from the HMC:
1. Retrieve information about the server:

a. In the navigation pane, expand Systems Management and click Servers.
b. In the work pane, select the server to which you want to add WWPNs.
c. From the Tasks menu, click Capacity On Demand (CoD) → Other Advanced Functions → View

Code Information. The CoD Advanced Functions Code Information window is displayed.
d. Click Save to save the information to a file on a remote system or to media, and click OK.

2. Go to the Capacity on Demand Web site and enter the information that you retrieved in step 1 to
generate an activation code.

3. Apply the activation code that you obtained in step 2 to the server:
a. In the navigation pane, expand Systems Management and click Servers.
b. In the work pane, select the server to which you want to add WWPNs.
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c. From the Tasks menu, click Capacity On Demand (CoD) → Other Advanced Functions → Enter
Activation Code. The Enter Activation Code window is displayed.

d. Enter the activation code that obtained in step 2 on page 190 and click OK.
4. Verify that the activation code that you entered in step 3 on page 190 was applied to the server:

a. In the navigation pane, expand Systems Management and click Servers.
b. In the work pane, select the server to which you want to add WWPNs.
c. From the Tasks menu, click Capacity On Demand (CoD) → Other Advanced Functions → View

History Log. The CoD Advanced Functions Activation History Log window is displayed.
d. Verify that there is a log entry for entering the CoD advanced functions activation code and click

Close.

After you finish, you can create virtual fibre channel adapters on client logical partitions and dynamically
add virtual fibre channel adapters to client logical partitions.
Related concepts

“Virtual fibre channel” on page 59
With N_Port ID Virtualization (NPIV), you can configure the managed system so that multiple logical
partitions can access independent physical storage through the same physical fibre channel adapter.
Related tasks

“Configuring a virtual fibre channel adapter” on page 131
You can configure a virtual fibre channel adapter dynamically for a running logical partition using the
Hardware Management Console (HMC).
“Adding virtual adapters dynamically” on page 172
You can dynamically add a virtual adapter to a running logical partition using the Hardware
Management Console (HMC).

Setting partition-availability priorities for your managed system
To avoid shutting down mission-critical workloads when your server firmware deconfigures a failing
processor, you can use the Hardware Management Console (HMC) to set partition-availablity priorities
for the logical partitions on your managed system. A logical partition with a failing processor can acquire
a replacement processor from logical partitions with a lower partition-availability priority. The acquisition
of a replacement processor allows the logical partition with the higher partition-availability priority to
continue running after a processor failure.

To set partition-availability priorities for your managed system using the HMC, follow these steps:
1. In the navigation pane, open Systems Management and click Servers.
2. In the work pane, select the managed system whose partition-availability priorities you want to set,

click the Tasks button, and select Configuration → Partition Availability Priority.
3. Select the logical partitions whose partition-availability priority you want to set, set Availability

priority to the partition-availability priority value that you want to use for all selected logical
partitions, and click OK. You can enter any value from 0 to 255 into Availability priority, or you can
select one of the preset choices. All selected logical partitions are set to the same partition-availability
priority value.

4. Repeat this procedure for other logical partitions to set the partition-availability priority for those
logical partitions.

Related concepts

“Processors” on page 15
A processor is a device that processes programmed instructions. The more processors that you assign to a
logical partition, the greater the number of concurrent operations that the logical partition can run at any
given time.

Installing new hardware for IBM i logical partitions
You can install an I/O processor (IOP) or an I/O adapter (IOA) for an IBM i logical partition.
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When you install new hardware in an IBM i partitioned environment, you should be aware of the
following things:
v Verify that your logical partition configuration is current.
v Empty positions might not be owned by a logical partition. They should be assigned to the desired

logical partition before installing new adapters in them. After you install the new adapter, you must
also add the adapter to the partition profile so that, when you shut down and activate the logical
partition using the partition profile, the logical partition reactivates with the adapter that you added.

v A new IOP or IOA is owned by the logical partition that owns the slot, and a new device is owned by
the logical partition that owns the IOA to which the device is attached.

v New processors and memory are available (unassigned) to be assigned to any logical partition.

To install an IOP or IOA for an IBM i logical partition, perform the following steps:
1. Assign empty slots to the desired logical partition. For instructions, see “Managing physical I/O

devices and slots dynamically” on page 170 and “Changing partition profile properties” on page 159.
2. Install the new hardware into the empty slots. For instructions, see Installing and configuring

POWER6 processor-based systems and system features.

Backing up and recovering data
It is crucial that you back up your data because you never know when you might need to do a server
recovery. Save everything in your system as often as possible. You might not be prepared to recover from
a site loss or certain types of disk failures if you do not regularly save everything.

For more information about planning a backup and recovery strategy for the Hardware Management
Console (HMC) and IBM i data, refer to the following topics:

Table 27. Backup and recovery information for the HMC and IBM i

Topic Description

Backing up critical HMC data This procedure explains how to save critical HMC data
(such as user information and platform-configuration
files) to a backup file. This information is in the
Managing the HMC topic.

Backing up partition profile data This procedure explains how to back up the partitioning
data on your HMC to a backup file on the HMC. This
information is in the Managing the HMC topic.

Reinstalling the HMC machine code This procedure explains how to reinstall the HMC
interface from the recovery CD-ROM. This information is
in the Managing the HMC topic.

Restoring profile data This procedure explains how to restore the partitioning
data from the backup file to the HMC. This information
is in the Managing the HMC topic.

Back up your server This information can help you develop the backup
strategy for your IBM i logical partition. This information
is in the Backup and recovery topic in the IBM i
Information Center.

Recover your server This information can help you reload your operating
system and data. This information is in the Backup and
recovery topic in the IBM i Information Center.

Managing logical partitions that use IBM i resources
You can manage logical partitions that use IBM i virtual I/O resources to help maximize utilization of the
physical hardware and simplify the backup procedure for your managed system.

Managing AIX logical partitions that use IBM i resources:
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You can manage AIX logical partitions that uses IBM i virtual I/O resources to help maximize utilization
of the physical hardware and simplify the backup procedure for your managed system.
Related information

Backup of the system image and user-defined volume groups

Installing system backups

Adding virtual disk units to an AIX logical partition:

You can dynamically add virtual disk units to an AIX logical partition that uses IBM i resources. This
allows you to increase the storage capacity of your AIX logical partition when needed.

Virtual disks simplify hardware configuration on the server because they do not require you to add
additional physical devices to the server in order to run AIX. You can allocate up to 64 virtual disks to an
AIX logical partition. Each virtual disk supports up to 1000 GB of storage. Each virtual disk appears to
AIX as one actual disk unit. However, the associated space in the IBM i integrated file system is
distributed across the disks that belong to the IBM i logical partition. Distributing storage across the disks
provides the benefits of device parity protection through IBM i. Therefore, you do not have to use
additional processing resources and memory resources by setting up device parity protection through
AIX.

IBM i provides the ability to dynamically add virtual disks to an AIX logical partition. You can allocate
disk space in the integrated file system and make it available to AIX without restarting the server or
logical partition. The AIX administrator can also configure the newly allocated disk space and make it
available without restarting the server.

To add virtual disks dynamically to an AIX logical partition, do the following:
1. If you use System i Navigator, create a network-server storage space using System i Navigator.

a. Expand My Connections → your server → Network → Windows Administration .
b. Right-click the Disk Drives and select New Disk.
c. In the Disk drive name field, specify the name that you want to give to the network-server

storage space.
d. In the Description field, specify a meaningful description for the network-server storage space.
e. In the Capacity field, specify the size of the new network-server storage space in megabytes. To

help you determine the size you want to use, see Installing AIX.
f. Click OK.
g. Continue with step 3.

2. If you use a character-based interface, create a network-server storage space using the
character-based interface:
a. At an IBM i command line, type the command CRTNWSSTG and press F4. The Create NWS

Storage Space (CRTNWSSTG) display opens.
b. In the Network-server storage space field, specify the name you want to give to the

network-server storage space.
c. In the Size field, specify the size in megabytes for the new network-server storage space. To help

you determine the size you want to use, see Installing AIX.
d. In the Text description field, specify a meaningful description for the network-server storage

space.
e. Press Enter.
f. Continue with step 4 on page 194

3. If you use System i Navigator, link the network-server storage space using System i Navigator.
a. Expand My Connections → your server → Network → Windows Administration .
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b. Click Disk Drives, right-click an available network-server storage space, and select Add Link.
c. Select the server to which you want to link the network-server storage space.
d. Select one of the available data access types.
e. Click OK.
f. Continue with step 5.

4. If you use a character-based interface, link the network-server storage space using a character-based
interface:
a. At an IBM i command line, type the command ADDNWSSTGL and press F4. The Add

Network-Server Storage Link (ADDNWSSTGL) display opens.
b. In the Network server description field, specify the name of the network server description

(NWSD).
c. In the Dynamic storage link field, specify *YES to make the network-server storage space

dynamically available to the logical partition (that is, available without rebooting the AIX logical
partition).

d. In the Drive sequence number field, specify the link sequence position you want to use.
e. Press Enter.

5. Activate the AIX logical partition (if it is not already activated).
6. Log in to AIX using a user name with superuser (root) privileges.
7. Configure the new virtual disk on the AIX logical partition by running the AIX command cfgmgr.
8. Verify that your new disk has been added and can be configured by running the AIX command

lspv. When you enter lspv at the command prompt, the system lists the disks that are currently
available to AIX. An example of the output for this command is below:
# lspv
hdisk0 00cad6aceafe8fe4 rootvg active
hdisk1 none None

Note the name of the new disk as it displays in the left-hand column.
9. Configure the new disk using one of the following two methods.

v Add the new virtual disk to the root volume group by using the AIX command extendvg rootvg
diskname, where diskname is the name of the new disk. If you use this method, you do not need to
continue this procedure. You can use AIX methods to increase the file system size at a later time.

v Create a new volume group for the new virtual disk by using the AIX command mkvg -y
volgroup diskname, where volgroup is the name that you want to use for the new volume group
and diskname is the name of the new disk.

10. Make a logical volume on the new virtual disk using the AIX mklv -y logicvol volgroup 1
diskname command. logicvol is the name that you want to use for the new logical volume, volgroup
is the name of the new volume group, and diskname is the name of the new disk. (The numeral 1
indicates that the logical volume is to consist of one logical disk partition.)

11. Format the disk partition using the AIX crfs command. There are a number of optional parameters
for the crfs command, but typically the defaults satisfy most disk uses. To format the disk partition
created in the previous steps, type the following command at an AIX command prompt, where
logicvol is the name of the logical volume and /mnt/data is the mount point directory at which you
want to mount the new disk:
crfs -v jfs -d logicvol -m /mnt/data

The crfs command displays the following diagnostic messages:
crfs -v jfs -d logicvol -m /mnt/data
Based on the parameters chosen, the new /mnt/data JFS file system is limited to
a maximum size of 134217728 (512 byte blocks)
New File System size is 8192.
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12. Verify that the mount point directory exists by using the cd /mnt/data command. /mnt/data is the
mount point. The crfs command creates this directory so that you can access your new file system.
If the mount point directory does not exist, then run the following command, where /mnt/data is the
name of the mount point directory:
mkdir /mnt/data

13. Verify that an entry for your new file system exists in the /etc/filesystems file. The crfs command
automatically generates the appropriate /etc/filesystems entry for your new file system. To verify
that the entry exists, use an AIX text editor, such as vi, to open the /etc/filesystems file, and look
for the entry in the /etc/filesystems file. If the entry does not exist, use the text editor to add the
entry to the /etc/filesystems file. An example of such an entry is below:
/mnt/data:
dev = /dev/logicvol
vfs = jfs
log = /dev/loglv01
mount = true
account = false

This entry mounts the virtual disk every time you restart AIX.
14. Mount the virtual disk drive in the new directory by typing: mount /dev/logicvol /mnt/data.

logicvol is the name of the logical volume and /mnt/data is the mount point directory.

Linking a network-server storage space to a network server description:

You can link a network-server storage space (NWSSTG) to one or more network server descriptions
(NWSDs). This allows the NWSDs and their associated logical partitions to use the data stored on the
NWSSTG.

You can link an NWSSTG to an unlimited number of NWSDs. This is beneficial when multiple logical
partitions need access to a single application.

When you link an NWSSTG to an NWSD, you can set up the NWSD to have read-only access to the
NWSSTG, or you can set up the NWSD to read or write to the NWSSTG.

Attention: If more than one NWSD can write to the NWSSTG, ensure that only one NWSD can update
the data at a time. Otherwise, changes made by one NWSD can be overwritten by another NWSD.

To link an NWSSTG to an NWSD, follow these steps:
1. At an IBM i command line, type the command ADDNWSSTGL and press F4.
2. From the Add Server Storage Link display, provide the following information:

NWSSTG (Name)
NWSD (Name)
DYNAMIC (*YES)
DRVSEQNBR (*CALC)

3. Press F10 (Additional Parameters).
4. Enter the type of access the storage space will have.

Deleting network-server descriptions for an AIX logical partition:

You can delete the IBM i network-server description (NWSD) for an AIX logical partition that uses IBM i
resources. When you delete the NWSD, all the configuration information for the AIX logical partition is
deleted from IBM i.

To delete the network-server description (NWSD) for an AIX logical partition, follow these steps:
1. On an IBM i control language (CL) command line, type the command WRKNWSD and press Enter.
2. Type 8 in the Opt field to the left of the Network Server and press Enter.
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3. In the Work with Configuration Status display, if the status of the NWSD is not varied off, type 2 in
the Opt field to the left of the Network Server and press Enter. Otherwise, go to the next step.

4. Press F3 to return to the previous display
5. Enter a 4 in the Opt field to the left of the Network Server and press Enter.
6. On the Confirm Delete of Network Server Descriptions display, press Enter.

Deleting virtual disk drives for an AIX logical partition:

You can delete a virtual disk drive from an AIX logical partition that uses IBM i resources to make the
space available to the IBM i logical partition once more. When you delete a virtual disk drive, all of the
information on the virtual disk drive is erased.

Before you can delete a virtual disk drive, you must unlink the virtual disk drive from the
network-server description (NWSD). For instructions, see “Unlinking virtual disk drives from an AIX
logical partition” on page 197.

To delete a virtual disk drive, follow these steps:

Delete the disk drive using the interface that you prefer.

Interface Actions

System i Navigator 1. Click Network → Windows Administration → Disk
Drives.

2. Right-click the disk drive that you want to delete.

3. Click Delete in the confirmation window.

IBM i character-based interface 1. At an IBM i control language (CL) command line,
type DLTNWSSTG and press F4.

2. Type the name of the disk drive in the
Network-server storage space field and press Enter.

Using IPL types when running AIX:

The IPL source (IPLSRC) parameter on the network-server description (NWSD) determines the initial
program that is loaded when the NWSD is varied on. For an AIX logical partition that uses IBM i
resources, the initial program is the kernel. Ensure that the IPLSRC parameter specifies the kernel
location of the kernel for the AIX logical partition that uses IBM i resources.

You can set the IPLSRC parameter when you use the Create Network Server Description (CRTNWSD)
command, and you can change the IPLSRC parameter when you use the Change Network Server
Description (CHGNWSD) command.

Note: IPLSRC parameter also has the values A, B, and D, which are not valid for IBM System i
hardware.

The IPLSRC parameter has the following valid values.

IPLSRC values Description

*Panel The logical partition is started from the source indicated on the control panel.

*NWSSTG (network-server
storage space)

This IPL type is used to start a logical partition from a virtual disk. The open
firmware will find the kernel in the virtual disk. The open firmware searches the
first virtual disk connected to the server for a logical partition marked bootable,
and of type 0x41 (PReP start). If a logical partition of this type does not exist,
the logical partition IPL will fail.
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IPLSRC values Description

*STMF (stream file) This IPL type is used to start a logical partition from a kernel IBM i loaded in
the IBM i integrated file system. Note that the integrated file system includes
files on the optical (CD) drive on IBM i.

Unlinking virtual disk drives from an AIX logical partition:

By unlinking virtual disk drives (network-server storage spaces) from an AIX logical partition that uses
IBM i resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk
drives inaccessible to users. If you delete an AIX logical partition that uses IBM i resources, you must
unlink all virtual disk drives from the logical partition before you delete the logical partition.

To unlink a virtual disk drive from an AIX logical partition that uses IBM i resources, follow these steps:
1. Unlink disk drives from a logical partition using System i Navigator. If you prefer to use a

character-based interface, go to step 2.
a. Vary off the NWSD for your logical partition.
b. Click Network → Windows Administration → Disk Drives.
c. Right-click the name of the disk drive that you want to unlink.
d. Click Remove Link.
e. Select a server from the list of linked servers.
f. If you are unlinking a disk drive that you plan to relink later, uncheck Compress link sequence.

You must relink the disk drive as the same link sequence number before you vary on the server. By
preventing compression of the link sequence values, you avoid having to unlink and relink all the
disk drives to get them in the correct sequence.

g. Click Remove.
h. You have completed this procedure. Do not complete step 2.

2. Unlink disk drives from a logical partition using a character-based interface:
a. Vary off the NWSD for your logical partition.
b. Type RMVNWSSTGL and press F4.
c. In the Network-server storage space field, type the name of the storage space that you want to

unlink and press Enter.
d. In the Network server description field, type the name of the server from which you want to

unlink the storage space and press Enter.
e. If you are unlinking a linked disk drive that you plan to relink later, specify *NO in the Renumber

field.

Note: You must relink the disk drive as the same sequence number before you vary on the server.
By preventing automatic renumbering, you avoid having to unlink and relink all the disk drives to
get them in the correct sequence.

f. Press Enter.

Note: If you are uninstalling a logical partition, your next step is to delete the disk drive. For
instructions, see “Deleting virtual disk drives for an AIX logical partition” on page 196. Otherwise,
vary on the NWSD for your logical partition.

Related concepts

“Saving AIX server objects in IBM i”
When an AIX logical partition uses IBM i resources, IBM i stores AIX information in IBM i objects. IBM i
can restore the objects correctly only if you save all objects for an AIX logical partition.

Saving AIX server objects in IBM i:
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When an AIX logical partition uses IBM i resources, IBM i stores AIX information in IBM i objects. IBM i
can restore the objects correctly only if you save all objects for an AIX logical partition.

You can save these objects by using options of the IBM i GO SAVE command in the server.
v Option 21 saves the entire server.
v Option 22 saves server data, which includes objects in the QUSRSYS library.
v Option 23 saves all user data, which includes objects in the QFPNWSSTG library.

If you want to save a particular object, use the following table to see the location of that object on IBM i
and the command to use.

Table 28. Objects to save for logical partitions with virtual disk

Object content Object name Object location Object type Save command

Guest partition and
virtual disk drive

stgspc /QFPNWSSTG User-defined
network-server
storage spaces in
system auxiliary
storage pool
(ASP)

GO SAV, option 21 or 23

SAV OBJ(’/QFPNWSSTG/stgspc’)
DEV(’/QSYS.LIB/TAP01.DEVD’)

User-defined
network-server
storage spaces in
user ASP

SAV OBJ((’/QFPNWSSTG/stgspc’)
(’/dev/QASPnn /stgspc.UDFS’))
DEV(’/QSYS.LIB/TAP01.DEVD’)

Table 29. Objects to save for all logical partitions with a server

Object content Object name Object location Object type Save command

Messages from the
logical partition

Various Various Server message
queue

GO SAVE, option 21 or 23

SAVOBJ OBJ(msg) LIB(qlibrary)
DEV(TAP01) OBJTYPE(*MSGQ)

IBM i configuration
objects for logical
partitions

Various QSYS Device
configuration
objects

GO SAVE, option 21, 22, or 23

SAVOBJ DEV (TAPO1)

Various Various QUSRSYS Various GO SAVE, option 21 or 23

SAVLIB LIB(*NONSYS) or
LIB(*ALLUSR)

Related information

Backup of the system image and user-defined volume groups

Installing system backups

Backup and recovery

Managing IBM i logical partitions that use i resources:

You can manage IBM i logical partitions that uses i virtual I/O resources to help maximize utilization of
the physical hardware and simplify the backup procedure for your managed system.

Adding virtual disk units to an IBM i logical partition that uses i virtual I/O resources:

You dynamically can add virtual disk units to an IBM i logical partition that uses i virtual I/O resources.
This allows you to increase the storage capacity of the i logical partition that uses i virtual I/O resources
when needed.
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IBM i provides the ability to add virtual disks dynamically to another i logical partition. You can allocate
disk space in the integrated file system and make it available to i without restarting the server or logical
partition.

To add virtual disks dynamically to an IBM i logical partition that uses i virtual I/O resources, do the
following:
1. Create a network-server storage space using the interface of your choice.

Interface Actions

System i Navigator 1. Expand My Connections → your server → Network →
Windows Administration .

2. Right-click the Disk Drives and select New Disk.

3. In the Disk drive name field, specify the name that
you want to give to the network-server storage space.

4. In the Description field, specify a meaningful
description for the network-server storage space.

5. In the Capacity field, specify the size of the new
network-server storage space in megabytes. To help
you determine the size you want to use, see
Installing, upgrading, or deleting IBM i and related
software.

6. Click OK.

IBM i character-based interface 1. At an IBM i command line on the IBM i logical
partition that provides virtual I/O resources, type the
command CRTNWSSTG and press F4. The Create
NWS Storage Space (CRTNWSSTG) display opens.

2. In the Network-server storage space field, specify the
name you want to give to the network-server storage
space.

3. In the Size field, specify the size in megabytes for the
new network-server storage space.

4. In the Text description field, specify a meaningful
description for the network-server storage space.

5. Press Enter.

2. Add the new disk to the auxiliary storage pool (ASP) on the client IBM i logical partition. For
instructions, see Adding disk units to an existing auxiliary storage pool (ASP).

3. Link the network-server storage space using the interface of your choice.

Interface Actions

System i Navigator 1. Expand My Connections → your server → Network →
Windows Administration.

2. Click Disk Drives, right-click an available
network-server storage space, and select Add Link.

3. Select the server to which you want to link the
network-server storage space.

4. Select one of the available data access types.

5. Click OK.
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Interface Actions

IBM i character-based interface 1. At an IBM i command line on the IBM i logical
partition that provides virtual I/O resources, type the
command ADDNWSSTGL and press F4. The Add
Network-Server Storage Link (ADDNWSSTGL)
display opens.

2. In the Network server description field, specify the
name of the network server description (NWSD).

3. In the Dynamic storage link field, specify *YES to
make the network-server storage space dynamically
available to the logical partition (that is, available
without restarting the IBM i logical partition).

4. In the Drive sequence number field, specify the link
sequence position you want to use.

5. Press Enter.

4. Activate the IBM i logical partition (if it is not already activated).

Linking a network-server storage space to a network server description:

You can link a network-server storage space (NWSSTG) to a network server description (NWSD). This
allows the NWSD and its associated logical partition to use the data stored on the NWSSTG.

You can link an NWSSTG to one NWSD. When you link an NWSSTG to an NWSD, you can set up the
NWSD to have read-only access to the NWSSTG, or you can set up the NWSD to read or write to the
NWSSTG.

To link an NWSSTG to an NWSD, follow these steps:
1. At an IBM i command line on the IBM i logical partition that provides virtual I/O resources, type the

command ADDNWSSTGL and press F4.
2. From the Add Server Storage Link display, provide the following information:

NWSSTG (Name)
NWSD (Name)
DYNAMIC (*YES)
DRVSEQNBR (*CALC)

Deleting network server descriptions for an IBM i logical partition that uses i virtual I/O resources:

You can delete the IBM i network-server description (NWSD) for an i logical partition that uses i virtual
I/O resources. When you delete the NWSD, all the configuration information for the i logical partition
that uses i virtual I/O resources is deleted.

Before you start, ensure that you remove the disk from the auxiliary storage pool (ASP). For instructions,
see Removing a disk unit from an auxiliary storage pool (ASP).

To delete the network-server description (NWSD) for an IBM i logical partition that uses i virtual I/O
resources, follow these steps:
1. On an IBM i control language (CL) command line on the i logical partition that provides virtual I/O

resources, type the command WRKNWSD and press Enter.
2. Type 8 in the Opt field to the left of the Network Server and press Enter.
3. In the Work with Configuration Status display, if the status of the NWSD is not varied off, type 2 in

the Opt field to the left of the Network Server and press Enter. Otherwise, go to the next step.
4. Press F3 to return to the previous display
5. Enter a 4 in the Opt field to the left of the Network Server and press Enter.
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6. On the Confirm Delete of Network Server Descriptions display, press Enter.

Deleting virtual disk drives for an IBM i logical partition that uses i virtual I/O resources:

You can delete a virtual disk drive from an IBM i logical partition that uses i virtual I/O resources.
Deleting the virtual disk drive makes the space available once more to the i logical partition that provides
the virtual disk resources. When you delete a virtual disk drive, all of the information on the virtual disk
drive is erased.

Before you can delete a virtual disk drive, you must unlink the virtual disk drive from the
network-server description (NWSD). For instructions, see “Unlinking virtual disk drives from an IBM i
logical partition that uses i resources” on page 202.

To delete a virtual disk drive, follow these steps:

Delete the disk drive using the interface that you prefer.

Interface Actions

System i Navigator 1. Click Network → Windows Administration → Disk
Drives.

2. Right-click the disk drive that you want to delete.

3. Click Delete in the confirmation window.

IBM i character-based interface 1. At an IBM i control language (CL) command line,
type DLTNWSSTG and press F4.

2. Type the name of the disk drive in the
Network-server storage space field and press Enter.

Using IPL types when running an IBM i logical partition that uses IBM i virtual I/O resources:

The IPL source (IPLSRC) parameter on the network-server description (NWSD) determines the initial
program that is loaded when the NWSD is varied on. For an IBM i logical partition that uses IBM i
virtual I/O resources, the initial program is the load source. Ensure that the IPLSRC parameter specifies
the location of the load source for the IBM i logical partition that uses IBM i virtual I/O resources.

You can set the IPLSRC parameter when you use the Create Network Server Description (CRTNWSD)
command, and you can change the IPLSRC parameter when you use the Change Network Server
Description (CHGNWSD) command.

Note: IPLSRC parameter also has the values A, B, and D, which are not valid for IBM System i
hardware.

The IPLSRC parameter has the following valid values.

IPLSRC values Description

*Panel The logical partition is started from the source indicated on the control panel.

*NWSSTG (network-server
storage space)

This IPL type is used to start a logical partition from a virtual disk. The open
firmware will find the load source in the virtual disk. If the firmware does not
find the load source in the virtual disk, then the logical partition IPL will fail.

*STMF (stream file) This IPL type is used to start a logical partition from a stream file loaded in the
IBM i integrated file system of the IBM i logical partition that provides virtual
I/O resources. Note that the integrated file system includes files on the optical
(CD) drive on the IBM i logical partition that provides virtual I/O resources.
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Unlinking virtual disk drives from an IBM i logical partition that uses i resources:

By unlinking virtual disk drives (network-server storage spaces) from an IBM i logical partition that uses
i resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk
drives inaccessible to users. If you delete an i logical partition that uses i resources, you must unlink all
virtual disk drives from the logical partition before you delete the logical partition.

To unlink a virtual disk drive from an IBM i logical partition that uses i resources, follow these steps:

Unlink disk drives from a logical partition using the interface that you prefer.

Interface Actions

System i Navigator 1. Vary off the NWSD for your logical partition.

2. Click Network → Windows Administration → Disk
Drives.

3. Right-click the name of the disk drive that you want
to unlink.

4. Click Remove Link.

5. Select a server from the list of linked servers.

6. If you are unlinking a disk drive that you plan to
relink later, uncheck Compress link sequence. You
must relink the disk drive as the same link sequence
number before you vary on the server. By preventing
compression of the link sequence values, you avoid
having to unlink and relink all the disk drives to get
them in the correct sequence.

7. Click Remove.

IBM i character-based interface 1. Vary off the NWSD for your logical partition.

2. At an i command line on the i logical partition that
provides virtual I/O resources, type RMVNWSSTGL and
press F4.

3. In the Network-server storage space field, type the
name of the storage space that you want to unlink
and press Enter.

4. In the Network server description field, type the
name of the server from which you want to unlink
the storage space and press Enter.

5. If you are unlinking a linked disk drive that you plan
to relink later, specify *NO in the Renumber field.
Note: You must relink the disk drive as the same
sequence number before you vary on the server. By
preventing automatic renumbering, you avoid having
to unlink and relink all the disk drives to get them in
the correct sequence.

6. Press Enter.
Note: If you are uninstalling a logical partition, your
next step is to delete the disk drive. For instructions,
see “Deleting virtual disk drives for an IBM i logical
partition that uses i virtual I/O resources” on page
201. Otherwise, vary on the NWSD for your logical
partition.
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Related concepts

“Saving IBM i server objects in i”
When an IBM i logical partition uses i resources, the i logical partition that provides the virtual I/O
resources stores the information for the i logical partition that uses the virtual I/O resources in i objects. i
can restore the objects correctly only if you save all objects for an i logical partition that uses i virtual I/O
resources.

Saving IBM i server objects in i:

When an IBM i logical partition uses i resources, the i logical partition that provides the virtual I/O
resources stores the information for the i logical partition that uses the virtual I/O resources in i objects. i
can restore the objects correctly only if you save all objects for an i logical partition that uses i virtual I/O
resources.

You can save these objects by using options of the i GO SAVE command in the server.
v Option 21 saves the entire server.
v Option 22 saves system data, which includes objects in the QUSRSYS library.
v Option 23 saves all user data, which includes objects in the QFPNWSSTG library.

You can also use any save or restore command, or any Backup, Recovery, and Media Services (BRMS)
function to save i server objects.

If you want to save a particular object, use the following table to see the location of that object on i and
the command to use.

Table 30. Objects to save for logical partitions with virtual disk

Object content Object name Object location Object type Save command

Guest partition and
virtual disk drive

stgspc /QFPNWSSTG User-defined
network-server
storage spaces in
system auxiliary
storage pool
(ASP)

GO SAV, option 21 or 23

SAV OBJ(’/QFPNWSSTG/stgspc’)
DEV(’/QSYS.LIB/TAP01.DEVD’)

User-defined
network-server
storage spaces in
user ASP

SAV OBJ((’/QFPNWSSTG/stgspc’)
(’/dev/QASPnn /stgspc.UDFS’))
DEV(’/QSYS.LIB/TAP01.DEVD’)

Table 31. Objects to save for all logical partitions with a server

Object content Object name Object location Object type Save command

Messages from the
logical partition

Various Various Server message
queue

GO SAVE, option 21 or 23

SAVOBJ OBJ(msg) LIB(qlibrary)
DEV(TAP01) OBJTYPE(*MSGQ)

IBM i configuration
objects for logical
partitions

Various QSYS Device
configuration
objects

GO SAVE, option 21, 22, or 23

SAVOBJ DEV (TAPO1)

Various Various QUSRSYS Various GO SAVE, option 21 or 23

SAVLIB LIB(*NONSYS) or
LIB(*ALLUSR)

You can save and restore network server storage spaces on the i logical partition that uses i virtual
resources; however, you cannot save and restore individual files.
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Related information

Backup and recovery

Backing up and recovering IBM i logical partitions that use i virtual I/O resources:

You can back up and recover an IBM i logical partition that uses resources from another i logical partition
by using the GO SAVE operation.
Related information

Performing a complete save using the GO SAVE checklist

Managing Linux logical partitions that use IBM i resources:

You can manage Linux logical partitions that uses IBM i virtual I/O resources to help maximize
utilization of the physical hardware and simplify the backup procedure for your managed system.

Adding virtual disk units to a Linux logical partition:

You can add virtual disk units dynamically to a Linux logical partition that uses IBM i resources. This
allows you to increase the storage capacity of your AIX logical partition when needed.

Virtual disks simplify hardware configuration on the server because they do not require you to add
additional physical devices to the server in order to run Linux. You can allocate up to 64 virtual disks to
a Linux logical partition. Each virtual disk supports up to 1000 GB of storage. Each virtual disk appears
to Linux as one actual disk unit. However, the associated space in the i integrated file system is
distributed across the disks that belong to the i logical partition. Distributing storage across the disks
provides the benefits of device parity protection through i. Therefore, you do not have to use additional
processing resources and memory resources by setting up device parity protection through Linux.

IBM i provides the ability to dynamically add virtual disks to a Linux logical partition. You can allocate
disk space in the integrated file system and make it available to Linux without restarting the server or
logical partition. The Linux administrator can also configure the newly allocated disk space and make it
available without restarting the server.

To add virtual disks dynamically to a Linux logical partition, do the following:
1. If you use System i Navigator, create a network-server storage space using System i Navigator.

a. Expand My Connections → your server → Network → Windows Administration .
b. Right-click the Disk Drives and select New Disk.
c. In the Disk drive name field, specify the name that you want to give to the network-server

storage space.
d. In the Description field, specify a meaningful description for the network-server storage space.
e. In the Capacity field, specify the size of the new network-server storage space in megabytes.

Refer to the installation documentation of your preferred Linux distributor to determine the size
you want to use.

f. Click OK.
g. Continue with step 4 on page 205.

2. If you use a character-based interface, create a network-server storage space using the
character-based interface:
a. At an IBM i command line, type the command CRTNWSSTG and press F4. The Create NWS

Storage Space (CRTNWSSTG) display opens.
b. In the Network-server storage space field, specify the name you want to give to the

network-server storage space.
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c. In the Size field, specify the size in megabytes for the new network-server storage space. Refer to
the installation documentation of your preferred Linux distributor to determine the size you want
to use.

d. In the Text description field, specify a meaningful description for the network-server storage
space.

e. Press Enter.
3. If you use System i Navigator, link the network-server storage space using System i Navigator.

a. Expand My Connections → your server → Network → Windows Administration .
b. Click Disk Drives, right-click an available network-server storage space, and select Add Link.
c. Select the server to which you want to link the network-server storage space.
d. Select one of the available data access types.
e. Click OK.
f. Continue with step 5.

4. If you use a character-based interface, link the network-server storage space using a character-based
interface:
a. At an IBM i command line, type the command ADDNWSSTGL and press F4. The Add

Network-Server Storage Link (ADDNWSSTGL) display opens.
b. In the Network server description field, specify the name of the network server description

(NWSD).
c. In the Dynamic storage link field, specify *YES to make the network-server storage space

dynamically available to the logical partition (that is, available without rebooting the Linux
logical partition).

d. In the Drive sequence number field, specify the link sequence position you want to use.
e. Press Enter.

5. If the Linux logical partition is not running, activate the Linux logical partition. Do not continue
until the logical partition is running.

6. Log in to Linux using a user name with superuser (root) privileges.
7. Determine the host ID, SCSI bus, and logical unit number (LUN) for your new virtual disk drive.

You can list the existing devices by typing the following command at the Linux command prompt:
cat /proc/scsi/scsi. The following example shows sample output of the command:
Attached devices:
Host: scsi0 Channel: 00 Id: 00 Lun: 00

Vendor: IBM Model: VDASD NETSPACE Rev: 0001
Type: Direct-Access ANSI SCSI revision: 04

In this example, NETSPACE is the name of the network storage space for the displayed device. Look
for the name of an existing network storage space on your Linux logical partition. Note the numeric
part of the Host: value (host ID) and the Channel: (SCSI bus) and Lun: (logical unit number (LUN))
values for the existing network storage space. The new virtual disk drive will have the same host ID,
SCSI bus, and LUN as the existing network storage space. For example, if the existing network
storage space is as displayed in the preceding example output, then the new virtual disk drive will
have a host ID of 0, a SCSI bus of 0, and a LUN of 0.

8. Determine the SCSI ID for your new virtual disk drive. You can list the existing devices in table
form by typing the following commands at the Linux command prompt:
cd /proc/scsi/sg
cat device_hdr; cat devices

The following example shows sample output of the commands:
host chan id lun type opens qdepth busy online
0 0 0 0 0 2 30 0 1
0 1 0 0 0 0 30 0 1
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Note the host (host ID), chan (SCSI bus), id (SCSI ID), and lun (logical unit number (LUN)) values
for the existing devices. Find the devices that have the same host ID, SCSI bus, and LUN as the new
virtual disk drive (as you determined in the previous step). Of those devices, find the device with
the greatest SCSI ID. The new virtual disk drive will have a SCSI ID that is one greater than the
greatest existing SCSI ID. For example, if the new virtual disk drive has a host ID of 0, a SCSI bus of
0, and a LUN of 0, and the devices on your Linux logical partition are as listed in the example
output above, then the new virtual disk drive will have a SCSI ID of 1.

9. Type the following command at the Linux command prompt to add the virtual disk drive manually:
echo "scsi add-single-device host chan id lun" > /proc/scsi/scsi. Use the following
information to help you understand the arguments of the command:
v host is the host ID.
v chan is the SCSI bus.
v id is the SCSI ID.
v lun is the LUN.

For example, if the new virtual disk drive is to have a host ID of 0, a SCSI bus of 0, a SCSI ID of 1,
and a LUN of 0, you would type the command echo "scsi add-single-device 0 0 1 0" >
/proc/scsi/scsi at the Linux command prompt.

10. At the Linux command prompt, type the following command to create a disk partition on the virtual
disk drive: fdisk /dev/sdb. You must have superuser (root) privileges to run this command. The
Command (m for help): prompt is displayed.

11. Type p at the prompt to see the current partition table for the virtual disk drive. By default, the new
virtual disk drive shows a single disk partition on the virtual disk. For example,
Disk /dev/sdb: 64 heads, 32 sectors, 200 cylinders
Units = cylinders of 2048 * 512 bytes

Device Boot Start End Blocks Id System
/dev/sdb1 1 199 203760 6 FAT16

12. Type d at the command prompt to delete the current partition and then create a new one. The
default format for the disk partition is FAT16. Do not use a disk partition that is formatted as FAT16
on your virtual disk drive. The Partition number (1-4): prompt is displayed.

13. Type the disk partition number you want to delete and press Enter. In this example, you type a 1.
The fdisk command indicates that the deletion is successful by displaying the command prompt.

14. Type n to create a new disk partition. The Command action E extended P primary partition
(1-4) prompt is displayed.

15. Type p to create a primary disk partition on the virtual disk and press Enter. The Partition number
(1-4): prompt is displayed.

16. Type 1 because this is the first partition on the virtual disk, and press Enter. The First cylinder
(1-200, default 1): prompt is displayed.

17. Press Enter to use the default of 1 for the first disk cylinder. This uses the entire disk for this disk
partition. The Last cylinder or +size or +sizeM or +sizeK (1-200, default 200): prompt is
displayed.

18. Press Enter to use the default of 200 for the last disk cylinder. This uses the entire virtual disk for
this partition.

Note: The type of the partition defaults to Linux. If you need a different disk type (like Logical
Volume Manager (LVM), or Linux Extended), type t to change the type of the partition.
The fdisk command indicates that the partition creation is successful by returning the command
prompt.

19. Type w to commit the changes to the disk structure and press Enter. The fdisk command writes the
changes to the virtual disk drive. The fdisk command displays the following diagnostic message:

206 Logical partitioning



The partition table has been altered!

Calling ioctl() to re-read partition table.
Syncing disks.

After the operation is completed, the fdisk command returns the command prompt.
20. Format the disk partition using the Linux mkfs command . There are a number of optional

parameters for the mkfs command, but typically the defaults satisfy most disk uses. To format the
disk partition created in the previous steps, ensure that you are logged in with superuser (root)
privileges and type the following command at a Linux command prompt:
mkfs /dev/sdb1

Since a single disk partition exists on the second virtual disk, the name of the disk is /dev/sdb1 (the
sdb indicates that it is the second disk, and the 1 indicates that it is partition 1). The mkfs command
displays the following diagnostic messages:
mke2fs 1.28 (31-Aug-2002)
Fileserver label=
OS type: Linux Block size=1024 (log=0)
Fragment size=1024 (log=0)
51200 inodes, 204784 blocks
10239 blocks (5.00%) reserved for the super user
First data block=1
25 block groups
8192 blocks per group, 8192 fragments per group
2048 inodes per group
Superblock backups stored on blocks:

8193, 24577, 40961, 57345, 73729

Writing inode tables: done
Writing superblocks and fileserver accounting information: done

This fileserver will be automatically checked every 29 mounts or
180 days, whichever comes first. Use tune2fs -c or -i to override.

21. Type the following command to create a directory that you can use to access the new file: mkdir
/mnt/data

22. Type the following command to mount the virtual disk drive in the new directory: mount /dev/sdb1
/mnt/data

23. Add an entry to the /etc/fstab file using a Linux text editor, such as vi. For example, /dev/sdb1
/mnt/data ext2 defaults 1 1. This entry mounts the virtual disk every time you restart Linux.

Linking a network-server storage space to a network-server description:

You can link a network-server storage space (NWSSTG) to one or more network-server descriptions
(NWSDs). This allows the NWSDs and their associated logical partitions to use the data stored on the
NWSSTG.

You can link an NWSSTG to an unlimited number of NWSDs. This is beneficial when multiple logical
partitions need access to a single application.

When you link an NWSSTG to an NWSD, you can set up the NWSD to have read-only access to the
NWSSTG, or you can set up the NWSD to read or write to the NWSSTG.

Attention: If more than one NWSD can write to the NWSSTG, ensure that only one NWSD can update
the data at a time. Otherwise, changes made by one NWSD can be overwritten by another NWSD.

To link an NWSSTG to an NWSD, follow these steps:
1. At an IBM i command line, type the command ADDNWSSTGL and press F4.
2. From the Add Server Storage Link display, provide the following information:
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NWSSTG (Name)
NWSD (Name)
DYNAMIC (*YES)
DRVSEQNBR (*CALC)

3. Press F10 (Additional Parameters).
4. Enter the type of access the storage space will have.

Deleting network server descriptions for a Linux logical partition:

You can delete the IBM i network server description (NWSD) for a Linux logical partition that uses i
resources. When you delete the NWSD, all the configuration information for the Linux logical partition is
deleted from i.

To delete the network-server description (NWSD) for a Linux logical partition, follow these steps:
1. On an i control language (CL) command line, type the command WRKNWSD and press Enter.
2. Type 8 in the Opt field to the left of the Network Server and press Enter.
3. In the Work with Configuration Status display, if the status of the NWSD is not varied off, type 2 in

the Opt field to the left of the Network Server and press Enter. Otherwise, go to the next step.
4. Press F3 to return to the previous display
5. Enter a 4 in the Opt field to the left of the Network Server and press Enter.
6. On the Confirm Delete of Network Server Descriptions display, press Enter.

Deleting virtual disk drives for a Linux logical partition:

You can delete a virtual disk drive from a Linux logical partition that uses IBM i resources to make the
space available to the i logical partition once more. When you delete a virtual disk drive, all of the
information on the virtual disk drive is erased.

Before you can delete a disk drive, you must unlink it from the network-server description. For
instructions, see “Unlinking virtual disk drives from a Linux logical partition” on page 209.

To delete a virtual disk drive, follow these steps:

Delete the disk drive using the interface that you prefer.

Interface Actions

System i Navigator Complete the following steps:

1. Click Network → Windows Administration → Disk
Drives.

2. Right-click the disk drive that you want to delete.

3. Click Delete.

4. Click Delete in the confirmation window.

IBM i character-based interface Complete the following steps:

1. At an IBM i control language (CL) command line,
type DLTNWSSTG and press F4.

2. Type the name of the disk drive in the
Network-server storage space field and press Enter.

Using IPL types when running Linux:

The IPL source (IPLSRC) parameter on the network server description (NWSD) determines the initial
program that is loaded when the NWSD is varied on. For a Linux logical partition that uses IBM i
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resources, the initial program is the kernel. Ensure that the IPLSRC parameter specifies the kernel
location of the kernel for the Linux logical partition that uses i resources.

You can set the IPLSRC parameter when you use the Create Network Server Description (CRTNWSD)
command, and you can change the IPLSRC parameter when you use the Change Network Server
Description (CHGNWSD) command.

Note: IPLSRC parameter also has the values A, B, and D, which are not valid for IBM System i
hardware.

The IPLSRC parameter has the following valid values.

IPLSRC values Description

*Panel The logical partition is started from the source indicated on the control panel.

*NWSSTG (network-server
storage space)

This IPL type is used to start a logical partition from a virtual disk. The open
firmware will find the kernel in the virtual disk. The open firmware searches the
first virtual disk connected to the server for a logical partition marked bootable,
and of type 0x41 (PReP start). If a logical partition of this type does not exist,
the logical partition IPL will fail.

*STMF (stream file) This IPL type is used to start a logical partition from a kernel loaded in the IBM
i integrated file system. Note that the integrated file system includes files on the
optical (CD) drive on IBM i .

Unlinking virtual disk drives from a Linux logical partition:

By unlinking virtual disk drives (network-server storage spaces) from a Linux logical partition that uses
IBM i resources, you disconnect the virtual disk drives from the logical partition, making the virtual disk
drives inaccessible to users. If you delete a Linux logical partition that uses i resources, you must unlink
all virtual disk drives from the logical partition before you delete the logical partition.

To unlink a virtual disk drive from a Linux logical partition that uses i resources, follow these steps:
1. Unlink disk drives from a logical partition using System i Navigator. If you prefer to use a

character-based interface, go to step 2.
a. Vary off the NWSD for your logical partition.
b. Click Network → Windows Administration → Disk Drives.
c. Right-click the name of the disk drive that you want to unlink.
d. Click Remove Link.
e. Select a server from the list of linked servers.
f. If you are unlinking a disk drive that you plan to relink later, uncheck Compress link sequence.

You must relink the disk drive as the same link sequence number before you vary on the server. By
preventing compression of the link sequence values, you avoid having to unlink and relink all the
disk drives to get them in the correct sequence.

g. Click Remove.
h. You have completed this procedure. Do not complete step 2.

2. Unlink disk drives from a logical partition using a character-based interface:
a. Vary off the NWSD for your logical partition.
b. Type RMVNWSSTGL and press F4.
c. In the Network-server storage space field, type the name of the storage space that you want to

unlink and press Enter.
d. In the Network server description field, type the name of the server from which you want to

unlink the storage space and press Enter.
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e. If you are unlinking a linked disk drive that you plan to relink later, specify *NO in the Renumber
field.

Note: You must relink the disk drive as the same sequence number before you vary on the server.
By preventing automatic renumbering, you avoid having to unlink and relink all the disk drives to
get them in the correct sequence.

f. Press Enter.

Note: If you are uninstalling a logical partition, your next step is to delete the disk drive. For
instructions, “Deleting virtual disk drives for a Linux logical partition” on page 208. Otherwise,
vary on the NWSD for your logical partition.

Related concepts

“Saving Linux server objects in IBM i”
When a Linux logical partition uses IBM i resources, i stores Linux information in i objects. IBM i can
restore the objects correctly only if you save all objects for a Linux logical partition.
Related information

Stopping and starting the NWSD for a Linux partition

Saving Linux server objects in IBM i:

When a Linux logical partition uses IBM i resources, i stores Linux information in i objects. IBM i can
restore the objects correctly only if you save all objects for a Linux logical partition.

You can save these objects by using options of the i GO SAVE command in the server.
v Option 21 saves the entire server.
v Option 22 saves server data, which includes objects in the QUSRSYS library.
v Option 23 saves all user data, which includes objects in the QFPNWSSTG library.

If you want to save a particular object, use the following table to see the location of that object on i and
the command to use.

Table 32. Objects to save for logical partitions with virtual disk

Object content Object name Object location Object type Save command

Guest partition and
virtual disk drive

stgspc /QFPNWSSTG User-defined
network-server
storage spaces
in system
auxiliary
storage pool
(ASP)

GO SAV, option 21 or 23

SAV OBJ(’/QFPNWSSTG/stgspc’)
DEV(’/QSYS.LIB/TAP01.DEVD’)

User-defined
network-server
storage spaces
in user ASP

SAV OBJ((’/QFPNWSSTG/stgspc’)
(’/dev/QASPnn /stgspc.UDFS’))
DEV(’/QSYS.LIB/TAP01.DEVD’)

Table 33. Objects to save for all logical partitions with a server

Object content Object name Object location Object type Save command

Messages from the
logical partition

Various Various Server message
queue

GO SAVE, option 21 or 23

SAVOBJ OBJ(msg) LIB(qlibrary)
DEV(TAP01) OBJTYPE(*MSGQ)
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Table 33. Objects to save for all logical partitions with a server (continued)

Object content Object name Object location Object type Save command

IBM i configuration
objects for logical
partitions

Various QSYS Device
configuration
objects

GO SAVE, option 21, 22, or 23

SAVOBJ DEV (TAPO1)

Various Various QUSRSYS Various GO SAVE, option 21 or 23

SAVLIB LIB(*NONSYS) or
LIB(*ALLUSR)

Related information

Backup and recovery

Backing up and recovering Linux logical partitions that use IBM i virtual I/O resources:

When you create a Linux logical partition that uses resources from an IBM i logical partition, you can
manage backup and recovery using IBM i control language (CL) commands, Linux commands, or a
combination of the two.

To save Linux data in a logical partition that uses i resources to a shared tape drive and restore the data
from the tape drive, you can use either the Linux tar command or the i Save (SAV) and Restore (RST)
commands. You can also use the tar command to save your data to a file. If you use the tar command to
save data, the only way you can restore that data is by using the tar command again. Similarly, if you use
the SAV command to save data, the only way you can restore that data is by using the RST command.
The two methods of backing up and restoring data are not compatible.

The following restrictions apply:
v To use the tape device from Linux, you must vary the tape off under IBM i.
v Saving the storage space is typically faster than saving by using the tar command, but it does not

provide file-level backup and recovery.
v Linux does not support switching tapes in a library device. You can only use the tape that is currently

in the device.
v You cannot save IBM i data and tar data on the same tape volume.
Related information

Backup and recovery

Backing up and recovering Linux files using the tar command:

The most common data backup utility in Linux is the tar (tape archive) utility. Use the Linux tar
command if you have Linux installed on a dedicated disk or if you cannot vary off a Linux logical
partition while you are backing up data.

Backups using the Linux tar command are at the file level. They save only the files and directories that
the tar command specifies. Therefore, you cannot use the tar command to save Linux data that is not in
the file server. For example, you cannot save a kernel in the PowerPC Reference Platform® (PReP) start
logical partition by using the tar command.

One advantage of the tar command is that it supports incremental backups and backup of special
devices, which is not common for tar implementations. Also, the tar command backs up files without
regard to the underlying file system type.

Saving to and restoring from a tape device:
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Use these procedures to save and restore Linux files between a Linux logical partition that uses IBM i
resources and a shared tape drive.

Ensure that your Linux data is in the file server.

Linux typically treats tape as a character device that it can quickly read from or write to in long streams of
data, but cannot quickly access to find specific data. By contrast, Linux treats a disk or CD as a block
device that it can read from or write to quickly at any point on the device, making it suitable for the
mount command.

Complete the following steps to save and restore Linux files between a logical partition that uses IBM i
resources and a shared tape drive:
1. Type the following command: tar -b 40 -c -f /dev/st0 files Use the following descriptions to help

you understand the arguments of this command:
v tar is the command name (the contraction of “tape archive”).
v -b 40 is the block size in sectors. This argument specifies that Linux is to write the archive stream

in blocks of 40 sectors (20 KB). If you do not specify a value for this argument, the default value is
20 sectors (10 KB), which does not perform as well over virtual tape as does a value of 40.

v -c is the command action to create. This argument specifies that the tar command creates a new
archive or overwrites an old one (as opposed to restoring files from an archive or adding individual
files to an existing archive).

v -f /dev/st0 is the virtual tape device and number. This argument specifies that the command uses
virtual tape 0 on the IBM System i server. After the tar command runs, the tape device is closed
and the tape is rewound. To save more than one archive on the tape, you must keep the tape from
rewinding after each use, and you must position the tape to the next file marker. To do this, specify
the nst0 (nonrewinding virtual tape) device instead of st0.

v files are the names of the files and directories that you plan to save.

You have now saved Linux data from a logical partition that uses IBM i resources to the shared tape
drive.

2. Type the following command: tar -b 40 -x -f /dev/st0 files The -x (extract) argument replaces the
-c (create) argument in the tar command used in step 1. You have now restored Linux data from the
shared tape drive to a logical partition that is sharing resources.

Saving to and restoring from a file:

You can save and restore Linux files between a Linux logical partition that uses IBM i resources and a tar
file.

Saving to a file

The following is an example of using the tar command to save to a file.

tar -cvf /tmp/etc.tar /etc

Use the following descriptions to help you understand the arguments of this command:

tar The command name.

c Create a tar file.

v Verbose. This argument shows the files that are being added to the tar file.

f The data immediately following f is the name of the tar file.

/tmp/etc.tar
The name of the tar file.
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/etc An object to be added to the tar file. Because /etc is a directory, the utility adds all the contents
of the directory and its subdirectories to the tar file.

After you create the tar file, you can save it to an offline medium in several ways. For example, you can
save the tar file to a virtual tape device or a directly attached tape device. You can also copy the tar file
to the integrated file system and save it at a later time.

You can save the data on a Linux logical partition to a tar file during normal server usage. You can
automate and start the tar utility by using the cron (chronology) daemon on the logical partition. The
cron daemon is a scheduling mechanism for Linux. You can also use the tar utility to schedule a single
backup request. For example, if you want to use the tar utility to back up the /etc directory at 10 p.m. on
19 September, you can type the following command:at 10pm Sep 19 -f tar.command.

Restoring from a file

The following is an example of using the tar command to restore from file: tar -xvf /tmp/etc.tar /etc.
The -x (extract) argument replaces the -c (create) argument in the tar command used to save the files.

Backing up and recovering Linux logical partitions using i commands:

If you have a Linux logical partition that uses IBM i resources, tools are available in i for backup and
recovery. You can use the Save (SAV) and Restore (RST) control language (CL) commands to save and
restore entire virtual disks in their current state.

The SAV command saves the directory that has the same name as the virtual disk under the
QFPNWSSTG directory in the integrated file system. This method of backup and recovery is most
effective if the Linux kernel is saved in a PowerPC Reference Platform (PReP) start logical partition on
the virtual disk. On most Linux distributions, this usually occurs as part of a default installation.

Backups of storage spaces using i commands are at drive level. This means that i backs up the entire
contents of a virtual disk, or network storage space, rather than individual files. Thus, the correct SAV
command backs up any information on the drive, including a kernel in the PReP start logical partition.

If you save the Linux kernel in a PReP logical partition, you can restore and start the logical partition
after a total system reinstallation. You can also transport and restore saved virtual disks to other IBM
System i servers using File Transfer Protocol (FTP) and tape.

Save Linux data by using IBM i SAV:

You can save data for a Linux logical partition that uses IBM i resources by using the Save (SAV) i CL
command.

On IBM i, your data is in a network-server storage space.

Saving and restoring individual Linux files using IBM i commands requires that you use the QNTC
directory in the integrated file system. You can access the files that you save and restore by using a file
share. You can define the fiile share by using Samba on Linux, and you can access the file share by using
QNTC.

To save data for a Linux logical partition that uses IBM i resources by using the Save (SAV) IBM i CL
command, follow these steps:
1. At the IBM i command line, enter the Save (SAV) command.
2. On the Save display, enter the following parameter values:
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a. In the Device field, enter the associated IBM i device description. To save to a file in a library like
QGPL, enter /qsys.lib/qgpl.lib/myfile.file. For example, if your tape device is named TAP01,
enter /qsys.lib/tap01.devd.

b. In the Objects: Name field, enter the server, share, or file. For example, if your server is named
MYSERVER, your share is named MYSHARE, and it contains all of the directories and files that
need to be saved, enter /QNTC/MYSERVER/MYSHARE.

3. At the IBM i command line, enter the Display Save File (DSPSAVF) command to verify that the
changed save file exists.

4. In the Option field by the new save file name, enter 5 (Display) to display a list of the stream files in
the save file.

Related information

Backing up and recovering individual integrated Linux server files and directories

Restore Linux data using i RST:

You can restore data for a Linux logical partition that uses i resources by using the Restore (RST) IBM i
CL command.

Saving and restoring individual Linux files using IBM i commands requires that you use the QNTC
directory in the integrated file system. You can access the files that you save and restore by using a file
share. You can define the file share by using Samba on Linux, and you can access the file share by using
QNTC.

Restore (RST) is the i command to restore Linux files from the shared tape drive of the logical partition
that shares resources. On the Restore Object display, enter the following parameter values:
1. To restore from a tape device, enter the associated i device description in the Device field. For

example, if your tape device is named TAP01, enter /qsys.lib/tap01.devd.
2. To restore from a save file in library QGPL, enter the associated file name. For example,

/qsys.lib/qgpl.lib/myfile.file.
3. In the Objects: Name field, enter the server, share, or file. For example, if your server is named

MYSERVER, your share is named MYSHARE, and it contains all of the directories and files that need
to be restored, enter /QNTC/MYSERVER/MYSHARE.

Related information

Backing up and recovering individual integrated Linux server files and directories

Backing up the network server description and virtual disk drives associated with a Linux logical partition:

Learn about how to back up the data for a Linux logical partition that uses IBM i resources.

Backing up the data for a Linux logical partition that uses IBM i resources is different from backing up
the data for a Linux logical partition that uses its own resources. When you install the logical partitions
with virtual disk, the IBM i logical partition that shares resources creates a network server description
and creates disk drives for your Linux logical partition that you need to back up. Some of the disk drives
are server-related (the installation and server drives), while others are user-related. Because your Linux
logical partition might consider the disk drives to be a unified server, you must save all the disk drives
and the network server description so they restore correctly.

The implementation of a logical partition for IBM System i servers allows you to save and restore virtual
disks as IBM i network-server storage space objects. These objects are saved as part of the IBM i server
when you perform a full IBM i server backup. You can also specifically save the network server
description and storage spaces that are associated with a logical partition on an IBM System i server.
Daily backup of the server drive is a good practice.
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Building a rescue image on a network storage space:

You can build a rescue image on a network storage space (NWSSTG) to assist you in checking and
repairing a faulty Linux installation.

A rescue image is a disk image that contains the Linux kernel, a shell, and the diagnostic tools, drivers,
and other utilities that would be useful for checking and repairing a faulty Linux installation. Many
Linux distributors include a rescue image on their installation disks. One rescue solution for a logical
partition is to create a small NWSSTG that can remain on the integrated file system solely for the purpose
of rescuing logical partitions. You can install a rescue image to the NWSSTG when you create your
logical partition.

Before creating a rescue image on network storage, it is important to document the configuration
information for each of your logical partitions.
1. Document the drive configuration information, which is located in the /etc/fstab file.
2. Capture the networking information that is reported when you run the ifconfig command.
3. Create a list of the modules that are needed by each logical partition. You can see which modules are

in use by using the lsmod command from within Linux. Use the information obtained from the
commands and files listed above to determine which files to store on your rescue network storage
space.

To build a rescue image on an NWSSTG, follow these steps:
1. Determine how much network storage space you need to build the rescue image. Consult your

Linux documentation to see how much space is required for a minimum installation of your
distribution, and add enough space to create a swap partition (a PowerPC Reference Platform (PReP)
start partition) and to install any extra software that you would like to have available in your rescue
image. For example, if the documentation states that a minimum server installation is 291 MB, create
a storage space of 425 MB.

2. Create a network storage space (CRTNWSSTG) of the size you determined for the rescue image. You
might want to make a note in the storage space description field that indicates which distribution
was used to make the rescue image and warns that it should be saved.

3. Link this storage space to a network server description (NWSD). You do not need to create a new
NWSD for this step. You could unlink an existing storage space and temporarily link your rescue
storage space to any of your existing NWSDs.

4. Start the installation server for your distribution as described in the documentation and follow the
prompts. To partition your installation manually, ensure that you create a PReP start partition. At the
point where you select the packages to install, select the minimum number of packages supported.
The name for the package group varies by distribution.

5. Allow the installer to complete its package installation and configuration. After installation has
finished, the installer starts the rescue image for you.

6. Verify that the rescue image has all the utilities that you need. For a logical partition, at a Linux
command prompt, type rpm -qa | grep ibmsis to make sure that the utilities that work with the
integrated disk are available.

7. Ensure that the device drivers that your logical partitions require are installed. For example, verify
that pcnet32 is installed for Ethernet devices, or that olympic is installed for token-ring devices. The
kernel modules that have been compiled can be found in the /lib/modules/kernel
version/kernel/drivers directory or in directories under that directory.

8. Install any other special drivers or software packages that your logical partitions require.
9. Use File Transfer Protocol (FTP) to send the files with the configuration information for your other

logical partitions to the rescue server network storage space.
10. Install the kernel manually (if you are required to do so by your Linux distribution). For details

regarding installing the kernel, consult the appropriate installation documentation for your
distribution.
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11. Make note of the path to the root partition on the rescue-storage space. You must use this
information to start the rescue network storage space from the network. To determine the root
partition, type the command cat /etc/fstab. The partition that has a forward slash (/) in the second
column is your root partition. For further assistance in determining the root partition, see the
documentation for your distribution.

You can shut down your logical partition by typing shutdown -h now and varying off the logical partition
after the shutdown has completed. After the logical partition has varied off, you can unlink the rescue
storage space and relink the normal storage space for the NWSD.

Using a rescue image from a network-server storage space:

You can use a Linux rescue image on a network-server storage space (NWSSTG) to repair a Linux logical
partition that uses IBM i resources. A rescue image is a disk image that contains the Linux kernel, a shell,
and the diagnostic tools, drivers, and other utilities that would be useful for checking and repairing a
faulty Linux installation.

To use the rescue image that you built on the NWSSTG, use the following steps:
1. Disconnect the virtual storage space for the failed logical partition (if applicable) by using the Work

with NWS Storage Spaces (WRKNWSSTG) command.
2. Connect your rescue storage space as the first drive to the network server description (NWSD), and

reconnect the original storage space (where applicable) as the second drive.
3. Edit the NWSD for the failed partition so that it starts from IPL source *NWSSTG. Also, edit the IPL

Parameters field to reflect the root partition on the rescue storage space. For most distributions, this is
a parameter such as root=/dev/sda3 or root=/dev/vda1. For assistance, see the documentation for
your Linux distribution.

4. Restart the partition.
5. If the existing root partition is on a dedicated disk, you might need to insert the ibmsis driver using

the insmod ibmsis command.
6. Create a mount point to which you will mount the root partition of the network storage space that

you are trying to rescue. You can use a command such as mkdir /mnt/rescue.
7. Mount the root partition of the network storage space that you are trying to rescue. Mount a drive

using the command mount -t partition-type partition-location mount-point, where the partition
type is the format of the partition such as ext2 or reiserfs, the partition location is similar to
/dev/sdb3 (for non-devfs disk partitions), /dev/sd/disc1/part3 (for devfs disk partitions), or
/dev/sda2 (for a partition on a dedicated disk).

8. The drive that you are trying to rescue, when using virtual disk, will be the second drive rather than
the first drive. (That is, if the drive was /dev/sda3 when the partition was running normally, it will
be /dev/sdb3 in the rescue server.)

9. Use the documentation or the configuration files you created when you created the rescue NWSSTG
to help you determine the device for the root of the partition you are trying to rescue. Your mount
point will be similar to /mnt/rescue if you use the previous example.

You can either use the rescue tools provided in your rescue storage space against the mount point you
have created or you can work on the partition that you are rescuing from within its own storage space. If
rescuing the image from its own storage space, change the root directory for that partition using the
chroot mount-point command.

Backing up network server descriptions for a Linux logical partition:

When you save the storage space objects that are associated with a logical partition that uses virtual
disks, you must also save the network server description (NWSD). Otherwise, a logical partition might
not be able to re-establish items such as the file-system permissions for the logical partition.
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Use the Save Configuration (SAVCFG) command to save the network server description:
1. On the IBM i command line, type SAVCFG.
2. Press Enter to save the NWSD configuration.

The Save Configuration command (SAVCFG) saves the objects associated with an NWSD, including the
line descriptions and network-server storage space link information. SAVCFG does not save the storage
spaces associated with this server. You can use the Save Object (SAV) command to save the storage
spaces.

Restoring network-server descriptions for a Linux logical partition:

In a disaster-recovery situation, you would restore all the configuration objects, which include the
network-server description (NWSD) for your logical partition. In some situations, you must specifically
restore the NWSD. For example, you must restore the NWSD when you migrate to new hardware.

To have IBM i automatically relink disk drives within the integrated file system to the restored NWSD,
restore those disk drives first.

To restore the NWSD, use the Restore Configuration (RSTCFG) command:
1. On an IBM i command line, type RSTCFG and press F4 (Prompt).
2. In the Objects field, specify the name of the NWSD.
3. In the Device field, specify which device you are using to restore the NWSD. If you are restoring

from media, specify the device name. If you are restoring from a save file, specify *SAVF and identify
the name and library for the save file in the appropriate fields.

4. Press Enter to restore the NWSD.
5. When you have restored the NWSD and all of its associated storage spaces, start (vary on) the logical

partition.

Performance considerations for logical partitions
You can manage and enhance the performance of logical partitions so that your system uses its resources
in the most efficient manner.

You can manage and enhance the performance of a AIX logical partition by configuring the AIX
operating system.

Managing IBM i performance ensures that your managed system is efficiently using resources and that
your managed system provides the best possible services to you and to your business. Moreover, effective
performance management can help you quickly respond to changes in your managed system and can
save on expenses by postponing costly upgrades and service fees.
Related information

AIX Performance management

Performance Tools Guide and Reference

Performance Toolbox Version 2 and 3 Guide and Reference

Performance considerations for shared memory partitions
You can learn about performance factors (such as shared memory overcommitment) that influence the
performance of a logical partition that uses shared memory (hereafter referred to as a shared memory
partition). You can also use shared memory statistics to help you determine how to adjust the
configuration of a shared memory partition to improve its performance.

Performance considerations for overcommitted shared memory partitions:
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Learn about how the degree to which the memory configuration of a logical partition that uses shared
memory (hereafter referred to as a shared memory partition) is overcommitted affects the performance of
the shared memory partition. In general, the less overcommitted the memory configuration of a shared
memory partition, the better its performance.

A shared memory configuration is considered overcommitted when the sum of the logical memory that is
assigned to all of the shared memory partitions is greater than the amount of physical memory in the
shared memory pool.

When the sum of the physical memory currently used by the shared memory partitions is less than or
equal to the amount of memory in the shared memory pool, the memory configuration is logically
overcommitted. In a logically overcommitted memory configuration, the shared memory pool has enough
physical memory to contain the memory used by all shared memory partitions at one point in time.

The figure shows a shared memory partition that is assigned 2.5 GB of logical memory. Its maximum
logical memory is 3 GB and its minimum logical memory is 1 GB. The figure also shows that the amount
of physical memory that is currently allocated to the shared memory partition from the shared memory
pool is 2.1 GB. If the workload that runs in the shared memory partition currently uses 2.1 GB of
memory and requires an additional 0.2 GB of memory, and the shared memory pool is logically
overcommitted, the hypervisor allocates an additional 0.2 GB of physical memory to the shared memory
partition by assigning memory pages that are not currently in use by other shared memory partitions.

When the sum of the physical memory currently used by the shared memory partitions is greater than
the amount of memory in the shared memory pool, the memory configuration is physically overcommitted.
In a physically overcommitted memory configuration, the shared memory pool does not have enough
physical memory to contain the memory used by all the shared memory partitions at one point in time.
The hypervisor stores the difference in auxiliary storage.

Figure 7. A shared memory partition in a logically overcommitted memory configuration
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The figure shows a shared memory partition that is currently allocated 0.8 GB of physical memory and
assigned 2.5 GB of logical memory. If the workload that runs in the shared memory partition currently
uses 0.8 GB of memory and requires an additional 1.5 GB of memory, and the shared memory pool is
physically overcommitted, the hypervisor stores 1.5 GB of the shared memory partition’s memory in its
paging space device.

When the shared memory partition needs to access data on the paging space device, the hypervisor
directs a paging VIOS partition to read the data from the paging space device and write the data to the
shared memory pool. The more memory that the hypervisor must store on the paging space device, the
more often the hypervisor and paging VIOS partition need to read and write data between the paging
space device and the shared memory pool. Compared to directly accessing data that is stored in the
shared memory pool, it takes more time to access data that is stored in the paging space device. Thus, in
general, the less overcommitted the memory configuration of a shared memory partition, the better its
performance.

The operating systems that run in the shared memory partitions help improve the performance of the
shared memory partitions with overcommitted memory configurations by providing the hypervisor with
information about how the operating system uses the physical memory allocated to it. Using this
information, the hypervisor can store data that the operating system accesses the least often in the paging
space device and store the data that the operating system accesses the most often in the shared memory
pool. This reduces the frequency that the hypervisor needs to access the paging space device and
increases the performance of the shared memory partition.

Figure 8. A shared memory partition in a physically overcommitted memory configuration
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Related concepts

“Factors that influence the performance of shared memory partitions”
In addition to overcommitment considerations, you need to consider other factors that can affect the
performance of a logical partition that uses shared memory (hereafter referred to as a shared memory
partition). These factors include the workload running in the shared memory partition, the I/O
entitlement of the shared memory partition, whether the operating system or applications that run in the
shared memory partition use memory affinity, and whether the shared memory partition is configured to
use redundant Virtual I/O Server (VIOS) logical partitions (hereafter referred to as paging VIOS
partitions).
“Example: A shared memory configuration that is logically overcommitted” on page 28
When the sum of the physical memory currently used by the shared memory partitions is less than or
equal to the amount of memory in the shared memory pool, the memory configuration is logically
overcommitted. In a logically overcommitted memory configuration, the shared memory pool has enough
physical memory to contain the memory used by all shared memory partitions at one point in time.
“Example: A shared memory configuration that is physically overcommitted” on page 30
When the sum of the physical memory currently used by the shared memory partitions is greater than
the amount of memory in the shared memory pool, the memory configuration is physically overcommitted.
In a physically overcommitted memory configuration, the shared memory pool does not have enough
physical memory to contain the memory used by all the shared memory partitions at one point in time.
The hypervisor stores the difference in auxiliary storage.
“Shared memory distribution” on page 48
The hypervisor uses the memory weight of each logical partition that uses shared memory (hereafter
referred to as shared memory partitions) to help determine which logical partitions receive more physical
memory from the shared memory pool. To help optimize performance and memory use, the operating
systems that run in shared memory partitions provide the hypervisor with information about how the
operating system uses its memory to help the hypervisor determine which pages to store in the shared
memory pool and which pages to store in the paging space devices.
Related reference

“Performance statistics for shared memory” on page 221
The Hardware Management Console (HMC), Integrated Virtualization Manager, AIX, IBM i, and Linux
environments provide statistics about the shared memory configuration.

Factors that influence the performance of shared memory partitions:

In addition to overcommitment considerations, you need to consider other factors that can affect the
performance of a logical partition that uses shared memory (hereafter referred to as a shared memory
partition). These factors include the workload running in the shared memory partition, the I/O
entitlement of the shared memory partition, whether the operating system or applications that run in the
shared memory partition use memory affinity, and whether the shared memory partition is configured to
use redundant Virtual I/O Server (VIOS) logical partitions (hereafter referred to as paging VIOS
partitions).

The following table describes the types of workloads that are appropriate to run in shared memory
configurations that are logically and physically overcommitted. It also describes the types of workloads
that are not appropriate to run in a shared memory configuration.
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Table 34. Workloads to run in logically overcommitted configurations, physically overcommitted configurations, and
dedicated memory configurations

Workloads for logically
overcommitted configurations

Workloads for physically
overcommitted configurations

Workloads for dedicated memory
configurations

v Workloads that peak at opposite
and varying times.

v Workloads with memory residency
requirements that have a low
average.

v Workloads that do not have a
sustained load.

v Logical partitions that serve as
failover and backup logical
partitions when configured on the
same server as their primary
counterparts.

v Test and development
environments.

v Workloads that run the AIX
operating system and use the file
cache.

v Print servers, file servers, network
applications, and other workloads
that are less sensitive to I/O
latency.

v Workloads that are inactive most of
the time.

v Workloads with high quality of
service criteria.

v Workloads that consistently
consume memory resources due to
sustained peak load.

v High performance computing
(HPC) workloads.

In addition to the degree to which the memory configuration of a shared memory partition is
overcommitted, the following factors can influence the performance of a shared memory partition:
v The workload that runs in a shared memory partition, the number of virtual adapters that are assigned

to the shared memory partition, and the I/O entitled memory set for the shared memory partition all
directly affect the performance of I/O devices. These factors can cause I/O devices to operate at their
minimum memory requirements rather than their optimal memory requirements. This can cause delays
in I/O operations.

v The amount of I/O entitlement required for optimal performance depends on the workload and
number of adapters configured.

v The operating systems that run in shared memory partitions cannot use memory affinity. Some
applications rely on memory affinity to improve their performance.

v The shared memory partition might be suspended if it attempts to access data on its paging space
device when the following situations occur simultaneously:
– The paging VIOS partition becomes unavailable. For example, you shut down the paging VIOS

partition or the paging VIOS partition fails.
– The shared memory partition is not configured to use redundant paging VIOS partitions to access its

paging space device.
Related concepts

“Performance considerations for overcommitted shared memory partitions” on page 217
Learn about how the degree to which the memory configuration of a logical partition that uses shared
memory (hereafter referred to as a shared memory partition) is overcommitted affects the performance of
the shared memory partition. In general, the less overcommitted the memory configuration of a shared
memory partition, the better its performance.
Related reference

“Performance statistics for shared memory”
The Hardware Management Console (HMC), Integrated Virtualization Manager, AIX, IBM i, and Linux
environments provide statistics about the shared memory configuration.

Performance statistics for shared memory:

The Hardware Management Console (HMC), Integrated Virtualization Manager, AIX, IBM i, and Linux
environments provide statistics about the shared memory configuration.
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Where to view statistics Statistics to view

HMC utilization data v Statistics about the shared memory pool, such as:

– Size of the shared memory pool

– Total amount of memory that is overcommitted

– Total amount of logical memory that is assigned to the shared
memory partitions

– Total amount of I/O entitled memory that is assigned to the shared
memory partitions

– Total amount of physical memory that the shared memory partitions
currently use for their I/O devices

– Amount of memory from the shared memory pool that the
hypervisor uses to manage the shared memory partitions

– The time it takes, in microseconds, for data to be written to the
shared memory pool from the paging space device

v Statistics about the shared memory partitions, such as:

– Amount of logical memory assigned to the shared memory partition

– Amount of physical memory from the shared memory pool that is
allocated to the shared memory partition

– Amount of memory that is overcommitted

– I/O entitled memory assigned to the shared memory partition

– Amount of physical memory that the shared memory partition
currently uses for its I/O devices

– Memory weight of the shared memory partition

Integrated Virtualization Manager

Use the IVM lslparutil command to
view shared memory statistics in the
Integrated Virtualization Manager.

v Statistics about the shared memory pool, such as:

– Size of the shared memory pool

– Total amount of logical memory that is assigned to the active shared
memory partitions

– Total amount of I/O entitled memory that is assigned to the active
shared memory partitions

– Total amount of physical memory that the active shared memory
partitions currently use for their I/O devices

– The total number of page faults that occurred since the shared
memory pool was created or since the managed system was
restarted, whichever is most recent

– Total time, in milliseconds, that the processors waited for page faults
to be resolved since the shared memory pool was created or since the
managed system was restarted, whichever is most recent

– Amount of physical memory in the shared memory pool that is
reserved for the server firmware

v Statistics about the shared memory partitions, such as:

– Amount of physical memory from the shared memory pool that is
allocated to the shared memory partition

– I/O entitled memory assigned to the shared memory partition

– Amount of physical memory that the shared memory partition
currently uses for its I/O devices

– Memory weight of the shared memory partition
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Where to view statistics Statistics to view

AIX

Use the lparstat command to view
shared memory statistics in AIX.

v Whether the shared memory partition is capable of using shared
memory

v Amount of physical memory allocated to the shared memory partition

v Hypervisor page size

v Memory weight of the shared memory partition

v I/O entitled memory assigned to the shared memory partition

v Unused I/O entitled memory of the shared memory partition

v Highest amount of physical memory that the shared memory partition
has used for its I/O devices since the last time the shared memory
partition was activated or since the last time the memory statistics were
reset, whichever is most recent

v I/O entitled memory usage statistics for each I/O entitled memory
device pool

IBM i

Use Collection Services to view shared
memory statistics in IBM i.

v Statistics about the shared memory pool, such as:

– Total number of page faults for all of the shared memory partitions

– Total time, in milliseconds, that the processors waited for page faults
to be resolved

– Total physical memory, in bytes, that is assigned to the shared
memory pool

– Sum of the logical memory, in bytes, that is assigned to all of the
shared memory partitions that are active

– Sum of the I/O entitled memory, in bytes, that is assigned to all of
the shared memory partitions that are active

– Sum of the physical memory, in bytes, that the shared memory
partitions that are active currently use for their I/O devices

v Statistics about the shared memory partition, such as:

– Memory weight of the shared memory partition

– Amount of physical memory, in bytes, from the shared memory pool
that is currently used by the shared memory partition

– Number of times that the shared memory partition waited for a page
fault

– The time, in milliseconds, that the shared memory partition waited
for page faults to be resolved

– Maximum amount of memory, in bytes, that the shared memory
partition can assign to data areas that are shared between the
operating system and the server firmware

– I/O entitled memory assigned to the shared memory partition

– Minimum amount of physical memory, in bytes, required for all of
the configured I/O devices to operate

– Optimal amount of physical memory, in bytes, required for I/O
devices to maximize throughput performance

– Amount of physical memory, in bytes, that the shared memory
partition currently uses for its I/O devices

– Highest amount of physical memory, in bytes, that the shared
memory partition has used for its I/O devices since the last time the
shared memory partition was activated or since the last time the
memory statistics were reset, whichever is most recent

– Number of delayed I/O operations since the last time the shared
memory partition was activated
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Where to view statistics Statistics to view

Linux

View memory statistics for Linux in the
sysfs file system as follows:

v Shared memory partition data: cat
/proc/ppc64/lparcfg

v Virtual I/O bus attributes:
/sys/bus/vio/ directory.

v Virtual I/O device attributes:
/sys/bus/vio/devices/ directory.
This directory has a subdirectory for
each device. Look in the subdirectory
for each device to see the virtual I/O
device statistics for each device.

v Statistics about the shared memory partition:

– I/O entitled memory set for the shared memory partition

– Memory weight of the shared memory partition

– Amount of physical memory allocated to the shared memory
partition

– Size of the shared memory pool to which the shared memory
partition belongs

– Frequency that data is written to the shared memory pool from the
paging space device

– The time it takes, in microseconds, for data to be written to the
shared memory pool from the paging space device

v Statistics about the virtual I/O bus, such as the highest amount of
physical memory the shared memory partition has ever used for its I/O
devices.

v Statistics about the virtual I/O devices, such as the frequency that the
device tried to map a page to perform an I/O operation and was
unable to obtain sufficient memory. Consequently, the attempt failed
and delayed the I/O operation.

Related concepts

“Factors that influence the performance of shared memory partitions” on page 220
In addition to overcommitment considerations, you need to consider other factors that can affect the
performance of a logical partition that uses shared memory (hereafter referred to as a shared memory
partition). These factors include the workload running in the shared memory partition, the I/O
entitlement of the shared memory partition, whether the operating system or applications that run in the
shared memory partition use memory affinity, and whether the shared memory partition is configured to
use redundant Virtual I/O Server (VIOS) logical partitions (hereafter referred to as paging VIOS
partitions).
“Performance considerations for overcommitted shared memory partitions” on page 217
Learn about how the degree to which the memory configuration of a logical partition that uses shared
memory (hereafter referred to as a shared memory partition) is overcommitted affects the performance of
the shared memory partition. In general, the less overcommitted the memory configuration of a shared
memory partition, the better its performance.

Adjusting the shared memory configuration to improve performance
You can use the Hardware Management Console (HMC) to adjust the configuration of your shared
memory environment to improve its performance. For example, you can change the I/O entitled memory
or the memory weight that is assigned to a logical partition that uses shared memory (hereafter referred
to as a shared memory partition.)

The following table lists several ways that you can adjust the configuration of your shared memory
environment to improve its performance.

Table 35. Performance adjustments for shared memory configurations

Performance improvement task Instructions

Set the memory weight for each shared memory partition
so that the shared memory partitions with the most
critical memory requirements receive more physical
memory from the shared memory pool.

“Changing the memory weight of a shared memory
partition” on page 183
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Table 35. Performance adjustments for shared memory configurations (continued)

Performance improvement task Instructions

Change the I/O entitled memory that is assigned to each
shared memory partition to improve the throughput of
I/O operations.

v “Adding and removing I/O entitled memory
dynamically to and from a shared memory partition”
on page 166

v “Determining the I/O entitled memory for a shared
memory partition”

Add or remove physical memory to and from the shared
memory pool, which can increase or decrease the degree
to which the shared memory configuration is
overcommitted.

“Changing the size of the shared memory pool” on page
139

Dynamically change the amount of logical memory that
each shared memory partition uses, which can increase
or decrease the degree to which the memory
configuration of the shared memory partition is
overcommitted.

“Adding and removing logical memory dynamically to
and from a shared memory partition” on page 165

Change a shared memory partition to a dedicated
memory partition.

“Changing the memory mode of a logical partition” on
page 184

Determining the I/O entitled memory for a shared memory partition:

After you create a new logical partition that uses shared memory (hereafter referred to as a shared memory
partition) or you dynamically add or remove a virtual adapter, you can use memory statistics that are
displayed by the Hardware Management Console (HMC) to dynamically increase and decrease the
amount of I/O entitled memory assigned to a shared memory partition.

The I/O entitled memory set for a shared memory partition needs to be high enough to ensure the
progress of I/O operations, and low enough to ensure adequate memory use among all the shared
memory partitions in the shared memory pool.

The operating system manages the I/O entitled memory allocated to a shared memory partition by
distributing it among the I/O device drivers. The operating system monitors how the device drivers use
the I/O entitled memory, and sends usage data to the HMC. You can view the data in the HMC and
dynamically adjust the I/O entitled memory that is assigned to a shared memory partition.

To determine the I/O entitled memory for a shared memory partition, complete the following steps using
the HMC:
1. View information about the physical memory that is used by the shared memory partition for its I/O

devices.
a. In the navigation pane, expand Systems Management → Servers.
b. Click the server on which the shared memory partition runs.
c. In the work pane, select the shared memory partition and click select Properties from the Tasks

menu. The Partition Properties page is displayed.
d. Click the Hardware tab.
e. Click the Memory tab.
f. Click Memory Statistics. The Memory Statistics panel is displayed.

2. Determine whether you want to change the I/O entitled memory that is assigned to the shared
memory partition, and the value to which you want to change it:
v If the Maximum I/O Entitled Memory Used value is less than the Assigned I/O Entitled Memory

value, the operating system is able to run all of the workload’s I/O operations simultaneously
without using all of its assigned I/O entitled memory. In this situation, you can decrease the
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Assigned I/O Entitled Memory value to the Maximum I/O Entitled Memory Used value and
continue to maintain unconstrained I/O performance.

v If the Maximum I/O Entitled Memory Used value is equal to the Assigned I/O Entitled Memory
value, the I/O operations of the shared memory partition might or might not be constrained by the
Assigned I/O Entitled Memory value as follows:
– The Assigned I/O Entitled Memory value does not constrain the I/O operations: The operating

system runs all of the workload’s I/O operations simultaneously and uses all of the I/O entitled
memory that is assigned to it. In this situation, the shared memory partition operates with the
smallest amount of I/O entitled memory necessary to maintain unconstrained I/O performance.

– The Assigned I/O Entitled Memory value constrains the I/O operations: The workload requires
more physical memory for I/O operations than the Assigned I/O Entitled Memory value, so the
operating system must delay some I/O operations so that the shared memory partition operates
within the Assigned I/O Entitled Memory value. In this situation, you can increase the Assigned
I/O Entitled Memory value so that it no longer constrains I/O performance.

If you are unsure as to whether the Assigned I/O Entitled Memory value constrains the I/O
operations of the shared memory partition, you can increase the I/O entitled memory that is
assigned to the shared memory partition, reset the data collector, and view the memory statistics
again. Repeat this process until the Maximum I/O Entitled Memory Used value no longer equals
the Assigned I/O Entitled Memory value. You can also view statistics, for AIX, IBM i and Linux
shared memory partitions, that show the number and frequency of delayed I/O operations. For
instructions about how to view these statistics, see “Performance considerations for shared memory
partitions” on page 217.

3. Dynamically increase or decrease the I/O entitled memory that is assigned to the shared memory
partition. For instructions, see “Adding and removing I/O entitled memory dynamically to and from
a shared memory partition” on page 166. (Dynamically changing the I/O entitled memory also
changes the I/O entitled memory mode to the manual mode.)

4. Reset the data collector. From the Memory Statistics panel, click Reset Statistics and then click Close.
5. Repeat this procedure until you are satisfied with the amount of I/O entitled memory that is assigned

to the shared memory partition.
For example, you create a shared memory partition with eight virtual adapters. You activate the
shared memory partition and the HMC automatically assigns 128 MB of I/O entitled memory to the
shared memory partition. After some time, you view the memory statistics for the shared memory
partition and see that the Maximum I/O Entitled Memory Used value is 96 MB. You dynamically
decrease the I/O entitled memory that is assigned to the shared memory partition from 128 MB to 96
MB and reset the data collector. After some time, you view the memory statistics for the shared
memory partition and see that the Maximum I/O Entitled Memory Used value is 88 MB. Because 88
MB is similar to 96 MB, you decide to leave the I/O entitled memory assigned to 96 MB for the
shared memory partition.

Examples

Creating a new shared memory partition

1. You activate the new shared memory partition. The HMC automatically sets the I/O entitled memory
for the shared memory partition.

2. After some time, you view the memory statistics and see that the Maximum I/O Entitled Memory
Used value is much less than the Assigned I/O Entitled Memory value.

3. You dynamically decrease the I/O entitled memory of the shared memory partition to the Maximum
I/O Entitled Memory Used value and reset the data collector. (Dynamically decreasing the I/O
entitled memory also changes the I/O entitled memory mode to the manual mode.)

4. After some time, you view the memory statistics again and determine that the new Maximum I/O
Entitled Memory Used value is only slightly less than the new Assigned I/O Entitled Memory value,
and no further adjustment is necessary.
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Dynamically adding a virtual adapter to a shared memory partition in the auto I/O entitled memory
mode

1. You dynamically add a virtual adapter to a shared memory partition. The HMC automatically
increases the I/O entitled memory that is assigned to the shared memory partition.

2. After some time, you view the memory statistics and see that the Maximum I/O Entitled Memory
Used value is much less than the Assigned I/O Entitled Memory value.

3. You dynamically decrease the I/O entitled memory of the shared memory partition to the Maximum
I/O Entitled Memory Used value and reset the data collector. (Dynamically decreasing the I/O
entitled memory also changes the I/O entitled memory mode to the manual mode.)

4. After some time, you view the memory statistics again and determine that the new Maximum I/O
Entitled Memory Used value is only slightly less than the new Assigned I/O Entitled Memory value,
and no further adjustment is necessary.

Dynamically adding a virtual adapter to a shared memory partition in the manual I/O entitled
memory mode

1. You ensure that the shared memory partition has enough I/O entitled memory to accommodate the
new adapter by dynamically increasing the I/O entitled memory of the shared memory partition.

2. You dynamically add a virtual adapter to the shared memory partition.
3. After some time, you view the memory statistics and see that the Maximum I/O Entitled Memory

Used value is much less than the Assigned I/O Entitled Memory value.
4. You dynamically decrease the I/O entitled memory of the shared memory partition to the Maximum

I/O Entitled Memory Used value and reset the data collector.
5. After some time, you view the memory statistics again and determine that the new Maximum I/O

Entitled Memory Used value is only slightly less than the new Assigned I/O Entitled Memory value,
and no further adjustment is necessary.

Dynamically removing a virtual adapter from a shared memory partition

1. You dynamically remove a virtual adapter from a shared memory partition. If the I/O entitled
memory mode is in the auto mode, the HMC automatically decreases the I/O entitled memory that is
assigned to the shared memory partition.

2. You reset the data collector.
3. After some time, you view the memory statistics and see that the Maximum I/O Entitled Memory

Used value is much less than the Assigned I/O Entitled Memory value.
4. You dynamically decrease the I/O entitled memory of the shared memory partition to the Maximum

I/O Entitled Memory Used value and reset the data collector. (If the I/O entitled memory mode is in
the auto mode, dynamically decreasing the I/O entitled memory also changes the I/O entitled
memory mode to the manual mode.)

5. After some time, you view the memory statistics again and determine that the new Maximum I/O
Entitled Memory Used value is only slightly less than the new Assigned I/O Entitled Memory value,
and no further adjustment is necessary.

The following example is another way to accomplish this example for AIX shared memory partitions:
1. Determine the amount of physical memory that the virtual adapter (that you plan to remove)

currently uses by running the lparstat command from the AIX command line.
2. If the I/O entitled memory mode is in the auto mode, dynamically change the I/O entitled memory

mode to the manual mode by running the chhwres command from the HMC command line.
3. Using the HMC graphical interface, dynamically remove the virtual adapter.
4. Using the HMC graphical interface, dynamically decrease the I/O entitled memory that is assigned to

the shared memory partition by the amount that you identified in step 1.
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Related tasks

“Managing virtual adapters dynamically” on page 172
You can dynamically add and remove virtual adapters to and from running logical partitions using the
Hardware Management Console (HMC).

Managing security for logical partitions and operating systems
When all logical partitions are managed by the Hardware Management Console, you can control who has
access to the HMC and the system. You can also use the IBM eServer Security Planner to help you plan a
basic security policy for each of the operating systems on your system.

When all logical partitions are managed by the Hardware Management Console (HMC), the system
administrator for the HMC can control who has access to the HMC and the managed systems by creating
HMC user roles. The user roles control who can access different parts of the HMC and what tasks they
can perform on the managed system.

You can use the IBM eServer Security Planner to help you plan a basic security policy for each of the
operating systems on your IBM Power Systems orIBM Systems hardware. The planner provides you with
a list of recommendations for setting password rules, resource-access rules, logging and auditing rules,
and other security settings that are specific to the operating system.
Related information

AIX security
IBM i security

eServer Security Planner

Troubleshooting IBM i logical partitions
If you have problems with a partitioned system, determine if the problem is specific to logical partitions
or is a system problem. If your problem is specific to logical partitions, you can use the reference codes to
resolve the error. However, specific recovery actions and tasks might require the assistance of your next
level of support.

Debugging network server description error messages for AIX logical partitions
This topic provides a list of network server description (NWSD) error codes and explanations to help you
debug NWSD error messages for AIX logical partitions.

You could encounter error messages when you try to vary on an AIX logical partition. These error
messages are displayed if you provide information that does not apply to a logical partition running on
the server when you create your network server description (NWSD). All error messages related to the
NWSD are displayed in QSYSOPR and indicate a description of the problem and a resolution to the
problem.

Table 36. NWSD error messages

Reason codes Code explanations

00000001 *NWSSTG was specified as the IPL source, but no storage space was found.

00000002 The partition specified in the PARTITION parameter was not found.

00000003 The partition specified in the PARTITION parameter is not a GUEST partition (that
is, the TYPE parameter for the partition specified in the PARTITION parameter
does not have a value of *GUEST).

00000004 There is already an NWSD in the IBM i logical partition that is active and using
the partition specified in the PARTITION parameter of the NWSD.

00000005 The partition specified in the PARTITION parameter of the NWSD is powered on
(perhaps through the LPAR configuration interface or from another IBM i logical
partition.)
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Table 36. NWSD error messages (continued)

Reason codes Code explanations

00000006 The partition is set to start from a stream file (stmf) and that did not work. You
should note that the user performing the vary on operation needs read access to
the IPL STMF parameter.

00000007 The NWSD is set to start from a network-storage space (NWSSTG), but the kernel
could not found the NWSSTG. Some common reasons are that the storage space
does not have a disk partition that is formatted as type 0x41 or is marked as
startable.

00000008 The partition would not start. There are a variety of reasons why the partition will
not start. You should look at the information for this partition and start reviewing
the SRCs.

00000009 The partition identified as the logical partition is not configured. You should
specify who has power controlling access to the partition.

00000010 A network server storage space linked to this network server is damaged. Contact
your next level of support.

00000011 Contact your next level of support to find a proper solution to the problem.

00000012 The resource name you selected in the RSRCNAME parameter is not valid. Use
the Work with Hardware Resources (WRKHDWRSC) command with the
TYPE(*CMN) parameter to help determine the resource name.

00000013 The resource you selected in the RSRCNAME command exists, but is not in the
partition you specified. Use the WRKHDWRSC command with the TYPE(*CMN)
parameter to help determine a resource name in the partition you specified.

00000014 Unable to determine partition for resource name. Either specify a partition directly
or update the resource definition at the HMC to indicate the client partition.

00000015 Unknown error occurred. Contact your next level of support.

Troubleshooting errors for Linux partitions using IBM i virtual I/O resources
In many cases, you can troubleshoot and resolve errors specific to Linux logical partitions using IBM i
virtual I/O resources without having to call service and support.

Debugging network server description error messages:

This topic provides a list of network server description (NWSD) error codes and explanations to help you
debug NWSD error messages for Linux logical partitions.

You could encounter error messages when you try to vary on a Linux logical partition. These error
messages are displayed if you provide information when you create your network server description
(NWSD) that does not apply to a logical partition running on the server. All error messages related to the
NWSD are displayed in QSYSOPR indicating a description of the problem and a resolution to the
problem.

Table 37. NWSD error messages

Reason codes Code explanations

00000001 *NWSSTG was specified as the IPL source, but no storage space was found.

00000002 The partition specified in the PARTITION parameter was not found. Use the
CHGNWSD IBM i Control Language (CL) command to compare the partition
name in the NWSD with the partition name created on the Hardware Management
Console (HMC), and change the partition name as necessary.

00000003 The partition specified in the PARTITION parameter is not a GUEST partition (that
is, the TYPE parameter for the partition specified in the PARTITION parameter
does not have a value of *GUEST).
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Table 37. NWSD error messages (continued)

Reason codes Code explanations

00000004 There is already an NWSD in the IBM i logical partition that is active and using
the partition specified in the PARTITION parameter of the NWSD.

00000005 The partition specified in the PARTITION parameter of the NWSD is powered on
(perhaps through the LPAR configuration interface or from another IBM i logical
partition.)

00000006 The partition is set to start from a stream file (stmf) and that did not work. You
should note that the user performing the vary on operation needs read access to
the IPL STMF parameter.

00000007 The NWSD is set to start from a network-storage space (NWSSTG), but the kernel
could not found the NWSSTG. Some common reasons are that the storage space
does not have a disk partition that is formatted as type 0x41 or is marked as
startable.

00000008 The partition would not start. There are a variety of reasons why the partition will
not start. You should look at the information for this partition and start reviewing
the SRCs.

00000009 The partition identified as the logical partition is not configured. You should
specify who has power controlling access to the partition.

00000010 A network server storage space linked to this network server is damaged. Contact
your next level of support.

00000011 Contact your next level of support to find a proper solution to the problem.

00000012 The resource name you selected in the RSRCNAME parameter is not valid. Use
the Work with Hardware Resources (WRKHDWRSC) command with the
TYPE(*CMN) parameter to help determine the resource name.

00000013 The resource you selected in the RSRCNAME command exists, but is not in the
partition you specified. Use the WRKHDWRSC command with the TYPE(*CMN)
parameter to help determine a resource name in the partition you specified.

00000014 Unable to determine partition for resource name. Either specify a partition directly
or update the resource definition at the HMC to indicate the client partition.

00000015 Unknown error occurred. Contact your next level of support.

Troubleshooting Linux virtual tape errors:

You can troubleshoot and recover from many common errors that are related to Linux virtual tape
without having to call service and support.

If errors occur while you access Linux virtual tape, examine the file /proc/System i/viotape. It describes
the mapping between IBM i device names and Linux device names and records the last error for each
tape device.

Table 38. Common errors and recovery scenarios for troubleshooting Linux virtual tape

Error Recovery scenario

Device unavailable Make sure the device is varied off in the IBM i logical
partition.

Not ready Retry the operation. If the operation still fails with the
same description in /proc/iSeries/viotape, verify that
the correct medium is in the tape drive.

Load failure or cleaning cartridge found Verify that the correct medium is in the tape drive.
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Table 38. Common errors and recovery scenarios for troubleshooting Linux virtual tape (continued)

Error Recovery scenario

Data check or Equipment check Verify that you are using a supported block size to read
or write the tape. All known tape devices that are
supported by IBM can use a block size of 20 KB
(supplied by the -b 40 argument to tar).

Internal error Contact your service representative.

Situations requiring the assistance of an authorized service provider
Some IBM i troubleshooting tasks on the server require the assistance of an authorized service provider.
These tasks are not common and are only performed if the authorized service provider deems it
necessary.

If you need to perform any of these tasks on your server, consult the Support for IBM Systems and
servers Web site for information on System i support.

Main storage dumps on IBM i logical partitions

When your system performs a main storage dump, contact service and support.

On a system with logical partitions, two types of failures can cause main storage dumps: server failure
and logical partition failure.

Failures caused by server processing hardware or server firmware might cause the entire server to fail.
Software failures in a logical partition cause only that logical partition to fail. A server failure may cause
a platform system dump. A logical partition failure may cause a main storage dump only on that logical
partition.

You can also force a main storage dump on a logical partition or managed system when you are directed
to do so by an authorized service provider.

Using remote service with logical partitions

You can use the Hardware Management Console (HMC) to enable remote services with logical partitions.
Remote service is a method that an authorized service provider can use to access your managed system
through a modem.

Attention: Use this procedure only when directed to do so by service and support, and ensure that
remote service is deactivated when you authorized service provider is finished with it. It is a security risk
to leave remote service enabled when not in use. Someone could access your server without your
knowledge.

The logical partition that is using remote service must have an electronic customer support
communications IOP with a modem. The IOP needs to be tagged as the electronic customer support
resource for the logical partition. If the communications IOP is on a shared bus and is used by another
logical partition, switch the IOP to the logical partition that needs to use the modem. If this IOP is also
attached to Operations Console, the console may be unavailable until the IOP is switched back to the
original logical partition.
1. Create user ID.
2. Service Applications > Remote Support > Customize Inbound Connectivity Settings
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Shutting down a power domain with logical partitions

You can use the Hardware Management Console (HMC) to power off, repair, and power on the
appropriate power domain when a disk unit I/O processor (IOP) or disk unit I/O adapter (IOA) fails.
This allows you to replace the IOP or IOA without restarting the logical partition or managed system.

Attention: Use this procedure only when directed to do so by service and support. Incorrect use of this
function can cause loss of data. It can also cause failures that may be incorrectly diagnosed as expensive
hardware failures.

When a disk unit IOP or IOA fails, communication with the disk units (which is controlled by the) IOP or
IOA is lost resulting in a disk unit attention SRC and possibly partial or complete loss of system
responsiveness.

Resetting a disk unit IOP with IBM i logical partitions

You can use the Hardware Management Console (HMC) to reset a disk unit I/O processor (IOP). This
function should only be used to start an IOP dump to reset the IOP or to reload IOP. This function
becomes enabled when certain disk unit reference codes are displayed and the associated IOP supports a
reset or reload function.

Attention: Use this procedure only when directed to do so by service and support. Incorrect use of this
function can cause loss of data. It can also cause failures that may be incorrectly diagnosed as expensive
hardware failures.
Related information

Performing dumps
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Notices

This information was developed for products and services offered in the U.S.A.

The manufacturer may not offer the products, services, or features discussed in this document in other
countries. Consult the manufacturer’s representative for information on the products and services
currently available in your area. Any reference to the manufacturer’s product, program, or service is not
intended to state or imply that only that product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any intellectual property right of the
manufacturer may be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any product, program, or service.

The manufacturer may have patents or pending patent applications covering subject matter described in
this document. The furnishing of this document does not grant you any license to these patents. You can
send license inquiries, in writing, to the manufacturer.

For license inquiries regarding double-byte character set (DBCS) information, contact the Intellectual
Property Department in your country or send inquiries, in writing, to the manufacturer.

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: THIS INFORMATION IS PROVIDED “AS IS ” WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
The manufacturer may make improvements and/or changes in the product(s) and/or the program(s)
described in this publication at any time without notice.

Any references in this information to Web sites not owned by the manufacturer are provided for
convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at
those Web sites are not part of the materials for this product and use of those Web sites is at your own
risk.

The manufacturer may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact the
manufacturer.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement,
IBM License Agreement for Machine Code, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
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been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning products not produced by this manufacturer was obtained from the suppliers of
those products, their published announcements or other publicly available sources. This manufacturer has
not tested those products and cannot confirm the accuracy of performance, compatibility or any other
claims related to products not produced by this manufacturer. Questions on the capabilities of products
not produced by this manufacturer should be addressed to the suppliers of those products.

All statements regarding the manufacturer’s future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only.

The manufacturer’s prices shown are the manufacturer’s suggested retail prices, are current and are
subject to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to the manufacturer, for the purposes of developing, using, marketing or
distributing application programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not been thoroughly tested
under all conditions. The manufacturer, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs.

Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. _enter the year or years_. All rights reserved.

If you are viewing this information in softcopy, the photographs and color illustrations may not appear.

Programming interface information
This Logical partitioning publication documents intended Programming Interfaces that allow the
customer to write programs to obtain the services of IBM AIX Version 6.1, IBM AIX 5L Version 5.3,
Virtual I/O Server version 2.1.1, and version 6, release 1, modification 0 of IBM i (product number
5722-SS1).

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at
Copyright and trademark information at www.ibm.com/legal/copytrade.shtml.

234 Logical partitioning

http://www.ibm.com/legal/copytrade.shtml


Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Red Hat, the Red Hat ″Shadow Man″ logo, and all Red Hat-based trademarks and logos are trademarks
or registered trademarks of Red Hat, Inc., in the United States and other countries.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, or service names may be trademarks or service marks of others.

Terms and conditions
Permissions for the use of these publications is granted subject to the following terms and conditions.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of the manufacturer.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of the manufacturer.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any data, software or other intellectual property contained
therein.

The manufacturer reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as determined by the manufacturer,
the above instructions are not being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

THE MANUFACTURER MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THESE PUBLICATIONS ARE PROVIDED ″AS-IS″ AND WITHOUT WARRANTY OF
ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED
WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR
PURPOSE.
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